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บทคดัย่อ 
 

การวิจยัคร้ังน้ีมีวตัถุประสงค์ 1) เพื่อพฒันาห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ย
โปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 2) เพื่อหาประสิทธิภาพห้องเรียน
เสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6  ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
3) เพื่อเปรียบเทียบผลสัมฤทธ์ิก่อนเรียนและหลงัเรียน และ 4) เพื่อหาความพึงพอใจของนกัเรียนชั้น
ประถมศึกษาปีท่ี 6 ท่ีใชห้อ้งเรียนเสมือน วชิาคอมพิวเตอร์ 
 กลุ่มตวัอย่างท่ีใชใ้นการวิจยัเป็นนกัเรียนชั้นประถมศึกษาปีท่ี 6/1 โรงเรียนมีนประสาท
วทิยา สังกดัส านกังานคณะกรรมการส่งเสริมการศึกษาเอกชน กระทรวงศึกษาธิการ ปีการศึกษา 2558 
จ านวน 30 คน เคร่ืองมือท่ีใชใ้นการวิจยั ประกอบดว้ย แบบสอบถามความคิดเห็นส าหรับผูเ้ช่ียวชาญ 
ห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6 แบบทดสอบก่อนเรียนและ
หลงัเรียน แบบสอบถามความพึงพอใจของนกัเรียนท่ีมีต่อห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์
ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6 สถิติท่ีใชใ้นการวิจยั ไดแ้ก่ ค่าร้อยละ ค่าเฉล่ีย ค่าเบ่ียงเบนมาตรฐาน 
และการทดสอบค่าที ของกลุ่มตวัอยา่งไม่อิสระ (t-test for dependent  sample)   
 ผลก ารว ิจ ัยพบว ่า  ห ้อง เ รี ยน เสมือน  เ ร่ื อง  ก า รสร้า ง เ ว ็บ ไซต์ด ้ว ยโปรแกรม        
ดรีมวีฟเวอร์ CS6 มีประสิทธิภาพตามเกณฑ์โดยเฉล่ียเท่ากบั 81.92/80.56 ผลสัมฤทธ์ิทางการเรียน
ของนกัเรียนหลงัเรียนสูงกว่าก่อนเรียน มีค่า t-test เท่ากบั 26.67 มีค่าเฉล่ียก่อนเรียนเท่ากบั 13.07   
ส่วนเบ่ียงเบนมาตรฐาน  2.16  และค่าเฉล่ียหลงัเรียนเท่ากบั 24.17 ส่วนเบ่ียงเบนมาตรฐาน 0.99 ซ่ึงมี
ความแตกต่างอยา่งมีนยัส าคญัทางสถิติท่ีระดบั 0.05 และความพึงพอใจของนกัเรียนท่ีมีต่อห้องเรียน
เสมือน วิชาคอมพิวเตอร์ เร่ือง การสร้างเวบ็ไซต์ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6  มีค่าเฉล่ียเท่ากบั 
4.69 อยูใ่นระดบัมากท่ีสุด มีค่าส่วนเบ่ียงเบนมาตรฐาน 0.48 
ค าส าคัญ: หอ้งเรียนเสมือน การสร้างเวบ็ไซต ์โปรแกรมดรีมวฟีเวอร์  
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ABSTRACT 
 

 The objectives of this study are to 1) develop virtual classroom in creating website with 
Dreamweaver CS6 program for Prathomsuksa 6 students, 2) gain the efficiency of the virtual 
classroom in creating a website with Dreamweaver CS6 program for Prathomsuksa 6 students, 3) 
compare the students’ pretest and posttest scores in the Computer subject, and 4) identify the 
students’ satisfaction on learning through the virtual classroom in the Computer subject. 

The samples used in the study were 30 students studyin g at Prathomsuksa 6 at                                         
Minprasatwitaya School under the Office of Private Education, Ministry of Education in the 
academic year 2015. The research instruments consisted of a questionnaire to gain opinions from 
experts of virtual classroom in creating a website with Dreamweaver CS6 program, a pretest and 
posttest in the Computer subject, and a questionnaire on students’ satisfaction on learning through 
the virtual classroom in creating a website with Dreamweaver CS6 program. The statistical devices 
used in the study were percentage, mean, standard deviation, and t-test for dependent samples. 
 The findings revealed that the virtual classroom in creating website with Dreamweaver 
CS6 program for Prathomsuksa 6 has the efficiency of 81.92/80.56 in average based on the set 
criteria. The students’ learning achievement after learning via the virtual classroom was higher than 
that of the pretest. The statistical analysis of the results was the t-test: 22.67, the mean of the pretest: 
13.07, and S.D.: 2.16 while the mean of the posttest was 24.17, and S.D.: 0.99 which is statistically 
significant at the 0.05 level. The students’ satisfaction on learning via the virtual classroom in 
creating website with Dreamweaver CS6 program gained the average of 4.69 which was at the 
highest level with S.D.: 0.48.  
Keywords: virtual classroom, building site, dream weaver CS6 program 
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บทที่1 
บทน า 

 

1.1  ความเป็นมาและความส าคญัของปัญหา 
 ปัจจุบนัเทคโนโลยสีารสนเทศมีบทบาทส าคญัเพื่อส่ือสารทางการศึกษาและการพฒันาทาง
การศึกษาดา้นต่างๆไดแ้ก่ดา้นบริหารดา้นบริการและดา้นวิชาการตลอดจนดา้นธุรกิจดา้นสาธารณสุข
ดา้นการทหารและความมัน่คงดา้นโทรคมนาคมและการส่ือสารซ่ึงทุกหน่วยงานดา้นต่างๆจ าเป็นตอ้ง
ใช้เทคโนโลยีสารสนเทศเป็นเคร่ืองมือส าคญัในการบริหารการจดัการในองค์กรเพื่อเพิ่มระดบัขีด
ความสามารถในการจดัการกบัขอ้มูลสารสนเทศการติดต่อส่ือสารถึงกนัทั้งภายในและภายนอกองคก์ร
มีการเผยแพร่ส่ือสารขอ้มูลข่าวสารสารสนเทศต่างๆผ่านเทคโนโลยีระบบเครือข่ายขยายไปทัว่โลก
หน่วยงานต่างๆเทคโนโลยีสารสนเทศและการส่ือสารเพื่อการศึกษาจึงเป็นทั้งเคร่ืองมือหลกัและ
เคร่ืองมือสนบัสนุนท่ีตอ้งจดัหาและน ามาใชใ้นการเรียนการสอนเพื่อให้เป็นไปตามลกัษณะการศึกษา
ท่ีสอดคลอ้งตามพระราชบญัญติัการศึกษาแห่งชาติท่ีไดก้ าหนดทิศทางและนโยบายการจดัการศึกษา
ไทยหน่วยงานภาครัฐและหน่วยงานท่ีเก่ียวข้องจึงต้องด าเนินการอย่างเร่งด่วนสอดคล้องกับ
พระราชบญัญติัการศึกษาแห่งชาติ พ.ศ. 2542 แกไ้ขเพิ่มเติม (ฉบบัท่ี 2) พ.ศ.2545 และ (ฉบบัท่ี 3) พ.ศ. 
2543 หมวด 9 วา่ดว้ยเทคโนโลยีทางการศึกษา มาตรา 66 ไดก้ล่าววา่ “ผูเ้รียนมีสิทธิไดรั้บการพฒันา
ขีดความสามารถในการใชเ้ทคโนโลยีเพื่อการศึกษาในโอกาสแรกท่ีท าได ้ เพื่อให้มีความรู้และทกัษะ
เพียงพอท่ีจะใชเ้ทคโนโลยีเพื่อการศึกษาในการแสวงหาความรู้ดว้ยตนเองไดอ้ยา่งต่อเน่ืองตลอดชีวิต
ผูเ้รียนมีสิทธิไดรั้บการพฒันาความสามารถในการใช้เทคโนโลยีเพื่อการศึกษา เพื่อให้มีความรู้และ
ทกัษะในการใชท่ี้คุม้ค่าและเหมาะสมกบักระบวนการเรียนรู้ของคนไทย” 

นอกจากน้ีเพื่อให้ทนัต่อความกา้วหน้าของเทคโนโลยีท่ีมีผลต่อการก าหนดคุณสมบติัและ
คุณภาพของแรงงานในอนาคตดงันั้นการจดัการศึกษาจึงตอ้งมีการเพิ่มเติมความรู้เก่ียวกบัเทคโนโลยี
ใหม่ๆในหลกัสูตรการเรียนการสอนและปรับปรุงให้ทนัต่อการเปล่ียนแปลงเทคโนโลยีและควรตอ้ง
ปรับโครงสร้างพื้นฐานดา้นช่องทางและส่ือเทคโนโลยีสารสนเทศเทคโนโลยีการขนส่งเทคโนโลยี
การผลิตนาโนเทคโนโลยเีทคโนโลยชีีวภาพซ่ึงเทคโนโลยเีหล่าน้ีลว้นมีความกา้วหนา้ข้ึนอยา่งต่อเน่ือง
เพื่อให้เกิดประโยชน์และเพิ่มศกัยภาพการแข่งขนัของประเทศยุคของเทคโนโลยีสารสนเทศท่ีมีการ
ปฏิรูปการจดัการเรียนการสอนด้วยการใช้ส่ือการสอนท่ีทนัสมยัเพื่อการจดัการเรียนการสอนใน
หลากหลายวิชา เช่น มีการใช้คอมพิวเตอร์เขา้มาช่วยจดัการเรียนการสอนเพื่อพฒันาและส่งเสริมให้
ผูเ้รียนมีคุณภาพ มีความคิดสร้างสรรคม์ากข้ึน  (ทศพร แสงสวา่ง, 2556, น. 1) โดยเฉพาะปัจจุบนัน้ีมี
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การน าแนวคิดและหลกัจิตวทิยาการเรียนรู้ กระบวนการเรียนรู้ต่างๆ เขา้มาช่วยท าใหกิ้จกรรมการเรียน
การสอนมีประสิทธิภาพมากข้ึน นกัเรียนทุกคนสามารถเรียนรู้ไดจ้นมีพฤติกรรมถึงเกณฑ์ตามเง่ือนไข
ท่ีแตกต่างกนัออกไป อนัไดแ้ก่ การใชเ้ทคนิคการสอนหลายๆวิธี เพื่อให้เหมาะสมกบันกัเรียนแต่ละ
กลุ่ม การใหเ้วลาในการเรียนรู้แก่นกัเรียนแต่ละคนอยา่งเพียงพอ และการใชเ้ทคนิควิธีต่างๆในการจูง
ใจให้นักเรียนเกิดแรงจูงใจใฝ่รู้ใฝ่เรียน ดงันั้นจึงเป็นหน้าท่ีของครูท่ีจะตอ้งคิดคน้หาวิธีการท่ีจะให้
ผูเ้รียนเกิดผลสัมฤทธ์ิสูงสุด และมีเจตคติท่ีดีต่อการเรียนวชิานั้นๆ  

การจดัการเรียนการสอนแบบหอ้งเรียนเสมือนเป็นนวตักรรมใหม่ทางการศึกษาท่ีก าลงัเป็น
ท่ีสนใจและยงัใหม่มากส าหรับผูเ้รียนและผูส้อนจ านวนมาก หากพิจารณาจากแนวคิดในการน าเอา
เทคโนโลยีสมยัใหม่มาประยุกตใ์ชเ้พื่อแกปั้ญหาดา้นทางการศึกษา จะเห็นไดว้า่ การจดัการเรียนการ
สอนแบบห้องเรียนเสมือนน่าจะมีความส าคญัมากต่อการเรียนการสอน เน่ืองจากความหลากหลาย
ของเทคโนโลยี ท าให้ผูส้อนสามารถน าเสนอบทเรียนรวมทั้งกิจกรรมการเรียนท่ีเอ้ือให้ผูเ้รียนท่ีมี
ความแตกต่างกนัในการรับรู้และเรียนรู้สามารถเรียนรู้ไดอ้ยา่งมีศกัยภาพตามสภาพแวดลอ้มของการ
น าเสนอท่ีแตกต่างกนั (ธนิดา หนูแป้น, 2552, น. 14-15) 

จากงานวิจยัของสุรพล บุญลือ (2550, น. 94) พบว่า การพฒันารูปแบบการสอนโดยใช้
หอ้งเรียนเสมือนแบบใชปั้ญหาเป็นหลกัในระดบัอุดมศึกษา ท าให้นกัศึกท่ีเรียนจากห้องเรียนเสมือนมี
ผลการเรียนสูงกว่านักเรียนท่ีเรียนจากห้องเรียนปกติ และนอกจากน้ีงานวิจยัของธนิดา   หนูแป้น 
(2552, น. 80) พบวา่ การเรียนดว้ยหอ้งเรียนเสมือนส าหรับการเรียนแบบใชปั้ญหาเป็นหลกัเร่ืองการใช ้
Microsoft Excel เพื่อการค านวณท าใหก้ลุ่มตวัอยา่งเกิดประสิทธิผลทางการเรียนรู้เพิ่มข้ึน 

กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย(ีคอมพิวเตอร์) จะสอดคลอ้งกบัสาระท่ี 3 
เทคโนโลยีสารสนเทศและการส่ือสาร มาตรฐาน ง 3.1 เขา้ใจ เห็นคุณค่า และใชก้ระบวนการ
เทคโนโลยสีารสนเทศในการสืบคน้ขอ้มูล การเรียนรู้ การส่ือสาร การแกปั้ญหา การท างาน และอาชีพ
อยา่งมีประสิทธิภาพ ประสิทธิผล และมีคุณธรรม ตวัช้ีวดัท่ี 4 น าเสนอขอ้มูลในรูปแบบท่ีเหมาะสม
โดยเลือกใชซ้อฟตแ์วร์ประยุกต์ และตวัช้ีวดัท่ี 5 ใชค้อมพิวเตอร์ช่วยสร้างช้ินงานจากจินตนาการหรือ
งานท่ีท าในชีวติประจ าวนัอยา่งมีจิตส านึกและความรับผดิชอบ  

จากผลการส ารวจสภาพปัญหาการจดัการเรียนการสอนวิชาคอมพิวเตอร์ของครูผูส้อนท่ี
สอนในโรงเรียนในเขตพื้นท่ีการศึกษากรุงเทพมหานครเขต 1 จ านวน 25 โรงเรียน พบวา่ ปัญหาการ
จดัการเรียนการสอนวชิาคอมพิวเตอร์ในปัจจุบนั โดยมีรายการประเมินค่าเฉล่ียโดยรวมอยูท่ี่ 3.95  ซ่ึง
แปลผลออกมาไดว้่าอยู่ในระดบัเห็นดว้ยมาก โดยสภาพปัญหาท่ีพบมากท่ีสุด คือ นกัเรียนขาดความ
ตั้งใจในการเขา้เรียนรู้ อุปกรณ์ไม่เพียงพอกบัความตอ้งการของผูเ้รียน และเวลาในการใช้งานและ
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เรียนรู้ในสถานศึกษามีน้อย เกินไป ส่วนในดา้นการจดัการเรียนการสอนส่วนใหญ่จะเห็นดว้ยมาก
ท่ีสุดกบัการสอนผา่นเวบ็ (หอ้งเรียนเสมือน) และการสอนแบบทดลอง ผูต้อบแบบสอบถามส่วนใหญ่
ตอ้งการสอนดว้ยการสอนดว้ยห้องเรียนเสมือน (ผา่นเวบ็) เป็นส่ือประกอบการจดัการเรียนการสอน 
กิจกรรมการเรียนการสอนส่วนใหญ่ตอ้งการให้นักเรียนท างานเป็นกลุ่ม ระดมความคิด และสร้าง
ผลงาน ตอ้งการให้จดัการเรียนการสอนโดยเนน้เทคโนโลยี(ห้องเรียนเสมือน) มากท่ีสุด และตอ้งการ
จดัการเรียนการสอนผา่นเครือข่าย ในหวัขอ้การติดต่อส่ือสารผา่นแอพพลิเคชัน่ไลน์มากท่ีสุด 

อย่างไรก็ตามถึงแม้ว่าเทคโนโลยีสารสนเทศจะมีความส าคญัต่อการเรียนการสอนวิชา
คอมพิวเตอร์ แต่ยงัพบปัญหาคือนกัเรียนส่วนใหญ่สามารถใชค้อมพิวเตอร์เพื่อเล่นเกม ท างานเอกสาร
และใช้งานอินเทอร์เน็ตพื้นฐานได ้แต่ยงัไม่สามารถใช้คอมพิวเตอร์ในการสืบคน้ขอ้มูล การใช้งาน
อินเทอร์เน็ตเพื่อการศึกษาและการเรียนการสอนผ่านเวบ็ นกัเรียนไม่สามารถแสวงหาความรู้ไดด้ว้ย
ตนเอง ท าใหก้ารเรียนของนกัเรียนจ ากดัความคิดและสร้างกรอบใหก้บัการเรียน และจากขอ้มูลในการ
จดักิจกรรมการเรียนการสอนของขา้พเจา้ในโรงเรียนมีนประสาทวิทยา ท่ีผา่นมา นกัเรียนมีเวลาเรียน
แค่ในห้องเรียนสัปดาห์ละ 1 ชัว่โมงซ่ึงเป็นเวลาท่ีนอ้ยมาก และไม่เอ้ือต่อการเรียนรู้ของนกัเรียนท่ีมี
ความแตกต่างกนัในการรับรู้และเรียนรู้ เม่ือนกัเรียนบางคนไม่เขา้ใจในบทเรียนท่ีผา่นมาก็ไม่สามารถ
ท่ีจะทบทวนบทเรียนท่ีผา่นไปแลว้ได ้เน่ืองจากวชิาคอมพิวเตอร์นั้นส่วนใหญ่เป็นวิชาท่ีเนน้ปฏิบติัเม่ือ
เรียนในหอ้งเรียนแลว้นกัเรียนจะตอ้งหาเวลาวา่งไปทบทวนดว้ยตนเองซ่ึงบางคร้ังนกัเรียนจ าบทเรียน
ท่ีเรียนไปไม่ไดจึ้งไม่สามารถทบทวนดว้ยตนเองไดเ้พียงล าพงั 

จากขอ้มูลดงักล่าวขา้งตน้ท าให้ผูว้ิจยัเห็นความส าคญัท่ีจะแกปั้ญหาดงักล่าวโดยการพฒันา
ห้องเรียนเสมือน ในฐานะท่ีเป็นครูผูส้อนคอมพิวเตอร์ไดห้ารูปแบบวิธีการสอนแบบต่างๆ ท่ีจะช่วย
ใหผู้เ้รียนเกิดความสนใจในบทเรียน สามารถแสดงออกตามความสามารถความสนใจ และความถนดั
ของตนเอง มีการคน้ควา้และแสวงหาความรู้ดว้ยตนเอง เพื่อให้คิดเป็น ท าเป็น วิเคราะห์เป็น แกปั้ญหา
ไดอ้ยา่งเหมาะสม และสามารถทบทวนบทเรียนไดทุ้กท่ีทุกเวลา ท าให้ผูเ้รียนไดพ้ฒันาตามศกัยภาพ 
โดยมีครูวางแผนร่วมกบัผูเ้รียน กระตุน้ ทา้ทาย ให้ก าลงัใจ และช้ีแนะแนวทางการแสวงหาความรู้ท่ี
ถูกตอ้ง การน าเอาความรู้เทคโนโลยีสารสนเทศมาใช ้และประยุกตใ์ชใ้นการท างาน และในสังคมยุค
สารสนเทศซ่ึงเป็นสังคมแห่งภูมิปัญญาและการเรียนรู้นั้นสมรรถนะทางเทคโนโลยีการศึกษาเป็นส่ิงท่ี
ส าคัญ เทคโนโลยีคอมพิวเตอร์ถือเป็นเทคโนโลยีท่ีมีบทบาทโดยตรงกับระบบการศึกษา โดย
เทคโนโลยีคอมพิวเตอร์สามารถน าเสนอและแสดงผลดว้ยระบบส่ือต่างๆ ทั้งในดา้นขอ้มูล รูปภาพ 
เสียง ภาพเคล่ือนไหว และวิดีโอ ท าให้การเรียนรู้ยุคใหม่ประสบความส าเร็จได้ดี (ยืน ภู่วรวรรณ, 
2544, น. 47-58) ผูว้ิจยัจึงไดส้นใจศึกษาวิจยัเร่ือง การพฒันาห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์
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ดว้ยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 วา่ส่งผลต่อผลสัมฤทธ์ิทางการ
เรียน และความพึงพอใจต่อบทเรียน อนัจะเป็นแนวทางในการท าห้องเรียนเสมือน เพื่อเพิ่ม
ประสิทธิภาพในการจดัการศึกษาต่อไปในอนาคต  
 

1.2  วตัถุประสงค์การวจิัย 
 1.2.1  เพื่อพฒันาห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6 
ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 1.2.2  เพื่อหาประสิทธิภาพของหอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม ดรีม
วฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 1.2.3  เพื่อหาผลสัมฤทธ์ิทางการเรียนของนักเรียนท่ีเรียนด้วยห้องเรียนเสมือน เร่ือง         
การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 1.2.4  เพื่อศึกษาความพึงพอใจของนักเรียนท่ีเรียนด้วยห้องเรียนเสมือน เร่ือง การสร้าง
เวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 

1.3  สมมติฐานการวจิัย 
 1.3.1  ห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับ
นกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีมีคุณภาพระดบัมากข้ึน ( ≥ 3.50) 
 1.3.2  ห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับ
นกัเรียนชั้นประถมศึกษาปีท่ี 6  มีประสิทธิภาพตามเกณฑม์าตรฐาน 80/80 
 1.3.3  นกัเรียนชั้นประถมศึกษาปีท่ี 6 มีผลสัมฤทธ์ิทางการเรียนหลงัเรียนดว้ยห้องเรียน
เสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 เพิ่มข้ึนมากกว่าก่อนเรียนอย่างมี
นยัส าคญัทางสถิติท่ีระดบั .05 
 1.3.4  นกัเรียนมีความพึงพอใจต่อห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ยโปรแกรมด
รีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ในระดบัมากข้ึนไป 
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1.4  ขอบเขตของการวจิัย 
 1.4.1  ขอบเขตด้านเน้ือหาในการวิจยัคร้ังน้ีเป็นวิชาคอมพิวเตอร์ ชั้นประถมศึกษาปีท่ี 6 
ภาคเรียนท่ี 2 หน่วยการเรียนรู้ท่ี 4 การสร้างเวบ็เพจดว้ยดรีมวีฟเวอร์ ซ่ึงประกอบไปดว้ยหน่วยการ
เรียนรู้ย่อย 10 เร่ือง ได้แก่ ความรู้เก่ียวกบัโปรแกรม การเรียกใช้งานโปรแกรม ส่วนประกอบของ
โปรแกรม รู้จกัแถบเคร่ืองมือ ขั้นตอนการสร้างเวบ็ การบนัทึกและเปิดเวบ็เพจ การใส่ขอ้ความลงบน
เวบ็เพจ การแทรกภาพบนเวบ็เพจ และการแทรกมลัติมิเดียบนเวบ็เพจ 
 1.4.2  ขอบเขตดา้นประชากรและกลุ่มตวัอยา่ง 

ประชากรที่ใช้ในการวิจยัคร้ังน้ี เป็นนักเรียนที่เรียนรายวิชาคอมพิวเตอร์    
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี ชั้นประถมศึกษาปีท่ี 6 ภาคเรียนท่ี 2 ปีการศึกษา 
2558 โรงเรียนมีนประสาทวิทยา ส านักงานคณะกรรมการส่งเสริมการศึกษาเอกชน  จ านวน 2 
หอ้งเรียน เป็นนกัเรียนชั้นประถมศึกษาปีท่ี 6 /1 จ านวน 30 คน และชั้นประถมศึกษา  ปีท่ี 6 /2 จ านวน 
30 คน รวมประชากรทั้งหมด 60 คน   

กลุ่มตวัอยา่งท่ีใชใ้นการวิจยัคร้ังน้ี ไดแ้ก่ นกัเรียนชั้นประถมศึกษาปีท่ี 6/1 โรงเรียน
มีนประสาทวิทยา จงัหวดักรุงเทพมหานคร จ านวน 30 คน โดยใช้วิธีเลือกแบบเจาะจง (Purposive 
Sampling) เน่ืองจากกลุ่มตวัอยา่งดงักล่าวเป็นกลุ่มตวัอยา่งท่ีผูว้ิจยัท าการควบคุมชั้นเรียนอยูจึ่งเลือก
กลุ่มตวัอยา่งกลุ่มน้ีมาเพื่อท าการวจิยั 

1.4.3  ตวัแปรท่ีศึกษา  
          การวจิยัในคร้ังน้ี ผูว้จิยัไดก้  าหนดตวัแปรท่ีศึกษา ดงัน้ี 
          1.4.3.1  ตวัแปรตน้ (Independent Variable) ไดแ้ก่  

ห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 
ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  

          1.4.3.2  ตวัแปรตาม (Dependent Variable) ไดแ้ก่ 
     1) ผลสัมฤทธ์ิทางการเรียนของนกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีเรียน
ดว้ยหอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 
     2) ความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีมีต่อห้องเรียน
เสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 

1.4.4  สถานท่ีท าการศึกษา 
โรงเรียนมีนประสาทวทิยา จงัหวดักรุงเทพมหานคร 
 



 
 

18 
 

1.4.5  ระยะเวลาท าการศึกษา 
 การวจิยัใชเ้วลาระหวา่งวนัท่ี  2 พฤศจิกายน  2558  ถึง 27 พฤศจิกายน 2558 

1.5  ค าจ ากดัความในการวจิัย 
1.5.1 ห้องเรียนเสมือน หมายถึง การเรียนการสอนผา่นระบบเครือข่ายคอมพิวเตอร์โดยจดั

สภาพแวดลอ้มทางการเรียนใหเ้หมือนกบัเรียนในหอ้งเรียนจริง โดยมีวิดีโอการสอนบทเรียนในแต่ละ
หน่วยการเรียนรู้ และมีการติดต่อครูประจ าวิชาด้วยโปรแกรมแชทและวิดีโอคอล ผูเ้รียนสามารถ
เรียนรู้ได้ทุกท่ีทุกเวลา มีความสมบูรณ์เบ็ดเสร็จในตวัเอง ส่ือ เน้ือหา ใบงานมีความสัมพนัธ์และ
สอดคลอ้งกบัเน้ือหาการใช้โปรแกรมอะโดบีดรีมวีฟเวอร์ (Adobe Dreamweaver) ในการสร้างเวบ็
อย่างง่าย สามารถน ามาใช้ในการเรียนการสอนเพื่อให้เกิดการเรียนรู้ด้วยตนเอง เป็นการทบทวน
บทเรียนดว้ยตนเองอยา่งไม่จ  ากดัเวลา และสถานท่ี 
 1.5.2 วิชาคอมพิวเตอร์ หมายถึง บทเรียนวิชาคอมพิวเตอร์ท่ีเรียนผ่านห้องเรียนเสมือน 
ระดบัชั้นประถมศึกษาปีท่ี 6 ภาคเรียนท่ี 2 ปีการศึกษา 2558 หน่วยการเรียนรู้ท่ี 4 การสร้างเวบ็เพจดว้ย          
ดรีมวิฟเวอร์ ซ่ึงประกอบไปดว้ยหน่วยการเรียนรู้ยอ่ย 10 เร่ือง ไดแ้ก่ ความรู้เก่ียวกบัโปรแกรม การ
เรียกใช้งานโปรแกรม ส่วนประกอบของโปรแกรม รู้จกัแถบเคร่ืองมือ ขั้นตอนการสร้างเว็บ การ
บนัทึกและเปิดเว็บเพจ การใส่ข้อความลงบนเว็บเพจ การแทรกภาพบนเว็บเพจ และการแทรก          
มลัติมิเดียบนเวบ็เพจ 

1.5.3 นักเรียน หมายถึง นักเรียนชั้นประถมศึกษาปีท่ี 6 โรงเรียนมีนประสาทวิทยา 
กรุงเทพมหานคร ท่ีเรียนวิชาคอมพิวเตอร์ ในภาคเรียนท่ี 1 ปีการศึกษา 2558 จ านวน 2 ห้องเรียน 
จ านวน 60 คน 
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1.6  กรอบแนวคดิในการท าวจิัย 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
ภาพที ่1.1  กรอบแนวคิดการวจิยั การพฒันาหอ้งเรียนเสมือนเร่ือง การสร้างเวบ็ไซตด์ว้ย
 โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
 

การพฒันาห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม 
ดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 

 

ห้องเรียนเสมือน เร่ือง การสร้าง
เวบ็ไซตด์ว้ยโปรแกรม   ดรีมวีฟ
เวอร์ CS6 ส าหรับนักเรียนชั้น
ประถมศึกษาปีท่ี 6     มี
ป ร ะ สิ ท ธิ ภ า พ ต า ม เ ก ณ ฑ์
มาตรฐาน80/80 

ผลสัมฤทธ์ิทางการเรียนหลงัจาก
เรียนด้วยห้องเรียนเสมือน เร่ือง 
การสร้างเวบ็ไซต์ดว้ยโปรแกรมด
รีม วีฟเวอร์ CS6 เพ่ิมข้ึนอย่างมี
นยัส าคญัทางสถิติท่ีระดบั.05 

ความพึงพอใจต่อหอ้งเรียนเสมือน 
เ ร่ื อ ง  ก ารส ร้ า ง เ ว็บไซต์ด้ว ย
โปรแกรมด รีมวีฟ เ วอ ร์  CS6 
ส าหรับนักเรียนชั้นประถมศึกษา
ปีท่ี 6 ในระดบัมากข้ึนไป 

จบ 

Join Class room 

Homepage 

ผา่น 

ติดต่อครูซี วิธีการใชง้านห้องเรียนเสมือน 

จุดประสงคก์ารเรียนรู้ 

แบบทดสอบก่อนเรียน 

วิดีโอการสอนขั้นตอนการสร้างเวบ็เพจ 

ใบงาน 1-4 

แบบทดสอบหลงัเรียน 
 

ไม่ผา่น 

วิดีโอคอลกบัครูซี 
ผา่นทางแอพพลิเคชัน่ไลน ์

ฐานขอ้มูล 
สมคัรสมาชิก Log in 
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1.7  ประโยชน์ทีค่าดว่าจะได้รับ 
 1.7.1  ห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับ
นกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีมีคุณภาพ 
 1.7.2  ไดห้อ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม ดรีมวีฟเวอร์ CS6 ส าหรับ
นกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีมีประสิทธิภาพตามเกณฑ ์80/80 
 1.7.3  ผลสัมฤทธ์ิทางการเรียนของนักเรียนท่ีเรียนด้วยห้องเรียนเสมือน เร่ือง การสร้าง
เวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 สูงข้ึน 
 1.7.4  นกัเรียนชั้นประถมศึกษาปีท่ี 6 มีความพึงพอใจท่ีเรียนดว้ยหอ้งเรียนเสมือน เร่ือง การ
สร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6  
 
   
 



 
 

 
 

บทที ่ 2 
เอกสารและงานวจิยัที่เกีย่วข้อง 

 
 ผูว้ิจยัได้ศึกษาเอกสารและงานวิจยัท่ีเก่ียวข้องเพื่อน ามาเป็นขอ้มูลในการพฒันาห้องเรียน
เสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษา ปีท่ี 6 
โดยไดจ้ดัเป็นหวัขอ้ดงัรายการต่อไปน้ี 
 2.1 แนวความคิดเก่ียวกบัหอ้งเรียนเสมือน 
 2.2 ขั้นตอนการพฒันาหอ้งเรียนเสมือน 
 2.3 เวบ็ไซต ์
 2.4 การหาประสิทธิภาพของการสอนและส่ือการสอน 
 2.5 ผลสัมฤทธ์ิทางการเรียน 
 2.6 ความพึงพอใจ 
 2.7 หลกัสูตรกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี ตามหลกัสูตรแกนกลาง
  การศึกษาขั้นพื้นฐาน  พ.ศ.2551 
 2.8 งานวจิยัท่ีเก่ียวขอ้ง 
 

2.1 แนวความคดิเกีย่วกบัห้องเรียนเสมอืน 
2.1.1  ความเป็นจริงเสมือนเพื่อการศึกษา 

  พรทิวา โตวิจิตร (2552, น. 32) กล่าวไวว้า่ในวงการศึกษา เป็นท่ีทราบกนัดีอยูแ่ลว้วา่
การสร้างจินตนาการเป็นวิธีการน าเสนอขอ้มูลและมโนทศัน์แก่ผูเ้รียนเพื่อช่วยให้เกิดความเขา้ใจและ
การปรับตวัให้เขา้กบัสังคม เพื่อให้บรรลุตามวตัถุประสงค์จึงมีการใชส่ื้อประกอบการสอนประเภท
หนงัสือ ภาพ และโสตทศันวสัดุมาใชใ้นการเรียนการสอน และในปัจจยัไดมี้การน าเทคโนโลยีความ
เป็นจริงเสมือนมาใช้เพิ่มพูนประสบการณ์ด้านน้ีแก่ผูเ้รียนได้เป็นอย่างดีในการสอนคณิตศาสตร์   
เฟอร์เนส ผูซ่ึ้งอยูใ่นวงการน้ีมากกวา่ 2 ทศวรรษไดก้ล่าววา่ ความเป็นจริงเสมือนสามารถน ามาใชใ้น
การปรับโครงสร้างทางการศึกษา นอกจากน้ีดา้นเทคโนโลยีความเป็นจริงเสมือน จะท าให้สารานุกรม
กลายเป็นพิพิธภณัฑ ์เป็นเสมือนท่ีเราสามารถท่องเท่ียวอยูภ่ายในสถาบนัท่ีนัน่ไดอ้ยา่งสนุกสนาน 
  สถาบันการศึกษาหลายแห่งในสหรัฐอเมริกา ได้เร่ิมเห็นความจ าเป็นในการน า
เทคโนโลยีความเป็นจริงเสมือนเขา้มาใช้ในการศึกษามากข้ึน โดยมีหน้าท่ีในการจดัหาการใช้อย่าง
เหมาะสมของความเป็นจริงเสมือน ตรวจสอบผลกระทบของความเป็นจริงเสมือนในการศึกษา 
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แพร่กระจายความรู้ทางดา้นน้ีให้กวา้งขวางออกไปมากทีสุดเท่าท่ีจะท าไดแ้ละคิดหาหนทางในการท่ี
จะน าความเป็นจริงเสมือนเขา้ไปเป็นส่วนหน่ึงในการเรียนการสอนระดบัชั้นต่างๆ 
   ผูว้ิจยัในห้องปฏิบติัการน้ีไดใ้ช้ซอร์ฟแวร์ Virtues Walkthrough ในการออกแบบ
หอ้งเรียนสามมิติและเดินเขา้ไปในหอ้งเรียนเสมือนเพื่อจดัโต๊ะและเกา้อ้ีท่ีใชเ้รียนในลกัษณะต่างๆ ให้
เหมือนกบัห้องเรียนจริง เพื่อดูวา่จะมีการจดัอยา่งไรให้เหมาะสมกบัการเรียนมากท่ีสุด และยงัท าการ
ประเมินโปรแกรมความเป็นจริงเสมือนของบริษทัต่างๆ เพื่อดูวา่โปรแกรมใดจะเหมาะสม ท่ีมาใชก้บั
ชั้นเรียนมากท่ีสุดทั้งดา้นราคาการใชอ้ยา่งคุม้ค่ารวมถึงความง่ายและสะดวกในการใชง้าน 
   การน าความเป็นจริงเสมือนมาใชใ้นการศึกษาในดา้นต่างๆ ดงัน้ี 
  1.  ส ารวจสถานท่ีและส่ิงของท่ีมีอยูท่ี่ผูเ้รียนไม่อาจเขา้ถึงได ้
  2.  ส ารวจของจริงซ่ึงถา้ไม่มีการเปล่ียนแปลงสัดส่วนขนาดและระยะเวลาแลว้ จะไม่
สามารถส ารวจไดอ้ยา่งมีประสิทธิผล 
   3.  สร้างสถานท่ีและวตัถุดว้ยคุณภาพท่ีดีกวา่เดิม 
   4.  มีปฏิสัมพนัธ์กบับุคคลอ่ืนท่ีอยูใ่นท่ีห่างไกลออกไป โดยผา่นทางสมาคมท่ีมีความ
สนใจในเร่ืองเดียวกนั หรือโดยเขา้ร่วมในโครงการระหวา่งผูเ้รียนดว้ยกนัท่ีอยูใ่นส่วนต่างๆของโลก 
   5.  มีปฏิสัมพนัธ์กบับุคคลจริงในโลกความเป็นจริงเสมือน 

  6.  สร้างและใช้มโนทศัน์ด้านนามธรรม เช่น โครงสร้างข้อมูลและฟังก์ชันด้าน
คณิตศาสตร์ 
   7.  มีปฏิสัมพนัธ์กบัส่ิงท่ีเป็นความจริงเสมือน เช่น ส่ิงท่ีอยูใ่นประวติัศาสตร์และส่ิงท่ี
เป็นปรัชญาเพื่อดูวา่จะสามารถท างานในสภาวะนั้นไดอ้ยา่งไร 
   ถึงแม้ว่าการน าความจริงเสมือนมาใช้ในการศึกษาจะไม่สามารถน ามาใช้ได้ทุก
โรงเรียนก็ตาม เน่ืองจากงบประมาณของแต่ละโรงเรียนอาจจะไม่เพียงพอ แต่ด้วยการท่ีเคร่ือง
คอมพิวเตอร์และซอร์ฟแวร์โปรแกรมมีราคาค่อนขา้งจะถูกลง และอุปกรณ์ท่ีใชเ้ทคโนโลยีความเป็น
จริงเสมือนก็มีหลายระดบัใหเ้ลือกใช ้จึงเป็นท่ีหวงัอยา่งยิง่วา่การน าเทคโนโลยคีวามเป็นจริงเสมือนมา
ใชใ้นการศึกษาจะเพิ่มประสิทธิภาพและประสิทธิผลในการเรียนการสอนไดใ้นอนาคตอนัใกลน้ี้ 
 2.1.2   ความหมายของหอ้งเรียนเสมือน 
  การจดัการเรียนการสอนจ าลองแบบท่ีเสมือนจริง เป็นนวตักรรมทางการศึกษาท่ี
สถาบนัการศึกษาต่างๆทัว่โลกก าลงัใหก้ารสนใจ การเรียนการสอนในระบบน้ีอาศยัส่ืออิเล็กทรอนิกส์
โทรคมนาคมและเครือข่ายคอมพิวเตอร์เป็นหลกัท่ีเรียกว่า Virtual Classroom หรือ Virtual Campus 
บา้ง จนกระทัง่เรียนวา่ Virtual University ก็มี นบัวา่เป็นการบริหารการศึกษาทางไหลชนิดท่ีเรียกวา่



 
 

23 
 

เคาะประตูบา้น เป็นรูปแบบใหม่ของสถาบนัการศึกษาในโลกยุคไร้พรมแดน กล่าวคือ ผูเ้รียนจะเรียน
ท่ีไหนก็ได ้จะเป็นท่ีบา้นหรือท่ีท างาน โดยไม่ตอ้งไปนัง่เรียนในห้องเรียนจริงๆ ท าให้ประหยดัเวลา 
ค่าเดินทาง และค่าใช้จ่ายอ่ืนๆ ไดม้าก ห้องเรียนเสมือนเป็นการจดัการส่ิงแวดลอ้มเพื่อการเรียนการ
สอนดว้ยระบบคอมพิวเตอร์ ระบบดงักล่าวเป็นการส่ือสารแบบเป็นกลุ่มและท างานบนพื้นฐานท่ีว่า 
และส่ิงอ านวยความสะดวกซ่ึงถูกสร้างข้ึนมาแบบเสมือนจริงด้วยซอร์ฟแวร์ การส่ือสารดงักล่าวมี
โครงสร้างท่ีเสมือนสภาพแวดลอ้มจริง เสมือนกระบวนการท่ีปฏิบติัอยูใ่นห้องเรียนปกติ นอกจากนั้น
ยงัมีส่ิงท่ีสนบัสนุนอ่ืนๆ ท่ีจะช่วยท าให้การมีปฏิสัมพนัธ์แบบเผชิญหนา้ท่ีบางโอกาสจะเป็นไปไม่ได ้
หรือเป็นไปไดย้าก บรรยากาศนั้นสามารถท าไดเ้สมือนการบรรยากาศการพบกนัจริงๆ กระบวนการ
ทั้งหมดดงักล่าวมาน้ีมิใช่เป็นการเดินทางไปท่ีโรงเรียนหรือมหาวิทยาลยั แต่จะเป็นการเขา้ถึงดว้ยการ
พิมพ์ การอ่านข้อความหรือข้อมูลผ่านทางคอมพิวเตอร์ท่ีเช่ือมต่อเข้ากับระบบคอมพิวเตอร์ท่ีมี
ซอร์ฟแวร์เพื่อควบคุมโครงสร้างบรรยากาศของหอ้งเรียนเสมือน  
  ภทัธีรา  มว้นจัน่ (2548, น. 52) กล่าวถึงห้องเรียนเสมือนวา่ หมายถึง การเรียนการ
สอนท่ีผ่านระบบเครือข่ายคอมพิวเตอร์ท่ีเ ช่ือมโยงคอมพิวเตอร์ของผู ้เ รียน เข้าไว้กับเคร่ือง
คอมพิวเตอร์จองผูใ้ห้บริการเครือข่าย (File Server) และเคร่ืองคอมพิวเตอร์ผูใ้ห้บริการเวบ็ (Web 
Server) เป็นการจดัการเรียนการสอนท่ีผูเ้รียนจะเรียนท่ีไหนก็ได ้เช่น ท่ีบา้น ท่ีท างานโดยไม่ตอ้งไป
นัง่เรียนในห้องเรียนจริงๆ ท าให้ประหยดัเวลา ค่าเดินทาง และค่าใช้จ่ายอ่ืนๆ และเป็นรูปแบบการ
สอนทางไหลเต็มรูปแบบ โดยมีองค์ประกอบครบ ได้แก่ ตวัผูเ้รียน ผูส้อน และเพื่อนร่วมชั้นเขา้สู่
กระบวนการเรียนการสอนพร้อมๆ กนั มีส่ือการสอนทั้งภาพและเสียงมีการก าหนดตารางเวลา หรือ
ตารางสอน ผูเ้รียนไม่ตอ้งเดินทางแต่เรียนผา่นเครือข่ายตามก าหนดเวลาเพื่อเขา้ห้องและเรียนไดแ้มจ้ะ
อยูท่ี่ใดในโลก 
  สุรพล  บุญลือ (2550, น. 32) ไดใ้ห้ความหมายของห้องเรียนเสมือนว่า ห้องเรียน
เสมือน (Virtual Classroom) หมายถึง การจดัสภาพแวดลอ้มการเรียนการสอนให้เสมือนการเรียนการ
สอนจริงๆ เป็นการน าแหล่งทรัพยากรออนไลน์มาใชใ้นลกัษณะการเรียนการสอนแบบร่วมมือโดยมี
การร่วมมือระหวา่ง ผูเ้รียนดว้ยกนั ผูเ้รียนกบัผูส้อน ชั้นเรียนกบัสถาบนัการศึกษาอ่ืนๆ และกบัชุมชน
ท่ีไม่เป็นเชิงวิชาการ ผู ้เรียนและ/หรือผู ้สอนจะได้รับความรู้ใหม่ๆ จากกิจกรรม การสนทนา
แลกเปล่ียนความคิดเห็นและขอ้มูลผ่านทางคอมพิวเตอร์หรือโทรศพัท์ ซ่ึงอาจจะเห็นหน้ากนัทาง
หน้าจอ และพูดคุยกนัได ้โดยมีส่วนประกอบคือ ประมวลรายวิชา เน้ือหาในหลกัสูตร รายช่ือแหล่ง
เน้ือหาเสริม กิจกรรมระหว่างผูเ้รียนผูส้อน ค าแนะน า และการให้ผลป้อนกลับ การน าเสนอใน
ลกัษณะมลัติมิเดีย และไม่มีขอ้จ ากดัในเร่ืองเวลาและสถานท่ี 
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  ห้องเรียนเสมือนเป็นการจัดการส่ิงแวดล้อมเพื่อการเรียนการสอนด้วยระบบ
คอมพิวเตอร์ ระบบดงักล่าวเป็นการส่ือสารแบบเป็นกลุ่มและท างานบนพื้นท่ีว่าง (Spaces) และส่ิง
อ านวยความสะดวกซ่ึงถูกสร้างข้ึนมาแบบเสมือนจริงดว้ยซอร์ฟแวร์การส่ือสารดงักล่าวมีโครงสร้างท่ี
เสมือนสภาพแวดลอ้มจริง เสมือนกระบวนการจริงท่ีปฏิบติัอยูใ่นห้องเรียนปกติ นอกจากนั้นยงัมีส่ิง
สนบัสนุนอ่ืน ๆ ท่ีจะช่วยท าให้การมีปฏิสัมพนัธ์แบบเผชิญหน้าจะช่วยท าให้การมีปฏิสัมพนัธ์แบบ
เผชิญหนา้ (Face-to-Face) ท่ีบางโอกาสจะจะเป็นไปไม่ไดห้รือเป็นไปไดย้าก บรรยากาศนั้นสามารถ
ท าไดเ้สมือนบรรยากาศการพบกนัจริง ๆ กระบวนการทั้งหมดดงักล่าวมาน้ีมิใช่เป็นการเดินทางไปท่ี
โรงเรียนหรือมหาวิทยาลัยแต่จะเป็นการเข้าถึงด้วยการพิมพ์ การอ่านข้อความหรือข้อมูลผ่าน
คอมพิวเตอร์ท่ีเช่ือมต่อเขา้กบัระบบคอมพิวเตอร์ท่ีมีซอร์ฟแวร์เพื่อควบคุมโครงสร้างบรรยากาศแบบ
ห้องเรียนเสมือน (The Virtual Classroom Software) การมีส่วนร่วมจะเป็นแบบภาวะต่างเวลา 
(Asynchronous) ซ่ึงท าใหผู้เ้รียนในระบบหอ้งเรียนเสมือนสามารถเช่ือมต่อเขา้ไปศึกษาไดจ้ากทุกท่ีทุก
เวลา ส่ิงท่ีตอ้งค านึงถึงอยา่งมากคือ ห้องเรียนเสมือนนั้นระบบคอมพิวเตอร์จะตอ้งสนบัสนุนกิจกรรม 
ภารกิจ การติดต่อส่ือสารตลอดจนการจดัท าในลกัษณะต่างๆ ท่ีปฏิบติักนัในห้องเรียนปกติ ไดท้ั้งหมด
หรือสามารถช่วยสร้างสภาพแวดลอ้มได้มากท่ีสุดเท่าท่ีจะกระท าได ้เช่น ควรจะตอ้งมีพื้นท่ีท่ีจะใช้
ส าหรับใหผู้ส้อนกบัผูเ้รียนไดมี้ปฏิสัมพนัธ์กนั อาจจะเป็นลกัษณะของการอภิปรายกลุ่ม หรือเป็นการ
พูดคุยเป็นการส่วนตวั คลา้ย ๆ กบัการมี “Office Hours” ของผูส้อนส าหรับให้ค  าปรึกษาแนะน าแก่
ผูเ้รียนได้ นอกจากนั้นยงัต้องมีระบบการบริหาร การบนัทึกผลการเรียน ผลการปฏิบติัการ และมี
ระบบท่ีเปิดโอกาสให้ผูเ้รียนไดพ้บเพื่อน ท ากิจกรรมร่วมกนั หรือเป็นงานมอบหมายท่ีจะตอ้งท างาน
ร่วมกนัเป็นกลุ่มยงัตอ้งมีสถานท่ีเหมือนเป็น “กระดานด า” ท่ีใชส้ าหรับเขียนแผนภาพหรือ สมการต่าง 
ๆ ส าหรับเป็นตุ๊กตาประกอบการสัมมนาร่วมกัน เหมือนกับการสัมมนาในห้องเรียนปกติโดยท่ี 
“กระดานด า” นั้นเป็นเสมือนกระดานด าจริงๆ ท่ีผูมี้ส่วนร่วมในการสัมมนาสามารถท่ีจะเขา้ไปลบหรือ
เพิ่มเติมขอ้ความได ้
  ส่ิงท่ีมีความแตกต่างอยา่งหน่ึงของการเรียนภายใตส้ภาพแวดลอ้มทั้งแบบห้องเรียน
เสมือนและห้องเรียนปกติก็คือ ห้องเรียนปกติ (Traditional Classroom) ปฏิสัมพนัธ์ส่วนมากจะเป็น
การพดูและการฟัง และอาจจะมีบางส่วนท่ีเป็นการเขียนและการอ่านจากกระดานด าหรือจากขอ้เขียน 
ส่วนห้องเรียนเสมือนปฏิสัมพนัธ์เกือบทั้งหมดจะเป็นการพิมพแ์ละการอ่านจากหนา้จอคอมพิวเตอร์ 
ซ่ึงอาจจะรวมถึงการใชว้สัดุส่ิงพิมพ ์เช่น ต ารา รวมไปถึง การพบปะประชุมกนั หรือการติดต่อพูดคุย
กนัทางโทรศพัทห์รือการใช้วิดีทศัน์ ซ่ึงเครือข่ายคอมพิวเตอร์ระบบส่ือประสมจะถูกน ามาผนวกเขา้
กบัระบบห้องเรียนเสมือนอนัจะท าให้การเรียนการสอนดว้ยห้องเรียนเสมือนมีศกัยภาพทดัเทียมหรือ
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ดีกว่าห้องเรียนปกติ เน่ืองจากห้องเรียนเสมือนเป็นการใช้ระบบส่ือสารด้วยกับคอมพิวเตอร์ 
(Computer-Mediated Communication :CMC System) เป็นส่ือกลางมีปฏิสัมพนัธ์ระหวา่งผูส้อนและ
ผูเ้รียนโดยพื้นฐานทัว่ไปจะเป็นการส่ือสารแบบต่างเวลา (Asynchronous) โดยระบบคอมพิวเตอร์จะ
เก็บข้อมูลท่ีส่ือสารไวส้ าหรับผูท่ี้เข้ามามีส่วนร่วมในห้องเรียนเสมือนแต่ละคนนั้นหมายความว่า
สมาชิกแต่ละคนของชั้นเรียนไม่จ าเป็นตอ้งมาอยูใ่นเวลาเดียวกนัหรือสถานท่ีเดียวกนัแต่ทุกคนอาจจะ
พบกนัได้โดยบงัเอิญ หรือโดนการนัดหมายหรือโดยการก าหนดตาราง       ในประเด็นน้ีจึงท าให้
ผูเ้รียนมีอิสระทั้งในเชิงสถานท่ีเรียนและเวลาเรียน แต่ผูเ้รียนสามารถท่ีจะเลือกเวลาเรียนไดเ้วลาใดก็
ได้ตามความสะดวกของแต่ละคนจากจงัหวะเวลาของการมีปฏิสัมพนัธ์ท่ีจะต้องใช้เวลามากข้ึนดู
เสมือนวา่การใช้การปฏิสัมพนัธ์แบบภาวะต่างเวลาจะเป็นจุดอ่านไม่ทนัใจ แต่ถา้พิจารณาในประเด็น
ท่ีว่าการท่ีสามารถเลือกเวลาตอบสนองกลบัไปนั้นเป็นปัจจยัส าคญัท่ีท าให้เกิดสภาพแวดล้อมใน
ลกัษณะการเรียนการสอนแบบร่วมมือกนั เพราะผูเ้รียนแต่ละคนสามารถมีส่วนช่วยเหลือสนบัสนุน
กนัไดด้ว้ยเวลาและสถานท่ีท่ีไม่ผกูมดัจนเกินไป ช่วยกนัไดต้ามความกา้วหนา้ของแต่ละคนอนัเป็นส่ิง
ท่ีมีความสะดวกสบายส าหรับผูเ้รียนแต่ละคน 
  ธนิดา  หนูแป้น (2552, น. 10) ไดก้ล่าวถึงความหมายของห้องเรียนเสมือนไวว้่า 
หมายถึงการจดัการเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ตซ่ึงประกอบไปดว้ย ค าแนะน าการเรียน 
เน้ือหา แบบฝึกหัด แบบทดสอบและกิจกรรมต่างๆ เพื่อให้ผูเ้รียนสามารถร่วมกิจกรรมกลุ่ม โตต้อบ 
หรือแลกเปล่ียน มีปฏิสัมพนัธ์ระหวา่งผูเ้รียนดว้ยกนัเอง หรือระหวา่งผูเ้รียนกบัผูส้อนได ้เสมือนอยูใ่น
หอ้งเรียนจริง 
  อญัชลี  บุญฤทธ์ิ (2554, น. 28-29) ไดใ้ห้ความหมายของห้องเรียนเสมือนไวว้่า 
หมายถึง การจดัการเรียนการสอนท่ีจดัสภาพแวดลอ้มการเรียนการสอนให้เสมือนการเรียนการสอน
จริงๆ โดยผา่นระบบเครือข่ายคอมพิวเตอร์ และใชช่้องทางของระบบการส่ือสารอินเทอร์เน็ต ผูเ้รียน
สามารถใช้คอมพิวเตอร์ท่ีเ ช่ือมต่อกับระบบอินเทอร์เน็ตเข้าไปเรียนในเว็บไซต์ท่ีออกแบบ
กระบวนการเรียนการสอนให้มีสภาพแวดลอ้มคลา้ยกบัเรียนในห้องเรียนแบบปฏิสัมพนัธ์ระหว่าง
ผูเ้รียนกบัผูส้อนและผูเ้รียนกบัผูเ้รียน โดยมีบรรยากาศเสมือพบกนัจริง กระบวนการเรียนการสอนจึง
ไม่ใช่การเดินทางไปเรียนในหอ้งเรียนแต่เป็นการเขา้ถึงขอ้มูลเน้ือหาของบทเรียนไดโ้ดยผา่นเครือข่าย
คอมพิวเตอร์ และไม่มีขอ้จ ากดัในเร่ืองของเวลา 
  ดงันั้นจึงสรุปไดว้่า ห้องเรียนเสมือน หมายถึง การจดัการเรียนการสอนท่ีผูเ้รียนไม่
จ าเป็นตอ้งเดินทางไปยงัสถานท่ีจริง เป็นการจดัสภาพแวดลอ้มผา่นทางระบบเครือข่ายให้เป็นเสมือน
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กบัหอ้งเรียนจริงท่ีผูเ้รียนสามารถใชเ้พื่อศึกษาหาความรู้ สามารถแลกเปล่ียนความคิดเห็น สร้างการมี
ปฏิสัมพนัธ์ระหวา่งผูเ้รียนกบัผูเ้รียน และหรือผูเ้รียนกบัผูส้อนโดยไม่มีขอ้จ ากดัของเวลาและสถานท่ี 

2.1.3  ประเภทของหอ้งเรียนเสมือน 
  อญัชลี บุญฤทธ์ิ (อา้งถึงใน อุทยั  ภิรมยร่ื์น, 2554, น. 29) ไดจ้  าแนกการเรียนใน
หอ้งเรียนเสมือนไว ้2 ประเภท ดงัน้ี  

  2.1.3.1 จดัการเรียนการสอนในหอ้งเรียนธรรมดา แต่มีการถ่ายทอดสดภาพและเสียง
เก่ียวกับบทเรียนโดยอาศยัระบบโทรคมนาคม และเครือข่ายคอมพิวเตอร์ไปยงัผูเ้รียนท่ีอยู่นอก
ห้องเรียน นักศึกษาก็สามารถรับฟังและติดตามการสอนของผูส้อนได้จากเคร่ืองคอมพิวเตอร์ของ
ตนเองอีกทั้งยงัสามารถโตต้อบกบัอาจารยผ์ูส้อนหรือเพื่อนนกัศึกษาในชั้นเรียนได ้ห้องเรียนแบบน้ียงั
อาศยัส่ิงแวดลอ้มทางกายภาพท่ีเป็นจริง ซ่ึงเรียกวา่ Physical Education Environmental  

 2.1.3.2  การจดัห้องเรียนจากโปรแกรมคอมพิวเตอร์สร้างภาพเสมือนจริง เรียกว่า 
Virtual Reality โดยใช้ส่ือท่ีเป็นตัวหนังสือ (Text-Based) หรือภาพกราฟิก (Graphic-Based)              
ส่งบทเรียนไปยงัผูเ้รียน โดยผ่านระบบโทรคมนาคมและเครือข่ายคอมพิวเตอร์ ห้องเรียนลกัษณะน้ี
เรียกวา่ Virtual Education Environmental ซ่ึงเป็น Virtual Classroom ท่ีแทจ้ริง  

 สุรพล บุญลือ (อ้างถึงใน Sandy, 2550, น. 34) ได้แบ่งจ าแนกรูปแบบการจดั
สภาพแวดลอ้มการเรียนรู้เสมือนจริงไวใ้นงานวิจยัเร่ือง  A Framework for Pedagogical Evaluation of 
Virtual Learning Environment โดยแบ่งเป็น 3 ลกัษณะดงัน้ี 

 1) Asynchronous Learning เหมาะกบัการเรียนแบบเสริมและการเรียนท่ีผูเ้รียน
สามารถเรียนรู้ได้ดว้ยตนเอง (Self-Learning) ผูเ้รียนจะเรียนวิชาผ่านเว็บเม่ือไรก็ได ้ในช่วงเวลาท่ี
เจ้าของหลักสูตรก าหนดการเรียนนั้ นจะมีกิจกรรมการอ่าน เน้ือหา ค้นคว้า ท าโครงการ ท า
แบบทดสอบ และท าการสอบ ผูเ้รียนมีปฏิสัมพนัธ์กบัผูส้อนหรือบทเรียนในรูปของการเรียนการสอน
แบบไม่ประสานเวลา คือ คนละเวลา ผูเ้รียนอาจตั้งค  าถามผา่น Web board ผูส้อนก็อาจเขา้ไปดูค าถาม 
และตอบในช่วงเวลาท่ีสะดวก หรือผูเ้รียนอาจติดต่อกบัผูส้อนผ่านทาง E-mail นอกจากน้ี ผูส้อน     
อาจให้การบา้นหรือขอ้มูลเพิ่มเติมแก่ผูเ้รียน ซ่ึงผูเ้รียนเห็นขอ้มูลภายหลงัจากท่ีผูส้อนประกาศและ
ระหวา่งท่ีผูเ้รียนเรียนบทเรียนนั้น ผูส้อนไม่ตอ้งออนไลน์อยูก่บัระบบ 

 2) Synchronous Learning คือการสอนเสมือนหน่ึงว่าผูส้อนอยูใ่นห้อง อยู่หน้าชั้น
เรียนแต่ผูเ้รียนอยู่กระจายทัว่ไป โดยผูเ้รียนแต่ละคนมีเคร่ืองคอมพิวเตอร์ส่วนบุคคลท่ีต่ออยู่กับ
อินเทอร์เน็ตและลงทะเบียนวิชานั้น ๆ ผูส้อนจะท าการสอนโดยมีการติดตามการเรียนของผูเ้รียนหรือ
ผูส้อนสามารถระบุหนา้ท่ีเรียน ผูส้อนสามารถติดต่อกบัผูเ้รียนทนัทีผา่น Chat, Message, IP Phone 
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หรือ IP Video การสอนนั้นผูเ้รียนจะตอ้งระบุเวลาท่ีทั้งผูส้อนและผูเ้รียนตอ้งออนไลน์มาพบกนัท่ี
หอ้งเรียนเสมือน (Virtual Classroom) 

 3) Collaborative Learning การสอนแบบร่วมมือนั้นยากข้ึน จะตอ้งมีซอร์ฟแวร์
เฉพาะท่ีทุกคนใชร่้วมกนัได ้เช่น Whiteboard หรือซอร์ฟแวร์ท่ีท างานเสมือนจริง เพื่อส่ือให้เป็นกลไก
ท าให้ผูเ้รียนกบัผูส้อนมีปฏิสัมพนัธ์ในการท างานร่วมกนั และเรียนรู้ร่วมกนัเพื่อน าไปสู่จุดหมายของ
บทเรียน การเรียนแบบร่วมมือจะเป็นการเรียนแบบประสานเวลาผสมกบัการใช้เคร่ืองมือระดบัท่ี
สูงข้ึน 

 การจดัการเรียนการสอนทางไกลทั้งสองลกัษณะน้ีในบางมหาวิทยาลยัก็ใชร่้วมกนั 
คือมีทั้งแบบท่ีเป็นห้องเรียนจริง แลห้องเรียนเสมือน การเรียนก็ผ่านผา่นทางเครือข่ายคอมพิวเตอร์ท่ี
เช่ือมโยงกนัอยูท่ ัว่โลก เช่น Internet www. ขณะน้ีไดมี้ผูพ้ยายามจดัตั้งมหาวิทยาลยัเสมือนจริงข้ึนแลว้ 
โดยเช่ือมโยง Site ต่างๆ ท่ีใหบ้ริการดา้นการเรียนการสอนทางไกล แบบ Virtual Classroom ต่างๆ เขา้
ดว้ยกนั และจดับริเวณอาคารสถานท่ี ห้องเรียน ห้องสมุด ภาควิชาต่างๆ ศูนยบ์ริการต่างๆ ตลอดจน
คณาจารย์ นักศึกษา กิจกรรม ทุกอย่างเสมือนเป็นชุมชนวิชาการจริงๆ แต่ขอ้มูลเล่าน้ีจะอยู่ท่ีศูนย์
คอมพิวเตอร์ของแต่ละแห่ง ผูป้ระสงค์จะเข้าร่วมในการเปิดบริการก็จะต้องจองเน้ือท่ีและเขียน
โปรแกรมใส่ข้อมูลเข้าไว ้เม่ือนักศึกษาติดต่อเข้ามา โปรแกรมคอมพิวเตอร์ก็จะแสดงภาพ เสียง 
ภาพเคล่ือนไหว และสามารถโตต้อบไดเ้สมือนเหน่ึงเป็นมหาวทิยาลยัจริงๆ การติดต่อกบัมหาวิทยาลยั
เสมือนจริงท าไดด้งัน้ี 

 1)  บทเรียนและแบบฝึกหดัต่างๆ อาจจะส่งใหผู้เ้รียนในรูปวีดีทศัน์ หรือวีดีทศัน์ผสม
กบั Virtual Classroom หรือ CD-ROM ท่ีมีส่ือประสมทั้งภาพ เสียง การเคล่ือนไหว โดยผา่นระบบ
สัญญาณเครือข่ายคอมพิวเตอร์ ดาวเทียม โทรทศัน์ โทรสาร หรือทางเมล์ ตามความตอ้งการของ
ผูเ้รียน 

 2)  ผูเ้รียนจะติดต่อส่ือสารกบัอาจารยผ์ูส้อนไดโ้ดยตรงในขณะสอนก็ได ้หากเป็นการ
เรียนท่ี Online ซ่ึงจะเป็นแบบของการส่ือสารสองทาง (Two-Way Communication) ท่ีโตต้อบโดย
ทนัทีทนัใดระหวา่งผูเ้รียนและผูส้อนหรือระหวา่งผูเ้รียนดว้ยกนั (Synchronous Interaction) เช่น การ 
Chat หรืออาจใชก้ารโตต้อบแบบไม่ทนัทีทนัใด (Asynchronous Interaction) เช่น การใช ้E-mail การ
ใช ้Web-Board เป็นตน้ 

 3)  การทดสอบ ท าไดห้ลายวิธี เช่น ทดสอบแบบ Online หรือทดสอบโดยผา่นทาง
โทรสาร ทาง E-mail และทางไปรษณียธ์รรมดา บางแห่งจะมีผูจ้ดัสอบโดยผ่านทางตวัแทนของ
มหาวิทยาลยัในทอ้งถ่ินท่ีนกัศึกษาอาศยัอยู ่การเรียนทางไกลโดยผ่านเครือข่ายคอมพิวเตอร์ เป็นการ
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เปิดโอกาสใหผู้เ้รียนเลือกเรียนวชิาท่ีตนสนใจไดต้ลอดเวลา ในทุกแห่งท่ีมีการเปิดสอน ไม่ตอ้งเขา้ชั้น
เรียนก็ได ้ในการศึกษาหาความรู้ จึงมีความยืดหยุน่ดา้นเวลาและประหยดัค่าใชจ่้ายลงมาก นอกจากน้ี
ผูเ้รียนยงัสามารถติดต่อกบัอาจารยผ์ูส้อนไดโ้ดยตรง สามารถแลกเปล่ียนความคิดเห็นกบัผูเ้รียนคนอ่ืน
ซ่ึงอยู่ห่างไกลกันได้ เป็นการเรียนแบบช่วยเหลือซ่ึงกันและกัน ท างานร่วมกัน (Collaborative 
Learning) อยา่งไรก็ตาม การเรียนทางไกลลกัษณะน้ีอาจจะขาดความสัมพนัธ์แบบ Face-to-Face คือ
การเผชิญหน้ากนัได้ แต่ในปัจจุบนัน้ีก็มีกล้องวีดีทศัน์ ท่ีเช่ือมต่อกับเคร่ืองคอมพิวเตอร์ในระบบ
เครือข่าย ก็สามารถท าให้เห็นหน้ากนัได ้ดงันั้นปัญหาเร่ือง Face-to-Face ก็หมดไป ความส าเร็จและ
คุณภาพของการเรียนในระบบน้ีข้ึนอยูก่บัตวัผูเ้รียนค่อนขา้งมาก เพราะจะตอ้งมีความรับผิดชอบ ตอ้ง
บริหารเวลาเพื่อนติดตามบทเรียน และท ากิจกรรมและการทดสอบต่างๆ ให้ทนัตามก าหนด จึงจะท า
ใหก้ารเรียนประสบผลส าเร็จไดอ้ยา่งมีประสิทธิภาพมากท่ีสุด 

2.1.4  ลกัษณะการจดัการเรียนการสอนแบบหอ้งเรียนเสมือน 
   การจดัการเรียนการสอนแบบห้องเรียนเสมือน เป็นการจดัการเรียนการสอนใน
ลกัษณะการสอนทางไกลผา่นเครือข่ายอินเทอร์เน็ต เพื่อให้เขา้ใจระบบการจดัการเรียนการสอนแบบ
หอ้งเรียนเสมือนยิง่ข้ึน คือ (อญัชลี บุญฤทธ์ิ, 2554, น. 31) 

 2.1.4.1  การจดัการศึกษาทางไกล (Distance Education) การศึกษาทางไกลเป็นการ
เปิดโอกาสทางการศึกษาให้แก่ผูท่ี้ใฝ่รู้และใฝ่เรียนท่ีไม่สามารถสละเวลาไปรับการศึกษาจากระบบ
การศึกษาปกติได ้เน่ืองจากภาระทางหนา้ท่ีการงาน หรือทางครอบครัว และเป็นการเปิดโอกาสให้ผูท่ี้
ตอ้งการเพิ่มพนูหรือปรับปรุงความรู้ท่ีมีอยูใ่หท้นัสมยั เพื่อประโยชน์ในการศึกษาและระบบการศึกษา
ท่ีผูเ้รียนและผูส้อนอยูไ่กลกนั แต่สามารถท าใหเ้กิดการเรียนรู้ไดโ้ดยอาศยัส่ือการสอน ในลกัษณะของ
ส่ือประสม คือ การใชส่ื้อต่างๆ ร่วมกนั เช่น ต าราเรียน เทปเสียง แผนภูมิ คอมพิวเตอร์ หรือโดยการใช้
อุปกรณ์ทางโทรคมนาคม และส่ือมวลชนประเภทวิทยุและโทรทศัน์เขา้มาช่วยในการแพร่กระจาย
การศึกษาไปยงัผูท่ี้ปรารถนาจะเรียนรู้ไดอ้ยา่งกวา้งขวางทัว่ทุกทอ้งถ่ิน การศึกษาน้ีมีตั้งแต่ในระดบัตน้
จนถึงระดบัสูงขั้นปริญญา การศึกษาทางไกลเป็นการศึกษาวิธีหน่ึงในการศึกษาทั้งในระบบและนอก
ระบบโรงเรียนท่ีอาศยัส่ือส่ิงพิมพ์ ส่ืออิเล็กทรอนิกส์ และส่ือบุคคล รวมทั้งระบบโทรคมนาคมใน
รูปแบบต่างๆ เป็นหลกัการเรียนการสอน เพื่อใหผู้เ้รียนไดเ้รียนรู้ดว้ยตนเองจากส่ือเหล่านั้น และอาจมี
การสอนเสริมควบคู่ไปดว้ย เพื่อให้ผูเ้รียนซักถามปัญหาจากผูส้อนหรือผูส้อนเสริม โดยการศึกษาน้ี
อาจจะอยูใ่นรูปแบบองคก์ารศึกษาอิสระการศึกษารายบุคคล หรือรูปแบบของมหาวิทยาลยัเปิดก็ได ้
ตวัอย่างการศึกษาทางไกลในประเทศไทยไดแ้ก่ มหาวิทยาลยัสุโขทยัธรรมาธิราช ซ่ึงในการจดัการ
เรียนการสอนของมหาวิทยาลัยแห่ง น้ีใช้ ส่ือส่ิงพิมพ์ เ ป็นหลัก  โดยมี ส่ือเสริม คือรายการ
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วิทยุกระจายเสียง และรายการโทรทศัน์บางวิชาอาจมีวิดีโอเทปหรือส่ือพิเศษอย่างอ่ืนรวมอยู่ด้วย 
นักศึกษาจะเรียนด้วยตนเอง โดยอาศยัส่ือเหล่าน้ีเป็นหลกั แต่มหาวิทยาลยัก็จดัการสอนเสริมเป็น
บางคร้ังบางคราว ซ่ึงเปิดโอกาสใหผู้ส้อนและผูเ้รียนไดพ้บกนัเพื่อซกัถามขอ้สงสัยเพิ่มเติม 

 2.1.4.2  การจดัการศึกษาผ่านเครือข่ายอินเทอร์เน็ต เป็นเทคโนโลยีในวงการ
คอมพิวเตอร์ในปัจจุบันท่ีมีผลต่อการเปล่ียนแปลงชีวิตประจ าวนัของชาวโลก คือ เทคโนโลยี
อินเทอร์เน็ต ซ่ึงเกิดจากการเช่ือมโยงเครือข่ายคอมพิวเตอร์ต่างๆ ในโลกเขา้ดว้ยกนั ภายใตก้ฎเกณฑ์
การเช่ือมต่ออยา่งเดียวกนั โลกทั้งโลกสามารถติดต่อส่ือสารกนัได ้ไม่วา่จะเพื่อวตัถุประสงคใ์ดในทาง
การศึกษา อินเทอร์เน็ตเป็นการเปิดกวา้งของการใหโ้อกาสในการศึกษาหาความรู้อยา่งไม่เคยมีมาก่อน 
และเป็นการเปิดโอกาสท่ีให้ความเท่าเทียมกนัส าหรับทุกคนท่ีสามารถเขา้ถึงเครือข่ายอินเทอร์เน็ตได ้
อินเทอร์เน็ตเป็นแหล่งสะสมความรู้ท่ีบางคนเรียกวา่ “ขุมทรัพยค์วามรู้” เพราะในบรรดาคอมพิวเตอร์
ท่ีเช่ือมอยูก่บัอินเทอร์เน็ตนั้น ต่างมีขอ้มูลสะสมไวม้ากมาย และวิธีให้บริการบนอินเทอร์เน็ตก็ท าให้
ผูใ้ช้สามารถเขา้ถึงขอ้มูลเหล่านั้นไดอ้ย่างง่ายดาย ผูท่ี้ตอ้งการใช้ขอ้มูลจะตอ้งใช้วิจารณญาณในการ
เลือกแหล่งข้อมูลท่ีเช่ือถือได้ และน ามาใช้เฉพาะข้อมูลท่ีเป็นประโยชน์เท่านั้ น อาจกล่าวได้ว่า
การศึกษาในยุคอินเทอร์เน็ตนั้นคือการเรียนรู้ท่ีจะแยกแยะและกลัน่กรองขอ้มูลเพื่อน าขอ้มูลมาเรียบ
เรียงและจดัระบบข้ึนเป็นความรู้ขณะน้ีมีงานวิจยัซ่ึงพยายามสร้างกระบวนการอตัโนมติั (โดยใช้
คอมพิวเตอร์) ของการคน้หาขอ้มูล  (จากเครือข่ายอินเทอร์เน็ต) และน ามาเรียบเรียงข้ึนเป็นความรู้ตาม
กฎเกณฑ์ท่ีผูใ้ชส้ามารถระบุไดศ้าสตร์ใหม่แขนงน้ีมีช่ือวา่ วิศวกรรมความรู้ ซ่ึงมีบริการ World Wide 
Web (WWW) เป็นวิธีการให้บริการขอ้มูลแบบหน่ึงบนเครือข่ายอินเทอร์เน็ต เป็นวิธีการท่ีพฒันาข้ึน
มาเพื่อความสะดวกต่อผูใ้ช้ โดยอาศยัสมรรถนะท่ีสูงข้ึนมากของคอมพิวเตอร์ในยุคน้ี WWW ใช้
กฎเกณฑ์การรับส่งขอ้มูลแบบ Hypertext Transfer Protocol (http) ซ่ึงมีจุดเด่นท่ีส าคญัอยู ่2 ประการ
คือ 

 1)  สามารถท าการเช่ือมโยงและเรียกขอ้มูลท่ีเก่ียวขอ้งใหเ้ขา้มาปรากฏได ้ โดยวิธีการ
ท่ีเรียนกวา่ Hyperlink 
 2)  สามารถจดัการขอ้มูลไดห้ลายรูปแบบไม่วา่จะเป็น ขอ้ความ ภาพน่ิง ภาพเคล่ือนไหว 
เสียง และวดีีทศัน์ เป็นตน้ 

  ลกัษณะของหอ้งเรียนเสมือน อาจเป็นไปในลกัษณะท่ีเสมือนในทางกายภาพท่ีพบได้
ในคอมพิวเตอร์ หรืออาจไม่มีลักษณะเสมือนห้องเรียนจริงๆเลยก็ได้ เพียงแต่ส่ิงเดียวท่ีห้องเรียน
เสมือนไม่ว่ารูปแบบใดหรือมีลกัษณะเหมือนหรือไม่ ไม่ใช่ประเด็นส าคญั ส่ิงท่ีส าคญัคือห้องเรียน
เสมือนจะตอ้งมีผูเ้รียน ผูส้อนหรือครู และตอ้งมีสังคมหรือกลุ่มเพื่อนท่ีเรียนดว้ยกนัโดยใชศ้กัยภาพ
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ของเทคโนโลยีคอมพิวเตอร์และการส่ือสารผา่นเครือข่ายอินเทอร์เน็ต ท าให้เกิดสภาพหรือกิจกรรม
การเรียนการสอนด าเนินไปได ้

2.1.5  หลกัการของหอ้งเรียนเสมือน 
  หลกัการของหอ้งเรียนเสมือนมี 4 ประการดงัน้ี 
  2.1.5.1  การให้การศึกษาท่ีทนัเวลาการใชง้าน (Just in Time Education) ห้องเรียน
เสมือนมีความคล่องตวัและเช่ือมโยงกบัแหล่งขอ้มูลและแหล่งวิชาการต่างๆ ไดท้ัว่โลก จึงเป็นแหล่ง
ความรู้ท่ีทนัสมยัตลอดเวลา สามารถตอบสนองประชาชนท่ีตอ้งการไดท้นัที 
  2.1.5.2  การเรียนเป็นการแลกเปล่ียน (Learn is Exchange) ในห้องเรียนเสมือนจะไม่
มีระบบท่ีมีผูรู้้ทุกเร่ืองคนเดียวและสอนคนอ่ืนๆ แต่จะเป็นลกัษณะท่ีทุกคนเสมอกนัแลกเปล่ียนความรู้
กนั 
  2.1.5.3 การเรียนเป็นการแลกเปล่ียนความรู้และขอ้มูลข่าวสาร ไม่ใช่การรับเพียง
อยา่งเดียว หลกัการน้ีเป็นลกัษณะของหอ้งเรียนเปิดท่ีครู อาจารย ์นกัศึกษา และผูส้นใจสามารถพบปะ
แลกเปล่ียนความรู้กนัได ้
  2.1.5.4  การจดัสภาพแวดลอ้มโดยยึดผูเ้รียนเป็นส าคญั (Environment According to 
User Profile) สภาพแวดลอ้มทางการเรียนจะเปล่ียนรูปไปตามลกัษณะของผูเ้รียน ตั้งแต่เร่ิมล็อกอิน 
(Log in) เขา้เรียน ผูเ้รียนจะเป็นผูก้  าหนดขอบข่ายความสนใจว่าจะเรียนอะไร และในระหวา่งเรียน
ผูเ้รียนจะเป็นผูป้รับเปล่ียนสภาพแวดลอ้มการเรียนเอง โดยเป็นผูเ้ลือกเน้ือหาท่ีจะเรียน เลือกปรึกษา
คนท่ีตนเองตอ้งการ ซ่ึงอาจเป็นผูส้อน บุคลากร หรือเพื่อนนกัศึกษาเองขณะท่ีลงทะเบียนเรียน ผูเ้รียน
จะให้ช่ือ ท่ีอยู่ในอีเมล์ คุณวุฒิในการท างาน ขอบข่ายความสนใจ ประสบการณ์ในการสัมมนาเชิง
ปฏิบติัการ เป็นตน้ ซ่ึงขอ้มูลน้ีจะเป็นกุญแจในการติดต่อกบัผูท่ี้มีความสนใจและคุณลกัษณะคลา้ยกนั 
  2.1.6  ขอ้ดีและขอ้จ ากดัของหอ้งเรียนเสมือน 
  การจดัการเรียนการสอนแบบห้องเรียนเสมือนเป็นนวตักรรมใหม่ทางการศึกษาท่ี
ก าลงัเป็นท่ีสนใจและยงัใหม่มากส าหรับผูเ้รียนและผูส้อนจ านวนมาก หากพิจารณาจากแนวคิดในการ
น าเอาเทคโนโลยสีมยัใหม่มาประยกุตใ์ชเ้พื่อแกปั้ญหาดา้นทางการศึกษา จะเห็นไดว้า่ การจดัการเรียน
การสอนแบบห้องเรียนเสมือนน่าจะมีความส าคญัมากต่อการเรียนการสอน แต่อยา่งไรก็ตาม ในขณะ
ท่ีการน าเอาเทคโนโลยีมาประยุกต์ใช้น้ียงัตอ้งพึ่ งพาองค์ประกอบอ่ืน ๆ อีกหลายอย่าง เช่น ด้าน
ฮาร์ดแวร์ (Hardware), ซอร์ฟแวร์ (Software), พีเพิ้ลแวร์ (Peopleware) และโครงสร้างพื้นฐานของ
ระบบเครือขา่ยน้ียงัมีขอ้จ ากดัอยูบ่า้งแต่ก็มีความส าคญัอยูไ่ม่นอ้ยส าหรับการศึกษาซ่ึง              (ธนิดา  
หนูแป้น, 2552, น. 14-15) ไดก้ล่าวไวด้งัน้ี 
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  2.1.6.1 ความส าคญัของการเรียนแบบหอ้งเรียนเสมือน 
 1) ช่วยท าให้การเรียนการสอนไม่จ  าเป็นตอ้งถูกจ ากดัดว้ยเร่ืองของเวลาและ
สถานท่ี 
 2) เปิดโอกาสให้ผูเ้รียนมีโอกาสคิดไตร่ตรองและวิเคราะห์เก่ียวกบัเน้ือหา
บทเรียนไดด้ว้ยตนเอง ซ่ึงเป็นการใหค้วามส าคญัของผูเ้รียนเป็นรายบุคคลท่ีมีความแตกต่างกนั 
 3) เน่ืองจากความหลากหลายของเทคโนโลยี ท าให้ผูส้อนสามารถน าเสนอ
บทเรียนรวมทั้งกิจกรรมการเรียนท่ีเอ้ือให้ผูเ้รียนท่ีมีความแตกต่างกนัในการรับรู้และเรียนรู้สามารถ
เรียนรู้ไดอ้ยา่งมีศกัยภาพตามสภาพแวดลอ้มของการน าเสนอท่ีแตกต่างกนั 
 4) ช่วยให้ผูส้อนและผูเ้รียนไดมี้โอกาสใกลชิ้ดกนัมากข้ึนด้านจิตใจและ
ความรู้สึก ผูส้อนมีเวลาให้ความสนใจกบัผูเ้รียนแต่ละคนมากข้ึน เน่ืองจากมีบทเรียนผา่นเครือข่ายท า
หนา้ท่ีถ่ายทอดความรู้ใหแ้ลว้ส่วนหน่ึง ดงันั้นเวลาท่ีเหลือ ผูส้อนจึงสามารถสละใหก้บัการจดักิจกรรม
และควบคุมการเรียนของผูเ้รียนแต่ละคน รวมทั้งคอยให้ความช่วยเหลือผูเ้รียนอยา่งใกลชิ้ดจึงช่วยลด
ความตึงเครียดระหวา่งผูเ้รียนและผูส้อนได ้
 5) ผูเ้รียนและผูส้อนสามารถติดต่อส่ือสารกนัไดด้ว้ยความสะดวกทั้งแบบ
ประสานเวลาและแบบไม่ประสานเวลา 
 6) ผูเ้รียนมีโอกาสแสดงความคิดเห็นหรืออภิปรายประเด็นต่าง ๆ ท่ีเก่ียวกบั
หวัขอ้หรือเน้ือหาบทเรียนไดอ้ยา่งอิสระ 
 7) สามารถจดักิจกรรมการเรียนการสอนไดห้ลากหลายรูปแบบ โดยเฉพาะ
การให้ผูเ้รียนมีส่วนร่วมกบัการเรียนการสอนและการเรียนแบบร่วมมือ ซ่ึงเป็นส่ิงท่ีนักการศึกษา
พยายามใหเ้กิดข้ึนในการเรียนการสอนในรูปแบบอ่ืนๆ 
 8) ผูเ้รียนสามารถควบคุมการเรียนของตนเองได้ การควบคุมการเรียนน้ี
รวมถึงความสามารถในการเลือกเรียนเน้ือหา การควบคุมความกา้วหนา้การเรียนของตนเอง การเลือก
กิจกรรมการเรียน การแสดงความคิดเห็นของตนเอง รวมทั้งเลือกเวลาและสถานท่ีเรียนเองได ้
  2.1.6.2  ขอ้จ ากดัของการเรียนการสอนแบบหอ้งเรียนเสมือน 
 1) ผูเ้รียนจะต้องมีอุปกรณ์การเรียนพื้นฐาน เช่น เคร่ืองคอมพิวเตอร์ท่ีมี
ความสามารถสูง รวมทั้งจะตอ้งมีระบบเครือข่ายอินเทอร์เน็ตรองรับ ซ่ึงส่ิงเหล่าน้ีถา้ผูเ้รียนจะแสวงหา
เองตอ้งลงทุนค่อนขา้งสูง 
 2) ผูเ้รียนและผูส้อนจะต้องมีพื้นฐานความรู้เก่ียวกับคอมพิวเตอร์และ
อินเทอร์เน็ตพอสมควรก่อน จึงจะสามารถร่วมเรียนแบบหอ้งเรียนเสมือนได ้
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 3) การติดต่อส่ือสาร แมว้า่สามารถท าได ้แต่บางคร้ังอาจเกิดปัญหาขดัขอ้ง
ทางเทคนิคของส่ืออิเล็กทรอนิกส์ ก็อาจท าใหก้ารเรียนการสอนเกิดการติดขดัได ้
 4) การเรียนการสอนเนน้การส่ือสารทางไกล ผูส้อนยงัไม่สามารถควบคุมได้
วา่ผูเ้รียนเป็นผูเ้รียนท่ีลงทะเบียนจริง มีตวัตนจริงหรือไม่ 
 5) การบริหารจดัการเร่ืองการสอนและการประเมินผลยงัท าไดค้่อนขา้งยาก 
 6) ผูเ้รียนจะตอ้งเป็นผูท่ี้มีความรับผิดชอบสูง และเป็นผูท่ี้ชอบคน้ควา้หา
ความรู้ด้วยตนเอง รวมทั้งจะต้องรู้จกัการท างานร่วมกับผูอ่ื้นและช่วยเหลือกัน ซ่ึงการเรียนแบบ
หอ้งเรียนเสมือนเป็นการจดัการเรียนการสอนรูปแบบใหม่ จึงอาจท าใหเ้กิดอุปสรรคทางการเรียนได ้
 7) ผูส้อนจะตอ้งมีทกัษะการจดัการเรียนการสอนแบบห้องเรียนเสมือนผา่น
ระบบเครือข่ายซ่ึงเป็นทกัษะท่ีแตกต่างไปจากการจดัการเรียนการสอนรูปแบบอ่ืน 
 8) ขอ้มูลท่ีปรากฏบนอินเทอร์เน็ต มีมากมายจนอาจท าให้ผูเ้รียนสับสนไม่
ทราบวา่ควรจะเช่ือถือหรือใชข้อ้มูลจากแหล่งใด 

2.1.7  องคป์ระกอบของบทเรียนแบบหอ้งเรียนเสมือนมี 3 ประการ ดงัน้ี 
  2.1.7.1  องค์ประกอบดา้นการน าเสนอกิจกรรมการเรียนการสอน ไดแ้ก่ เวบ็เพจ

หนา้ต่างๆ ท่ีผูส้อนใชใ้นการน าเสนอกิจกรรมการเรียนการสอน ไม่วา่จะเป็นการน าเสนอเน้ือหา การ
ท าแบบฝึกหดั หรือกิจกรรมเสริม รวมทั้งการประเมินผูเ้รียน ซ่ึงจดัไดว้า่เป็นองคป์ระกอบหลกัส าหรับ
บทเรียนแบบห้องเรียนเสมือน ซ่ึงได้ให้ความคิดเห็นและขอ้เสนอแนะในเร่ืองโครงสร้างหน้าเว็บ 
(Web Page) ส าหรับรายวชิา ดงัน้ี 

 1) โฮมเพจ (Homepage) เป็นเวบ็เพจหนา้แรกของเวบ็ไซตค์วรมีเน้ือหาสั้นๆ 
เฉพาะท่ีจ าเป็นท่ีเก่ียวขอ้งกบัรายวิชา ซ่ึงควรประกอบดว้ย ช่ือวิชา ช่ือ หน่วยงานท่ีรับผิดชอบสถานท่ี
และหนา้โฮมเพจควรจะจบในหนา้จอเดียว  ควรหลีกเล่ียงการใส่ภาพกราฟฟิคขนาดใหญ่ซ่ึงจะท าให้
ผูใ้ชเ้สียเวลาในการเรียกดูขอ้มูล (Download) 

 2) เวบ็เพจแนะน า (Introduction) แสดงสังเขปของรายวิชา ควรจะมีการเช่ือมโยง
ไปยงัรายละเอียดท่ีเก่ียวขอ้ง ควรจะมีขอ้ความทกัทาย ตอ้นรับ รายช่ือผูเ้ก่ียวขอ้งกบัการสอนวิชาน้ี
พร้อมทั้งเช่ือมโยงไปยงัเวบ็เพจท่ีอยูข่องผูเ้ก่ียวขอ้งแต่ละคน และเช่ือมโยงไปยงัรายละเอียดของแต่ละวชิา 

 3) เวบ็เพจแสดงภาพรวมของรายวิชา (Overview) แสดงภาพรวมโครงสร้าง
ของรายวชิา มีค าอธิบายสั้นๆ เก่ียวกบัหน่วยการเรียน วธีิการเรียน วตัถุประสงคแ์ละเป้าหมายของรายวชิา 

 4) เวบ็เพจแสดงส่ิงจ าเป็นในรายวิชา (Course Requirement) เช่น หนงัสือ
ประกอบบทเรียนแหล่งทรัพยากรบนเครือข่าย (Online Resources) เคร่ืองมือต่างๆทั้งฮาร์ดแวร์และ
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ซอร์ฟแวร์ โปรแกรมการอ่านเวบ็ท่ีจ าเป็นตอ้งใช้ในการเรียนแบบห้องเรียนเสมือน เช่น โปรแกรม 
Acrobat Reader   

 5) เวบ็เพจแสดงขอ้มูลส าคญั (Vital Information) ไดแ้ก่ขอ้มูลเก่ียวกบัการ
ติดต่อผูส้อน เช่น ท่ีอยู่ หมายเลขโทรศพัท ์เวลาท่ีจะติดต่อแบบออนไลน์ การเช่ือมโยงเวบ็เพจต่างๆ 
เช่น ลงทะเบียนใบรับรองการเรียน ค าแนะน า หอ้งสมุดเสมือน และเวบ็เพจของสถานศึกษา 

 6) เวบ็เพจแสดงบทบาทหนา้ท่ีและความรับผิดชอบ (Responsibilities) ของผู ้
ท่ีเก่ียวขอ้ง ไดแ้ก่ ส่ิงท่ีคาดหวงัจากผูเ้รียนในรายวิชาน้ี ก าหนดการสั่งงานท่ีไดรั้บมอบหมาย วิธีการ
ประเมินผลรายวชิา บทบาทหนา้ท่ีของผูส้อน ผูช่้วยสอน และผูส้นบัสนุน เป็นตน้ 

 7) เวบ็เพจกิจกรรมท่ีมอบหมายงานหรือแบบฝึกหดั (Assignment) ประกอบดว้ย
งานท่ีมอบหมายหรืองานท่ีผูเ้รียนจะตอ้งท าในรายวิชาทั้งหมด ก าหนดการส่งงาน การเช่ือมโยงไปยงั
กิจกรรมส าหรับการเรียนเสริม 

 8) เวบ็เพจแสดงก าหนดการเรียน (Course Schedule) ก าหนดวนัส่งงาน วนั
ทดสอบยอ่ย วนัสอบ เป็นการก าหนดเวลาท่ีชดัเจน จะช่วยใหผู้เ้รียนควบคุมตนเองไดดี้ข้ึน 

 9) เว็บเพจทรัพยากรสนบัสนุนการเรียน (Resources) แสดงรายช่ือแหล่ง
ทรัพยากร ส่ือ พร้อมการเช่ือมโยงไปยงัเวบ็ไซตท่ี์มีขอ้มูลความรู้ท่ีเก่ียวขอ้งกบัรายวชิา 

 10) เว็บเพจแสดงตวัอย่างแบบทดสอบ (Sample Test) แสดงค าถาม 
แบบทดสอบในการสอบยอ่ยหรือตวัอยา่งของงานส าหรับการทดสอบ 

 11) เวบ็เพจแสดงประวติั (Biography) แสดงขอ้มูลส่วนตวัของผูส้อน ผูช่้วย
สอนและผูท่ี้เก่ียวขอ้งกบัการเรียนการสอน พร้อมภาพถ่าย ขอ้มูลการศึกษา ผลงาน ส่ิงท่ีสนใจ 

 12)  เวบ็เพจการประเมิน (Evaluation) แสดงแบบประเมินเพื่อให้ผูเ้รียนใช้
ส าหรับการประเมินผลรายวชิา 

 13)  เวบ็เพจแสดงค าศพัท ์(Glossary) แสดงค าศพัทแ์ละความหมายท่ีใชใ้น
การเรียนรายวชิา 

 14)  เวบ็เพจการอภิปราย (Discussion) ส าหรับการสนทนา แลกเปล่ียนความ
คิดเห็น ถามตอบปัญหาการเรียนระหวา่งผูเ้รียนและผูส้อน หรือระหวา่งผูเ้รียนกบัผูเ้รียน ซ่ึงท าไดท้ั้ง
แบบประสานเวลา (Synchronous) คือสามารถติดต่อส่ือสารไดพ้ร้อมกนัตามเวลาจริง (Real Time) 
และแบบไม่ประสานเวลา (Asynchronous) คือผูเ้รียนส่งค าถามเขา้ไปในเวบ็เพจน้ี และผูต้อบจะมา
พมิพข์อ้ความค าตอบเม่ือมีเวลาวา่ง 
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 15)  เวบ็เพจประกาศข่าว (Bulletin Board หรือ Announcement) ส าหรับให้
ผูเ้รียนและผูส้อนใชใ้นการประกาศขอ้ความต่างๆ ซ่ึงอาจจะเก่ียวขอ้งหรือไม่เก่ียวขอ้งกบัการเรียนก็ได ้

 16)  เวบ็เพจค าถาม ค าตอบท่ีถามกนับ่อยๆ (FAQ) แสดงค าถามและค าตอบ
เก่ียวกบัรายวชิา โปรแกรมการเรียน สถาบนัการศึกษา และเร่ืองท่ีเก่ียวขอ้ง 

 17)  เวบ็เพจแสดงค าแนะน าในการเรียนรายวิชา ค าแนะน าในการออกแบบ
เวบ็ไซตข์องรายวชิา 

 2.1.7.2  องคป์ระกอบดา้นการติดต่อส่ือสาร เป็นองคป์ระกอบส าคญัท่ีท าให้บทเรียน
แบบห้องเรียนเสมือนแตกต่างจากบทเรียนคอมพิวเตอร์ช่วยสอน (CAI) โดยทัว่ไป เน่ืองจากช่วยให้
ผูส้อนและผูเ้รียนสามารถติดต่อส่ือสารระหวา่งกนัได ้ทั้งในรูปแบบของการสั่งงาน การอภิปรายกลุ่ม
หรือการให้ขอ้เสนอแนะรายบุคคล โดยผา่นเคร่ืองมือต่างๆ ของระบบเครือข่าย ไดแ้ก่ อีเมล์ กระดาน
ข่าว หอ้งสนทนา หรือหากมีความพร้อมในเร่ืองของอุปกรณ์อาจจดัใหมี้การถ่ายทอดสัญญาณภาพและ
เสียงสดผา่นระบบเครือข่ายได ้
  2.1.7.3  องค์ประกอบดา้นการบริหารจดัการ ในการเรียนการสอนแบบห้องเรียน
เสมือนอย่างเต็มรูปแบบ จ า เป็นจะต้องมีระบบท่ีใช้ส าหรับบริหารจัดการรายวิชา (Course 
Management System) เขา้มาเก่ียวขอ้ง ซ่ึงท าหน้าท่ีเป็นเคร่ืองมืออ านวยความสะดวกแก่ผูใ้ช้ในการ
จดัการเรียนการสอนแบบห้องเรียนเสมือน ทั้งในกลุ่มของผูส้อน ผูเ้รียน และผูบ้ริหารระบบเครือข่าย
ในดา้นต่างๆ เช่น การลงทะเบียนเรียน ระบบเขา้ออกชั้นเรียน (Login / Logout) ฐานขอ้มูลผูเ้รียน    
การเตรียมเน้ือหาบทเรียน การเก็บผลคะแนน สถิติการเขา้เรียนและพฤติกรรมผูเ้รียน รวมทั้งระบบ
การสืบคน้ (Search) เป็นตน้ 
 2.1.8  เป้าหมายของหอ้งเรียนเสมือน 

 เป้าหมายของห้องเรียนเสมือจริงเป็นการเปิดโอกาสให้ผูเ้รียนทุกคนสามารถเขา้ถึง 
(Access) และไดรั้บการศึกษาอยา่งมีประสิทธิภาพและเป้าหมายประการส าคญัท่ีสอดคลอ้งและเป็น
ปัจจยัส าคญัของห้องเรียนเสมือนคือ การเรียนแบบร่วมมือ (Collaborative Learning) เป้าหมายพฒันา
โอกาสของการเขา้ถึงการศึกษาอาจพิจารณาจากแนวคิดกวา้งๆ ท่ีเก่ียวกบัห้องเรียนเสมือนในประเด็น
เป้าหมาย ดงัน้ี (ภทัธีรา มว้นจัน่, 2548, น. 56) 
 2.1.8.1  ท าเลเป้าหมาย (Location) ผูเ้รียนอาจจะเลือกเรียนวิชาใดๆ จากผูส้อนคนใด
คนหน่ึงทัว่โลก หากมีการเปิดโอกาสใหล้งทะเบียนเรียนไดโ้ดยไม่มีขีดจ ากดั ขอ้จ ากดัเร่ืองพื้นท่ี 
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  2.1.8.2  เวลาท่ียืดหยุน่ (Flexible Time) ผูเ้รียนอาจจะมีส่วนร่วมไดต้ลอดเวลา ไม่วา่
จะเป็นกลางวนัหรือกลางคืน การได้รับขอ้มูลยอ้นกลบัจากผูส้อนและเพื่อนท่ีเรียนร่วมกนัจะไม่มี
ขอ้จ ากดัเร่ืองเวลา 
  2.1.8.3  ไม่มีการเดินทาง (No Travel) ผูเ้รียนสามารถท างานและศึกษาอยูก่บับา้นได้
อยา่งสะดวกสบาย ซ่ึงอาจจะเป็นขอ้ดีส าหรับผูเ้รียนท่ีมีอุปสรรคอนัเน่ืองมาจากความพิการท าให้ไม่มี
โอกาสมาเรียน ท าให้ไม่มีความจ าเป็นตอ้งเดินทางมาเรียน หรือแมแ้ต่ผูเ้รียนท่ีมีภาระดา้นครอบครัว 
ปัจจยัประการน้ีเป็นโอกาสท่ีท าใหทุ้กคนมีทางเลือกและความสะดวกสบาย 
  2.1.8.4  ประหยดัเวลา (Wasted Time) ผูเ้รียนท่ีจ าเป็นตอ้งเดินทางไปยงัสถานศึกษา
ถา้เรียนจากหอ้งเรียนเสมือนจะประหยดัเวลาการเดินทาง 
  2.1.8.5  ท างานร่วมกนั (Shared Workshop) ดว้ยศกัยภาพของเทคโนโลยีผูเ้รียน
สามารถแลกเปล่ียนข่าวสารขอ้มูลร่วมกนัไดอ้ยา่งง่ายดาย ในขณะท่ีการแลกเปล่ียนขอ้มูลในห้องเรียน
ปกติกระท าไดย้าก ผูเ้รียนในระบบห้องเรียนเสมือนจะสามารถอภิปรายปัญหาร่วมกนัแลกเปล่ียนเคา้
โครงงานซ่ึงกนัและกนัได ้
  2.1.8.6  โอกาสการมีส่วนร่วม (Participation Opportunity) ดว้ยระบบส่ือสารดว้ย
คอมพิวเตอร์เป็นส่ือกลาง สามารถเปิดโอกาสให้ผูเ้รียนทุกคนมีโอกาสเท่าเทียมกนัในการถามค าถาม 
การใหข้อ้สังเกตและการท ากิจกรรมร่วมกนั การจดัหอ้งเรียนเสมือนเป็นการเนน้ท่ีกระบวนการในการ
เรียนการสอนโดยใช้ห้องเรียนเสมือนเป็นเสมือนช่องทาง หรือเป็นเสมือนห้องเรียนจริงท่ีผูเ้รียนและ
ผูส้อนมาพบกนัในหอ้งเรียน ดงันั้นการจดัหอ้งเรียนเสมือนจึงเป็นการจดัเพื่อสร้างสภาพการเรียนแบบ
เสมือนจริงข้ึน  
 

2.2  ขั้นตอนการพฒันาห้องเรียนเสมอืน 
 2.2.1  แนวความคิดเก่ียวกบัหอ้งเรียนในอนาคต 
 สุปรียา ศิริพฒันกุลขจร (อ้างถึงใน เพอร์ริน, 2548, น. 36) ผูอ้  านวยการศูนย์
นวตักรรมการเรียนอลัควิสตข์องมหาวิทยาลยัแห่งรัฐแซนโฮเซ (The Alquist Center for Innovation 
Learning at San Jose State University) ไดค้าดการณ์ถึงลกัษณะของห้องเรียนในอนาคต (The 
University of the Future) ซ่ึงเป็นรูปแบบของมหาวทิยาลยันานาชาติ คือ 
 2.2.1.1  หอ้งเรียนท่ีไม่มีก าแพงขวางกั้น ซ่ึงผูเ้รียนสามารถเลือกหลกัสูตรรายวิชาและ
อาจารย์ท่ีปรึกษาจากสถาบันอุดมศึกษาชั้นน า ห้องน ้ า พิพิธภณัฑ์ และสถาบนัทางเทคนิคต่างๆ        
ทัว่โลก 
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 2.2.1.2  เป็นหอ้งเรียนท่ีออกแบบ ส าหรับคนท่ีไม่สามารถเรียนตามกรอบประเพณีใน
รูปแบบโรงเรียน ใหส้ามารถเรียนเวลาใดก็ได ้สถานท่ีใดก็ได ้และผูเ้รียนเป็นผูก้  าหนดทางเลือก 
 2.2.1.3  เป็นห้องเรียนท่ีเปิดท าการตลอด 24 ชัว่โมงต่อวนั 360 วนัต่อปี ซ่ึงผูเ้รียน
สามารถมีส่วนร่วมในการเรียนแบบสด ๆ หรือเรียนจบหลกัสูตรตามกรอบเวลา (Timeframe) ของ
ตนเอง 
 2.2.1.4  เป็นห้องเรียนระหวา่งชาติอยา่งแทจ้ริง มีวฒันธรรม และภาษาท่ีหลากหลาย 
ซ่ึงหลกัสูตรต่าง ๆ มีแหล่งก าเนิดมาจากนานาประเทศ นานาวฒันธรรมและนานาภาษา 
 2.2.1.5  เป็นห้องเรียนท่ีผูเ้รียน เป็นผูก้  าหนดแบบแผนการเรียนดว้ยตนเอง บนฐาน
ของความจ าเป็น ความสนใจ รูปแบบการเรียนท่ีชอบและวธีิประเมินผล 
 2.2.1.6  เป็นห้องเรียนท่ีคอมพิวเตอร์มลัติมิเดียปฏิสัมพนัธ์ ห้องสมุดอิเล็กทรอนิกส์
และทางด่วนข้อมูลข่าวสาร มีบทบาทส าคญัในการจดัหารายวิชาและบริการท่ีมีปฏิสัมพนัธ์เต็ม
รูปแบบ 
 2.2.1.7  เป็นห้องเรียนท่ีจดัหลกัสูตรท่ีเอ้ือต่อความตอ้งการในอนาคต และเตรียม
ผูเ้รียนใหท้ างานไดอ้ยา่งแทจ้ริง และวางกลยทุธ์ส าหรับบรรจุเขา้ท างานไวต้ั้งแต่ตอนสมคัรเรียน 
 2.2.1.8  เป็นห้องเรียนท่ีตอบสนองคนอจัฉริยะ คนสร้างสรรค ์และคนท่ีชอบท างาน
ร่วมกนั และแผนการเรียนการสอนเป็นแบบท่ีปรับตวักบัอนาคต น่าต่ืนเตน้และตรงประเด็นเน้ือหา 
 ห้องเรียนแห่งอนาคต เป็นห้องเรียนท่ีมีสภาพแวดลอ้มการเรียนเสมือนจริง (Virtual 
Learning) ไม่มีวทิยาเขต หรือสถานท่ีทางกายภาพ ซ่ึงนิยมเรียกวา่หอ้งเรียนเสมือน 
 2.2.2  จุดมุ่งหมายของหอ้งเรียนเสมือน 
 2.2.2.1  จุดมุ่งหมายทัว่ไปของหอ้งเรียนเสมือน 
 ห้องเรียนเสมือนมีจุดมุ่งหมายทัว่ไปในการกระจายความรู้โดยใช้เทคโนโลยีมลั
ติมิเดียและเครือข่ายสารสนเทศ ระหว่างนกัศึกษาในห้องเรียนกบัผูส้อน เพื่อเตรียมคนส าหรับโลก
อิเล็กทรอนิกส์ในวนัขา้งหนา้และฝึก “การเช่ือมต่อทางปัญญา” ในโครงร่างของสภาพแวดลอ้มเสมือน
จริง 
 2.2.2.2  จุดมุ่งหมายเฉพาะของหอ้งเรียนเสมือน ไดแ้ก่ 
 1) เพื่อสร้างหอ้งเรียนขา้มชาติ 
 2) เพื่อออกแบบห้องเรียนส าหรับวนัขา้งหน้า ท่ีผสมผสานระหว่างปฏิบติั
และทฤษฎีโดยการสนับสนุนการเรียนตลอดชีวิต เน่ืองจากเทคโนโลยีในปัจจุบนัมีความก้าวหน้า
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รวดเร็วมาก ประชาชนจะตอ้งปรับความรู้ใหท้นัสมยัอยูเ่สมอเพื่อไม่ใหต้กอยูใ่นความลา้หลงั การสอน         
มลัติมิเดียโดยใชม้ลัติมิเดีย หมายถึง การสอนส่ิงท่ีหลากหลายโดยใชส่ื้อท่ีหลากหลายเช่นเดียวกนั 

2.2.3  การออกแบบหอ้งเรียนเสมือน 
   หอ้งเรียนเสมือนสามารถออกแบบใหมี้ลกัษณะดงัน้ี  
  2.2.3.1  Learning is Fun ไดน้ าเทคโนโลยีของ JAVA มาเสริมในการเรียนรู้แบบ
สนุกสนานและไม่เครียดนกัจะไดเ้ล่นเกมทางวิทยาศาสตร์และรายวิชาอ่ืนๆ ท่ีจะสามารถออกแบบใน
ลกัษณะน้ีได ้
  2.2.3.2  Multimedia นกัเรียนจะเรียนรู้บทเรียนจากภาพและเสียง สามารถควบคุม
ขั้นตอนของการเรียนรู้ไดด้ว้ยปลายน้ิวสัมผสัของตน 
  2.2.3.3  Asynchronous Learning หมายถึง การเรียนท่ีไม่จ  าเป็นตอ้งมีครูผูส้อนอยูก่บั
นกัเรียนในเวลาและสถานท่ีเดียวกนั ครูจะจดัท า รวบรวม บทเรียนออนไลน์ ซ่ึงใช้เรียนท่ีไหนก็ได้
เวลาใดก็ได ้ตามแต่ผูเ้รียนจะสะดวก บทเรียนมีให้เลือกมากมาย และเช่ือมโยงไปยงับทเรียนอ่ืนๆ ท่ีมี
ความเก่ียวเน่ืองกนั 
  2.2.3.4  Electronic Library เป็นห้องสมุดอิเล็กทรอนิกส์ นกัเรียนสามารถคน้หาส่ิงท่ี
ตอ้งการจากแหล่งต่างๆ ทัว่โลกไดโ้ดยใช ้
  1) Search Engine นอกจากน้ียงัมีบริการให้คน้หาหนงัสือจากห้องสมุดของ
มหาวทิยาลยัต่างๆ คน้หาค าศพัทแ์ละอ่ืนๆ จาก Web Site ต่างๆ 
  2)  Information on Demand นกัเรียนสามารถเรียกดูขอ้มูลสารสนเทศตามท่ี
ตอ้งการไดจ้ากขอ้มูลตามค าสั่ง ซ่ึงไดแ้ก่ ข่าว และสารพนัความรู้ต่างๆ จากภาพในอนาคตท่ีปรากฏ
ลกัษณะของ Virtual Classroom ผนวกกบักระแสความเจริญทางดา้นเทคโนโลยีสารสนเทศและความ
ต้องการเห็นสังคมไทยเป็นสังคมแห่งการเรียนรู้ แข่งขันและร่วมมือ มีสมรรถภาพ การพฒันา
กระบวนการเรียนรู้ของผูเ้รียนในแง่มุมของ Virtual Classroom หรือห้องเรียนเสมือน ทางเลือกใหม่
ของนกัเรียนไทยจึงเป็นเร่ืองท่ีน่าจบัตามอง 
 2.2.4  วธีิส่ือสารและรับความรู้ของหอ้งเรียนเสมือน 
  หอ้งเรียนเสมือนมีวธีิส่ือสารและคน้ควา้หาความรู้ 6 วธีิใหญ่ๆ คือ 
  2.2.4.1  การสนทนาแบบออนไลน์ (Online Chat) 
  2.2.4.2  ส่ิงพิมพท่ี์พิมพใ์นห้องสมุดตามหลกัสูตร จดัเก็บเป็นหนงัสืออิเล็กทรอนิกส์
เพื่อใหน้กัศึกษาคน้ควา้ดว้ยตนเอง 
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 2.2.4.3  ผนงัข่าว (News wall) เป็นป้ายประกาศแจง้ข่าวต่างๆ ในห้องเรียน เช่น 
ก าหนดการสัมมนาปฏิบติัการ การประชุม ข่าวส าหรับนกัศึกษาใหม่ การติดต่อต่างๆ เป็นตน้ 
 2.2.4.4  ห้องสมุด เป็นแหล่งคน้หาความรู้ในทุกๆ ดา้น โดยมีฐานขอ้มูลท่ีเช่ือมต่อ
เครือข่ายสารสนเทศ และขอ้เขียนท่ีจดัพิมพโ์ดยหอ้งสมุดเอง 
 2.2.4.5  แหล่งคน้ควา้เพิ่มเติม เป็นแหล่งคน้ควา้ท่ีนอกเหนือจากห้องสมุด เช่น เวบ็ไซต ์ 
ต่าง ๆ ท่ีเก่ียวขอ้งกบัการเรียน หรือเป็นเวบ็ไซตเ์พื่อฝึกปฏิบติัจริง 
 2.2.4.6 เน้ือท่ีส าหรับส่งการบา้นหรือขอ้สอบบนเวบ็ไซต ์ซ่ึงเป็นส่วนตวัของนกัศึกษา
แต่ละคน เพื่อใหอ้าจารยส์ามารถเขา้ไปตรวจสอบได ้
 2.2.5 คู่มือส าหรับผูส้อนในหอ้งเรียนเสมือน 
 ห้องเรียนบางแห่งไดจ้ดัท าคู่มือส าหรับอาจารยป์ระจ าคณะ (On line faculty handbook) 
เช่น ห้องเรียนเสมือนแห่งมหาวิทยาลยัแคลิฟอร์เนีย วิทยาเขตโดมินกูซ ไดจ้ดัท าคู่มือส าหรับอาจารย์
ประจ าคณะ ซ่ึงประกอบดว้ยเน้ือหาแต่ละเร่ืองท าเป็นเวบ็เพจ แยกเป็นชุดดงัน้ี 
 2.2.5.1  คู่มือส าหรับผูติ้ดต่อร่วมงาน เป็นรายช่ือของผูร่้วมงานทั้งหมด ซ่ึงมีหวัขอ้ของ
บุคลากรทุกคน คือ ช่ือ ต าแหน่งงาน เบอร์โทรศพัท ์และท่ีอยูอี่เมล ์
 2.2.5.2 คู่มือส าหรับอาจารยใ์หม่ เป็นคู่มือในท านองปฐมนิเทศให้รู้จกัประวติัความ
เป็นมาของอินเทอร์เน็ต และการใช้อินเทอร์เน็ต รวมทั้งทกัษะพื้นฐานในการสอนทางอินเทอร์เน็ต
 2.2.5.3 คู่มือส าหรับตรวจสอบรายวิชาท่ีพฒันาข้ึนใหม่ เป็นแบบตรวจสอบรายการ 
(Checklist) ส าเร็จรูปใช้ส าหรับตรวจสอบความถูกต้องสมบูรณ์ของรายวิชาทั้งด้านเน้ือหาวิชา       
โครงร่างและกระบวนการเรียน  
 2.2.5.4 คู่มือแนะแนวทางเตรียมรายวิชา เป็นคู่มือส าหรับท าความเข้าใจเก่ียวกับ
ส่วนประกอบท่ีจ าเป็นในการประกอบเป็นรายวิชาส าหรับสอนแบบออนไลน์ โดยจดัท าเป็นหัวขอ้
พร้อมตวัอยา่ง 
 2.2.5.5 คู่มือเก่ียวกับส่ิงท่ีอาจารยจ์ะตอ้งปฏิบติัและจะตอ้งมี ได้แก่ ทกัษะทางด้าน
คอมพิวเตอร์ จะตอ้งมีความรู้พื้นฐานทางด้านคอมพิวเตอร์ และมีความรู้พื้นฐานด้านอินเทอร์เน็ต 
 2.2.5.6 คู่มือส าหรับตรวจสอบตวัอาจารยเ์อง เป็นรายการตรวจสอบส าหรับตรวจสอบ
ความตอ้งการ และความรับผิดชอบของผูส้อน โดยระบุความตอ้งการท่ีเน้นเป็นอนัดบัแรกก็คือ มี
ความปรารถนาท่ีจะเรียนรู้และยอมรับเทคโนโลยใีหม่ๆ 
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 2.2.6  การด าเนินการวจิยัและพฒันาทางการศึกษา (สุรพล  บุญลือ, 2550, น. 14-15) 
  2.2.6.1 การก าหนดผลิตภณัฑ์และรวบรวมขอ้มูล (Product selection)การก าหนด
ผลิตภณัฑ์ทางการศึกษาท่ีจะพฒันาเป็นขั้นตอนแรกและเป็นขั้นตอนท่ีจ าเป็นท่ีสุดคือตอ้งก าหนดให้
ชัดเจนว่าผลิตภัณฑ์ทางการศึกษาท่ีจะวิจัยและพฒันาคืออะไรโดยมีการก าหนดลักษณะทั่วไป 
รายละเอียดของการใชแ้ละวตัถุประสงคข์องการใชแ้ละมีเกณฑ์ในการเลือกก าหนดผลิตภณัฑ์ โดยมี
เกณฑใ์นการเลือกก าหนดผลิตภณัฑก์ารศึกษาท่ีจะวจิยัและพฒันา 4 ขอ้คือ 
 1) ตรงกบัความตอ้งการอนัจ าเป็นหรือไม่ 
 2) ความกา้วหนา้ทางวชิาการมีเพียงพอในการท่ีจะพฒันาผลิตภณัฑ์ท่ีก าหนด
หรือไม ่
 3) บุคลากรท่ีมีอยู ่มีทกัษะความรู้และประสบการณ์ท่ีจ าเป็นต่อการวิจยัและ
พฒันานั้นหรือไม ่
 4) ผลิตภณัฑ์นั้นจะพฒันาข้ึนในเวลาอนัสมควรได้หรือไม่เม่ือก าหนด
ผลิตภณัฑ์ท่ีตอ้งการวิจยัและพฒันาไดแ้ลว้ผูว้ิจยัจะตอ้งรวบรวมขอ้มูลและงานวิจยัท่ีเก่ียวขอ้งกบัการ
ใช้ผลิตภณัฑ์นั้น ถ้ามีความจ าเป็นผูท้  าวิจยัและพฒันาอาจตอ้งท าการศึกษาวิจยัขนาดเล็ก เพื่อหา
ค าตอบซ่ึงงานวจิยัและทฤษฎีท่ีมีอยูไ่ม่สามารถตอบได ้ก่อนท่ีจะเร่ิมท าการพฒันาต่อไป 
 2.2.6.2 การวางแผนการวิจยัและพฒันา (Planning) การวางแผนการวิจยัและพฒันา
ประกอบดว้ย  
  1) ก าหนดวตัถุประสงคข์องการใชผ้ลิตภณัฑ ์
 2) ประมาณการค่าใชจ่้าย  
 3) การก าหนดก าลงัคน  
 4) การก าหนดระยะเวลาท่ีตอ้งใชเ้พื่อศึกษาความเป็นไปได ้ 
 5) พิจารณาผลสืบเน่ืองจากผลิตภณัฑ์ขั้นตอนในการวางแผนการวิจยัและ
พฒันาเป็นขั้นตอนท่ีผูว้จิยัจะสามารถคาดคะเนไดว้า่การวิจยัคร้ังน้ีจะมีแนวทางเป็นไปไดห้รือประสบ
ความส าเร็จตามเวลาท่ีวางแผนไวห้รือไม่ 
 2.2.6.3  การพฒันารูปแบบขั้นตอนของการผลิต (Develop Preliminary Form of 
Product) ขั้นน้ีเป็นการออกแบบและจดัท าผลิตภณัฑ์ทางการศึกษาท่ีวางไว ้เช่น ถา้เป็นโครงการวิจยั
และพฒันาหลกัสูตรฝึกอบรมระยะสั้นก็ตอ้งออกแบบหลกัสูตร เตรียมวสัดุหลกัสูตร คู่มือผูฝึ้กอบรม
เอกสารในการฝึกอบรม และเคร่ืองมือในการประเมินผล โดยให้สอดคล้องกบัจุดมุ่งหมายขอบ
ผลิตภณัฑท์างการศึกษาท่ีตั้งไว ้
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 2.2.6.4  ทดลองหรือทดสอบผลิตภณัฑ์ขั้นตน้ (Preliminary Field Testing)ในขั้นน้ีจะ
เป็นการน าผลิตภณัฑ์ท่ีออกแบบและจดัเตรียมไวใ้นขั้นท่ี 3 ไปทดลองใชเ้พื่อทดสอบคุณภาพขั้นตน้
ของผลิตภณัฑ์ในสถาบนัการศึกษาจ านวน 1 – 3 สถาบนั ใช้กลุ่มตวัอยา่งขนาดเล็ก 6 –12 คน 
ประเมินผลโดยการใชแ้บบสอบถาม การสังเกต และการสัมภาษณ์ แลว้รวบรวมขอ้มูลมาวเิคราะห์ 
 2.2.6.5  น าขอ้มูลและผลการทดลองมาปรับปรุงผลิตภณัฑ์คร้ังท่ี 1 (Main Product 
Revision)ในขั้นตอนน้ีจะน าขอ้มูลและผลการทดลองท่ีไดจ้ากขั้นท่ี 4 มาปรับปรุงผลิตภณัฑค์ร้ังท่ี 1 
 2.2.6.6  ทดลองหรือทดสอบผลิตภณัฑ์คร้ังท่ี 2 (Main Field Testing) ในขั้นน้ีจะน า
ผลิตภณัฑท่ี์ไดรั้บการปรับปรุงไปทดลองเพื่อทดสอบคุณภาพของผลิตภณัฑ์ตามวตัถุประสงค์ โดยใช้
สถาบนัประมาณ 5 – 15 สถาบนั ใชก้ลุ่มตวัอยา่ง 30 – 100 คน ประเมินผลเชิงปริมาณในลกัษณะ
ทดสอบก่อนเรียน (Pre-test) กบัทดสอบหลงัเรียน (Post-test) น าผลไปเปรียบเทียบกบัวตัถุประสงค์
ของการใชผ้ลิตภณัฑ ์อาจมีกลุ่มควบคุมการทดลองถา้จ าเป็น 
 2.2.6.7  น าขอ้มูลและผลการทดลองมาปรับปรุงผลิตภณัฑ์คร้ังท่ี 2(Operational 
Product Revision)ในขั้นตอนน้ีจะน าขอ้มูลและผลการทดลองท่ีไดจ้ากขั้นท่ี 6 มาปรับปรุงผลิตภณัฑ์
คร้ังท่ี 2 
 2.2.6.8  ทดลองหรือทดสอบผลิตภณัฑ์คร้ังท่ี 3 (Operational Field Testing)ในขั้นน้ี
จะน าผลิตภณัฑ์ท่ีไดรั้บการปรับปรุงไปทดลองเพื่อทดสอบคุณภาพของผลิตภณัฑ์ตามวตัถุประสงค์
โดยใชส้ถาบนัประมาณ 10 – 30 สถาบนั ใช้กลุ่มตวัอย่าง 40 – 200 คน ประเมินโดยการใช้
แบบสอบถาม การสังเกต และการสัมภาษณ์ แลว้รวบรวมขอ้มูลมาวเิคราะห์ 
 2.2.6.9  น าขอ้มูลและผลการทดลองมาปรับปรุงผลิตภณัฑ์คร้ังท่ี 3 (Final Product 
Revision)ในขั้นตอนน้ีจะน าขอ้มูลและผลการทดลองท่ีไดจ้ากขั้นท่ี 8 มาปรับปรุงเพื่อผลิตและเผยแพร่ 
ต่อไป 
 2.2.6.10  การเผยแพร่ (Dissemination) เสนอรายงานเก่ียวกบัผลการวิจยัและพฒันา
ผลิตภณัฑ์ในท่ีประชุมสัมมนาทางวิชาการหรือวิชาชีพ ส่งไปลงเผยแพร่ในวารสารทางวิชาการ และ
ติดต่อกบัหน่วยงานทางการศึกษาเพื่อจดัท าผลิตภณัฑ์ทางการศึกษาเผยแพร่ไปในโรงเรียนต่างๆ หรือ
ติดต่อกบับริษทัเพื่อผลิตจ าหน่ายต่อไป 
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2.3  เวบ็ไซต์ 
 2.3.1  ความหมายของเวบ็ไซต ์
 การพฒันาเว็บไซต์ จะตอ้งเก่ียวขอ้งกบักระบวนการหลายอย่าง เช่น การออกแบบ
โครงสร้าง ลกัษณะหน้าตาของเว็บ หรือการเขียนโปรแกรม การสร้างเว็บไซต์ข้ึนมาโดยขาดการ
วางแผนและท างานอย่างไม่เป็นระบบอาจเร่ิมต้นด้วยการใช้โปรแกรมช่วยสร้างเว็บ เน้ือหาและ
รูปแบบก็เป็นไปตามท่ีนึกข้ึนได ้ท าใหเ้วบ็นั้นมีเป้าหมายและแนวทางท่ีไม่แน่นอน ผลลพัธ์จึงเส่ียงกบั
ความลม้เหลว เวบ็ท่ีแสดงขอ้ความว่าอยู่ระหว่างการก่อสร้าง (Under Construction หรือ Coming 
Soon) หมายถึงการขาดวางแผนท่ีดี บางเวบ็ก็ถือไดว้า่ตายไปแลว้ เน่ืองจากขอ้มูลลา้สมยั การออกแบบ
ท่ีไม่เหมาะสม เทคโนโลยีลา้สมยั ลิงคผ์ิดพลาด หรือความผิดพลาดของโปรแกรม ซ่ึงส่ิงต่างๆเหล่าน้ี
แสดงใหเ้ห็นถึงการขาดการดูแลตรวจสอบ และการพฒันาใหท้นัสมยัอยูเ่สมอ (กิตติพงษ ์จ ารูญ, 2551, 
น. 15) 
 วชิราภรณ์ คชสีห์ (อา้งถึงใน เอเบอร์โซล, 2551, น. 20-21) กล่าววา่ เวบ็ไซตห์มายถึง 
ส่ือประสมการเช่ือมต่อและน าเสนอข้อมูลข่าวสาร และแหล่งความบนัเทิงต่างๆ ไปยงักลุ่มผูใ้ช้
คอมพิวเตอร์ท่ีเช่ือมต่อกบัอินเทอร์เน็ต โดยปัจจยัหน่ึงท่ีท าให้เวบ็ไซตเ์ติบโตอยา่งรวดเร็วก็คือ ความ
ง่ายในการใชง้านและการเปล่ียนแปลงอยูเ่สมอ ซ่ึงคนท่ีดูแลเน้ือหาของเวบ็เองก็คอยจะน าเสนอบริการ
ใหม่ ๆ เพิ่มข้ึนด้วย ในความเป็นจริงแล้วองค์ประกอบท่ีสลบัซับซ้อนของเว็บไซต์อยู่ท่ีความเป็น
พลวตั และความสามารถในการรวมตวักบัคุณสมบติัของส่ืออ่ืน หรือเปล่ียนแปลงไปเป็นส่ิงอ่ืนๆ ได้
โดยในแต่ละเดือนท่ีผา่นไปไดน้ ามาซ่ึงเทคโนโลยใีหม่ๆ เพื่อการพฒันาและขยายขอบเขตของเวบ็ไซต์ 
และประสบการณ์ท่ีผูรั้บสารจะได้รับผ่านเว็บไซต์ และในปัจจุบนัได้มีการน าเว็บไซต์มาใช้เพื่ อ
การศึกษาของโรงเรียนต่างๆ เพิ่มมากข้ึนอีกที 
 2.3.2  ความส าคญัของเวบ็ไซต ์
  ในปัจจุบนัเวบ็ไซตไ์ดก้ลายเป็นส่ือท่ีมีความส าคญัซ่ึงมีบทบาทอยา่งมากในเร่ืองของ
การโฆษณาและประชาสัมพนัธ์ ทั้งน้ีเน่ืองจากคุณสมบติัท่ีสามารถน าเสนอ เผยแพร่ขอ้มูลข่าวสารได้
อยา่งไร้ขีดจ ากดัทั้งในเร่ืองเวลาและระยะทาง ใครก็สามารถคลิกเขา้มาเปิดดูไดต้ลอดเวลาไม่วา่จะนัง่
อยูส่่วนใดของโลกก็ตาม ดว้ยขอ้ดีดงักล่าว บริษทั ห้างร้าน สถานประกอบการเกือบทุกแห่งทั้งภาครัฐ
และเอกชนหรือแมแ้ต่บุคคลทัว่ไปต่างก็มีความตอ้งการจดัท าเวบ็ไซตข้ึ์นเพื่อเป็นช่องทางการส่ือสาร
รูปแบบใหม่ เพื่อประโยชน์ในการเผยแพร่ขอ้มูลข่าวสารไปสู่กลุ่มเป้าหมาย เช่น การโฆษณาขาย
สินคา้และบริการในรูปแบบต่าง ๆ ท่ีมีจุดมุ่งหมายในเชิงธุรกิจ หรือการใชเ้วบ็ไซตเ์ป็นช่องทางในการ
เผยแพร่ขอ้มูลข่าวสารขององค์กร เพื่อประชาสัมพนัธ์องค์กรให้เป็นท่ีรู้จกัเพื่อหวงัผลในการสร้าง
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ภาพลกัษณ์ขององค์กรให้เป็นท่ียอมรับ ซ่ึงเวบ็ไซตน์ั้นเป็นส่ือท่ีมีประสิทธิภาพเป็นอย่างมากในการ
สนองภารกิจดงักล่าว ประโยชน์ของเวบ็ไซตส์ามารถสรุปไดด้งัน้ี (วชิราภรณ์ คชสีห์, 2551, น. 27) 
  2.3.2.1 เป็นส่ืออิเล็กทรอนิกส์ทางอินเทอร์เน็ตท่ีใชเ้พื่อการโฆษณา ประชาสัมพนัธ์ 
การตลาดใหข้อ้มูลข่าวสาร และสร้างภาพลกัษณ์ท่ีดีแก่ธุรกิจและองคก์ร 
  2.3.2.2 สามารถน ามาใชเ้ป็นร้านคา้ออนไลน์เพื่อจ าหน่ายสินคา้ / บริการ 
  2.3.2.3 มีประสิทธิภาพเขา้ถึงกลุ่มเป้าหมายไดท้ัว่โลก 
  2.3.2.4 เสียค่าใช้จ่ายในการผลิตต ่ากว่าส่ืออ่ืนๆ แต่มีอายุการใช้งานยาวนานกว่า 
สามารถอพัเดตเปล่ียนแปลงขอ้มูลไดง่้าย 
  2.3.2.5 กลุ่มเป้าหมายสามารถเขา้ถึงส่ือไดโ้ดยสะดวกและรวดเร็วผ่านอินเทอร์เน็ต
ไดทุ้กวนัตลอด 24 ชัว่โมง 
  ดงันั้นในโลกยุคปัจจุบนัท่ีมีความเจริญก้าวหน้าในเร่ืองเทคโนโลยีอย่างไม่หยุดย ั้ง 
การใช้ส่ือเวบ็ไซต์เพื่อนเป็นช่องทางการส่ือสาร เพื่อเพิ่มประสิทธิภาพในการประชาสัมพนัธ์ให้กบั
องคก์รของตนจึงเป็นเร่ืองท่ีไม่สามารถท่ีจะมองขา้มไปได ้
 2.3.3  องคป์ระกอบของเวบ็ไซต ์
  เวบ็ไซตโ์ดยทัว่ไปมีองคป์ระกอบดงัน้ี 
  2.3.3.1 ช่ือของเวบ็ไซต ์หรือ URL (Uniform Resource Location) ต าแหน่งท่ีเก็บ     
เวบ็เพจเปรียบเสมือนท่ีอยูข่องเวบ็เพจ เม่ือตอ้งการเปิดเวบ็เพจใดจะตอ้งระบุต าแหน่งท่ีเก็บเวบ็เพจนั้น
หรือรหสัสืบคน้แหล่งขอ้มูล ซ่ึงเป็นการเช่ือมโยงขอ้มูลในระบบเวลิดไ์วดเ์วบ็ 
  2.3.3.2 โฮมเพจ (Homepage) เป็นค าเรียกช่ือเวบ็เพจหนา้แรกสุดของขอ้มูลแต่ละเร่ือง 
  2.3.3.3 เว็บเพจ (Webpage) เป็นองค์ประกอบหลกัส าหรับการน าเสนอขอ้มูลใน
ระบบเวลิดไ์วดเ์วบ็ 
 2.3.4  วธีิการจดัการเรียนรู้ผา่นเวบ็ 
  การใช้เครือข่ายอินเทอร์เน็ตมาพฒันาการเรียนการสอนในรูปแบบของการเรียนรู้
ผา่นเวบ็ท่ีมีลกัษณะสนบัสนุนให้ผูเ้รียนใฝ่หาความรู้ดว้ยตนเอง มีกิจกรรมต่างๆ ดว้ยบริการท่ีมีอยูใ่น
อินเทอร์เน็ตจ าเป็นอยา่งยิ่งตอ้งใชส่ื้อน้ีอยา่งมีประสิทธิภาพ นกัการศึกษาไดใ้ห้ขอ้เสนอแนะเก่ียวกบั
วธีิการจดัการเรียนรู้ผา่นเวบ็ไว ้5 ประการดงัน้ี (กนน ทศานนท,์ 2553, น. 18-19) 
  2.3.4.1 ส่งเสริมใหผู้เ้รียนและผูส้อนสามารถส่ือสารถึงกนัไดต้ลอดเวลา จะช่วยสร้าง
ความกระตือรือร้นให้กบัการเรียนการสอน ช่วยเสริมสร้างความคิด ความเขา้ใจแลกเปล่ียนความ
คิดเห็น แกปั้ญหาต่างๆ ไดต้ลอดเวลา 
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  2.3.4.2 สนับสนุนให้มีการพฒันาความร่วมมือระหว่างผูเ้รียนซ่ึงจะช่วยพฒันา
ความคิด ความเขา้ใจไดดี้กวา่ท างานคนเดียว เป็นการยอมรับความคิดเห็นผูอ่ื้น สร้างความสัมพนัธ์เป็น
ทีมโดยการแลกเปล่ียนความคิดเห็นระหวา่งกนัเพื่อหาแนวทางท่ีดีท่ีสุด 
  2.3.4.3 สนบัสนุนใหผู้เ้รียนรู้จกัแสวงหาความรู้ดว้ยตนเอง เปล่ียนบทบาทของผูส้อน
จากผูป้้อนความรู้มาเป็นผูแ้นะน า ผูเ้รียนเป็นผูข้วนขวายใฝ่หาขอ้มูลดว้ยตนเอง 
  2.3.4.4 การให้ผลป้อนกลบัแก่ผูเ้รียนโดยทนัที ท าให้ทราบถึงความสามารถของ
ตนเองจากผูส้อนหรือผูเ้รียนคนอ่ืน แมว้า่จะไม่ไดน้ัง่เรียนในชั้นเรียนแบบเผชิญหนา้กนัก็ตาม 
  2.3.4.5 ควรสนบัสนุนการจดัการเรียนการสอนท่ีไม่มีขีดจ ากดัส าหรับบุคคลท่ีใฝ่หา
ความรู้ เป็นการขยายโอกาสใหก้บัทุกคนท่ีสนใจ เน่ืองจากไม่จ าเป็นตอ้งการเดินทางไปเรียน ณ ท่ีใดท่ี
หน่ึง แต่สามารถเรียนไดด้ว้ยตนเองเม่ือเวลาสะดวก 
 

2.4  การหาประสิทธิภาพการสอนและส่ือการสอน 
การหาประสิทธิภาพของการสอนและส่ือการสอนเป็นการประเมินว่าวิธีสอนหรือส่ือการ

สอนท่ีเราเรียกว่า นวตักรรม มีประสิทธิภาพเพียงใดซ่ึงผลจากการหาประสิทธิภาพน้ีจ าน าไปสู่การ
พฒันาและหาทางเลือกอ่ืนในการพฒันาการสอนของครูผูส้อนเอง การหาประสิทธิภาพการสอนและ
ส่ือการสอนมีอยู ่2 แนวทางคือ การทดสอบคะแนนก่อนเรียนและหลงัเรียน, การใช้เกณฑ์มาตรฐาน 
E1/E2 การทดสอบคะแนนก่อนเรียนและหลงัเรียน เป็นการหาค่าคะแนนของการทดสอบระหวา่งเรียน
และหลงัเรียนจบแลง้จึงน ามาคิดค านวณโดยใชส้ถิติการหาค่าที (t-test) การใช้เกณฑ์มาตรฐาน E1/E2  
เกณฑ์มาตรฐาน E1/E2  เป็นเกณฑ์ท่ีใช้ในการเปรียบเทียบคะแนนท่ีไดจ้ากการประเมินในการะบวน
การเรียนการสอน กบัคะแนนท่ีไดจ้ากากรสอบคร้ังสุดทา้ย (Final) หลงัจากเรียนจบเร่ืองหรือผลการ
เรียนรู้ท่ีคาดหวงัแต่ละขอ้ การตั้งเกณฑค์วรค านึงถึงลกัษณะของวชิาดว้ยวา่เป็นวชิาประเภทใด เช่น 

ถา้เป็นวชิาประเภทเนน้ความรู้ความจ าควรตั้งเกณฑท่ี์ 80/80 
ถา้เป็นวชิากลุ่มทกัษะปฏิบติัควรตั้งเกณฑท่ี์ 75/75 
ในการเปรียบเทียบเราจะเปรียบเทียบค่า E1 กบั E2 วา่สูงหรือต ่ากวา่เกณฑ์ท่ีเราตั้งไวป้กติจะ

มีความคลาดเคล่ือนอยูป่ระมาณ 5% หาค่า E1 กบั E2 สูงเกณฑท่ี์ตั้งไวก้็แสดงวา่วิธีสอนหรือส่ือท่ีเราใช้
มีประสิทธิภาพแต่ถา้ค่า E1 กบั E2 ต ่ากวา่เกณฑ์ก็แสดงวา่เราตอ้งปรับปรุงวิธีสอนหรือส่ือท่ีเราใชน้ั้น
ใหมี้คุณภาพมากยิง่ข้ึน 
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ค่า E1 เป็นร้อยละของคะแนนเฉล่ียของคะแนนทั้งหมดในห้องท่ีเก็บจากกิจกรรม เช่น        
ใบงาน แบบฝึกหัด แบบทดสอบย่อยระหว่างเรียนเร่ืองนั้นๆ หรือผลการเรียนรู้ท่ีคาดหวงัหรือ
จุดประสงคน์ั้นๆ  

ค่า E2 เป็นร้อยละของคะแนนเฉล่ียจากการสอบหลงัเรียนหรือสอบคร้ังสุดทา้ยของผลการ
เรียนรู้ท่ีคาดหวงัหรือจุดประสงคน์ั้นๆ  

การหาประสิทธิภาพส่ือการสอน/นวตักรรมการศึกษา ส่วนใหญ่จะใชว้ิธีการหาขอ้มูลแบบ
ผสมผสานระหว่างข้อมูลเชิงคุณภาพกับข้อมูลเชิงปริมาณ โดยใช้กระบวนการของการวิจยัและ
พฒันาการหาประสิทธิภาพส่ือการสอน/นวตักรรมการศึกษา จึงมีวิธการท่ีหลากหลายให้เลือกใช้ได้
อยา่งเหมาะสมกบัประเภทของส่ือสภาพแวดลอ้มทางการเรียนและการจดักิจกรรมการเรียน อยา่งไรก็
ดี แมว้า่จะมีวธีิการหาประสิทธิภาพหลายวธีิ แต่ละวธีิต่างก็มีวตัถุประสงคเ์พื่อหาค่าตวัเลขท่ีบ่งบอกถึง
ปริมาณท่ีแสดงว่าส่ือการสอน/นวตักรรมการศึกษานั้นๆ มีคุณภาพเพียงพอต่อการน าไปใช้กับ
กลุ่มเป้าหมายนั้นๆ โดยอาจใชเ้คร่ืองมือในการหาประสิทธิภาพเพียงประเภทเดียวหรือหลายประเภทก็
ได้ เคร่ืองมือท่ีนิยมน ามาหาประสิทธิภาพ ได้แก่ แบบสอบถามชนิดตรวจสอบรายการ (Checklist) 
แบบให้ขอ้มูลสารสนเทศ (Identifying Information) แบบทดสอบวดัผลสัมฤทธ์ิ (Achievement Test) 
แบบสอบถามความคิดเห็น (Questionnaire) การสังเกต/การสัมภาษณ์ (Observation/Interviewing) ใน
ท่ีน้ีจะขอกล่าวถึงการหาประสิทธิภาพส่ือการสอนและนวตักรรมการศึกษา ดงัน้ี 

2.4.1  ส่ือการสอน/นวตักรรมการศึกษาท่ีสนบัสนุนการเรียนรู้รายบุคคล 
2.4.1.1  บทเรียนโปรแกรม 

 มีการหาประสิทธิภาพหลายวิธีแต่ทุกวิธีจะใช้การค านวณหาร้อยละของ
ค าตอบท่ีผูเ้รียนตอบถูก จะไดต้วัเลขท่ีแสดงถึงประสิทธิภาพของบทเรียนโปรแกรม ค่าประสิทธิภาพ
ของบทเรียนโปรแกรมท่ียอมรับกันนั้นมีอยู่หลายค่า เช่น ถ้ายึดหลักผู ้เรียนต้องรอบรู้ (Master 
Learning) ค่าประสิทธิภาพขั้นต ่าอยู่ท่ีร้อยละ 80 และจะเขียนค่าประสิทธิภาพในรูปแบบ 80/80 
หมายความวา่ 

 ผูเ้รียนร้อยละ 80 ท าแบบทดสอบวดัผลสัมฤทธ์ิทางการเรียนแต่ละขอ้ได้
ถูกตอ้ง (80 ตวัหนา้)  

 ผูเ้รียนร้อยละ 80 ท าแบบทดสอบวดัผลสัมฤทธ์ิทางการเรียนไดค้ะแนนร้อย
ละ 80 ข้ึนไป (80 ตวัหลงั) 

 ถา้ยึดถือเอาเกณฑ์บทเรียนโปรแกรมแบบสกินเนอร์ (Skinnerian Type) จะ
ก าหนดค่าประสิทธิภาพไวท่ี้ 95/95 โดยความหมายของตวัเลขมีความหมาย ดงัน้ี 
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 ผูเ้รียนร้อยละ 95 ท าแบบทดสอบวดัผลสัมฤทธ์ิทางการเรียนแต่ละข้อได้ถูกต้อง               
(95 ตวัหนา้) 

 ผูเ้รียนร้อยละ 95 ท าแบบทดสอบวดัผลสัมฤทธ์ิทางการเรียนไดค้ะแนนร้อยละ 95 
ข้ึนไป (95 ตวัหลงั) 

 ถา้ยดึเกณฑม์าตรฐานท่ีก าหนดโดยผูส้ร้างบทเรียนโปรแกรม ซ่ึงอาจหมายถึง ครู นกั
เทคโนโลยีการศึกษา นกัผลิตส่ือฯ ก็จะก าหนดให้สอดคลอ้งกบัริบททางการศึกษา โดยทัว่ไปมกัจะ
ก าหนดไวท่ี้ 80/80 หมายความวา่ 

 ผูเ้รียนท าคะแนนแบบฝึกหดัในบทเรียนไดร้้อยละ 80 ข้ึนไป (80 ตวัหนา้) 
 ผูเ้รียนท าคะแนนแบบทดสอบวดัผลสัมฤทธ์ิไดร้้อยละ 80 ข้ึนไป (80 ตวัหลงั) 
 นอกจากเกณฑ์ดงัท่ีกล่าวมาแลว้ การตั้งเกณฑ์ยงัข้ึนอยูก่บัอตัราการตอบผิดท่ีผูส้ร้าง

บทเรียนยอมรับไดซ่ึ้งจะข้ึนอยูก่บัชนิดของบทเรียนดว้ย กล่าวคือ 
 บทเรียนโปรแกรมแบบเส้นตรง (Linear Program) จะมีอตัราการตอบผิด (Error 

Rate) ท่ียอมรับไดอ้ยูร่ะหวา่งร้อยละ 5-10 (5-10% Error Rate) 
 บทเรียนโปรแกรมแบบสาขา (Branching Program) จะมีอตัราการตอบผิด (Error 

Rate) ท่ียอมรับไดอ้ยูร่ะหวา่งร้อยละ 10-20 (10-20% Error Rate) 
 ดงันั้น การเลือกเกณฑ์เพื่อก าหนดค่าประสิทธิภาพของบทเรียนโปรแกรมจึงควรมี

ปัจจยัท่ีจะตอ้งพิจารณาหลายประการ เช่น 
1) สติปัญญาของผูเ้รียนความสามารถในการอ่านของผูเ้รียน 
2) ความสามารถในการเขียนของผูเ้รียน 
3) วฒิุภาวะของผูเ้รียน 
4) วตัถุประสงคข์องการเรียน 

2.4.1.2 ชุดการเรียนรายบุคคลหรือหน่วยการเรียนรายบุคคล 
ชุดการเรียนรายบุคคลหรือหน่วยการเรียนรายบุคคล เป็นนวตักรรมประเภท

บูรณาการ (Integrated Innovation) เป็นนวตักรรมของการใช้เทคโนโลยีส่ือผสม (Multimedia 
Technology) เป็นการใชส่ื้อหลายชนิดให้เอ้ือประโยชน์ซ่ึงกนัและกนั เช่น ใชบ้ทเรียนคอมพิวเตอร์
ช่วยสอนในการใหส้าระรายบุคคล หลงัจากนั้นจึงให้ท ากิจกรรมกลุ่มโดยมีส่ือส่ิงพิมพแ์ละส่ือเทคนิค
วธีิการในการใหส้าระ เป็นตน้ การหาประสิทธิภาพของส่ือประเภทน้ีจึงใชว้ธีิการหาประสิทธิภาพของ
กระบวนการ (E1) และประสิทธิภาพของผลลพัธ์ (E2) นิยมเขียนในรูปแบบ ดงัน้ี 
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  E1/E2   โดยก าหนดให้ 
  E1 เป็นค่าประสิทธิภาพของกระบวนการ 
  E2 เป็นค่าประสิทธิภาพของผลลพัธ์ 

 ค่าประสิทธิภาพของกระบวนการ หมายถึง ตัวเลขคิดเป็นร้อยละท่ีบ่งบอกถึง
ประสิทธิภาพของการปฏิบติักิจกรรมตามท่ีก าหนดให้ภายในนวตักรรมนั้นๆ ของผูเ้รียน หรือเป็น
ตวัเลขคิดเป็นร้อยละของคะแนนท่ีได้จากการท าแบบฝึกหัดในระหว่างท่ีผูเ้รียนก าลังเรียนจาก
นวตักรรมนั้น ค านวณไดจ้ากสูตร 

          

 
   
   

  E1 =  ประสิทธิภาพของกระบวนการ 
  ∑X1 =  คะแนนเตม็ของแบบฝึกหดั 
  N =  จ  านวนผูเ้รียน 
  A =  คะแนนเตม็ของแบบฝึกหดั 
 

  ค่ าประสิทธิภาพของผลลัพธ์  หมายถึง  ตัว เลขคิดเ ป็นร้อยละ ท่ีบ่งบอกถึง
ประสิทธิภาพของการปฏิบติักิจกรรมหลงัการเรียนจบบทเรียนของผูเ้รียน หรือเป็นตวัเลขคิดเป็นร้อย
ละของคะแนนท่ีไดจ้ากการท าแบบทดสอบหลงัเรียนของผูเ้รียนท่ีเรียนจากนวตักรรมนั้นค านวณได้
จากสูตร 
 
  
   
 
  E2 =  ประสิทธิภาพของกระบวนการ 

∑X2 =  ผลรวมของคะแนนแบบทดสอบหลงัเรียนท่ีผูเ้รียนท าได ้
N =  จ  านวนผูเ้รียน 
B =  คะแนนเตม็ของแบบทดสอบหลงัเรียน 
 

  

E1 

∑X1 

N 

A 
x 100 = 

E2 

∑X2 

N 

B 
x 100 = 
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 หรือค านวณโดยใชสู้ตรแบบง่าย ดงัน้ี  
 

 
 
 
 
 
 ส่วนเกณฑ์การตั้ งค่าประสิทธิภาพนั้ นนิยมใช้หลักของการเรียนแบบรอบรู้ 

(Mastering Learning) คือ ตั้งเกณฑ์ไวท่ี้ ร้อยละ 80 และมีช่วงของการยอมรับประสิทธิภาพท่ี 80-2.5 
(ยอมรับความผิดพลาดไดร้้อยละ 2.5) หรือ ยอมรับประสิทธิภาพท่ี 80-5 (ยอมรับความผิดพลาดได้
ร้อยละ 5) ตวัอยา่งเช่น ตั้งเกณฑข์อง E1/E2 ไวท่ี้ 80/80 และตั้งค่าการยอมรับความผิดพลาดไดไ้วท่ี้ร้อย
ละ 2.5 สมมติวา่ ค  านวณค่า E1/E2 ได ้78/79 ถือไดว้า่ค่าประสิทธิภาพอยูใ่นเกณฑ์ยอมรับได ้แมว้า่จะมี
ค่าต ่ากวา่ 80/80 ทั้งน้ีเพราะวา่เกณฑ์ขั้นต ่าท่ียอมรับไดข้อง E1 จะเท่ากบั 80-2.5 ซ่ึงก็คือ 77.5 และ E2 
จะเท่ากบั 80-2.5 ซ่ึงก็คือ 77.5 จากตวัอย่างให้ค่าท่ีค  านวณไดเ้ท่ากบั 78/79 จึงมีค่าสูงกว่า 77.5/77.5  
นัน่คือค่าประสิทธิภาพท่ีค านวณไดอ้ยู่ในเกณฑ์ท่ียอมรับได้ จากขอ้มูลเดียวกนัถา้ตั้งค่าการยอมรับ
ความผดิพลาดไดไ้วท่ี้ร้อยละ 5 ค่าประสิทธิภาพขั้นต ่าท่ียอมรับไดคื้อ 75/75  
  ดงันั้น จึงสรุปได้ว่า ประสิทธิภาพของชุดการเรียนรายบุคคลหรือหน่วยการเรียน
รายบุคคลควรตั้งค่าประสิทธิภาพไวท่ี้ E1/E2 = 80/80  โดยตอ้งก าหนดเกณฑ์ของความผิดพลาดท่ี
ยอมรับไดไ้วด้ว้ย ซ่ึงไม่ควรเกินร้อยละ 5 

 2.4.1.3  ส่ือผสม (Multimedia) 
 การหาค่าประสิทธิภาพของส่ือผสมมีวธีิการหาไดห้ลายวธีิ เช่น 

 1)  หาค่าประสิทธิภาพโดยใชว้ธีิเดียวกบับทเรียนโปรแกรม โดยมีเง่ือนไขวา่
ส่ือผสมนั้นจะตอ้งมีแบบฝึกหดัใหผู้เ้รียนไดท้  าในระหวา่งการเรียน 

 2)  หาค่าประสิทธิภาพโดยใชว้ธีิหาค่า E1/E2 
 3)  หาค่าร้อยละ (Percentage) ของคะแนนผลสัมฤทธ์ิทางการเรียนท่ีท าได้

ภายหลงัจากเรียนดว้ยส่ือผสม โดยผูส้ร้างนวตักรรมเป็นผูก้  าหนดเกณฑ์ประสิทธิภาพ เช่น ก าหนดไว้
ท่ีร้อยละ 60 หรือร้อยละ 70 หรือข้ึนอยูก่บัหลายปัจจยัดงัไดก้ล่าวมาแลว้ในเร่ืองการหาประสิทธิภาพ
ของบทเรียนโปรแกรม 

คะแนนรวมแบบฝึกหดัท่ีผูเ้รียนทุกคนท าได ้

คะแนนเตม็ของแบบฝึกหดัคูณจ านวนผูเ้รียน 
E1 = x 100 

E2 
คะแนนรวมของแบบทดสอบหลงัเรียนท่ีผูเ้รียนทุกคนท าได ้

คะแนนเตม็ของแบบทดสอบหลงัเรียนคูณจ านวนผูเ้รียน 
x 100 = 
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 4)  ใชว้ธีิทวเิกณฑ ์(Double Percentage) เป็นการหาร้อยละของผูเ้รียนท่ีเรียน
ผ่านเกณฑ์ท่ีก าหนด ค่าประสิทธิภาพของส่ือ/นวตักรรมการศึกษาท่ีหาได้ด้วยวิธีการน้ีเขียนอยู่ใน
รูปแบบดงัน้ี 

ค่าประสิทธิภาพส่ือหรือนวตักรรม  =  ร้อยละของผูเ้รียนท่ีเรียนผ่านเกณฑ์ท่ี           
ก าหนด – ร้อยละของคะแนนเกณฑ์ท่ีก าหนด เช่น  ค่าประสิทธิภาพของส่ือ  =  65-75  (หรือ  65-75)
หมายความว่า  ส่ือท่ีสร้างข้ึนสามารถท าให้ผูเ้รียนร้อยละ 65 ท่ีเรียนจากส่ือน้ีท าคะแนนจากการ
ทดสอบหลังการเรียนได้เท่ากับหรือสูงกว่าร้อยละ 75  ซ่ึงเป็นเกณฑ์ขั้นต ่าท่ีก าหนดไว ้ส่วนการ
ก าหนดค่าประสิทธิภาพท่ียอมรับไดผู้ส้ร้างส่ือหรือนวตักรรมจะเป็นผูก้  าหนดตามความเหมาะสมโดย
พิจารณาปัจจยัต่างๆ ดงัท่ีกล่าวมาแลว้ดว้ย 

2.4.1.4  บทเรียนคอมพิวเตอร์ช่วยสอน 
 การหาประสิทธิภาพของบทเรียนคอมพิวเตอร์ช่วยสอนมีด้วยกนัหลายวิธี 

เช่น ใชว้ธีิแบบบทเรียนโปรแกรม ใชว้ิธีแบบส่ือผสม ใชว้ิธีหาค่า E1/E2 ในท่ีน้ีจะขออธิบายอีกวิธีหน่ึง
ท่ีนิยมกนั คือ วิธีหาร้อยละของผูเ้รียนจบบทเรียนโดยสมบูรณ์ภายในระยะเวลาท่ีก าหนด (Triple 
Criteria) การค านวณหาประสิทธิภาพส่ือ/นวตักรรม โดยวธีิน้ีมีเกณฑจ์ะตอ้งพิจารณา ดงัน้ี  

 1)  เกณฑร้์อยละของผูเ้รียนท่ีเรียนจบบทเรียนโดยสมบูรณ์ 
 2)  เกณฑข์ั้นต ่าของการจบบทเรียนโดยสมบูรณ์ 
 3)  เกณฑเ์วลาท่ีก าหนดใหเ้รียนจบบทเรียนโดยสมบูรณ์ 

 ยกตวัอย่างเช่น บทเรียนคอมพิวเตอร์ช่วยสอนเร่ืองจักรวาลและอวกาศ
ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 5 ตั้งค่าประสิทธิภาพของบทเรียนโดยวิธีหาร้อยละของผูเ้รียนท่ี
เรียนจบบทเรียนโดยสมบูรณ์ภายในระยะเวลาท่ีก าหนด  (Triple Criteria) และไดก้ าหนดเกณฑ์ไวท่ี้ 
60_70_50 นาที หมายความว่า ผูเ้รียนร้อยละ 60 จะต้องเรียนจบบทเรียนโดยสมบูรณ์  โดยท า
แบบทดสอบวดัผลสัมฤทธ์ิทางการเรียนไดค้ะแนนร้อยละ 70 ข้ึนไป และใช้เวลาในการเรียนไม่เกิน 
50 นาที หรือตั้งค่าประสิทธิภาพไวท่ี้ 70_70_90 นาที หมายความวา่ ผูเ้รียนร้อยละ 70 จะตอ้งเรียนจบ
บทเรียนโดยสมบูรณ์ โดยท าแบบทดสอบวดัผลสัมฤทธ์ิทางการเรียนไดค้ะแนนร้อยละ 70 ข้ึนไป และ
ใชเ้วลาในการเรียนไม่เกิน 90 นาที 

2.4.1.5  ส่ือแบบโปรแกรม 
 ส่ือแบบโปรแกรมท่ีนิยมผลิตกนัมีอยู่ 2 ชนิด คือ สไลด์เทปแบบโปรแกรม 

และวีดีทศัน์แบบโปรแกรม ส่ือทั้งสองชนิดน้ีมีวิธีหาประสิทธิภาพไดห้ลายวิธี เช่น แบบบทเรียน
โปรแกรมแบบส่ือผสม วธีิ E1/E2 วธีิ Double Percentage วธีิ Triple Criteria 
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2.5  ผลสัมฤทธ์ิทางการเรียน 
 2.5.1  แนวคิด ทฤษฎีเก่ียวกบัผลสัมฤทธ์ิทางการเรียน 
 ไพศาล หวงัพานิช (2533, น. 137) ให้ความหมายผลสัมฤทธ์ิทางการเรียนรู้ หมายถึง 
ความสามารถและคุณลกัษณะของบุคคลท่ีเกิดจากการเรียนการสอนเป็นการแลกเปล่ียนพฤติกรรม
และประสบการณ์การเรียนท่ีเกิดจากการฝึกอบรมหรือจากการสอน การวดัผลสัมฤทธ์ิจึงเป็นการ
ตรวจสอบความสามารถหรือความสัมฤทธ์ิผลของบุคคลวา่เรียนรู้แลว้เท่าไร สามารถวดัได ้2 แบบ คือ 
  2.5.1.1 วดัดา้นปฏิบติั เป็นการตรวจสอบความสามารถในการปฏิบติัหรือทกัษะของ
ผูเ้รียนโดยมุ่งเน้นให้ผูเ้รียนแสดงความสามารถในรูปของการกระท าจริงให้ออกมาเป็นผลงาน เช่น 
การทดลอง การปฏิบติัจริง การวดัแบบน้ีคือ “ขอ้สอบภาคปฏิบติั” 
  2.5.1.2 วดัด้านเน้ือหาเป็นการตรวจสอบความสามารถเก่ียวกับเน้ือหาอันเป็น
ประสบการณ์เรียนรู้ของผูเ้รียน รวมถึงพฤติกรรมความสามารถในด้านต่างๆ สามารถวดัไดโ้ดยใช ้
“ขอ้สอบวดัผลสัมฤทธ์ิ” 
 การวดัผลสัมฤทธ์ิทางการเรียนจะตอ้งสอดคลอ้งกบัวตัถุประสงค์เชิงพฤติกรรม 3 
ดา้นคือ 
  1) ดา้นความรู้ ความคิด (Cognitive Domain) พฤติกรรมดา้นน้ีเก่ียวขอ้งกบั
กระบวนการต่าง ๆ ทางด้านสติปัญญาและสมองเช่น การจดจ าข้อเท็จจริง ความเข้าใจ การ
ตั้งสมมติฐานและปัญหา 
 2)  ดา้นความรู้สึก (Affective Domain) พฤติกรรมดา้นน้ีเก่ียวขอ้งกบั
ความรู้สึกนึกคิด เช่น ความชอบไม่ชอบ เจตคติ ความพึงพอใจ 
 3)  ดา้นการปฏิบติั (Psychomotor Domain) พฤติกรรมดา้นน้ีเก่ียวกบัการ
พฒันาทกัษะในการปฏิบติัและด าเนินการ เช่น การทดลองเป็นตน้ 
 2.5.2  การวดัประเมินผลตามสภาพจริง 
 การวดัประเมินผลตามสภาพจริง เป็นการวดัผลท่ีค านึงถึงความแตกต่างระหว่าง
ผูเ้รียนและพฤติกรรมท่ีเกิดข้ึนในการจัดการเรียนรู้ ในการจัดกิจกรรมการเรียนรู้ของผู ้เรียนมี
หลากหลาย เช่น กิจกรรมภาคสนาม กิจกรรมการทดลองและกิจกรรมการค้นควา้ ซ่ึงในการจัด
กิจกรรมเหล่านั้นควรค านึงวา่ผูเ้รียนแต่ละคนมีศกัยภาพแตกต่างกนั ดงันั้นการท างานช้ินเดียวกนัอาจ
เสร็จในเวลาท่ีต่างกัน ผลงานท่ีได้ก็แตกต่างกันด้วย ในการวดัผลประเมินผลตามสภาพจริงท่ีมี
ประสิทธิภาพควรมีการประเมินหลายๆ ดา้นและหลากหลายวธีิ 
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 2.5.3  ลกัษณะการวดัและประเมินตามสภาพจริง 
 2.5.3.1 ใชว้ธีิประเมินการคิดท่ีซับซ้อน ความสามารถในการปฏิบติังานและศกัยภาพ
ของผูเ้รียนมากกวา่ท่ีจะประเมินดา้นความรู้ ความจ า 
 2.5.3.2 เป็นการประเมินความสามารถของผูเ้รียน เพื่อท่ีจะวินิจฉยัผูเ้รียนในส่วนท่ี
ควรส่งเสริมและในส่วนท่ีควรแกไ้ข 
 2.5.3.3 เป็นการประเมินท่ีใหผู้เ้รียนมีส่วนร่วมในการประเมินงานของตนเองและของ
เพื่อนร่วมหอ้ง เพื่อใหรู้้จกัตนเองและเกิดการยอมรับในผลงานของผูอ่ื้น 
 2.5.3.4 ขอ้มูลท่ีไดจ้ากกการประเมินจะสะทอ้นให้เห็นถึงกระบวนการเรียนการสอน
และการวางแผนของผูส้อนว่า สามารถสนองต่อความสามารถ ความสนใจ และความตอ้งการของ
ผูเ้รียนหรือไม่ 
 2.5.3.5 ประเมินความสามารถของผูเ้รียนในการถ่ายโอนการเรียนรู้ไปสู่ชีวิตจริง 
 2.5.3.6 ประเมินดา้นต่างๆ ดว้ยวธีิท่ีหลากหลายในสถานการณ์ต่างๆ อยา่งต่อเน่ือง 
 

2.6  ความพงึพอใจ 
 2.6.1  ความหมายของความพึงพอใจ 
 บุญธรรม กิจปรีดาบริสุทธ์ิ (2549. น. 189) กล่าวว่า ความพึงพอใจเป็นสภาพ
ความรู้สึกท่ีมีความสุข สดช่ืน เป็นภาวะทางอารมณ์เชิงบวกท่ีบุคคลแสดงออกเม่ือไดรั้บผลส าเร็จทั้ง
ปริมาณและคุณภาพ ตามจุดมุ่งหมาย ความตอ้งการ ความพึงพอใจจึงเป็นผลของความตอ้งการท่ีไดรั้บ
การตอบสนองโดยมีการจูงใจ (Motivation) หรือส่ิงจูงใจ (Motivators) เป็นตวัเหตุ 
 จากท่ีกล่าวมาขา้งตน้สรุปได้ว่า ความพึงพอใจ หมายถึง ทศันคติหรือความรู้สึกท่ี
บุคคลแสดงออกต่อส่ิงหน่ึงส่ิงใดในทางบวก ซ่ึงระดบัความพึงพอใจในแต่ละบุคคลจะมีความแตกต่าง
กนั 
 2.6.2  ลกัษณะของความพึงพอใจ 
 ลกัษณะของความพึงพอใจเป็นความรู้สึกท่ีดีโดยส่วนรวมของคนต่องานของเขา ซ่ึง
เป็นความตอ้งการของคนในการท างาน ประกอบดว้ยความตอ้งการภายนอกและความตอ้งการภายใน 
ดงัน้ี 
 2.6.2.1 ความตอ้งการภายนอก ได้แก่ รายได้ ความมัน่คงปลอดภยัในการท างาน 
สภาพแวดลอ้มทางกายภาพ ต าแหน่งหนา้ท่ี การไดท้  างานท่ีถนดั 
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 2.6.2.2 ความตอ้งการภายใน ได้แก่ ความต้องการมีส่วนร่วมในหมู่คณะ ความ
ต้องการเป็นท่ีรักใคร่ของเพื่อนและผูร่้วมงาน ความต้องการเป็นท่ียอมรับนับถือของผูอ่ื้น ความ
ตอ้งการในศกัด์ิศรีของตนเอง 
 2.6.2.3 ความพึงพอใจในลกัษณะของงาน ไดแ้ก่ งานท่ีปฏิบติัถูกอธัยาศยัของผูป้ฏิบติั 
งานมีลกัษณะไม่ซ ้ าซากจ าเจ งานมีลกัษณะกา้วหนา้ งานไม่ยากเกินความสามารถของผูป้ฏิบติั 
 2.6.3  การวดัความพึงพอใจ 
  ในการวดัความพึงพอใจเราสามารถวดัไดโ้ดยใชเ้คร่ืองมือวดัท่ีเรียกวา่ แบบวดั ค าวา่ 
แบบวดัน้ีเป็นค ากลางใชแ้ทนความหมายของเคร่ืองมือรวบรวมขอ้มูลทัว่ไป ทั้งแบบสอบถาม แบบ
สัมภาษณ์ แบบประเมินค่า แบบทดสอบวดัความรู้ วดัความถนดัและวดัพฤติกรรม ดงันั้นในการวดั
ความพึงพอใจเราจึงสามารถสร้างแบบสอบถามความพึงพอใจของผูต้อบไดโ้ดยอาศยัแนวคิด ทฤษฎี
สนบัสนุน แบบวดัความพึงพอใจจึงจะมีคุณภาพ สามารถวดัไดต้รงกบัความตอ้งการของผูว้ิจยั การวดั
ความพึงพอใจสามารถท าไดห้ลายวธีิ 
 2.6.3.1 การใชแ้บบสอบถาม โดยผูส้อบถามจะออกแบบสอบถามเพื่อตอ้งการทราบ
ความคิดเห็น ซ่ึงสามารถท าได้ในลกัษณะท่ีก าหนดค าตอบให้เลือก หรือตอบค าถามอิสระ ค าถาม
ดงักล่าวอาจถามความพึงพอใจในดา้นต่าง ๆ เช่น การบริหาร การควบคุมเง่ือนไขต่าง ๆ เป็นตน้ 
 2.6.3.2 การสัมภาษณ์ เป็นวิธีวดัความพึงพอใจทางตรงทางหน่ึง ซ่ึงตอ้งอาศยัเทคนิค
และวธีิการท่ีดีจึงจะท าใหไ้ดข้อ้มูลท่ีเป็นจริงได ้
 2.6.3.3 การสังเกต เป็นวธีิวดัความพึงพอใจโดยสังเกตพฤติกรรมของบุคคลเป้าหมาย
ไม่ว่าจะแสดงออกทางการพูด กิริยาท่าทาง วิธีน้ีจะตอ้งอาศยัการกระท าอย่างจริงจงั และการสังเกต
อยา่งมีระเบียบแบบแผน 
 

2.7  กลุ่มสาระการเรียนรู้การงานอาชีพและคอมพวิเตอร์ตามหลกัสูตรแกนกลางการศึกษา 
ขั้นพืน้ฐานปี พ.ศ. 2551 
 2.7.1  หลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน  พ.ศ.2551 

 2.7.1.1  หลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน  มีหลกัการท่ีส าคญัดงัน้ี 
 1) เป็นหลักสูตรการศึกษาเพื่อความเป็นเอกภาพของชาติมีจุดมุ่งหมาย
และมาตรฐานการเรียนรู้เป็นเป้าหมายส าหรับพฒันาเด็กและเยาวชนให้มีความรู้ ทกัษะ เจตคติ และ
คุณธรรม บนพื้นฐานของความเป็นไทยควบคู่กบัความเป็นสากล 
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 2) เป็นหลกัสูตรการศึกษาเพื่อปวงชนที่ประชาชนทุกคนมีโอกาสไดร้ับ
การศึกษาอยา่งเสมอภาคและมีคุณภาพ 
 3)  เป็นหลกัสูตรการศึกษาท่ีสนองการกระจายอ านาจให้สังคมมีส่วนร่วมใน
การจดัการศึกษาใหส้อดคลอ้งกบัสภาพแลความตอ้งการของทอ้งถ่ิน 
 4)  เป็นหลกัสูตรการศึกษาที่มีโครงสร้างยืดหยุ่นทั้งดา้นสาระการเรียนรู้ 
เวลาและการจดัการเรียนรู้ 
 5)  เป็นหลกัสูตรการศึกษาท่ีเนน้ผูเ้รียนเป็นส าคญั 
 6)  เป็นหลกัสูตรการศึกษาส าหรับการศึกษาในระบบ นอกระบบ และ
ตามอธัยาศยัครอบคลุมทุกกลุ่มเป้าหมาย สามารถเทียบโอนผลการเรียนรู้ และประสบการณ์ 
  2.7.1.2  หลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน  มุ่งพฒันาผูเ้รียนให้เป็นคนดี          
มีปัญญา  มีความสุขมีศกัยภาพในการศึกษาต่อ  และประกอบอาชีพ   จึงก าหนดเป็นจุดหมาย  เพื่อให้
เกิดกบัผูเ้รียนเม่ือจบการศึกษาขั้นพื้นฐาน  ดงัน้ี 
 1)  มีคุณธรรม จริยธรรม และค่านิยมท่ีพึงประสงค์ เห็นคุณค่าของตนเอง 
มีวินัยและปฏิบติัตนตามหลกัธรรมของพระพุทธศาสนา หรือศาสนาท่ีตนนบัถือ ยึดหลกัปรัชญาของ
เศรษฐกิจพอเพียง 
 2)  มีความรู้อนัเป็นสากลและมีความสามารถในการส่ือสาร การคิด การ
แกปั้ญหาการใชเ้ทคโนโลยแีละมีทกัษะชีวติ 
 3)  มีสุขภาพกายและสุขภาพจิตท่ีดี มีสุขนิสัย และรักการออกก าลงักาย 
 4)  มีความรักชาติ มีจิตส านึกในความเป็นพลเมืองไทยและพลโลก ยึด
มัน่ในวิถีชีวิต และการปกครองตามระบอบประชาธิปไตยอนัมีพระมหากษตัริยท์รงเป็นประมุข 
 5)  มีจิตส านึกในการอนุรักษว์ฒันธรรมและภูมิปัญญาไทย การอนุรักษแ์ละ
พฒันาส่ิงแวดลอ้ม มีจิตสาธารณะท่ีมุ่งท าประโยชน์และสร้างส่ิงท่ีดีงามในสังคม และอยู่ร่วมกนัใน
สังคมอยา่งมีความสุข 
 2.7.2   หลกัสูตรกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี

   สาระและมาตรฐานการเรียนรู้ 
   สาระและมาตรฐานการเรียนรู้ของกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี
ในหลกัสูตรแกนกลางการศึกษาขั้นพื้นฐานพุทธศกัราช 2551 ท่ีเป็นองคค์วามรู้ของกลุ่มการงานอาชีพ
และเทคโนโลยี ประกอบดว้ย 4 สาระคือสาระท่ี 1: การด ารงชีวิตและครอบครัวสาระท่ี 2: การ
ออกแบบและเทคโนโลยี สาระท่ี 3: เทคโนโลยีสารสนเทศและการส่ือสาร สาระท่ี 4: อาชีพในการ
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ศึกษาวจิยัคร้ังน้ีจะขอกล่าวถึงเฉพาะสาระและมาตรฐานการเรียนรู้ในระดบัช่วงชั้นท่ีเก่ียวขอ้งกบัการ
วจิยัเท่านั้นมีรายละเอียดดงัต่อไปน้ี

    สาระท่ี 3 เทคโนโลยสีารสนเทศและการส่ือสาร 
   เทคโนโลยีสารสนเทศและการส่ือสารเป็นสาระเก่ียวกบักระบวนการเทคโนโลยี
สารสนเทศการติดต่อส่ือสารการคน้หาขอ้มูลการใชข้อ้มูลและสารสนเทศการแกปั้ญหาหรือการสร้าง
งานคุณค่าและผลกระทบของเทคโนโลยสีารสนเทศและการส่ือสาร 

  มาตรฐาน  ง3.1 เขา้ใจเห็นคุณค่าและใช้กระบวนการเทคโนโลยีสารสนเทศใน
การสืบค้นขอ้มูลการเรียนรู้ การส่ือสาร การแก้ปัญหา การท างาน และอาชีพอย่างมีประสิทธิภาพ 
ประสิทธิผล และมีคุณธรรม 

  ตวัช้ีวดัท่ี 1 อธิบายหลกัการเบ้ืองตน้ของการส่ือสารขอ้มูลและเครือข่ายคอมพิวเตอร์ 

  ตวัช้ีวดัท่ี 2 อธิบายหลกัการและวธีิการแกปั้ญหาดว้ยกระบวนการเทคโนโลย ี  
สารสนเทศ 

   ตวัช้ีวดัท่ี 3 คน้หาขอ้มูล และติดต่อส่ือสารผา่นเครือข่ายคอมพิวเตอร์อยา่งมีคุณธรรม
และจริยธรรม 

  ตวัช้ีวดัท่ี 4 ใชซ้อฟตแ์วร์ในการท างาน 

  กล่าวโดยสรุป  กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี   เป็นสาระท่ีเน้น
พฒันาผูเ้รียนแบบองค์รวม เพื่อให้มีความรู้ความสามารถมีทกัษะในการท างานเห็นแนวทางในการ
ประกอบอาชีพและการศึกษาต่อไดอ้ย่างมีประสิทธิภาพมีเป้าหมายเพื่อให้ผูเ้รียนพฒันาให้ผูเ้รียนมี
ความรู้ความเขา้ใจมีทกัษะพื้นฐานท่ีจ าเป็นต่อการด ารงชีวิตและรู้เท่าทนัการเปล่ียนแปลงสามารถน า
ความรู้เก่ียวกบัการด ารงชีวิตการอาชีพและเทคโนโลยีมาประยุกต์ใช้ในการท างานอย่างมีความคิด
สร้างสรรคแ์ละแข่งขนัในสังคมไทยและสากลเห็นแนวทางในการประกอบอาชีพรักการท างานและมี
เจตคติท่ีดีต่อการท างานสามารถด ารงชีวติอยูใ่นสังคมไดอ้ยา่งพอเพียงและมีความสุข 
  ผูว้ิจยัไดย้ึดหลกัสูตรกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยีโดยเฉพาะ
สาระการเรียนรู้ท่ี 3 เทคโนโลยีสารสนเทศและการส่ือสารมาตรฐาน ง 3.1 เขา้ใจเห็นคุณค่าและใช้
กระบวนการเทคโนโลยสีารสนเทศในการสืบคน้ขอ้มูลการเรียนรู้การส่ือสารการแกปั้ญหาการท างาน
และอาชีพอยา่งมีประสิทธิภาพประสิทธิผลและมีคุณธรรมตวัช้ีวดัท่ี1 อธิบายหลกัการเบ้ืองตน้ของการ
ส่ือสารขอ้มูลและเครือข่ายคอมพิวเตอร์ตวัช้ีวดัท่ี 2 อธิบายหลกัการและวิธีการแก้ปัญหาด้วย
กระบวนการเทคโนโลยีสารสนเทศตวัช้ีวดัท่ี 3 ค้นหาข้อมูลและติดต่อส่ือสารผ่านเครือข่าย
คอมพิวเตอร์อยา่งมีคุณธรรมและจริยธรรม    
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2.8 งานวจิัยทีเ่กีย่วข้อง 
 รวิวรรณ กาละดี (2553) ได้ท าการวิจยัเร่ือง การพฒันาบทเรียนคอมพิวเตอร์การสอน 
วิชาการสร้างเวบ็ไซตด์ว้ยโปรแกรม Dreamweaver หรับนกัเรียนชั้นมธัยมศึกษาปีท่ี 3 พบวา่คะแนน
การทดสอบก่อนเรียนและการทดสอบหลงัเรียน เม่ือน ามาวิเคราะห์หาประสิทธิผลการเรียนรู้โดยการ
ทดสอบค่า Epost - Epreพบวา่มีผลต่างกนัเท่ากบั 60 ผลการวิเคราะห์ความพึงพอใจของผูเ้รียนพบว่า 
ผูเ้รียนมีความพึงพอใจอยูใ่นระดบัดี ค่าเฉล่ียเท่ากบั 3.96 ดงันั้นบทเรียนคอมพิวเตอร์การสอนท่ีสร้าง
ข้ึนสามารถน าไปใชใ้นการเรียนการสอนวชิาการสร้างเวบ็ไซตด์ว้ยโปรแกรม Dreamweaver ได ้
 สุปรียา ศิริพฒันกุลขจร (2548) ได้ท าการวิจยัเร่ือง การพฒันารูปแบบห้องเรียนเสมือน
แบบจ าลองสถานการณ์ร่วมกับการฝึกปฏิบัติเร่ืองการผลิตรายการโทรทัศน์ ผลการวิจัยพบว่า            
(1) รูปแบบห้องเรียนเสมือนแบบจ าลองสถานการณ์ร่วมกับการฝึกปฏิบติัวิชาการผลิตรายการ
โทรทศัน์ประกอบดว้ยบริบท 6 ประการปัจจยัน าเขา้ 5 ปัจจยักระบวนการด าเนินงาน 6 ระบบยอ่ย
ผลิตผล 1 ประเภทและขอ้มูลยอ้นกลบั 1 ระบบย่อย(2) ชุดบทเรียนรูปแบบห้องเรียนเสมือน
แบบจ าลองสถานการณ์ร่วมกบัการฝึกปฏิบติัเร่ืองการผลิตรายโทรทศัน์ท่ีสร้างข้ึนมีประสิทธิภาพ 
92.18/91.38 (3) ชุดบทเรียนท่ีสร้างข้ึนมีผลสัมฤทธ์ิทางการเรียนสูงข้ึนอยา่งมีนยัส าคญัท่ี .05 จากการ
เปรียบเทียบผลสัมฤทธ์ิทางการเรียนของกลุ่มท่ีเรียนห้องเรียนเสมือนแบบจ าลองสถานการณ์ร่วมกบั
การฝึกปฏิบติักบัการเรียนแบบบรรยายประกอบการสาธิตร่วมกบัการฝึกปฏิบติัพบวา่แตกต่างกนัอยา่ง
มีนยัส าคญัท่ี .05 4) นกัศึกษามีเจตคติท่ีดีต่อการเรียนดว้ยชุดบทเรียนท่ีสร้างข้ึน 
 พิชยุชย ์ธีรปรีชาวิศว ์ (2553) ไดท้  าการวิจยัเร่ือง การพฒันาบทเรียนแสวงรู้บนเวบ็โดยใช้
กระบวนการเรียนแบบร่วมมือ เร่ือง ซากดึกด าบรรพ์ ส าหรับนักเรียนชั้นมธัยมศึกษาปีท่ี 4 พบว่า      
(1) บทเรียนแสวงรู้บนเว็บโดยใช้กระบวนการเรียนแบบร่วมมือ เร่ือง ซากดึกด าบรรพ์ ส าหรับ
นกัเรียนชั้นมธัยมศึกษาปีท่ี 4 มีค่าประสิทธิภาพ E1/E2เท่ากบั 81.96/82.78 เป็นไปตามเกณฑท่ี์ตั้งไว ้คือ 
80/80 (2) นกัเรียนชั้นมธัยมศึกษาปีท่ี 4 ท่ีเรียนดว้ยบทเรียนแสวงรู้บนเวบ็โดยใชก้ระบวนการเรียน
แบบร่วมมือ เร่ือง ซากดึกด าบรรพ์ มีผลสัมฤทธ์ิทางการเรียนหลังเรียนสูงกว่าก่อนเรียนอย่างมี
นยัส าคญัทางสถิติท่ีระดบั .01 (3) นกัเรียนชั้นมธัยมศึกษาปีท่ี 4 มีความพึงพอใจต่อการเรียนดว้ย
บทเรียนแสวงรู้บนเว็บโดยใช้กระบวนการเรียนแบบร่วมมือ เร่ือง ซากดึกด าบรรพ์ โดยรวมอยู่ใน
ระดบัมาก 
 

 



 
 

บทที ่ 3 
วธีิด าเนินการวจิยั 

 
การวิจยัคร้ังน้ีเป็นการวิจยั เร่ือง การพฒันาห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วย

โปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  โดยขั้นตอนในการวิจยัประกอบ
ไปดว้ย 

3.1 แบบแผนการวจิยั 
3.2 ประชากรและกลุ่มตวัอยา่ง 
3.3  เคร่ืองมือท่ีใชใ้นการวจิยั 
3.4  การเก็บรวบรวมขอ้มูล 
3.5 วธีิการวเิคราะห์ขอ้มูล 
3.6 สถิติท่ีใชใ้นการวจิยั 

 

3.1  แบบแผนการวจิัย 
แบบแผนการทดลอง ผูว้จิยัไดด้ าเนินการทดลองตามรูปแบบ One - Group Pretest -  

Posttest Design 
 

ตารางที ่3.1  แบบแผนการวิจยัแบบ One - Group Pretest – Posttest Design     
 

กลุ่มตวัอยา่ง ก่อนเรียน ทดลอง หลงัเรียน 
                E O1 X O2 
                          

สัญลกัษณ์ท่ีใชใ้นแบบแผนการทดลอง  
E แทน  กลุ่มตวัอยา่ง 
O1 แทน  การทดสอบก่อนเรียน 
X          แทน  หอ้งเรียนเสมือน 
O2 แทน  การทดสอบหลงัเรียน 
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3.2  ประชากรและกลุ่มตัวอย่าง 
3.2.1 ประชากรท่ีใชใ้นการวิจยัคร้ังน้ี ไดแ้ก่ นกัเรียนชั้นประถมศึกษาปีท่ี 6 ภาคเรียนท่ี 2     

ปีการศึกษา 2558 โรงเรียนมีนประสาทวิทยา ส านกังานคณะกรรมการส่งเสริมการศึกษาเอกชน  
จ านวน 2 หอ้งเรียน เป็นนกัเรียนชั้นประถมศึกษาปีท่ี 6/1 จ านวน 30 คน และชั้นประถมศึกษาปีท่ี 6/2  
จ านวน 30 คน รวมประชากรทั้งหมด 60 คน   

3.2.2  กลุ่มตวัอยา่งท่ีใชใ้นการวิจยัคร้ังน้ี ไดแ้ก่ นกัเรียนชั้นประถมศึกษาปีท่ี 6/1 โรงเรียน
มีนประสาทวิทยา จงัหวดักรุงเทพมหานคร จ านวน 30 คน ซ่ึงไดม้าโดยใชว้ิธีการเลือกตวัอยา่งแบบ
เจาะจง (Purposive Sampling) เน่ืองจากกลุ่มตวัอยา่งดงักล่าวเป็นกลุ่มตวัอยา่งท่ีผูว้ิจยัท าการควบคุม
ชั้นเรียนอยูจึ่งเลือกกลุ่มตวัอยา่งกลุ่มน้ีมาเพื่อท าการวจิยัในคร้ังน้ี 

 

3.3  เคร่ืองมอืทีใ่ช้ในการวิจัย 
การวจิยัเร่ืองน้ีผูว้จิยัไดก้  าหนดเคร่ืองมือท่ีใชใ้นการวจิยัไวด้งัน้ี 
3.3.1 แบบสอบถามความคิดเห็นส าหรับผูเ้ช่ียวชาญ เก่ียวกบัการพฒันาห้องเรียนเสมือน

เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้นประถมศึกษาปีท่ี 6             
มีขั้นตอนการสร้างแบบสอบถาม ดงัต่อไปน้ี 

3.3.1.1 ศึกษาคน้ควา้และรวบรวมขอ้มูลจากเอกสารงานวิจยัท่ีเก่ียวขอ้งกบัทฤษฎี 
แนวคิด และหลกัการของหอ้งเรียนเสมือน 

3.3.1.2 วิเคราะห์องค์ประกอบและขั้นตอนของห้องเรียนเสมือนและสร้างข้อ
ค าถามเพื่อใช้สร้างแบบสอบถามปลายเปิดเพื่อให้ผูเ้ช่ียวชาญแสดงความคิดเห็นแลว้น าผลของความ
คิดเห็นไปหาค่า (IOC: Index of Item Objective Congruence) น าขอ้ค าถามท่ีผูเ้ช่ียวชาญท่ีมี
ประสบการณ์ดา้นเทคโนโลยีการศึกษาหรือ เทคโนโลยีสารสนเทศ จ านวน 3 ท่าน เลือกและ
เสนอแนะใหป้รับปรุงแกไ้ข เพื่อน าไปสร้างแบบสอบถามมาตราส่วนประเมินค่า 5 ระดบั  

คะแนน +1  คือ  แน่ใจวา่ขอ้ค าถามน้ีมีความสอดคลอ้ง 
                               กบัการการประเมินการออกแบบส่ือใหเ้ป็นไปตาม 
                                   กระบวนการห้องเรียนเสมือน 

คะแนน  0    คือ  ไม่แน่ใจวา่ขอ้ค าถามน้ีสอดคลอ้งตรง 
                                กบัการการประเมินการออกแบบส่ือใหเ้ป็นไปตาม 
                                    กระบวนการห้องเรียนเสมือน 
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คะแนน  -1   คือ   แน่ใจวา่ขอ้สอบน้ีไม่สอดคลอ้งตรง 
                                กบัการการประเมินการออกแบบส่ือใหเ้ป็นไปตาม 

 กระบวนการห้องเรียนเสมือน 
หมายเหตุ ค่าดชันีความสอดคลอ้งท่ียอมรับไดต้อ้งมีค่าตั้งแต่ 0.50 ข้ึนไปในการวิจยั

คร้ังน้ีแบบสอบถามท่ีใชมี้ค่าดชันีความสอดคลอ้งอยูร่ะหวา่ง 0.80 – 0.93 (ดงัแสดงในภาคผนวก ช ) 
3.3.1.3 สร้างแบบสอบถามท่ีเป็นมาตราส่วนประเมินค่า (Rating Scale) มี 5 ระดบั 

ตามเกณฑ์ของลิเคิร์ท (Likert Scale) เพื่อให้ผูเ้ช่ียวชาญพิจารณาให้น ้ าหนกัท่ีตรงกบัความคิดเห็นของ
ผูเ้ช่ียวชาญมากท่ีสุด ซ่ึงแต่ละระดบัมีความหมายดงัน้ี (ลว้น สายยศ และองัคณา สายยศ, 2536, น. 157)   
   5 หมายถึง    มีความคิดเห็นอยูใ่นระดบัมากท่ีสุด 
   4 หมายถึง    มีความคิดเห็นอยูใ่นระดบัมาก 
   3 หมายถึง    มีความคิดเห็นอยูใ่นระดบัปานกลาง 
   2 หมายถึง    มีความคิดเห็นอยูใ่นระดบันอ้ย 

1       หมายถึง    มีความคิดเห็นอยูใ่นระดบันอ้ยท่ีสุด 
โดยใชเ้กณฑใ์นการแปลค่าดงัน้ี 

              ค่าเฉล่ีย              ระดบัความคิดเห็น 
4.51 - 5.00           เหมาะสมมากท่ีสุด 
3.51 - 4.50           เหมาะสมมาก 
2.51 - 3.50           เหมาะสมปานกลาง 
1.51 - 2.50           เหมาะสมนอ้ย 
1.00 - 1.50           เหมาะสมนอ้ยท่ีสุด 

  3.3.1.4 ส่งแบบสอบถามท่ีสร้างข้ึนให้ผูเ้ช่ียวชาญท่ีมีประสบการณ์ดา้นเน้ือหาดา้น
เทคโนโลยีการศึกษา และดา้นวดัและประเมินผล ดา้นละ 3 คน พิจารณา เพื่อปรับแกไ้ขให้ตรงกบั
เร่ืองท่ีจะศึกษา   

3.3.1.5 วเิคราะห์ระดบัความคิดเห็นของผูเ้ช่ียวชาญท่ีมีต่อห้องเรียนเสมือน เร่ือง การ
สร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยวิเคราะห์
ดว้ยสถิติ ค่าเฉล่ีย (X) และส่วนเบ่ียงเบนมาตรฐาน  (S.D.) 

3.3.2 ห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับ
นกัเรียนชั้นประถมศึกษาปีท่ี 6 มีขั้นตอนการสร้างเคร่ืองมือดงัน้ี 
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  3.3.2.1 ศึกษาคน้ควา้และรวบรวมขอ้มูลจากเอกสารงานวิจยัท่ีเก่ียวขอ้งกบัทฤษฎี 
แนวคิด และหลกัการของหอ้งเรียนเสมือน 
  3.3.2.2 วิเคราะห์องค์ประกอบ หลกัการและคุณลกัษณะของห้องเรียนเสมือนเพื่อ
น าไปสร้างห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียน
ชั้นประถมศึกษาปีท่ี 6 
  3.3.2.3 ออกแบบห้องเรียนเสมือนโดยผูว้ิจยัได้ท าการสร้างห้องเรียนในเว็บไซต์ 
www.wikispaces.com โดยมีขั้นตอนการออกแบบและท าการสร้างดงัน้ี 
   1) จดัเตรียมแผนการสอน เน้ือหา ภาพประกอบ ใบงานและกิจกรรมใน
รายวชิาคอมพิวเตอร์ เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม ดรีมวีฟเวอร์ CS6 อดัวิดีโอการสอนในแต่
ละหน่วยการเรียนรู้ รวมถึงออกแบบแบนเนอร์ต่างๆ 
   2) ท าการสมคัรสมาชิกเวบ็ไซต ์www.wikispaces.com  
   3) น าเน้ือหา ภาพประกอบ ใบงาน และวิดีโอส่ือการสอน อพัโหลดเขา้
ห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้น
ประถมศึกษาปีท่ี 6 
   4) ก าหนดปฏิทินกิจกรรมในห้องเรียนเสมือน เร่ืองการสร้างเวบ็ไซต์ดว้ย
โปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้นประถมศึกษาปีท่ี 6 เพื่อให้นกัเรียนสามารถรู้ถึง
กิจกรรมท่ีจะมีข้ึนในภาคการศึกษา 2/2558 
   5) ก าหนดรายละเอียดคู่มือการใชง้านห้องเรียนเสมือนเพื่อให้นกัเรียนท่ีเขา้
มาเรียนในคร้ังแรกทราบถึงวิธีการใชง้านห้องเรียนเสมือนเร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีม
วฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
    6) สร้างเว็บเพจหน้า “ติดต่อครูประจ าวิชา” โดยมีช่องทางการติดต่อ        
ได้หลายช่องทางด้วยกัน ได้แก่ ติดต่อผ่านทางกล่องโตต้อบของห้องเรียนเสมือน ติดต่อผ่านทาง
จดหมายอิเล็กทรอนิกส์ (E-mail) ติดต่อผา่นทางเฟสบุค (Facebook) หรือสามารถติดต่อครูประจ าชั้น
แบบ Face-to-Face โดยผา่นทางแอพพลิเคชัน่ไลน์ (Line) 
  3.3.2.4 ท าการ invite เพื่อเชิญให้นักเรียนชั้นประถมศึกษาปีท่ี 6/1 โรงเรียน             
มีนประสาทวิทยา ปีการศึกษา 2558 เขา้ร่วมเรียนในห้องเรียนเสมือนเร่ือง การสร้างเว็บไซต์ด้วย
โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 

http://www.wikispaces.com/
http://www.wikispaces.com/
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3.3.3 แบบทดสอบก่อนเรียนและหลงัเรียน ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีเรียน
จากห้องเรียนเสมือน  เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6  ในการวิจยัคร้ังน้ีผูว้ิจยั
ไดก้  าหนดขั้นตอนการสร้างแบบทดสอบไว ้ดงัน้ี 
     3.3.3.1 ศึกษาจุดมุ่งหมายของหลกัสูตร หลกัสูตรท่ีน ามาใชใ้นการจดัการเรียนรู้คร้ัง
น้ี ได้แก่ หลกัสูตรกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี ตามหลักสูตรแกนกลาง
การศึกษาขั้นพื้นฐาน พุทธศกัราช 2551 ท่ีก าหนดจุดมุ่งหมายไวว้่า เพื่อให้นักเรียนมีความรู้
ความสามารถ มีทกัษะในการท างาน เห็นแนวทางในการประกอบอาชีพและการศึกษาต่อไดอ้ย่างมี
ประสิทธิภาพ มีเป้าหมายเพื่อให้ผูเ้รียนพฒันาให้ผูเ้รียนมีความรู้ความเขา้ใจ มีทกัษะพื้นฐานท่ีจ าเป็น
ต่อการด ารงชีวิต และรู้เท่าทนัการเปล่ียนแปลง สามารถน าความรู้เก่ียวกบัการด ารงชีวิต การอาชีพ 
และเทคโนโลย ีมาประยกุตใ์ชใ้นการท างานอยา่งมีความคิดสร้างสรรค ์และแข่งขนัในสังคมไทยและ
สากล เห็นแนวทางในการประกอบอาชีพ รักการท างาน และมีเจตคติท่ีดีต่อการท างาน สามารถ
ด ารงชีวติอยูใ่นสังคมไดอ้ยา่งพอเพียงและมีความสุข 

3.3.3.2 ศึกษาเอกสารท่ีเก่ียวขอ้งกบัการสร้างแบบทดสอบ โดยให้สอดคลอ้งกบั
เน้ือหาท่ีก าหนดไว ้ 
      3.3.3.3 การก าหนดจุดประสงค์เชิงพฤติกรรม ผูว้ิจยัได้น าจุดมุ่งหมายรายวิชา
คอมพิวเตอร์ มาก าหนดเป็นวตัถุประสงคเ์ชิงพฤติกรรม เพื่อก าหนดทิศทางในการพฒันานกัเรียนใน
แต่ละดา้น ไดแ้ก่ ความรู้ความจ า ความเขา้ใจ การน าไปใช้ในการวิเคราะห์ เพื่อน ามาใชใ้นการ
ประเมินผลผูเ้รียน 
 3.3.3.4 การวิเคราะห์ผูเ้รียน เป็นขั้นวิเคราะห์ความตอ้งการ วตัถุประสงค์ ความรู้
พื้นฐานของนกัเรียนท่ีตอ้งการจะเรียนรู้ เพื่อแน่ใจว่าส่ิงท่ีนกัเรียนตอ้งการเรียนรู้นั้น ตรงตามความ
ตอ้งการของตนเองหรือไม่ มากนอ้ยเพียงใด เพื่อผูว้ิจยัไดมี้โอกาสเตรียมความพร้อมให้กบันกัเรียน 
ก่อนท่ีจะเขา้ร่วมกิจกรรมการเรียนรู้ต่อไป โดยการเรียนการสอนจากห้องเรียนเสมือนในคร้ังน้ี มี
ลกัษณะพิเศษท่ีแตกต่างจากการจดักิจกรรมการเรียนรู้ตามปกติ กล่าวคือ นกัเรียนควรจะตอ้งมีความรู้
เก่ียวกบัพื้นฐานการใชง้านระบบเครือข่ายอินเทอร์เน็ตมาก่อนแลว้บา้ง รวมทั้งมีความสามารถในการ
ใชเ้คร่ืองคอมพิวเตอร์ และอุปกรณ์เสริมต่างๆ ไดบ้า้ง เช่น การเปิด ปิดเคร่ืองคอมพิวเตอร์ การเขา้ออก
โปรแกรม การใชแ้ป้นพิมพ ์การใชเ้มาส์ เป็นตน้ 

3.3.3.5 การออกแบบเน้ือหาบทเรียนและสร้างบทเรียน เน้ือหารายวิชาคอมพิวเตอร์ ท่ี
ได้พฒันาเพื่อการวิจยัคร้ังน้ี ผูว้ิจยัจดัท าในรูปแบบวีดีทศัน์ เพื่อน าเสนอเน้ือหาสาระรายวิชา             
บนเวบ็ไซต ์ น ามาใชเ้ป็นเคร่ืองมือห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ยโปรแกรม         ดรีม
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วีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  โดยห้องเรียนเสมือน ผูว้ิจยัไดน้ าโปรแกรมดรีม
วีฟเวอร์ (DreamWeaver) มาใชใ้นการบริหารจดัการเรียนการสอนบนเครือข่ายอินเทอร์เน็ตในคร้ังน้ี 
ผูว้ิจยัได้สมคัรเป็นสมาชิกของเว็บไซต์ Wikispaces.com ส าหรับสร้างห้องเรียนเสมือน เพื่อให้
นกัเรียนไดเ้ขา้ร่วมกิจกรรมการจดัการเรียนรู้บนเวบ็ไซต์น้ีให้มีลกัษณะท่ีเป็นห้องเรียนเสมือน ซ่ึง
นกัเรียนสามารถร่วมกิจกรรมการเรียนรู้ และติดต่อกบัผูส้อนไดโ้ดยใชช่้องทางท่ีผูว้ิจยัไดอ้อกแบบไว ้
ซ่ึงนกัเรียนสามารถเรียนรู้เน้ือหาสาระรายวชิาไดอ้ยา่งไม่มีขอ้จ ากดั ทั้งเร่ืองของระยะเวลาและสถานท่ี 

3.3.3.6 ด าเนินการสร้างแบบทดสอบก่อนเรียน และแบบทดสอบหลังเรียน โดย
วิเคราะห์จากเน้ือหาและวตัถุประสงค์เชิงพฤติกรรม จากนั้นสร้างแบบทดสอบแบบเลือกตอบ             
4  ตวัเลือก จ านวน 90 ขอ้ ท่ีประเมินผลตามวตัถุประสงคเ์ชิงพฤติกรรม ขอ้สอบท่ีไดจ้ะน ามาจ าแนก
เป็นแบบทดสอบก่อนเรียน และแบบทดสอบหลงัเรียนจ านวน 30 ขอ้  

3.3.3.7 น าขอ้สอบท่ีจะสร้างแบบทดสอบก่อนเรียน และแบบทดสอบหลังเรียน     
ไปให้ผูเ้ช่ียวชาญตรวจสอบความตรงของเน้ือหา  เหมาะสมกบักระบวนการเรียนรู้ด้วยเทคโนโลยี
เสมือนจริง โดยใช้ค่าดชันีความสอดคลอ้งสัมประสิทธ์ระหว่างขอ้ค าถามกบัวตัถุประสงค์ (IOC : 
Index of Item Objective Congruence) มีเกณฑก์ารใหค้ะแนนตามเกณฑ์ ดงัน้ี 

คะแนน +1  คือ  แน่ใจวา่แบบทดสอบน้ีสอดคลอ้งตรงกบั 
เน้ือหาตามวตัถุประสงค ์

คะแนน   0   คือ ไม่แน่ใจวา่แบบทดสอบน้ีสอดคลอ้งตรงกบั 
เน้ือหาตามวตัถุประสงค ์

คะแนน  -1   คือ  แน่ใจวา่ขอ้สอบน้ีไม่สอดคลอ้งตรงกบัเน้ือหา 
ตามวตัถุประสงค ์

                                  หมายเหตุ ค่าดชันีความสอดคลอ้งท่ียอมรับไดต้อ้งมีค่าตั้งแต่ 0.50 ข้ึนไป    
ในการวิจยัคร้ังน้ีแบบสอบถามท่ีใช้มีค่าดชันีความสอดคลอ้งอยู่ระหว่าง 0.70 – 1.00  (ดงัแสดงใน
ภาคผนวก ช) 

3.3.3.8 น าข้อสอบท่ีผู ้เ ชี่ ย วช าญตรวจสอบความตรงของเน้ือหาเหมาะสมกับ     
การเรียนรู้ด้วยห้องเรียนเสมือนมาเพื่อหาระดับความยากง่าย (p) และอ านาจจ าแนก (r) โดยน า
แบบทดสอบท่ีได้ผ่านการตรวจสอบคุณภาพเป็นรายขอ้จากผูเ้ช่ียวชาญเรียบร้อยแล้ว ไปทดลองกับ
นกัเรียนท่ีเคยเรียนมาแลว้โดยมีหลกัเกณฑ์การพิจารณา ดงัน้ี (บุญธรรม กิจปรีดาบริสุทธ์ิ, 2549, น. 
268) 
                0.81 – 1.00 หมายถึง  ขอ้สอบท่ีง่ายมากไม่ควรใชห้รือปรับปรุง 
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0.61 – 0.80  หมายถึง  ขอ้สอบท่ีค่อนขา้งง่ายแต่ใชไ้ด ้
0.41 – 0.60  หมายถึง  ขอ้สอบความยากปานกลางเป็นขอ้สอบท่ีดีมาก 
 
0.20 – 0.40  หมายถึง  ขอ้สอบท่ีค่อนขา้งยากแต่ใชไ้ด ้
0.00 – 0.19  หมายถึง  ขอ้สอบท่ียากมากไม่ควรใช ้หรือปรับปรุง 
ดงันั้น ขอบเขตของค่าความยากง่ายของแบบทดสอบท่ียอมรับ คือ ระหวา่ง  

0.20 – 0.80 ในการวิจยัคร้ังน้ีแบบทดสอบท่ีใชมี้ค่าความยากง่ายอยูร่ะหวา่ง 0.20 – 0.77 (ดงัแสดงใน
ภาคผนวก ช) 

3.3.3.9 คดัเลือกขอ้สอบท่ีมีค่าความยากง่าย ระหว่าง 0.20 – 0.80 จ านวน 30 ขอ้ 
น ามาใชเ้ป็นขอ้สอบฉบบัเดียวกนัท่ีมีการประเมินผลตามวตัถุประสงค์เชิงพฤติกรรมโดยมีหลกัเกณฑ์
การพิจารณาคะแนนท่ีได้มาจากการวิเคราะห์หาค่าความยากง่าย (p) และค่าอ านาจจ าแนก (r)               
มีความหมาย ดงัน้ี (ลว้น สายยศ และองัคณา สายยศ, 2538, น. 210) 

0.40 ข้ึนไป อ านาจจ าแนกสูง  คุณภาพของขอ้สอบดีมาก 
0.30 – 0.39  อ านาจจ าแนกปานกลาง คุณภาพของขอ้สอบดีพอสมควร 
0.20 – 0.29  อ านาจจ าแนกค่อนขา้งต ่า คุณภาพของขอ้สอบพอใช ้
0.00 – 0.19  อ านาจจ าแนกต ่า       คุณภาพของขอ้สอบใชไ้ม่ได ้
ดงันั้น ขอบเขตของค่าอ านาจจ าแนกของแบบทดสอบท่ียอมรับ คือ 0.20    

ข้ึนไป ในการวจิยัคร้ังน้ีแบบทดสอบท่ีใชมี้ค่าอ านาจจ าแนก ระหวา่ง 0.26 – 0.60 (ดงัแสดงในภาคผนวก 
ช) 

3.3.3.10 วิเคราะห์ค่าความเช่ือมัน่ของแบบทดสอบวดัผลการเรียนรู้ทั้งหมด
โดยใช้สูตร KR-20 ของKuder Richardson ก าหนดให้ขอบเขตของค่าความเช่ือมัน่แบบทดสอบ               
มีความหมาย ดงัน้ี ค่าความเช่ือมัน่ของแบบทดสอบมีค่าตั้งแต่ –1.00 ถึง +1.00  

+1.00   หรือเขา้ใกล ้ +1.00   แสดงวา่ แบบทดสอบมีความเช่ือมัน่สูงสุด 
  0.00   หรือใกลเ้คียงกบั  0.00  แสดงวา่ แบบทดสอบไม่มีความเช่ือมัน่ 
–1.00   แสดงว่า แบบทดสอบมีความเช่ือมัน่ต ่าดงันั้น ขอบเขตค่าความ

เช่ือมัน่ท่ียอมรับ เท่ากบั 0.80 ข้ึนไปค่าความเชื่อมั่นของแบบทดสอบก่อนและหลังเ รียนของ   
ห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้น
ประถมศึกษาปีท่ี 6 จ านวน 30 ขอ้ มีความเช่ือมัน่เท่ากบั 0.82  (แสดงในภาคผนวกท่ี ช ) 
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3.3.3.11 จดัเตรียมแบบทดสอบก่อนเรียนและแบบทดสอบหลงัเรียนท่ีไดคุ้ณภาพไป
ใชใ้นคร้ังต่อไป 

3.3.4 แบบสอบถามความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีเรียนจากห้องเรียน
เสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 มีขั้นตอนการด าเนินการ ดงัต่อไปน้ี 

3.3.4.1 ศึกษาหลักการสร้างแบบสอบถามความพึงพอใจจากเอกสาร  งานวิจัย 
แนวคิดทฤษฎีท่ีเก่ียวขอ้งกบัแบบสอบถามความพึงพอใจ 
 3.3.4.2 น าแบบสอบความพึงพอใจไปให้ผูเ้ช่ียวชาญตรวจสอบความถูกต้องของ
ขอ้ถามท่ีเหมาะสมกบัการออกแบบห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม      ดรีม  
วฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ใหต้รงกบัขั้นตอนการเรียนรู้ โดยใชค้่าดชันีความ
สอดคลอ้งสัมประสิทธ์ระหว่างขอ้ค าถามกบัการออกแบบห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์
ดว้ยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  มีเกณฑก์ารใหค้ะแนน ดงัน้ี 

+1  หมายถึง แน่ใจวา่ขอ้ค าถามน้ีมีสอดคลอ้งตรงกบัการออกแบบ   
หอ้งเรียนเสมือน  

                                         0  หมายถึง    ไม่แน่ใจวา่ขอ้ค าถามน้ีมีสอดคลอ้งตรงกบัการออกแบบ 
                                                              หอ้งเรียนเสมือน 
    -1  หมายถึง      แน่ใจวา่ขอ้สอบน้ีไม่สอดคลอ้งกบัการออกแบบ 
                                                              หอ้งเรียนเสมือน 

หมายเหตุ ค่าดชันีความสอดคลอ้งท่ียอมรับไดต้อ้งมีค่าตั้งแต่ 0.50 ข้ึนไป   ในการวิจยัคร้ังน้ี
แบบสอบความพึงพอใจท่ีใชมี้ค่าดชันีความสอดคลอ้งอยูร่ะหวา่ง 0.73 – 0.94  (ดงัแสดงในภาคผนวก ฌ) 
  3.3.4.3 ด าเนินการสร้างแบบสอบถามความพึงพอใจ เป็นมาตราส่วนประมาณค่า
(Rating Scale)มี 5 ระดบั ตามเกณฑ์ของลิเคิร์ท (Likert Scale) ขอ้ค าถามจ านวน 30 ขอ้ โดยก าหนดค่า
ระดบัความพึงพอใจแต่ละช่วงคะแนน ดงัน้ี (ลว้น สายยศ และองัคณา สายยศ, 2536, น. 157)   
   5 หมายถึง    มีความคิดเห็นอยูใ่นระดบัมากท่ีสุด 
   4 หมายถึง    มีความคิดเห็นอยูใ่นระดบัมาก 
   3 หมายถึง    มีความคิดเห็นอยูใ่นระดบัปานกลาง 

2       หมายถึง    มีความคิดเห็นอยูใ่นระดบันอ้ย 
1           หมายถึง    มีความคิดเห็นอยูใ่นระดบันอ้ยท่ีสุด 

โดยใชเ้กณฑใ์นการแปลค่าดงัน้ี 
              ค่าเฉล่ีย                                 ระดบัความคิดเห็น 
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4.51 - 5.00                           เหมาะสมมากท่ีสุด 
3.51 - 4.50                           เหมาะสมมาก 
2.51 - 3.50                           เหมาะสมปานกลาง 
1.51 - 2.50                           เหมาะสมนอ้ย 
1.00 - 1.50                           เหมาะสมนอ้ยท่ีสุด 

  3.3.4.4 น าแบบสอบถามความพึงพอใจท่ีได้ไปให้ผูเ้ช่ียวชาญด้านเน้ือหาและส่ือ
พิจารณาและปรับปรุง จ านวน 3 ท่าน 
  3.3.4.5 น าแบบสอบถามความพึงพอใจไปทดลองใช้กบักลุ่มตวัอย่างจริง จ านวน     
30 คน 
 

3.4  การเกบ็รวบรวมข้อมูล 
3.4.1  การด าเนินการทดลอง 

ผูว้ิจยัไดด้ าเนินการทดลองตามรูปแบบ One - Group Pretest – Posttest Design    
โดยทดลองแบบกลุ่มเดียว(One Group Pretest-Posttest Design) เป็นการทดลองท่ีมีการวดัก่อน      
การทดลอง 1 คร้ัง หลงัการทดลอง 1 คร้ังท่ี O1 และO2 ใชเ้คร่ืองมือวดัดว้ยแบบทดสอบก่อนเรียน และ
หลงัเรียนฉบบัเดียวกนั 
                          ผูว้จิยัเลือกกลุ่มตวัอยา่งโดยวธีิการสุ่มกลุ่มตวัอยา่งแบบเฉพาะเจาะจง ท าการทดสอบ
ก่อนการทดลอง แลว้น าหอ้งเรียนเสมือนท่ีท าข้ึนไปใชท้ดลองกบันกัเรียนท่ีเรียน วิชาคอมพิวเตอร์ ชั้น
ประถมศึกษาปีท่ี 6 โรงเรียนมีนประสาทวิทยา  แขวง มีนบุรี เขต มีนบุรี  กรุงเทพมหานคร ส านกังาน
คณะกรรมการส่งเสริมการศึกษาเอกชน คละระดบัสติปัญญา เก่ง ปานกลาง อ่อนจ านวน 1 ห้อง 
จ านวน 30 คน และท าการทดสอบอีกคร้ังดว้ยเคร่ืองมือเก็บรวบรวมขอ้มูลชุดเดิม เพื่อดูผลหลงัการ
ทดลอง และน าผลการวดั O1 และ O2 มาค านวณหาค่าเฉล่ีย ( ̅) และน าเปรียบเทียบกนัโดยใชส้ถิติ t-
test แบบ (Dependent) ถา้ผลการวดัของ O2 สูงกว่า O1 แสดงว่าห้องเรียนเสมือน เร่ือง การสร้าง
เวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 ท่ีท าข้ึนนั้นใชไ้ดผ้ล หรือกล่าวไดว้า่สามารถน าไปใชส้อนได้
อยา่งมีประสิทธิภาพจริง  
 
 

3.4.2  การเก็บรวบรวมขอ้มูลด าเนินการดงัน้ี 
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3.4.2.1 ผูว้ิจยัด าเนินการติดต่อประสานงานท าหนงัสือขอความร่วมมือจากคณะ    
ครุศาสตร์อุตสาหกรรม มหาวทิยาลยัเทคโนโลยรีาชมงคลธญับุรี เพื่อขอทดลองในการท าวิจยัและใช้
สถานที่ ไปยงัผูอ้  านวยการโรงเรียนมีนประสาทวิทยา ส านักงานคณะกรรมการส่งเสริมการศึกษา
เอกชน 

3.4.2.2 เตรียมสถานท่ีและเคร่ืองมือ ซ่ึงสถานท่ีท่ีใช้ในการทดลองคร้ังน้ีคือ 
ห้องปฏิบติัการคอมพิวเตอร์ โรงเรียนมีนประสาทวิทยา โดยมีการจดัเตรียมเคร่ืองคอมพิวเตอร์ และ
ระบบเครือข่ายให้พร้อมต่อการทดลองกับกลุ่มตัวอย่าง คือ นักเรียนชั้นประถมศึกษาปีที่  6/1 
โรงเรียนมีนประสาทวิทยา จ านวน 30 คน   
  3.4.2.3 ออกแบบหอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม        ดรีมวีฟ
เวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ในเวบ็ไซต ์www.wikispaces.com  

3.4.2.4 วิเคราะห์ข้อค าถามเก่ียวกับห้องเรียนเสมือน น าแบบสอบถามไปให้
ผูเ้ช่ียวชาญลงความคิดเห็น และวิเคราะห์ระดบัความคิดเห็นของผูเ้ช่ียวชาญท่ีมีต่อห้องเรียนเสมือน 
เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดย
วเิคราะห์ดว้ยสถิติ ค่าเฉล่ีย (X) และส่วนเบ่ียงเบนมาตรฐาน  (S.D.) 

3.4.2.5 ด าเนินการสอน โดยใช้หอ้งเรียนเสมือน องคป์ระกอบ คือ   
1) Learning is Fun 
2) Multimedia 

   3) Asynchronous Learning 
   4) Electronic Library  
  3.4.2.6 เก ็บข ้อม ูลก ่อนท าการทดลองด ้วยแบบทดสอบก่อน เ รียนโดยให้
นักเรียนท าแบบทดสอบก่อนเรียน วิชา คอมพิวเตอร์ จ านวน 30 ข้อ 

3.4.2.7 ในระหว่างทดลองท าการเก็บคะแนนของผลระหว่างเรียนโดยให้นักเรียน
ท าใบงานหลังจากเรียนจบเน้ือหาในแต่ละเร่ือง โดยมีทั้งหมด 4 ใบงาน   

3.4.2.8 เก็บข้อมูลหลังท าการทดลองด้วยแบบทดสอบหลังเรียนโดยให้นักเรียน
ท าแบบทดสอบหลังเรียน วิชา คอมพิวเตอร์ จ านวน 30 ข้อ  

3.4.2.9 ให้นักเรียนตอบแบบสอบถามประเมินความพึงพอใจ หล ังจากเรียน
ด้วยห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียน
ชั้นประถมศึกษาปีท่ี 6  

http://www.wikispaces.com/
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  3.4.2.10 ผูว้ิจยัด าเนินการตรวจแบบทดสอบก่อนเรียน/หลงัเรียน จดัเก็บขอ้มูลเป็น
แบบการใช้คะแนน โดยให้ค  าตอบถูกเท่ากบั 1 และค าตอบท่ีผิดคือ 0 (Zero-One Method)  จากนั้น    
น าคะแนนท่ีไดม้าทดสอบดว้ยวธีิทางสถิติเพื่อทดสอบสมมติฐาน   

3.4.2.11 ด าเนินการบนัทึกขอ้มูลจากการตอบแบบสอบถามประเมินความพึงพอใจ
ของนกัเรียนชั้นประถมศึกษาปีท่ี 6 แลว้น าผลท่ีไดม้าวเิคราะห์ดว้ยวธีิทางสถิติต่อไป 
 

3.5  วธิกีารวเิคราะห์ข้อมูล 
ผู ้วิจ ัยใช้เคร่ืองมือในการวิจัย ได้แก่ ห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วย

โปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  แบบทดสอบก่อนและหลงัเรียน 
และแบบสอบถามความพึงพอใจ ของนกัเรียนชั้นประถมศึกษาปีท่ี 6 โรงเรียนมีนประสาทวิทยาท่ีมีต่อ
ห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้น
ประถมศึกษาปีท่ี 6  ผูว้จิยัไดว้เิคราะห์ขอ้มูลดงัขั้นตอนต่อไปน้ีต่อไปน้ี 

3.5.1  หาคุณภาพและการพัฒนาของห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วย
โปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยใช้ค่าเฉล่ีย (X) และส่วน
เบ่ียงเบนมาตรฐาน (S.D.) 

3.5.2  หาประสิทธิภาพของหอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม  ดรีมวีฟ
เวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  โดยใชสู้ตร E1 / E2 (ชยัยงค ์พรหมวงศ,์ 2548) 

3.5.3 หาผลสัมฤทธ์ิก่อนเรียนและหลงัเรียนของนกัเรียนท่ีเรียนจากห้องเรียนเสมือน เร่ือง 
การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้นประถมศึกษาปีท่ี 6 โดยใช้
แบบทดสอบก่อนเรียน และหลงัเรียนเป็นเคร่ืองมือวจิยั ซ่ึงเป็นแบบทดสอบชุดเดียวกนั ผูว้ิจยัไดส้ร้าง
เคร่ืองมือและวเิคราะห์ขอ้มูล โดยใชส้ถิติ ไดแ้ก่  

 1) หาค่าดชันีความสอดคลอ้งของขอ้ค าถาม แบบทดสอบก่อนเรียน และหลงัเรียน 
(Index of Item Objective Congruence: IOC) 

 2) หาค่าความยากง่าย (p) และอ านาจค่าจ าแนก (r) ของแบบทดสอบก่อนเรียน และ
หลงัเรียน 

 3) หาค่าความเช่ือมัน่ของแบบทดสอบก่อนเรียน และหลงัเรียน โดยค านวณจากสูตร 
KR-20 (KUDER Ricgardson 20) 

 4) หาค่า t-test ผูว้ิจยัไดว้ิเคราะห์เปรียบเทียบการทดสอบสมมติฐานเปรียบเทียบผล
การเรียนรู้จากห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับ
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นกัเรียนชั้นประถมศึกษาปีท่ี 6  จากกลุ่มตวัอยา่งกลุ่มเดียวกนั แลว้ท าขอ้สอบฉบบัเดียวกนั ซ่ึงสถิติท่ี
น ามาใชใ้นการวเิคราะห์สมมติฐานการวจิยัคร้ังน้ี คือ t-test Dependent ท่ีมีค่าระดบันยัส าคญั 0.05 
 3.5.4 หาความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีมีต่อห้องเรียนเสมือน เร่ือง การ
สร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6 โดยใชส้ถิติส่วนท่ีน ามาใชห้าค่าดชันีความสอดคลอ้ง 
(Index of Item Objective Congruence: IOC) โดยใชสู้ตรของโรแนลลี และแฮมเบิลตนั  
 

3.6  สถิติทีใ่ช้ในการวจิัย 
3.6.1 สถิติพื้นฐานการวจิยั ไดแ้ก่ 

 3.6.1.1  ค่าเฉล่ีย (Mean) ค านวณจากสูตร (ลว้น สายยศ และ องัคณา สายยศ, 
2540, น. 53) 

 ̅      
∑  

 
 

เม่ือ  ̅ แทน ค่าเฉล่ีย 
   ∑  แทน ผลรวมของคะแนนทั้งหมด 
        แทน จ านวนนกัเรียนในกลุ่มตวัอยา่ง 

     3.6.1.2 ค่าส่วนเบ่ียงเบนมาตรฐาน (S.D.) ค านวณจากสูตร (ลว้น สายยศ และ
องัคณา สายยศ, 2540, น. 53) 

      √
  ∑     (∑ ) 

 (   )
 

เม่ือ S.D. แทน ส่วนเบ่ียงเบนมาตรฐาน 
   n แทน จ านวนนกัเรียนในกลุ่มตวัอยา่ง 

X2  แทน ผลรวมของคะแนนทั้งหมด 
                     (X)2      แทน ผลรวมของคะแนนแต่ละตวัยกก าลงัสอง 

 3.6.2 หาค่าดชันีความสอดคล้องของขอ้ค าถาม แบบทดสอบก่อนเรียน และหลงัเรียน 
(Index of Item Objective Congruence: IOC) โดยใชสู้ตร ดงัน้ี (ลว้น สายยศ และ องัคณา สายยศ, 
2539, น. 249)  

IOC  =   
∑ 

 
 

 
เม่ือ IOC แทน ดชันีความสอดคลอ้ง 

  ∑  แทน ผลรวมของคะแนนความคิดเห็นของผูเ้ช่ียวชาญ 
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  N แทน จ านวนผูเ้ช่ียวชาญ 
 3.6.3 หาความยากง่าย (p) ของแบบทดสอบโดยใช้สูตร ดงัน้ี (ลว้น สายยศ และองัคณา 

สายยศ, 2536, น. 62) 

                             p  =   
 

 
 

เม่ือ p แทน ค่าความยากของแบบทดสอบแต่ละขอ้ 
  R แทน จ านวนผูต้อบถูกในแต่ละขอ้ 
  N แทน จ านวนผูเ้ขา้สอบทั้งหมด 

3.6.4 หาค่าอ านาจจ าแนก (r) ของแบบทดสอบ โดยใช้สูตร (ลว้น  สายยศ และองัคณา
สายยศ, 2536, น. 62) 

    
      
 
 

 

เม่ือ D แทน ค่าอ านาจจ าแนกรายขอ้ 
     แทน จ านวนนกัเรียนท่ีตอบถูกในกลุ่มสูง 
     แทน จ านวนนกัเรียนท่ีตอบถูกในกลุ่มต ่า 

  N แทน จ านวนนกัเรียนท่ีตอบถูกในกลุ่มสูงและกลุ่มต ่า 
3.6.5 หาค่าความเช่ือมัน่ของแบบทดสอบก่อนเรียน และหลงัเรียน โดยค านวณจากสูตร 

KR-20 (KUDER Ricgardson 20) ใชสู้ตรดงัน้ี (ลว้น สายยศ และ องัคณา สายยศ, 2531, น. 170) 

Rtt       =   

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โดยท่ี Rtt
 คือ   ความเช่ือมัน่ของแบบทดสอบ 

 n คือ   จ  านวนขอ้สอบทั้งหมด 
 S

2  คือ   ความแปรปรวนของคะแนนรวมทั้งฉบบั 
 p คือ   จ  านวนคนท่ีถูกทั้งหมด 
 q คือ   สัดส่วนของคนท าผดิแต่ละขอ้ (q = 1 – p) 

 
 
3.6.6 หาค่า t-test Dependent ท่ีมีค่าระดบันยัส าคญั 0.05 (ลว้น สายยศ และองัคณา สายยศ, 

2531, น. 170) โดยใชสู้ตร ดงัน้ี   
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t =                         
 

 1

22



 



n

Dn

D

D
 

โดยท่ี t คือ    ค่าสถิติทดสอบ 
 D   คือ    ผลรวมของคะแนนความแตกต่างระหวา่งคะแนน 
    การทดสอบหลงัเรียนกบัก่อนเรียนจากหอ้งเรียน
    เสมือนจริง 
  2D  คือ    ผลรวมของก าลงัสองของความแตกต่างระหวา่ง
    คะแนนของการทดสอบหลงัเรียนกบัก่อนการ
    เรียนจากห้องเรียนเสมือน 
      n  คือ จ านวนนกัเรียนท่ีเป็นกลุ่มตวัอยา่ง 
    df  คือ องศาความเป็นอิสระ มีค่าเท่ากบั n-1 

3.6.7 หาประสิทธิภาพของห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ยโปรแกรม    ดรีม
วีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  โดยใชสู้ตรการหาประสิทธิภาพ E1 / E2     (ชยั
ยงค ์พรหมวงศ,์ 2548) 

      =  100


A

N

X  

เม่ือ  E1 คือ ประสิทธิภาพของกระบวนการ 

    X  คือ คะแนนรวมของงาน 
A  คือ คะแนนเตม็ของงาน 
N คือ จ านวนนกัเรียนทั้งหมด 

E2   =  100


B

N

F  

เม่ือ  E2 คือ ประสิทธิภาพของผลลพัธ์ 

   F  คือ คะแนนรวมของผลลพัธ์หลงัเรียน 
B  คือ คะแนนเตม็ของการทดสอบหลงัเรียน 
N คือ จ านวนนกัเรียน 



 
 

บทที ่ 4 
ผลการวเิคราะห์ข้อมูล  

 
การวจิยัคร้ังน้ี ผูว้จิยัไดท้  าวจิยั เร่ือง การพฒันาหอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ย

โปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  โดยขั้นตอนในการวิจยัประกอบ
ไปดว้ย 

4.1  การน าเสนอผลการวเิคราะห์ขอ้มูล 
4.2  ผลการวเิคราะห์ 
 

4.1  การน าเสนอผลการวเิคราะห์ข้อมูล 
ผูว้จิยัไดด้ าเนินการวเิคราะห์ขอ้มูลตามขั้นตอนดงัน้ี 
4.1.1 ตอนท่ี 1 หาการพฒันาหอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม ดรีมวีฟ

เวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6   
4.1.2  ตอนท่ี 2 หาประสิทธิภาพของห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วย

โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6   
4.1.3  ตอนท่ี 3 เปรียบเทียบผลสัมฤทธ์ิก่อนเรียนและหลงัเรียนของนกัเรียนท่ีเรียนจาก

ห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้น
ประถมศึกษาปีท่ี 6   

4.1.4  ตอนท่ี 4 วิเคราะห์หาความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีเรียนจาก
หอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6  

 

4.2  ผลการวเิคราะห์ 
 4.2.1 ตอนท่ี 1 หาการพฒันาหอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม ดรีมวฟี

เวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6   
  ผลการวิเคราะห์ระดบัคุณภาพการพฒันาห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์
ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 เป็นการด าเนินการตาม
วตัถุประสงคข์อ้ท่ี 1 ดงัแสดงในตารางท่ี 4.1 
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ตารางที่  4.1  ผลการประเมินระดบัคุณภาพการพฒันาห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ย
โปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 จากแบบสอบถาม
ความคิดเห็นของผูเ้ช่ียวชาญ       

รายการประเมิน X S.D. แปลผล 
1. เป็นการเรียนรู้ดว้ยตนเอง โดยยดึผูเ้รียนเป็นส าคญั 4.22 0.44 มาก 
2. ช่วยพฒันาความสามารถในการคิดวิเคราะห์ของนกัเรียน 4.67 0.50 มากท่ีสุด 
3. ท าใหมี้ประสบการณ์ในการใชเ้คร่ืองคอมพิวเตอร์มากข้ึน 4.56 0.53 มากท่ีสุด 
4. สอนตามจุดประสงคข์องการเรียน 4.44 0.53 มาก 
5. มีแหล่งสนบัสนุนการเรียนท่ีเหมาะสม เช่น การติดต่อผูส้อน   
    กระดานแลกเปล่ียนเรียนรู้ แหล่งเรียนรู้ 

4.67 0.50 มากท่ีสุด 

6. เปิดโอกาสใหผู้เ้รียนติดต่อกบัผูส้อนใหมี้ปฏิสัมพนัธ์ระหวา่ง  
    ผูเ้รียน กบัผูส้อน ผูเ้รียนกบัผูเ้รียน และผูเ้รียนกบัส่ือ 

4.67 0.50 มากท่ีสุด 

7. น าเสนอเน้ือหาเป็นระบบ ช่วยใหเ้ห็นความต่อเน่ืองของเน้ือหา 4.78 0.44 มากท่ีสุด 
8. สามารถทบทวนเน้ือหาไดจ้นเขา้ใจ ตามความสามารถของ 
    ผูเ้รียน 

4.67 0.50 มากท่ีสุด 

9. กิจกรรมระหวา่งเรียนและการฝึกทกัษะช่วยใหผู้เ้รียนมีความ 
    เขา้ใจ เน้ือหาในบทเรียน 

4.78 0.44 มากท่ีสุด 

10. เปิดโอกาสใหผู้เ้รียนมีส่วนร่วมในบทเรียน 4.67 0.50 มากท่ีสุด 
11. มีความสะดวกในการเขา้ถึงบทเรียนหรือการคน้หา 
ขอ้มูลต่างๆ 

4.67 0.50 มากท่ีสุด 

12. กระตุน้ใหผู้เ้รียนอยากเรียนรู้ในเน้ือหาตอนต่อไป 4.89 0.33 มากท่ีสุด 
13. ผลการประเมินต่างๆ สามารถโตต้อบไดท้นัที 4.56 0.53 มากท่ีสุด 
14. ภาพประกอบและภาพเคล่ือนไหว มีส่วนช่วยใหเ้ขา้ใจเน้ือหา  
     ไดดี้ข้ึน 

4.67 0.50 มากท่ีสุด 

15. ศึกษาและทบทวนบทเรียนไดไ้ม่จ  ากดัเวลาและมีอิสระ 
     ในการเรียน 

4.56 0.53 มากท่ีสุด 

ค่าเฉล่ียรวม 4.63    0.48 มากท่ีสุด 
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จากตารางท่ี 4.1  แสดงคุณภาพของการพฒันาห้องเรียนเสมือนเร่ืองการสร้างเวบ็ไซต์ดว้ย
โปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้นประถมศึกษาปีท่ี 6 คุณภาพการพฒันาห้องเรียน
เสมือนอยู่ในระดับมากท่ีสุด 4.63 โดยคุณภาพการพฒันาห้องเรียนเสมือนในเร่ืองของกระตุน้ให้
ผูเ้รียนอยากเรียนรู้ในเน้ือหาตอนต่อไปสูงท่ีสุดดว้ยค่าเฉล่ีย 4.89   

4.2.2  ตอนท่ี 2 หาประสิทธิภาพของห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วย
โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6   

 จากวตัถุประสงคข์องการวจิยัในเร่ืองการหาประสิทธิภาพของห้องเรียนเสมือน เร่ือง 
การสร้างเวบ็ไซต์ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  ให้ตอ้ง
เป็นไปตามเกณฑ์ท่ีตั้งไวคื้อ 80/80 ผูว้ิจยัไดท้  าการศึกษาหาประสิทธิภาพของห้องเรียนเสมือน เร่ือง 
การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  ดงัตารางท่ี 
4.2 
 
ตารางที่  4.2  รายงานสรุปผลการหาประสิทธิภาพของห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ย

โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6       

รายการ คะแนนเตม็ คะแนนเฉล่ีย ร้อยละ E1/ E2 

คะแนนใบงาน 40 35.20 81.92 
81.92/80.56 

คะแนนทดสอบหลงัเรียน 30 25. 83 80.56 

 

จากตารางท่ี 4.2 แสดงให้เห็นวา่ ห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมด
รีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  แลว้น าผลของคะแนนจากการท าใบงานของ
นกัเรียน 30 คน คิดเป็นค่าเฉล่ียร้อยละได้ 81.92 และค่าเฉล่ียร้อยละของคะแนนทดสอบหลงัเรียน
เท่ากบั 80.56 แสดงใหเ้ห็นวา่ ผลการพฒันาหอ้งเรียนเสมือน ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  มี
ประสิทธิภาพตามเกณฑ์ 80/80 กล่าวคือ E1/ E2   มีค่าเท่ากบั 81.92/80.56           จึงเป็นไปตาม
สมมติฐาน 

4.2.3  ตอนท่ี 3 เปรียบเทียบผลสัมฤทธ์ิก่อนเรียนและหลงัเรียนของนกัเรียนท่ีเรียนจาก
ห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้น
ประถมศึกษาปีท่ี 6   
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ผลการวิเคราะห์ห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ 
CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  โดยการทดสอบก่อนเรียน แลว้ให้นกัเรียนไดเ้รียนรู้จาก
ห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้น
ประถมศึกษาปีท่ี 6  แลว้ท าการทดสอบหลงัเรียน ซ่ึงสอดคลอ้งกบัวตัถุประสงคข์อ้ท่ี 2 แสดงผลการ
วเิคราะห์ ดงัตารางท่ี 4.3 

 
ตารางที ่ 4.3  การเปรียบเทียบคะแนนเฉล่ียระหวา่งก่อนเรียนและหลงัเรียนดว้ยหอ้งเรียนเสมือนเร่ือง 

การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6   

 
คะแนนเตม็        คะแนนเฉล่ีย S.D. t Sig.(2-tailed) 

การทดสอบก่อนเรียน 30                     13.07 2.16 
26.67* 0.00 

การทดสอบหลงัเรียน 30                    24.17 0.99 

 
จากตารางท่ี 4.3 แสดงให้เห็นวา่ผลการใชห้้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ย

โปรแกรมดรีมวีฟเวอร์ CS6  ส าหรับนักเรียนชั้นประถมศึกษาปีท่ี 6 ในการทดสอบก่อนเรียน              
มีคะแนนเฉล่ียเท่ากบั 13.07  ค่า S.D. เท่ากบั 2.16 หลงัจากท่ีนกัเรียนไดเ้รียนรู้จากห้องเรียนเสมือน
เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้นประถมศึกษาปีท่ี 6        
แลว้ท าการทดสอบหลงัเรียน นกัเรียนมีคะแนนเฉล่ียสูงข้ึน มีคะแนนเฉล่ียเท่ากบั 24.17  มีค่า  S.D.  
เท่ากบั 0.99 การวิเคราะห์ t - test  Dependent ระหวา่งก่อนเรียนและหลงัเรียนเท่ากบั  26.67  มีความ
แตกต่างอยา่งมีนยัส าคญัทางสถิติท่ีระดบั 0.05 

4.2.4 ตอนที่  4 วิเคราะห์หาความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีเรียน
จากหอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6  
 ผลการวเิคราะห์ระดบัความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 6 หลงัจากการ
เรียนดว้ยหอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้น
ประถมศึกษาปีท่ี 6  เป็นการด าเนินการตามวตัถุประสงคข์อ้ท่ี 3 ดงัแสดงในตารางท่ี 4.4 
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ตารางที่  4.4  ผลการประเมินระดบัความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีมีต่อห้องเรียน
เสมือน  เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6  

รายการประเมิน X S.D. แปลผล 

1. ดา้นการน าเสนอดว้ยภาพ สี เสียงประกอบ และการเช่ือมโยงเน้ือหา 
    1.1 ภาพประกอบสอดคลอ้งกบัเน้ือหา 4.63 0.49 มากท่ีสุด 
    1.2 ภาพประกอบมีความน่าสนใจสามารถส่ือสารไดช้ดัเจน 4.73 0.45 มากท่ีสุด 
    1.3 มีภาพไอคอนสวยงามน่าสนใจ ส่ือความหมายชดัเจน 4.57 0.50 มากท่ีสุด 
    1.4 การเช่ือมโยงเน้ือเพื่อสร้างปฏิสัมพนัธ์ระหวา่งผูเ้รียนกบั 
          บทเรียน 

4.63 0.49 มากท่ีสุด 

    1.5 การเช่ือมโยง (Link) เน้ือหาของการสอนผา่นเวบ็ไดง่้าย 4.50 0.45 มากท่ีสุด 
 ค่าเฉล่ียรวม 4.66 0.48 มากท่ีสุด 

2.ด้านส่ิงอ านวยความสะดวก    
    2.1 การติดต่อส่ือสารผ่านจดหมายอิเล็กทรอนิกส์ 4.63 0.49 มากท่ีสุด 
    2.2 การส่งขอ้ความ (Send Massage) โดยใชโ้ปรแกรม  
          เฟสบุค๊  (Facebook) 

4.73 0.45 มากท่ีสุด 

    2.3 การติดต่อส่ือสารผ่านแอพพลิเคชั่นไลน์ 4.83 0.46 มากท่ีสุด 
 ค่าเฉล่ียรวม 4.73 0.47 มากท่ีสุด 

3. ดา้นเน้ือหา 
    3.1 เน้ือหาวชิาในการสอนผา่นเวบ็มีความสอดคลอ้ง 
          กบัวตัถุประสงคก์ารเรียนรู้ 

4.70 0.47 มากท่ีสุด 

    3.2 การล าดบัเน้ือหาเรียงจากง่ายไปหายาก 4.63 0.49 มากท่ีสุด 
    3.3 ผูเ้รียนสามารถเขา้ถึงเน้ือหาไดร้วดเร็ว 4.80 0.41 มากท่ีสุด 
    3.4 ผูเ้รียนเขา้ใจเน้ือหาในบทเรียนไดง่้าย 4.57 0.50 มากท่ีสุด 
    3.5 ผูเ้รียนน าความรู้ท่ีไดไ้ปประยกุตใ์ชใ้นชีวติประจ าวนัได้ 4.70 0.47 มากท่ีสุด 
    3.6 ผูเ้รียนตระหนกัถึงคุณค่าและประโยชน์ของความรู้    
         ท่ีไดรั้บ 

4.63 0.49 มากท่ีสุด 

 ค่าเฉล่ียรวม 4.67 0.47 มากท่ีสุด 
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ตารางที่  4.4  ผลการประเมินระดบัความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีมีต่อห้องเรียน
เสมือน  เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6  

รายการประเมิน X S.D. แปลผล 
4.  ด้านแบบทดสอบและการประเมินผล  
    4.1 การสอนผา่นเวบ็มีแบบทดสอบหลงัเรียนช่วยใหผู้เ้รียน 
         ไดต้รวจสอบความเขา้ใจในเน้ือหาบทเรียนไดเ้หมาะสม 

4.67 0.48 มากท่ีสุด 

    4.2 ค าถามมีความชัดเจน 4.50 0.51 มากท่ีสุด 
    4.3 แบบทดสอบสอดคล้องกับว ัตถุประสงค์  4.83 0.46 มากท่ีสุด 
    4.4 ความยากง่ายของแบบทดสอบเหมาะสม 4.63 0.49 มากท่ีสุด 
    4.5 สรุปผลคะแนนท้ายบทเรียนชัดเจน  4.77 0.50 มากท่ีสุด 

 ค่าเฉล่ียรวม 4.68 0.49 มากท่ีสุด 
 ค่าเฉล่ียรวม 4.69 0.48 มากท่ีสุด 

 
จากตารางท่ี 4.4  แสดงความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีมีต่อห้องเรียน

เสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6 จ านวนทั้งหมด 30 คน ในภาพรวมมี
ความพึงพอใจอยูใ่นระดบัมาก ดว้ยค่าเฉล่ีย  4.69 โดยมีความพึงพอใจดา้นส่ิงอ านวยความสะดวกสูง
ท่ีสุด ดว้ยค่าเฉล่ีย 4.73  



 
 

บทที ่ 5 
สรุปผลการวจิยั  การอภปิรายผล  และข้อเสนอแนะ 

 
ในการศึกษาวิจยั เร่ือง การพฒันาห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ดว้ยโปรแกรม 

ดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ซ่ึงมีวตัถุประสงคก์ารวิจยั 1) เพื่อพฒันา
ห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์  CS6 ส าหรับนักเรียนชั้น
ประถมศึกษาปีท่ี 6 2) เพื่อหาประสิทธิภาพหอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีม
วฟีเวอร์ CS6  ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 3) เพื่อเปรียบเทียบผลสัมฤทธ์ิก่อนเรียนและหลงั
เรียน และ 4) เพื่อหาความพึงพอใจของนกัเรียนท่ีเรียนดว้ยห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์
ด้วยโปรแกรม ดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้นประถมศึกษาปีท่ี 6 โดยมีกลุ่มตวัอย่างเป็น
นกัเรียนระดบัชั้นประถมศึกษาปีท่ี 6 โรงเรียนมีนประสาทวิทยา แขวงมีนบุรี          เขตมีนบุรี 
กรุงเทพมหานคร สังกดัส านกังานคณะกรรมการส่งเสริมการศึกษาเอกชน จ านวน 30 คน เลือกโดย
วิธีการเลือกกลุ่มตวัอย่างแบบเจาะจง (Purposive Sampling) มีเคร่ืองมือท่ีใช้ในการทดลอง ได้แก่ 
แบบสอบถามความคิดเห็นส าหรับผูเ้ช่ียวชาญ ห้องเรียนเสมือนส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
แบบทดสอบก่อนเรียนและหลงัเรียน เป็นขอ้สอบแบบปรนยัชนิดเลือกตอบ 4 ตวัเลือก จ านวน 30 ขอ้ 
และแบบสอบถามความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีเรียนจากห้องเรียนเสมือน เร่ือง
การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 สามารถสรุป
ผลการวจิยั การอภิปรายผลและขอ้เสนอแนะในการวจิยัไดด้งัน้ี   

5.1  วธีิการด าเนินการวิจยั 
5.2  สรุปผลการวจิยั 
5.3  การอภิปรายผล 
5.4  ขอ้เสนอแนะ 
5.5  ขอ้เสนอแนะในการท าวิจยัคร้ังต่อไป 

 

5.1  วธิกีารด าเนินการวจิัย 

        ผูว้จิยัไดป้ฏิบติัดงัน้ี 
5.1.1  ศึกษาหลกัสูตรกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีตามหลกัสูตร

แกนกลางการศึกษาขั้นพื้นฐาน พ.ศ.2551 
5.1.2  ศึกษาแนวคิด หลกัการ ทฤษฎี ท่ีเก่ียวขอ้งกบัการพฒันาห้องเรียนเสมือน  
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5.1.3  น าปัญหาท่ีไดรั้บจากประสบการณ์ในการสอนคอมพิวเตอร์มาวิเคราะห์ถึงประเด็น
ส าคญัของปัญหาและหาสาเหตุของปัญหาพบว่า ปัญหาท่ีส าคัญ คือผูเ้รียนไม่ให้ความสนใจใน
บทเรียนเท่าท่ีควร อีกทั้งนักเรียนส่วนใหญ่มีพื้นฐานในการใช้งานอินเทอร์เน็ต และนักเรียนรู้จกั
คอมพิวเตอร์เพียงแค่มีไวใ้หเ้ล่นเกม   
  5.1.4  ก าหนดจุดประสงคส์ าคญัของการวจิยั 
  5.1.5  จัดท าโครงสร้างของห้องเรียนเสมือน โดยการวิเคราะห์เน้ือหาจากหลักสูตร
แกนกลางและหลักสูตรสถานศึกษากลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี วิชา 
คอมพิวเตอร์  
  5.1.6  จดัท าห้องเรียนเสมือน ตามโครงสร้างของเน้ือหาท่ีก าหนดไว ้โดยยึดหลกัสูตร
แกนกลางกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีวชิา คอมพิวเตอร์  
  5.1.7  จดัท าแบบสอบถามส าหรับผูเ้ช่ียวชาญเพื่อหาการพฒันาและคุณภาพของห้องเรียน
เสมือน 
  5.1.8  จดัท าแบบทดสอบ และแบบประเมินความพึงพอใจของนักเรียนท่ีมีต่อห้องเรียน
เสมือน เพื่อใชเ้ป็นเคร่ืองมือในการวจิยั 
  5.1.9 น าห้องเรียนเสมือน และเคร่ืองมือท่ีผูว้ิจยัสร้างข้ึนให้ผูเ้ช่ียวชาญตรวจสอบเพื่อหา
ความสอดคลอ้งระหวา่งเน้ือหา ภาษาท่ีใช้ ขอ้ค าถาม กิจกรรมการเรียนการสอนกบัจุดประสงค์ของ
การจดัท าและหาประสิทธิภาพของเคร่ืองมือ แลว้น ามาปรับปรุงแกไ้ขขอ้ผิดพลาดให้ถูกตอ้งสมบูรณ์
ตามท่ีผูเ้ช่ียวชาญแนะน าทุกประการ 
  5.1.10  น าห้องเรียนเสมือน ไปทดลองใช้กบันกัเรียนชั้นปะถมศึกษาปีท่ี 6 ท่ีไม่ใช่กลุ่ม
ตวัอย่างเพื่อหาประสิทธิภาพของห้องเรียนเสมือน แลว้ไดท้  าการแกไ้ขปรับปรุงจนมีประสิทธิภาพท่ี
ยอมรับได ้
  5.1.11  น าห้องเรียนเสมือน ไปใช้กับกลุ่มตวัอย่างได้แก่นักเรียนชั้นประถมศึกษาปีท่ี 6 
โรงเรียนมีนประสาทวิทยา ส านกังานคณะกรรมการส่งเสริมการศึกษาเอกชน ซ่ึงผูว้ิจยัไดด้ าเนินการ
ใชห้อ้งเรียนเสมือน ในภาคเรียนท่ี2 ปีการศึกษา 2558 หาประสิทธิภาพของห้องเรียนเสมือนโดยใชค้่า 
E1/E2 ก าหนดไวเ้ท่ากบั 80/80 หาส่วนเบ่ียงเบนมาตรฐานโดยใช ้S.D. น าผลสัมฤทธ์ิทางการเรียนของ
นกัเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีเรียนจากห้องเรียนเสมือนมาเปรียบเทียบโดยใชค่้าเฉล่ีย       (X) และ 
t-test Dependent 
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5.2  สรุปผลการวจิัย 
        ในการวิเคราะห์ขอ้มูลทั้งหมดท่ีผ่านมาขา้งตน้ ผูว้ิจยัได้สรุปผลการวิจยัตามวตัถุประสงค์     
ท่ีไดต้ั้งไว ้ดงัต่อไปน้ีคือ 

5.2.1  คุณภาพของการพฒันาห้องเรียนเสมือนเร่ืองการสร้างเวบ็ไซตด์ว้ยโปรแกรม  ดรีม
วีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 คุณภาพการพฒันาห้องเรียนเสมือนอยูใ่นระดบั
มากท่ีสุด 4.63 โดยคุณภาพการพฒันาห้องเรียนเสมือนในเร่ืองของกระตุน้ให้ผูเ้รียนอยากเรียนรู้ใน
เน้ือหาตอนต่อไปสูงท่ีสุดดว้ยค่าเฉล่ีย 4.89   

5.2.2  ประสิทธิภาพของห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม       ดรีม
วีฟเวอร์ CS6 ท่ีได้ท าการสร้างและพฒันามีประสิทธิภาพตามเกณฑ์ 80/80 กล่าวคือ จากการหา
ประสิทธิภาพไดค้่าร้อยละของคะแนนระหวา่งเรียนเท่ากบั 81.92  (E1) และร้อยละของคะแนนจาก
แบบทดสอบหลงัเรียนเท่ากบั 80.56 (E2)   

5.2.3  ผลการเปรียบเทียบผลสัมฤทธ์ิก่อนเรียนและหลงัเรียน พบวา่ คะแนนหลงัการเรียนรู้
จากหอ้งเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6 มีค่าสูงกวา่คะแนนก่อน
เรียน อยา่งมีนยัส าคญัทางสถิติท่ีระดบั 0.05 

5.2.4  ผลการศึกษาความพึงพอใจของนกัเรียนกลุ่มตวัอย่าง พบว่ามีความพึงพอใจอยู่ใน
ระดบัมากท่ีสุด 
 

5.3  การอภิปรายผล 
 การวิจยัเร่ือง การพฒันาห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม         ดรีม
วฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ตามวตัถุประสงคแ์ละสมมติฐานของการวิจยั ซ่ึง
ผลการวจิยัน ามาอภิปรายผลไดด้งัน้ี 

5.3.1  จากการวจิยัพบวา่ คุณภาพของการพฒันาหอ้งเรียนเสมือนเร่ืองการสร้างเวบ็ไซตด์ว้ย
โปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้นประถมศึกษาปีท่ี 6 คุณภาพการพฒันาห้องเรียน
เสมือนอยู่ในระดับมากท่ีสุด 4.63 โดยคุณภาพการพฒันาห้องเรียนเสมือนในเร่ืองของกระตุน้ให้
ผูเ้รียนอยากเรียนรู้ในเน้ือหาตอนต่อไปสูงท่ีสุดดว้ยค่าเฉล่ีย 4.89   
 5.3.2  ห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีม วีฟเวอร์ CS6 ส าหรับ
นกัเรียนชั้นประถมศึกษาปีท่ี 6 ประกอบดว้ย กิจกรรมการเรียนรู้ท่ีมีความส าคญั ดงัน้ี การฝึกการใช้
และการส่ือสารผา่นเวบ็มีความส าคญัอยา่งยิง่ต่อการเรียนดว้ยหอ้งเรียนเสมือน เน่ืองจากหากผูเ้รียนไม่
มีความพร้อมทางดา้นทกัษะการใชง้านคอมพิวเตอร์ทั้งในดา้นการใชโ้ปรแกรม                 การ
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ประมวลผลและการใชง้านอินเทอร์เน็ตเบ้ืองตน้รวมทั้งความเขา้ใจในขั้นตอนและการท ากิจกรรมผา่น
ทางห้องเรียนเสมือนแลว้ ย่อมส่งผลให้เกิดอุปสรรคในการเขา้ปฏิบติักิจกรรมการเรียนรู้ของผูเ้รียน
อยา่งมากอาจท าให้กระบวนการจดัการเรียนรู้ไม่เป็นไปตามวตัถุประสงคข์องการจดัการเรียนรู้ ดว้ย
เหตุน้ีผูส้อนไดจ้ดัท าคู่มือเพื่อเตรียมความพร้อมของผูเ้รียนให้มีความพร้อมมากท่ีสุดก่อนท่ีจะปฏิบติั
กิจกรรมการเรียนรู้ด้วยห้องเรียนเสมือน จากการพฒันาประสิทธิภาพของห้องเรียนเสมือนให้มี
ประสิทธิภาพตามเกณฑ์  80/80 ผลการวิจยัพบว่า นกัเรียนท่ีเรียนดว้ยห้องเรียนเสมือน ก่อนการใช้
บทเรียนห้องเรียนเสมือนในการจดัการเรียนการสอนนกัเรียนท าการทดสอบก่อนเรียน    มีคะแนน
เฉล่ีย ของคะแนนเต็ม 30 คะแนน เท่ากบั 13.07 จากจ านวนนกัเรียนทั้งหมด 30 คน หลงัจากท่ีท าการ
ทดสอบก่อนเรียนเสร็จแลว้ ผูว้ิจยัไดห้้องเรียนเสมือนท่ีไดอ้อกแบบสร้างไวม้าใชใ้นการจดัการเรียน
การสอนโดยก าหนดกิจกรรมให้นกัเรียนไดเ้รียนรู้ซ่ึงประกอบดว้ยการใส่ขอ้ความใน    เวบ็เพจ การ
แทรกรูปภาพ การแทรกตาราง และการแทรกมลัติมิเดียลงในเว็บเพจ เพื่อให้นักเรียนได้ทบทวน
ความรู้ท่ีเรียนมาในห้องเรียน และให้นกัเรียนท าใบงานในแต่ละเร่ือง นกัเรียนมีความสนใจ   มีความ
กระตือรือร้น สนใจเรียนมากข้ึน มีการบนัทึกผลคะแนนระหว่างเรียนไวแ้ล้วน าผลของคะแนน
ระหวา่งเรียนมาหาค่าเฉล่ียคิดเป็นร้อยละไดเ้ท่ากบั 81.92 หลงัจากท่ีนกัเรียนไดเ้รียนรู้ดว้ยห้องเรียน
เสมือน จึงท าใบงานจนครบทุกใบงาน  จากนั้นนักเรียนท าการทดสอบหลังเรียน พบว่าคะแนน
ทดสอบหลงัเรียนมีค่าเฉล่ียคิดเป็นร้อยละ  80.56 แสดงให้เห็นว่าห้องเรียนเสมือนท่ีผูว้ิจยัสร้างข้ึนมี
ประสิทธิภาพเท่ากบั 81.92/80.56 ซ่ึงมีประสิทธิภาพตามเกณฑ์ท่ีก าหนดคือ 80/80 สอดคล้องกับ
งานวิจยัของงานวิจยัของสุรพล บุญลือ (2550, บทคดัยอ่) ไดว้ิจยัเร่ืองการพฒันารูปแบบการสอนโดย
ใช้ห้องเรียนเสมือนแบบใช้ปัญหาเป็นหลกัในระดบัอุดมศึกษา พบว่า ประสิทธิภาพของห้องเรียน
เสมือนท่ีพฒันาข้ึนมีประสิทธิภาพ(E1/E2) 83.15/81.17 เป็นไปตามเกณฑท่ี์ก าหนด 
 5.3.3  จากการวิจยัพบวา่ ผลสัมฤทธ์ิทางการเรียนหลงัเรียนท่ีเรียนโดยใชห้้องเรียนเสมือน 
ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 ในการทดสอบก่อนเรียนมีคะแนนเฉล่ียเท่ากบั 13.07 มีค่า
เบ่ียงเบนมาตรฐาน (S.D.) เท่ากบั 2.16 หลงัจากท่ีนกัเรียนไดเ้รียนรู้จากห้องเรียนเสมือนแลว้ท าการ
ทดสอบหลงัเรียน นกัเรียนมีคะแนนเฉล่ียสูงข้ึนจากเดิมมีคะแนนเฉล่ียเท่ากบั 24.17 มีค่าเบ่ียงเบน
มาตรฐาน (S.D.) เท่ากบั 0.99 การวิเคราะห์ t-test ระหว่างก่อนเรียนและหลงัเรียนเท่ากบั 26.67            
มีความแตกต่างอยา่งมีนยัส าคญัทางสถิติท่ีระดบั 0.05 ซ่ึงสอดคลอ้งกบังานวิจยัของอญัชลี  บุญฤทธ์ิ 
(2554, บทคดัย่อ) ได้ศึกษาวิจยั เร่ือง ผลสัมฤทธ์ิทางการเรียนของผูเ้รียนโดยใชห้้องเรียนเสมือน 
ผลการวิจยัพบว่าผลสัมฤทธ์ิทางการเรียนของผูเ้รียนท่ีเรียนโดยใช้ห้องเรียนเสมือนสูงกว่าผูเ้รียนท่ี
เรียนจากหอ้งเรียนปกติ อยา่งมีนยัส าคญัทางสถิติท่ีระดบั .01 
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5.3.4  จากการวิจยัพบว่าผลการวิเคราะห์ระดบัความพึงพอใจของนักเรียนหลงัการใช้
ห้องเรียนเสมือน ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6   นกัเรียนมีความพึงพอใจอยูใ่นระดบัมาก 
ท่ีสุดมีค่าเฉล่ีย 4.69 เพราะนกัเรียนไดเ้รียนรู้กิจกรรมท่ีทางบทเรียนจดักิจกรรมไว ้ ท าให้ผูเ้รียนมีความ
พอใจต่อหอ้งเรียนเสมือน เน่ืองจากหอ้งเรียนเสมือนให้ทั้งความรู้และความเพลิดเพลิน รวมทั้งช่วยให้
รู้จกัคิดและปฏิบติัอยา่งเป็นขั้นตอน ทั้งน้ีเน่ืองจากผูเ้รียนไดเ้รียนตามเน้ือหาท่ีผูเ้รียนตอ้งการ ไดล้งมือ
ปฏิบติั มีผลแสดงความกา้วหนา้ทางการเรียนเป็นระยะๆ ทา้ทายให้ผูเ้รียนเกิดความสนใจ และเม่ือ
ผูเ้รียนใชค้วามพยายามถึงระดบัหน่ึงจะไดค้วามส าเร็จทนัที  ซ่ึงสอดคลอ้งกบังานวจิยัของ    ธนิดา หนู
แป้น (2552, น. 76) ไดศึ้กษาวิจยัการสร้างห้องเรียนเสมือนส าหรับการเรียนแบบใชปั้ญหาเป็นหลกั 
เร่ือง การใช้ Microsoft Excel เพื่อการค านวณของนกัเรียนชั้นมธัยมศึกษาปีท่ี 2 โรงเรียนสุราษฎร์
พิทยา ผลการวิจยัพบวา่ความพึงพอใจในการเรียนของผูเ้รียนท่ีมีต่อห้องเรียนเสมือนส าหรับการเรียน
แบบใช้ปัญหาเป็นหลกั เร่ือง การใช ้Microsoft Excel เพื่อการค านวณมีค่าเฉล่ียรวมทุกส่วนเท่ากบั 
4.15 ค่าเบ่ียงเบนมาตรฐานเฉล่ียเท่ากบั 0.78 เม่ือน ามาเปรียบเทียบเกณฑ์ท่ีไดก้ าหนดไวพ้บวา่อยูใ่น
เกณฑพ์ึงพอใจมาก 

ขอ้สังเกตท่ีพบในระหว่างการเรียนรู้จากห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วย
โปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 นกัเรียนมีความตั้งใจและมีความ
กระตือรือร้นในการเรียน และนกัเรียนยงักลบัไปทบทวนบทเรียนจากห้องเรียนเสมือนเม่ือนกัเรียนมี
บทเรียนหรือเน้ือหาท่ีไม่เข้าใจนักเรียนจะท าการสอบถามครูประจ าวิชาในเวลาท่ีก าหนดไวแ้ละ
โตต้อบกบัครูประจ าวชิามากข้ึน อีกทั้งยงัสามารถปฏิบติังานไดอ้ยา่งสนุกสนาน ถูกตอ้งเป็นระเบียบ มี
ความเช่ือมัน่ในการท างานมากข้ึนเพราะทุกคนไดป้ฏิบติัจริงช่วยให้เกิดการเรียนรู้ รวมทั้งสามารถ
เรียนรู้ได้เองโดยอิสระ อีกทั้งยงัมีการแลกเปล่ียนเรียนรู้ซ่ึงกันและกัน ท าให้ผูเ้รียนได้พฒันาตาม
ศกัยภาพ โดยมีครูวางแผนร่วมกบัผูเ้รียน กระตุน้ ทา้ทาย ให้ก าลงัใจ และช้ีแนะแนวทางการแสวงหา
ความรู้ท่ีถูกตอ้ง 
 

5.4 ข้อเสนอแนะ 
ในการวจิยัคร้ังน้ี ผูว้จิยัมีขอ้เสนอแนะในการน าผลการวจิยัไปใช ้ ดงัน้ี 
5.4.1  การฝึกการใชง้านและการติดต่อส่ือสารผา่นเวบ็เป็นกิจกรรมท่ีส าคญัในการเรียนรู้

ดว้ยระบบห้องเรียนเสมือน ซ่ึงหากผูเ้รียนขาดความพร้อม จะส่งผลในการจดักิจกรรมการเรียนการ
สอนให้บรรลุตามวตัถุประสงคท่ี์ไดต้ั้งไว ้ ควรเตรียมความพร้อมของผูเ้รียน โดยการฝึกทกัษะการใช้
คอมพิวเตอร์ การใชง้านอินเทอร์เน็ต การสืบคน้ขอ้มูล การใช้โปรแกรมส าหรับการติดต่อส่ือสาร   
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รวมไปถึงวธีิการและขั้นตอนในการศึกษาหอ้งเรียนเสมือนอยา่งละเอียดในทุกขั้นตอนของจดักิจกรรม
การเรียนรู้ 

5.4.2  การท าห้องเรียนเสมือน สามารถน าไปประยุกตใ์ชก้บัการจดัการเรียนไดทุ้กช่วงชั้น
ของการศึกษา และทุกกลุ่มสาระการเรียนรู้ โดยการปรับกิจกรรมการเรียนรู้ให้สอดคลอ้งกบักิจกรรม
การเรียนรู้ในช่วงชั้นหรือกลุ่มสาระการเรียนรู้ท่ีจะน าไปใช ้ 

 

5.5  ข้อเสนอแนะในการท าวจิัยคร้ังต่อไป 
จากผลการวจิยัท่ีไดส้รุปและอภิปรายผลผูว้จิยัมีแนวคิดเป็นขอ้เสนอแนะดงัน้ี 
5.5.1  ผูส้อนตอ้งมีการโตต้อบกบัผูเ้รียนดว้ยการสอนผา่นเวบ็ตลอดเวลา ควรตอบอีเมล์

ทนัทีเม่ือผูเ้รียนส่งมาถึง เพราะจะท าใหผู้เ้รียนรู้สึกวา่ก าลงัศึกษาโดยมีครูคอยดูแลอยู ่
5.5.2  ควรมีการก าหนดให้ผูเ้รียนไดติ้ดต่อส่ือสารระหวา่งผูเ้รียนกบัผูส้อน หรือระหวา่ง

ผูเ้รียนดว้ยกนัเป็นประจ า โดยใชเ้วบ็บอร์ด (Web Board) แช็ท (Chat) และอีเมล ์(E-Mail) 
5.5.3  มีการศึกษาผลของการน ารูปแบบการเรียนรู้ดว้ยห้องเรียนเสมือนไปใช้กบัทกัษะ

กระบวนการคิดของผูเ้รียนตามมาตรฐานของหลกัสูตรอ่ืน ๆ เช่น ทกัษะกระบวนการคิดแบบ
สร้างสรรค ์ทกัษะกระบวนการคิดอยา่งเป็นระบบ ทกัษะกระบวนการคิดแบบมีวจิารณญาณ เป็นตน้ 
 5.5.4 ควรมีการศึกษาผลของการน ารูปแบบการเรียนรู้ดว้ยห้องเรียนเสมือนไปใชก้บัผูเ้รียน
ท่ีมีความสามารถในการเรียนต่างกนั เพื่อหาแนวทางในการเสริมสร้างความสามารถของผูเ้รียน 
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ภาคผนวก ก 
- รายนามผู้เช่ียวชาญตรวจสอบเคร่ืองมือวจิยั 
 - หนังสือเชิญผู้เช่ียวชาญ 
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รายนามผู้เช่ียวชาญตรวจสอบเคร่ืองมือวจิัย 
 

ผู้เช่ียวชาญด้านเทคโนโลยกีารศึกษา 
1. ดร.ไพบูลย ์ใสยาวงศ ์

ขา้ราชการบ านาญ มหาวทิยาลยัเทคโนโลยรีาชมงคลธญับุรี 
2. ดร.ภสัสร สังขศ์รี     

อาจารยป์ระจ าภาควชิาเทคโนโลยีโทรทศัน์และวทิยกุระจายเสียง  
คณะเทคโนโลยส่ืีอสารมวลชน มหาวทิยาลยัเทคโนโลยรีาชมงคลธญับุรี  

3. ผูช่้วยศาสตราจารย ์ดร.สัมพนัธ์ุ จนัดี 
อาจารยป์ระจ าภาควชิาเทคโนโลยีสารสนเทศทางธุรกิจ คณะบริหารธุรกิจ ศาลายา  
มหาวทิยาลยัเทคโนโลยรีาชมงคลรัตนโกสินทร์ 

 

ผู้เช่ียวชาญด้านวดัและประเมนิผล 
1. ดร.ลดัดา อ่ิมอกใจ   

ศึกษานิเทศกช์ านาญการพิเศษ ส านกังานเขตพื้นท่ีการศึกษาประถมศึกษาปทุมธานีเขต 1 
2. ดร.เอนก  ล่วงลือ    

ขา้ราชการบ านาญ ส านกังานเขตพื้นท่ีการศึกษาประถมศึกษาปทุมธานี เขต 1 
3. ดร.อิทธิฤทธ์ิ พงษปิ์ยะรัตน์ 

ศึกษานิเทศกช์ านาญการพิเศษ ส านกังานเขตพื้นท่ีการศึกษาประถมศึกษา สิงห์บุรี 
 

ผู้เช่ียวชาญด้านเนือ้หา 
1. นายทรงเดช ขุนแท ้    

ขา้ราชการบ านาญ ส านกังานเขตพื้นท่ีการศึกษาประถมศึกษาปทุมธานี เขต 1 
2. วา่ท่ีร้อยตรี วชิา   ช านาญวาด   

ครูช านาญการพิเศษ  วชิาคอมพิวเตอร์ โรงเรียนวดัทา้ยเกาะ 
3. นายมาโนช  ประดบัลาย     

ครูช านาญการพิเศษ  วชิาคอมพิวเตอร์  โรงเรียนวดับางกุฎีทอง 
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ภาคผนวก ข 
-  ค าอธิบายรายวชิาพืน้ฐาน 
-  ตวัช้ีวดั  สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิน่ 

-  วเิคราะห์ตวัช้ีวดัและสาระการเรียนรู้แกนกลางการศึกษาขั้นพืน้ฐาน พ.ศ. 2551 
    กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีวชิาคอมพวิเตอร์   
   ช้ันประถมศึกษาปีที ่6 
-  วเิคราะห์หน่วยการเรียนรู้ตามมาตรฐานการเรียนรู้ / ตวัช้ีวดั 
-  โครงสร้างรายวชิา หน่วยการเรียนรู้ที่ 4  การสร้างเวบ็เพจด้วยโปรแกรม 
   ดรีมวฟีเวอร์ CS6 
-  ก าหนดการสอนรายช่ัวโมง 
-  การวเิคราะห์วตัถุประสงค์เชิงพฤตกิรรม 
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ค าอธิบายรายวชิาพืน้ฐาน 
 

ง 16101  การงานอาชีพและเทคโนโลยี                   กลุ่มสาระการงานอาชีพและเทคโนโลยี 
ช้ันประถมศึกษาปีที ่6                                                                     เวลาเรียน  80  ช่ัวโมง       
 

ศึกษา อธิบาย  ส ารวจ  เลือก ระบุ หลกัการท างานและปรับปรุง แนวทางในการท างานแต่ละ
ขั้นตอนรวมถึงการวิวฒันาการของเทคโนโลยี เช่น งานบา้น งานประดิษฐ์ งานเกษตร และงานธุรกิจ
ส่วนประกอบของระบบเทคโนโลยี การปฏิบติัตนกบัครอบครัวและผูอ่ื้นของการท างานร่วมกัน                    
ในลกัษณะท่ีขยนั อดทน รับผิดชอบ ซ่ือสัตย ์มีมารยาท แสดงความคิดเห็นเก่ียวกบัการใช้พลงังาน 
ทรัพยากรและส่ิงแวดลอ้มอยา่งประหยดัและคุม้ค่าของประเทศสมาชิกอาเซียนและมีจิตส านึกในการ
ใช้ทรัพยากร ค้นหา รวบรวม จดัท า เก็บรักษา เอกสาร ข้อมูลในรูปแบบเทคโนโลยีต่างๆใน
ชีวิตประจ าวนัและ ก าหนดปัญหาหรือความต้องการ วางแผน ออกแบบ สร้าง เลือกใช้ น าเสนอ 
ประเมินผล ช้ินงาน ความรู้เก่ียวกบัภาษา วฒันธรรม การเมืองการปกครอง อาชีพประจ าชาติในกลุ่ม
ประเทศอาเซียนและทกัษะต่างๆ ใชก้ระบวนการเทคโนโลยีถ่ายทอดความคิดเป็นภาพร่าง 3 มิติ หรือ
แผนท่ีความคิด กราฟ ตาราง แผนภาพ รูปภาพ  เทคโนโลยีไปประยุกตใ์ชอ้ย่างสร้างสรรคป์ลอดภยั 
ต่อชีวิต และ สังคม โดยใชก้ระบวนการคิด การแกปั้ญหา กระบวนการท างานเป็นกลุ่ม กระบวนการ
ปฏิบติั  และกระบวนการเทคโนโลยี เพื่อใหเ้กิดความรู้ ความสามารถและคุณธรรมท่ีสัมพนัธ์กบัอาชีพ
ตามความสนใจเป็นแนวทางในการพฒันาอาชีพ และมีเจตคติท่ีดีต่ออาชีพ   

 
รหัสตัวช้ีวดั 
 ง 1.1 ป.6/1, ป.6/2, ป.6/3  
 ง 2.1  ป.6/1, ป.6/2, ป.6/3   
 ง 3.1  ป.6/1, ป.6/2, ป.6/3, ป.6/4, ป.6/5 
 ง 4.1  ป.6/1, ป.6/2 

รวมทั้งหมด  13  ตัวช้ีวดั  
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ตัวช้ีวดั  สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 
 

สาระที ่1  การด ารงชีวติและครอบครัว   
มาตรฐาน ง 1.1  เขา้ใจการท างาน มีความคิดสร้างสรรค ์มีทกัษะกระบวนการท างาน ทกัษะการจดัการ 

ทกัษะกระบวนการแกปั้ญหา ทกัษะการท างานร่วมกนั และทกัษะการแสวงหาความรู้  
มีคุณธรรม และลกัษณะนิสัยในการท างาน มีจิตส านึกในการใชพ้ลงังาน ทรัพยากร 
และส่ิงแวดลอ้ม เพื่อการด ารงชีวติและครอบครัว 

 
ตัวช้ีวดั สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 

1. อภิปรายแนวทางในการท างาน  
    และปรับปรุงการท างานแต่ละ   
    ขั้นตอน 
2. ใชท้กัษะการจดัการในการท างาน  
     และมีทกัษะการท างานร่วมกนั 
3. ปฏิบติัตนอยา่งมีมารยาทในการ 
    ท างานกบัครอบครัวและผูอ่ื้น 

 การท างานและการปรับปรุงการท างาน เช่น 
- การดูแลรักษาสมบติัภายในบา้น 
- การปลูกไมด้อก หรือ ไมป้ระดบั หรือปลูกผกั หรือ
เล้ียงปลาสวยงาม 

- การบนัทึกรายรับ – รายจ่ายของหอ้งเรียน 
- การจดัเก็บเอกสารการเงิน                             

 การจดัการในการท างานและทกัษะการท างานร่วมกนั 
เช่น 
- การเตรียม ประกอบ จดัอาหารใหส้มาชิกในครอบครัว 
- การติดตั้ง  ประกอบของใชใ้นบา้น 

     - การประดิษฐข์องใช ้ ของตกแต่ง  โดยใชว้สัดุใน  
        ทอ้งถ่ินใหส้มาชิกในครอบครัวหรือเพื่อนในโอกาส  
        ต่าง ๆ                        
   มารยาท  เช่น 

- การท างานกบัสมาชิกในครอบครัวและผูอ่ื้น                       
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สาระที ่2 การออกแบบและเทคโนโลยี 
มาตรฐาน ง 2.1  เขา้ใจเทคโนโลยแีละกระบวนการเทคโนโลยี ออกแบบและสร้างส่ิงของเคร่ืองใช ้ 
                        หรือวธีิการ ตามกระบวนการเทคโนโลยอียา่งมีความคิดสร้างสรรค ์เลือกใช ้
                        เทคโนโลยใีนทางสร้างสรรคต่์อชีวติ สังคม ส่ิงแวดลอ้ม และมีส่วนร่วมในการ 
                        จดัการเทคโนโลย ีท่ีย ัง่ยนื 
 

 
 
 
 
 

ตัวช้ีวดั สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 
1. อธิบายส่วนประกอบของระบบ 
    เทคโนโลย ี
2. สร้างส่ิงของเคร่ืองใชต้ามความ 
    สนใจ อยา่งปลอดภยั โดยก าหนด 
    ปัญหา หรือ ความตอ้งการ   
    รวบรวมขอ้มูล เลือก วธีิการ   
    ออกแบบโดย ถ่ายทอดความคิด  
    เป็นภาพร่าง 3 มิติ หรือแผนท่ี  
    ความคิด  ลงมือสร้าง และ        
    ประเมินผล 
3. น าความรู้และทกัษะการสร้าง 
    ช้ินงานไป ประยกุตใ์นการสร้าง 
    ส่ิงของ เคร่ืองใช ้
 

 ระบบเทคโนโลยี ประกอบดว้ย ตวัป้อน (Input)  
กระบวนการ (Process) และผลลพัธ์ (Output) 

 การสร้างส่ิงของเคร่ืองใช ้ อยา่งเป็นขั้นตอนตั้งแต่
ก าหนดปัญหา หรือความตอ้งการ รวบรวมขอ้มูล 
เลือกวธีิการ ออกแบบโดยถ่ายทอดความคิดเป็นภาพ
ร่าง  3 มิติ  หรือแผนท่ีความคิด ก่อนลงมือสร้าง และ
ประเมินผล ท าใหผู้เ้รียนท างานอยา่งเป็น
กระบวนการ 

 ภาพร่าง  3 มิติ  ประกอบดว้ย  ดา้นกวา้ง  ดา้นยาว   
    และดา้นสูง เป็นการถ่ายทอดความคิดหรือ
จินตนาการ 

 แผนท่ีความคิด เป็นการล าดบัความคิดใหเ้ห็นเป็น
ขั้นตอน  และเป็นการถ่ายทอดความคิดหรือ
จินตนาการรูปแบบหน่ึง 

 ทกัษะการเจาะเป็นความสามารถพื้นฐานในการ
สร้างช้ินงานอีกดา้นหน่ึง  ซ่ึงเกิดจากการฝึกฝนจน
สามารถปฏิบติังานไดค้ล่องแคล่ว รวดเร็ว 
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สาระที ่3 เทคโนโลยสีารสนเทศและการส่ือสาร 

ตัวช้ีวดั สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 
1. บอกหลกัการเบ้ืองตน้ของการ 
    แกปั้ญหา 
2. ใชค้อมพิวเตอร์ในการคน้หาขอ้มูล 
3. เก็บรักษาขอ้มูลท่ีเป็นประโยชน์ใน 
    รูปแบบต่างๆ 
4. น าเสนอขอ้มูลในรูปแบบท่ี  
    เหมาะสม โดยเลือกใชซ้อฟตแ์วร์  
    ประยกุต ์
5. ใชค้อมพิวเตอร์ช่วยสร้างช้ินงาน  
    จากจินตนาการหรืองานท่ีท าใน 
    ชีวติประจ าวนัอยา่งมีจิตส านึก   
    และความรับผดิชอบ 

  หลกัการเบ้ืองตน้ของการแกปั้ญหา  
     -   พิจารณาปัญหา -   วางแผนแกปั้ญหา 
     -   แกปั้ญหา  -   ตรวจสอบและปรับปรุง 
  การใช้คอมพิวเตอร์ในการคน้หาขอ้มูล  เช่น คน้หา 
    ข้อมูลในเคร่ืองคอมพิวเตอร์ ค้นหาข้อมูลจาก 
    อินเทอร์เน็ต  คน้หาขอ้มูลจากซีดีรอม 
  การเก็บรักษาขอ้มูลในรูปแบบต่างๆ  

-   ส าเนาถาวร  เช่น  เอกสาร แฟ้มสะสมงาน 
-   ส่ือบนัทึก   เช่น เทป แผน่บนัทึก ซีดีรอม   

  หน่วยความจ าแบบแฟลช 
 การจดัท าขอ้มูลเพื่อการน าเสนอ รูปแบบของ 
  ขอ้มูลใหเ้หมาะสมกบัการส่ือ ความหมายท่ีเขา้ใจ 
  ง่ายและชดัเจน เช่น กราฟ ตาราง แผนภาพ รูปภาพ  

 การใช้ซอฟต์แวร์น าเสนอ เช่น การสร้างสไลด์         
      การตกแต่งสไลด ์การก าหนดเทคนิคพิเศษ 
 การเลือกใชซ้อฟตแ์วร์ประยกุตใ์หเ้หมาะสมกบั 
 รูปแบบการน าเสนอ เช่น น าเสนอรายงานเอกสาร 
    โดยใชซ้อฟตแ์วร์ ประมวลค า น าเสนอแบบบรรยาย  
    โดยใชซ้อฟตแ์วร์น าเสนอ 
 การสร้างช้ินงานต้องมีการวางแผนงานและการ 
      ออกแบบอยา่งสร้างสรรค ์ 
 ใช้คอมพิวเตอร์ช่วยสร้างช้ินงาน เช่น แผ่นพับ           
       ป้ายประกาศ เอกสารแนะน า ช้ินงาน สไลด ์
       น าเสนอ ขอ้มูล โดยมีการอา้งอิงแหล่งขอ้มูล ใช ้
       ทรัพยากร อย่างคุม้ค่า ไม่คดัลอกผลงานผูอ่ื้น ใช ้
      ค  าสุภาพและไม่สร้างความเสียหายต่อผูอ่ื้น 



 

100 
 

  

 

มาตรฐาน ง 3.1 เขา้ใจ เห็นคุณค่า และใชก้ระบวนการเทคโนโลยีสารสนเทศในการสืบคน้ขอ้มูลการ   
  เรียนรู้ การส่ือสาร การแกปั้ญหา การท างาน และอาชีพอยา่งมีประสิทธิภาพ ประสิทธิผล  
  มีคุณธรรม  

สาระที ่4 การอาชีพ   
มาตรฐาน ง 4.1  เขา้ใจ มีทกัษะท่ีจ าเป็นมีประสบการณ์เห็นแนวทางในงานอาชีพ  ใชเ้ทคโนโลย ี
  เพื่อพฒันาอาชีพ  มีคุณธรรม และมีเจตคติท่ีดีต่ออาชีพ 
 

ตัวช้ีวดั สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 
 1.  ส ารวจตนเองเพื่อวางแผนในการเลือก 
      อาชีพ 
 2. ระบุความรู้  ความสามารถ   และ 
     คุณธรรมท่ีสัมพนัธ์กบัอาชีพท่ีสนใจ 

  การส ารวจตนเอง 
          -  ความสนใจ  ความสามารถ และทกัษะ 
  คุณธรรมในการประกอบอาชีพ  เช่น 
         -  ความซ่ือสัตย ์
         -  ความขยนั  อดทน 
         -   ความยติุธรรม 
         -  ความรับผิดชอบ                
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วเิคราะห์ตัวช้ีวดัและสาระการเรียนรู้แกนกลางการศึกษาข้ันพืน้ฐาน พุทธศักราช  2551 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีวชิาคอมพวิเตอร์ ช้ันประถมศึกษาปีที่ 6 

    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

สาระที่ 1 การด ารงชีวติและครอบครัว 
1.1 อภิปรายแนวทางในการท างานและปรับปรุงการท างานแต่ละ  ขั้นตอน    
1.2 ใชท้กัษะการจดัการในการท างาน และมีทกัษะการท างานร่วมกนั   
1.3 ปฏิบติัตนอยา่งมีมารยาทในการท างานกบัครอบครัวและผูอ่ื้น        
 
 

วชิา 
คอมพวิเตอร์ 

สาระที่ 2 การออกแบบและเทคโนโลยี 
2.1 อธิบายส่วนประกอบของระบบเทคโนโลยี   
2.2 สร้างส่ิงของเคร่ืองใช้ตามความสนใจ อย่างปลอดภัย โดยก าหนด 
      ปัญหา หรือความตอ้งการ รวบรวมขอ้มูล เลือกวิธีการ ออกแบบโดย 
      ถ่ายทอดความคิดเป็นภาพร่าง 3 มิติ หรือแผนท่ีความคิด ลงมือสร้าง  
      และ ประเมินผล   
2.3 น าความรู้และทกัษะการสร้างช้ินงานไป ประยุกต์ในการสร้างส่ิงของ 
      เคร่ืองใช ้
 
สาระที่ 3 เทคโนโลยสีารสนเทศและการส่ือสาร 
3.1 บอกหลกัการเบ้ืองตน้ของการแกปั้ญหา     
3.2 ใชค้อมพิวเตอร์ในการคน้หาขอ้มลู  
3.3 เกบ็รักษาขอ้มลูท่ีเป็นประโยชน์ในรูปแบบต่างๆ 
3.4 น าเสนอขอ้มูลในรูปแบบท่ีเหมาะสม โดยเลือกใชซ้อฟต์แวร์ประยุกต์   
3.5 ใช้คอมพิวเตอร์ช่วยสร้างช้ินงานจากจินตนาการหรืองานท่ีท าใน 
      ชีวิตประจ าวนัอยา่งมีจิตส านึก และความรับผิดชอบ 
 
 สาระที่ 4 การอาชีพ 
4.1 ส ารวจตนเองเพ่ือวางแผนในการเลือกอาชีพ 
4.2 ระบุความรู้ ความสามารถ และคุณธรรมท่ีสมัพนัธ์กบัอาชีพท่ีสนใจ 
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วเิคราะห์หน่วยการเรียนรู้ตามมาตรฐานการเรียนรู้ / ตัวช้ีวดั 
กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีวชิาคอมพิวเตอร์ ชั้นประถมศึกษาปีท่ี 6      

จากโรงเรียนต่างๆ ของส านกังานเขตพื้นท่ีการศึกษาประถมศึกษากรุงเทพมหานครเขต 1  
จ  านวน 25 โรงเรียน ซ่ึงมีผลสรุปความคิดเห็นไปในทิศทางเดียวกนัใหเ้ลือกท าการสอนบนเวบ็รายวิชา 
คอมพิวเตอร์ ชั้นประถมศึกษาปีท่ี 6  ซ่ึงผูว้จิยัวเิคราะห์ สาระการเรียนรู้ท่ี 3 เทคโนโลยีสารสนเทศและ
การส่ือสาร เน่ืองจากผลการส ารวจความคิดเห็นของผูเ้ช่ียวชาญทางดา้นเน้ือหาของครูคอมพิวเตอร์     
ท่ีอยูใ่นสารการเรียนรู้ท่ี 3  หวัขอ้ท่ี 3.5 ใชค้อมพิวเตอร์ช่วยสร้างช้ินงานจากจินตนาการหรืองานท่ีท า
ในชีวติประจ าวนัอยา่งมีจิตส านึกดว้ยความรับผิดชอบโดยไดว้ิเคราะห์หน่วยการเรียนรู้ตามมาตรฐาน 
การเรียนรู้ / ตวัช้ีวดั กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี วิชา คอมพิวเตอร์ชั้ น
ประถมศึกษาปีท่ี 6  ตามหลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศกัราช 2551 ดงัรายละเอียด
ต่อไปน้ี 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

มาตรฐาน 
การเรียนรู้ / ตัวช้ีวดั 

สาระส าคัญ/ 
ความคิดรวบยอด 

เวลา  
ช่ัวโมง 

น า้หนัก
คะแนน 

ภาระงาน / 
ช้ินงานรวบยอด 

ง 3.1    ป.6/5 
 

ใชค้อมพิวเตอร์ช่วยสร้างช้ินงาน
จากจินตนาการอยา่งมีจิตส านึก
ดว้ยความรับผิดชอบ 

8 20 - ใบงาน 

- แบบทดสอบ 
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โครงสร้างรายวชิา หน่วยการเรียนรู้ที ่4 การสร้างเวบ็เพจด้วยโปรแกรมดรีมวฟีเวอร์ CS6 
กลุ่มสาระการเรียนรู้  การงานอาชีพและเทคโนโลย ี รหสัวชิา ง 16101   

รายวชิาคอมพิวเตอร์  ชั้นประถมศึกษาปีท่ี 6     
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

แผนการจัดการเรียนรู้ที่ 2  
การใส่ขอ้ความและแทรกภาพลงในเวบ็เพจ 
เร่ืองท่ี 2.1  วิธีการใส่ขอ้ความและตกแต่งขอ้ความในเวบ็เพจ                 
เร่ืองท่ี 2.2  วิธีการจดัการกบัภาพ 
 
 

หน่วยการเรียนรู้ที ่4 
การสร้างเวบ็เพจดว้ย

โปรแกรม 
ดรีมวฟีเวอร์ 

 

แผนการจัดการเรียนรู้ที่ 1  
รู้จกักบัโปรแกรมดรีมวีฟเวอร์ CS6 
เร่ืองท่ี 1.1 การใชง้านโปรแกรมดรีมวีฟเวอร์ CS6 
เร่ืองท่ี 1.2 หลกัการท างาน ส่วนประกอบ และการน าไปใชข้อง 
                 โปรแกรมดรีมวีฟเวอร์ CS6 
 
 

แผนการจัดการเรียนรู้ที่ 3  
การแทรกตารางในเวบ็เพจ 
เร่ืองท่ี 3.1 รู้จกักบัตารางและวิธีการแทรกตาราง 
เร่ืองท่ี 3.2 การก าหนดคุณสมบติัของตาราง 
 
 แผนการจัดการเรียนรู้ที่ 4  

  การแทรกมลัติมิเดียลงในเวบ็เพจ 
เร่ืองท่ี 4.1 วิธีการแทรกไฟลม์ลัติมิเดีย  
เร่ืองท่ี 4.2 การก าหนดคุณสมบติัของมลัติมิเดีย 
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ก าหนดการสอนรายช่ัวโมง 
 หน่วยการเรียนรู้ท่ี 4 การสร้างเวบ็เพจดว้ยโปรแกรมดรีมวฟีเวอร์ CS6 
กลุ่มสาระการเรียนรู้  การงานอาชีพและเทคโนโลย ี รหสัวชิา ง 16101 

 รายวชิาคอมพิวเตอร์  ชั้นประถมศึกษาปีท่ี 6 เวลา  8  ชัว่โมง 
หน่วย 

การเรียนรู้ 
แผนการจัดการเรียนรู้ 

เวลา 
(ช่ัวโมง) 

หน่วย 
การเรียนรู้ 

ท่ี 4 
 

1. รู้จกักบัโปรแกรมดรีมวฟีเวอร์ CS6  
เร่ืองท่ี 1.1 การใชง้านโปรแกรมดรีมวฟีเวอร์ CS6 1 
เร่ืองท่ี 1.2 หลกัการท างาน ส่วนประกอบ และการน าไปใชข้อง
โปรแกรมดรีมวฟีเวอร์ CS6 

1 

2.การใส่ขอ้ความและแทรกภาพลงในเวบ็เพจ  
เร่ืองท่ี 2.1 วธีิการใส่ขอ้ความและตกแต่งขอ้ความในเวบ็เพจ                 1 
เร่ืองท่ี 2.2 วธีิการจดัการกบัภาพ 1 
3. การแทรกตารางในเวบ็เพจ   
เร่ืองท่ี 3.1 รู้จกักบัตารางและวธีิการแทรกตาราง 1 
เร่ืองท่ี 3.2 การก าหนดคุณสมบติัของตาราง 1 

   4. การแทรกมลัติมิเดียลงในเวบ็เพจ  
เร่ืองท่ี 4.1 วธีิการแทรกไฟลม์ลัติมิเดีย 1 
เร่ืองท่ี 4.2 การก าหนดคุณสมบติัของมลัติมิเดีย 1 
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การวเิคราะห์วตัถุประสงค์เชิงพฤติกรรม 
แผนการจดัการเรียนรู้ท่ี 1 รู้จกักบัโปรแกรมดรีมวฟีเวอร์ CS6 

 
สาระส าคัญ/ความคิดรวบยอด 
             การใช้งานโปรแกรมดรีมวีฟเวอร์ CS6 จะตอ้งศึกษาหลกัการท างานและส่วนประกอบของ
โปรแกรมดรีมวีฟเวอร์ CS6 ให้เข้าใจเพื่อท่ีจะสามารถใช้ในการสร้างช้ินงานทางคอมพิวเตอร์ได้
เหมาะสมและน่าสนใจ 
 

จุดประสงค์การเรียนรู้เชิงพฤติกรรม สาระการเรียนรู้ 
เวลา 

(2 ช่ัวโมง) 
1) รู้และเขา้ใจหนา้ท่ีของการท างานใน 
    ส่วนประกอบของโปรแกรม 
    ดรีมวฟีเวอร์ CS6 ไดอ้ยา่ง 
     ถูกตอ้ง 
2) ใชค้  าสั่งต่างๆของโปรแกรม 
    ดรีมวฟีเวอร์ CS6 ไดเ้หมาะสม 
     กบัขอ้มูลท่ีจะน าเสนอช้ินงาน ไดอ้ยา่ง
ถูกตอ้ง 
3) น าโปรแกรมดรีมวฟีเวอร์ CS6 
    ไปใชใ้นชีวติประจ าวนัไดอ้ยา่งถูกตอ้ง 
    เหมาะสม 

เร่ืองท่ี 1.1 การใชง้านโปรแกรม ดรีมวฟี
เวอร์ CS6 

1 

เร่ืองท่ี 1.2 หลกัการท างาน ส่วนประกอบ 
และการน าไปใชข้องโปรแกรม ดรีมวฟี
เวอร์ CS6 

1 
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การวเิคราะห์วตัถุประสงค์เชิงพฤติกรรม 
แผนการจดัการเรียนรู้ท่ี 2  การใส่ขอ้ความและแทรกภาพลงในเวบ็เพจ 

 
สาระส าคัญ/ความคิดรวบยอด 

          การสร้างและตกแต่งรูปภาพดว้ยโปรแกรมดรีมวฟีเวอร์ CS6  ใหถู้กตอ้ง เหมาะสมกบัขอ้มูลท่ี
ตอ้งการน าเสนอในช้ินงาน 
 

จุดประสงค์การเรียนรู้เชิงพฤติกรรม สาระการเรียนรู้ 
เวลา 

(2 ช่ัวโมง) 

1) รู้และเขา้ใจหลกัการใส่ขอ้ความ การ  
    แทรกภาพดว้ยโปรแกรม ดรีมวฟีเวอร์  
    CS6 ไดอ้ยา่งถูกตอ้ง 
2) ใชค้  าสั่งการแทรกรูปภาพในโปรแกรม 
     ดรีมวฟีเวอร์ CS6  ไดอ้ยา่งถูกตอ้ง 
3) น าความรู้เก่ียวกบัการแทรกรูปภาพใน 
     โปรแกรมดรีมวฟีเวอร์ CS6  
    ไปใชใ้นชีวติประจ าวนัไดอ้ยา่งเหมาะสม 

เร่ืองท่ี 2.1 วธีิการใส่ขอ้ความและ
ตกแต่งขอ้ความในเวบ็เพจ 

1 

เร่ืองท่ี 2.2 วธีิการจดัการกบัภาพ 1 
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การวเิคราะห์วตัถุประสงค์เชิงพฤติกรรม 
แผนการจดัการเรียนรู้ท่ี 3  การแทรกตารางในเวบ็เพจ 

 

สาระส าคัญ/ความคิดรวบยอด 

          การแทรกตาราง การเพิ่มแถว คอลมัน์ของตาราง การปรับขนาดตารางให ้เหมาะสมกบัขอ้มูลท่ี
ตอ้งการน าเสนอในช้ินงาน 
 

จุดประสงค์การเรียนรู้เชิงพฤติกรรม สาระการเรียนรู้ 
เวลา 

(2ช่ัวโมง) 
1) รู้และเขา้ใจหลกัการแทรกตารางดว้ย 
    โปรแกรม ดรีมวฟีเวอร์ CS6 ไดอ้ยา่ง 
     ถูกตอ้ง 
2) ใชค้  าสั่งการแทรกตารางในโปรแกรม 
     ดรีมวฟีเวอร์ CS6  ไดอ้ยา่งถูกตอ้ง 
3) น าความรู้เก่ียวกบัการแทรกตารางใน 
     โปรแกรมดรีมวฟีเวอร์ CS6  
    ไปใชใ้นชีวติประจ าวนัไดอ้ยา่ง 
     เหมาะสม 

เร่ืองท่ี 3.1 รู้จกักบัตารางและวธีิการ
แทรกตาราง 

1 

เร่ืองท่ี 3.2 การก าหนดคุณสมบติัของ
ตาราง 

1 
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การวเิคราะห์วตัถุประสงค์เชิงพฤติกรรม 
แผนการจดัการเรียนรู้ท่ี 4  การแทรกมลัติมิเดียลงในเวบ็เพจ 

                                                                                       
สาระส าคัญ/ความคิดรวบยอด 

          การแทรกมลัติมิเดีย การปรับค่าการเล่น และขนาดของมลัติมิเดีย ให้เหมาะสมกบัขอ้มูลท่ี
ตอ้งการน าเสนอในช้ินงาน 
 

จุดประสงค์การเรียนรู้เชิงพฤติกรรม สาระการเรียนรู้ 
เวลา 

(ช่ัวโมง) 
1) รู้และเขา้ใจหลกัการแทรกมลัติมิเดีย  
    ดว้ยโปรแกรม ดรีมวฟีเวอร์ CS6     
    ไดอ้ยา่งถูกตอ้ง 
2) ใชค้  าสั่งการแทรกมลัติมิเดียในโปรแกรม 
     ดรีมวฟีเวอร์ CS6  ไดอ้ยา่งถูกตอ้ง 
3) น าความรู้เก่ียวกบัการแทรกมลัติมิเดียใน 
     โปรแกรมดรีมวฟีเวอร์ CS6  
    ไปใชใ้นชีวติประจ าวนัไดอ้ยา่ง 
     เหมาะสม 
 

เร่ืองท่ี 4.1 วธีิการแทรกไฟลม์ลัติมิเดีย 1 
เร่ืองท่ี 4.2 การก าหนดคุณสมบติัของมลั
ติมิเดีย 

1 
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ภาคผนวก ค 
แผนการจดัการเรียนรู้กลุ่มสาระการงานอาชีพและเทคโนโลย ีวชิาคอมพวิเตอร์ 

ระดบัช้ันประถมศึกษาปีที่ 6
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แผนการจัดการเรียนรู้ที ่1 

 
หน่วยการเรียนรู้ที ่ 4  การสร้างเวบ็เพจด้วยโปรแกรมดรีมวฟีเวอร์ CS6     
เร่ือง รู้จักกบัโปรแกรมดรีมวีฟเวอร์ CS6              เวลาเรียน 2 ช.ม. 
สอนวนัที ่.........เดือน ................................. พ.ศ.2558           ภาคเรียนที ่2/2558 
 
1. สาระส าคัญ/ความคิดรวบยอด 
             การใช้งานโปรแกรมดรีมวีฟเวอร์ CS6 จะตอ้งศึกษาหลกัการท างานและส่วนประกอบของ
โปรแกรมดรีมวีฟเวอร์ CS6 ให้เข้าใจเพื่อท่ีจะสามารถใช้ในการสร้างช้ินงานทางคอมพิวเตอร์ได้
เหมาะสมและน่าสนใจ 
 
2. ตัวช้ีวดั/จุดประสงค์การเรียนรู้ 
 2.1 ตัวช้ีวดั  
  ง 3.1 ป 6/5 ใช้คอมพิว เตอร์ ช่วยสร้าง ช้ินงานจากจินตนาการหรืองานท่ีท าใน
ชีวติประจ าวนัอยา่งมีจิตส านึกและความรับผดิชอบ 
 2.2 จุดประสงค์การเรียนรู้ 
  1. รู้และเขา้ใจหนา้ท่ีของการท างานในส่วนประกอบของโปรแกรมดรีมวีฟเวอร์ CS6 ไดอ้ยา่ง
ถูกตอ้ง 
  2. ใชค้  าสั่งต่างๆของโปรแกรมดรีมวีฟเวอร์ CS6 ไดเ้หมาะสมกบัขอ้มูลท่ีจะน าเสนอช้ินงาน   
ไดอ้ยา่งถูกตอ้ง 
  3. น าโปรแกรมดรีมวฟีเวอร์ CS6ไปใชใ้นชีวติประจ าวนัไดอ้ยา่งถูกตอ้งเหมาะสม 
 
3. สาระการเรียนรู้ 
 3.1 สาระการเรียนรู้แกนกลาง 

1. การสร้างช้ินงานตอ้งมีการวางแผนงานและการ ออกแบบอยา่งสร้างสรรค ์ 
2. ใชค้อมพิวเตอร์ช่วยสร้างช้ินงาน เช่น แผน่พบั  ป้ายประกาศ เอกสารแนะน าช้ินงาน สไลด์

น าเสนอ ขอ้มูล โดยมีการอา้งอิงแหล่งขอ้มูล ใช้ ทรัพยากร อยา่งคุม้ค่า ไม่คดัลอกผลงานผูอ่ื้น ใช้ค  า
สุภาพและไม่สร้างความเสียหายต่อผูอ่ื้น 
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4. กจิกรรมการเรียนรู้ 
     ข้ันน าเข้าสู่บทเรียน 
  1. น าเขา้สู่บทเรียนโดยการกระตุน้เร้าดว้ยการให้นกัเรียนศึกษาวิธีการสร้างเวบ็เพจโดยใช้
โปรแกรมดรีมวีฟเวอร์ CS6 จาก Youtube เพื่อให้นกัเรียนมีความกระตือรือร้น เกิดความสนใจใน
บทเรียน 
      2. นกัเรียนเขา้ไปศึกษา หอ้งเรียนเสมือนจริง ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 โดยศึกษา
ขั้นตอนวธีิการเขา้ใชง้าน www.wikispace.com จากคู่มือการใชง้าน 
       3. นกัเรียนดูวีดีโอ สาธิตวิธีการสร้างเวบ็เพจโดยใช้โปรแกรมดรีมวีฟเวอร์ CS6 เพื่อกระตุน้
ใหน้กัเรียนเกิดความสนใจ 
  4.  นักเรียนท าแบบทดสอบก่อนเรียน เร่ือง การสร้างเว็บเพจด้วยโปรแกรมดรีมวีฟเวอร์
จ านวน 30 ขอ้ 

ขั้นด าเนินกจิกรรมการสอนด้วยห้องเรียนเสมือนจริง 
การด าเนินกิจกรรมการสอนด้วยห้องเรียนเสมือนจริงในทุกขั้นตอน นักเรียนจะมีการ

แลกเปล่ียนเรียนรู้กบัเพื่อนร่วมเรียนรู้ และขอค าแนะน าจากครู ผา่นทางห้องสนทนาอิเล็กทรอนิกส์ 
(Chat Room) และกระดานเสวนา (Webboard) และผา่นวดีิโอคอลทางแอพพลิเคชัน่ไลน์โดยมีขั้นตอน
ดงัน้ี 

2.1 เลือกและระบุกิจกรรมท่ีตอ้งการเรียนรู้ 
      2.1.1 นกัเรียน Download กิจกรรมพร้อมทั้งแบบบนัทึกผลการปฏิบติักิจกรรม เร่ือง 

หลกัการท างานเบ้ืองตน้ของโปรแกรมดรีมวีฟเวอร์ CS6 แล้วท าการศึกษาเพื่อท าความเขา้ใจกบั
กิจกรรม 

2.1.2 นักเรียนเลือกศึกษาเน้ือหาของบทเรียนตามท่ีตนเองสนใจ จากบทเรียนท่ี
ก าหนดให ้แลว้บนัทึกลงในสมุด 

2.2 ก าหนดเป้าหมายการเรียนรู้ นกัเรียนก าหนดเป้าหมายของการเรียนรู้ แลว้บนัทึกลงใน
สมุด ส าหรับการก าหนดเป้าหมายการเรียนรู้ ใหน้กัเรียนระบุวา่นกัเรียนตอ้งการเรียนรู้อะไร เช่น 

          2.2.1 เพื่อศึกษาหนา้ท่ีของการท างานในส่วนประกอบของโปรแกรมดรีมวฟีเวอร์ CS6 
          2.2.2 เพื่อศึกษาค าสั่งต่างๆของโปรแกรมดรีมวฟีเวอร์ CS6 

2.3 วางแผนการเรียนรู้ 
      2.3.1 นกัเรียนระบุขั้นตอนการปฏิบติักิจกรรม ลงในใบงานท่ี 1 โดยใหร้ะบุวา่นกัเรียนมี

วธีิการศึกษา สืบคน้อยา่งไร เพื่อตอบค าถามจากใบงานท่ีก าหนดให ้



 

112 
 

  

 

          2.3.2 นกัเรียนศึกษาเกณฑ์การประเมินผลการเรียนรู้ โดยท่ีเกณฑ์การประเมินผลท่ี
นกัเรียนตอ้งประเมิน ประกอบไปดว้ย 3 องคป์ระกอบ ไดแ้ก่ 1) การเรียนรู้ดว้ยห้องเรียนเสมือนจริง 2) 
กิจกรรมการเรียนรู้ และ 3) พฤติกรรมการเรียนรู้ของนกัเรียน 

2.4  เรียนรู้ตามแผนการเรียนรู้ 
          2.4.1 นกัเรียนเรียนรู้ตามแผนการเรียนรู้ โดยเร่ิมจากศึกษาเน้ือหาจากห้องเรียนเมือน

จริง เร่ือง การสร้างเวบ็เพจดว้ยโปรแกรมดรีมวีฟเวอร์ CS6  หลงัจากศึกษาจนไดค้  าตอบของกิจกรรม 
ใหน้กัเรียนบนัทึกผลลงในใบงานท่ี 1 ใหค้รบทุกขอ้ 

          2.4.2 ประเมินผลงานการเรียนรู้ของตนเองตามเกณฑ์ท่ีนกัเรียนไดก้ าหนดไว ้ ลงใน
แบบบนัทึกกิจกรรมการเรียนรู้ แลว้น าเสนอผลงานการเรียนรู้ โดยการอพัโหลดใบงานท่ี 1 ส่งใน   
www.wikispace.com 

   2.5 สรุปผลการเรียนรู้ 
          นกัเรียนร่วมกนัสรุปบทเรียน เร่ือง การสร้างเวบ็เพจดว้ยโปรแกรมดรีฟวีฟเวอร์ CS6 

พร้อมทั้งร่วมแลกเปล่ียนเรียนรู้กบัเพื่อนร่วมเรียนรู้และผูส้อน 
2.6 ประเมินผลการเรียนรู้ 

          2.6.1 ผูส้อนท าการประเมินผลงานการเรียนรู้ของนกัเรียน พร้อมทั้งให้ขอ้เสนอแนะกบั
นกัเรียน เพื่อท่ีนกัเรียนจะไดน้ าไปปรับปรุงผลงานการเรียนรู้ 

          2.6.2 นกัเรียนปรับปรุงผลงานการเรียนรู้ตามขอ้เสนอแนะของผูส้อน 
 

5.  ส่ือ/แหล่งเรียนรู้ 
 5.1 ส่ือการเรียนรู้ 
  5.1.1 ห้องเรียนเสมือนจริง  วิชาคอมพิวเตอร์ ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6   
  5.1.2 ใบงานท่ี 1 เร่ือง การสร้างโฟลเดอร์และไซต ์  
 5.2 แหล่งการเรียนรู้ 
  -   หอ้งปฏิบติัการคอมพิวเตอร์ 
 
 
 
 
 



 

113 
 

  

 

6. การวดัและประเมินผล 

วธีิการ เคร่ืองมือ เกณฑ์ 
ตรวจแบบทดสอบก่อนเรียน  แบบทดสอบก่อนเรียน  (ประเมินตามสภาพจริง) 
ตรวจใบงานท่ี 1 ใบงานท่ี 1 ร้อยละ 60 ผา่นเกณฑ์ 
ตรวจแบบบนัทึกกิจกรรม 
การเรียนรู้ 

แบบบนัทึกกิจกรรมการเรียนรู้ ระดบัคุณภาพ 2  
ผา่นเกณฑ ์
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ใบงานที ่1 เร่ือง การสร้างโฟลเดอร์และไซต์ 
ค าช้ีแจง ให้นกัเรียนสร้าง Folder ช่ือ student_1_(ช่ือเล่น) ใน My Document และสร้าง Site ช่ือ 
web_1_(ช่ือเล่น) 
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ผลการประเมินการปฏิบัติกจิกรรม 
 
ค าช้ีแจง ใหน้กัเรียนประเมินผลการปฏิบติักิจกรรมของนกัเรียน โดยท าเคร่ืองหมาย � ตามเกณฑท่ี์ 
ก าหนดไว ้

1) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ดว้ยหอ้งเรียนเสมือนจริง 
� ดี   � พอใช ้ � ปรับปรุง 

   2) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ 
� ดี   � พอใช ้ � ปรับปรุง 

 
เกณฑ์การประเมินผลการปฏิบัติกจิกรรม 

       1. เกณฑ์การประเมินผลการปฏิบัติกจิกรรมการสอนด้วยการเรียนรู้ด้วยห้องเรียนเสมือนจริง 
       ดี       หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมผา่นหอ้งเรียนเสมือนจริง 
      ไดถู้กตอ้งทุกขั้นตอน 

                   พอใช ้ หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมผา่นห้องเรียนเสมือนจริง 
       ไดถู้กตอ้งบางขั้นตอน 
                ปรับปรุง หมายถึง นกัเรียนไม่สามารถปฏิบติักิจกรรมผา่นหอ้งเรียนเสมือนจริงได ้
       2. เกณฑ์การประเมินผลการปฏิบัติกจิกรรมการเรียนรู้ 

       ดี        หมายถึง   นกัเรียนสามารถตอบค าถามจากกิจกรรมไดถู้กตอ้งทุกขอ้ 
                 พอใช ้    หมายถึง  นกัเรียนสามารถตอบค าถามจากกิจกรรมไดถู้กตอ้งเพียงบางขอ้ 
               ปรับปรุง   หมายถึง  นกัเรียนสามารถตอบค าถามจากกิจกรรมไดไ้ม่ถูกตอ้ง 
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แผนการจัดการเรียนรู้ที ่2 

 
หน่วยการเรียนรู้ที ่ 4 การสร้างเวบ็เพจด้วยโปรแกรมดรีมวฟีเวอร์ CS6     
เร่ือง การใส่ข้อความและแทรกภาพลงในเวบ็เพจ       เวลาเรียน 2  ช.ม. 
สอนวนัที ่.........เดือน ................................. พ.ศ.2558      ภาคเรียนที ่ 2/2558 
 
1. สาระส าคัญ/ความคิดรวบยอด 
          การสร้างและตกแต่งรูปภาพดว้ยโปรแกรมดรีมวีฟเวอร์ CS6  ให้ถูกตอ้ง เหมาะสมกบัขอ้มูลท่ี
ตอ้งการน าเสนอในช้ินงาน 
 
2. ตัวช้ีวดั/จุดประสงค์การเรียนรู้ 
 2.1 ตัวช้ีวดั  
  ง 3.1 ป 6/5 ใช้คอมพิว เตอร์ ช่วยสร้าง ช้ินงานจากจินตนาการหรืองานท่ีท าใน
ชีวติประจ าวนัอยา่งมีจิตส านึกและความรับผดิชอบ 
 2.2 จุดประสงค์การเรียนรู้ 
  1. รู้และเขา้ใจหลกัการใส่ขอ้ความ การแทรกภาพดว้ยโปรแกรม ดรีมวีฟเวอร์ CS6 ไดอ้ย่าง
ถูกตอ้ง 
  2. ใชค้  าสั่งการแทรกรูปภาพในโปรแกรมดรีมวฟีเวอร์ CS6  ไดอ้ยา่งถูกตอ้ง 
  3. น าความรู้เก่ียวกบัการแทรกรูปภาพในโปรแกรมดรีมวีฟเวอร์ CS6 ไปใชใ้นชีวิตประจ าวนั
ไดอ้ยา่งเหมาะสม 
 
3. สาระการเรียนรู้ 
 3.1 สาระการเรียนรู้แกนกลาง 

1. การสร้างช้ินงานตอ้งมีการวางแผนงานและการ ออกแบบอยา่งสร้างสรรค ์ 
2. ใชค้อมพิวเตอร์ช่วยสร้างช้ินงาน เช่น แผน่พบั  ป้ายประกาศ เอกสารแนะน าช้ินงาน สไลด์

น าเสนอ ขอ้มูล โดยมีการอา้งอิงแหล่งขอ้มูล ใช้ ทรัพยากร อยา่งคุม้ค่า ไม่คดัลอกผลงานผูอ่ื้น ใช้ค  า
สุภาพและไม่สร้างความเสียหายต่อผูอ่ื้น 
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4. กจิกรรมการเรียนรู้ 
 ข้ันน าเข้าสู่บทเรียน   
  1. ครูถามนักเรียนว่า ข้อมูลท่ีเป็นข้อความธรรมดาไม่มีความสวยงามหรือข้อมูลท่ีไม่มี
ภาพประกอบ กับขอ้มูลท่ีตกแต่งสวยงาม ดูสะดุดตาและมีภาพประกอบแบบไหนท่ีนักเรียนชอบ
มากกวา่กนั และเพราะอะไรถึงชอบ 
      2. ครูสุ่มเรียกนกัเรียน 2-3 คน แสดงความคิดเห็น หากนกัเรียนคนใดตอบเลือกการน าเสนอ
ด้วยข้อความท่ีสวยงาม และใช้ภาพประกอบ ให้ครูน าเข้าสู่บทเรียนเร่ืองการแทรกข้อความและ
ภาพประกอบในเวบ็เพจ 

ขั้นด าเนินการสอนผ่านห้องเรียนเสมือนจริง 
 การด าเนินกิจกรรมการสอนผ่านห้องเรียนเสมือนจริงในทุกขั้นตอน นักเรียนจะมีการ
แลกเปล่ียนเรียนรู้กบัเพื่อนร่วมเรียนรู้ และขอค าแนะน าจากครู ผา่นทางห้องสนทนาอิเล็กทรอนิกส์ 
(Chat Room) และกระดานเสวนา (Webboard) และผ่านวิดีโอคอลทางแอพพลิเคชัน่ไลน์ โดยมี
ขั้นตอนดงัน้ี 

2.1 เลือกและระบุกิจกรรมท่ีตอ้งการเรียนรู้ 
      2.1.1 นกัเรียน Download กิจกรรมพร้อมทั้งแบบบนัทึกผลการปฏิบติักิจกรรม เร่ืองการ

ใส่ขอ้ความและแทรกภาพลงในเวบ็เพจ แลว้ท าการศึกษาเพื่อท าความเขา้ใจกบักิจกรรม 
2.1.2 นักเรียนเลือกศึกษาเน้ือหาของบทเรียนตามท่ีตนเองสนใจ จากบทเรียนท่ี

ก าหนดให ้แลว้บนัทึกลงในสมุด 
2.2 ก าหนดเป้าหมายการเรียนรู้  นกัเรียนก าหนดเป้าหมายของการเรียนรู้ แลว้บนัทึกลงใน

สมุด ส าหรับการก าหนดเป้าหมายการเรียนรู้ ใหน้กัเรียนระบุวา่นกัเรียนตอ้งการเรียนรู้อะไร เช่น 
          2.2.1 เพื่อศึกษาหลกัการใส่ขอ้ความและแทรกภาพลงในเวบ็เพจ 
          2.2.2 เพื่อศึกษาค าสั่งการสร้าใส่ขอ้ความและแทรกภาพลงในเวบ็เพ 

2.3 วางแผนการเรียนรู้ 
      2.3.1 นกัเรียนระบุขั้นตอนการปฏิบติักิจกรรม ลงในใบงานท่ี 2 โดยใหร้ะบุวา่นกัเรียนมี

วธีิการศึกษา สืบคน้อยา่งไร เพื่อตอบค าถามจากใบงานท่ีก าหนดให ้
         2.3.2 นักเรียนศึกษาเกณฑ์การประเมินผลการเรียนรู้ โดยท่ีเกณฑ์การประเมินผลท่ี

นกัเรียนตอ้งประเมิน ประกอบไปดว้ย 3 องคป์ระกอบ ไดแ้ก่  1) การเรียนรู้ดว้ยห้องเรียนเสมือนจริง 
2) กิจกรรมการเรียนรู้ และ 3) พฤติกรรมการเรียนรู้ของนกัเรียน 
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2.4  เรียนรู้ตามแผนการเรียนรู้ 

          2.4.1 นกัเรียนเรียนรู้ตามแผนการเรียนรู้ โดยเร่ิมจากศึกษาเน้ือหาจากการสอนผ่าน
ห้องเรียนเสมือนจริง  วิชาคอมพิวเตอร์  เร่ือง การสร้างเวบ็เพจดว้ยโปรแกรมดรีมวีฟเวอร์หลงัจาก
ศึกษาจนไดค้  าตอบของกิจกรรม ใหน้กัเรียนบนัทึกผลลงในใบงานท่ี 2 ใหค้รบทุกขอ้ 

          2.4.2 ประเมินผลงานการเรียนรู้ของตนเองตามเกณฑ์ท่ีนกัเรียนไดก้ าหนดไว ้ ลงใน       
แบบบนัทึกกิจกรรมการเรียนรู้ แลว้น าเสนอผลงานการเรียนรู้ โดยการอพัโหลดใบงานท่ี 2 ส่งใน   
www.wilispace.com 

    2.5 สรุปผลการเรียนรู้ 
          นกัเรียนร่วมกนัสรุปบทเรียน เร่ือง การใส่ขอ้ความและแทรกภาพลงในเวบ็เพจพร้อม

ทั้งร่วมแลกเปล่ียนเรียนรู้กบัเพื่อนร่วมเรียนรู้และผูส้อน 
2.6 ประเมินผลการเรียนรู้ 

          2.6.1 ผูส้อนท าการประเมินผลงานการเรียนรู้ของนกัเรียน พร้อมทั้งให้ขอ้เสนอแนะกบั
นกัเรียน เพื่อท่ีนกัเรียนจะไดน้ าไปปรับปรุงผลงานการเรียนรู้ 

          2.6.2 นกัเรียนปรับปรุงผลงานการเรียนรู้ตามขอ้เสนอแนะของผูส้อน 
 

5.  ส่ือ/แหล่งเรียนรู้ 
 5.1 ส่ือการเรียนรู้ 
  5.1.1 ห้องเรียนสมือนจริง  วิชาคอมพิวเตอร์ ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6   
  5.1.2 ใบงานท่ี 2  เร่ือง ขอ้ความกบัภาพ 
 5.2 แหล่งการเรียนรู้ 
  -   หอ้งปฏิบติัการคอมพิวเตอร์ 
6. การวดัและประเมินผล 

วธีิการ เคร่ืองมือ เกณฑ์ 
ตรวจใบงานท่ี 2 ใบงานท่ี 2 ร้อยละ 60 ผา่นเกณฑ์ 
ประเมินการน าเสนอผลงาน แบบประเมินการน าเสนอผลงาน ระดบัคุณภาพ 2  

ผา่นเกณฑ ์
ตรวจแบบบนัทึกกิจกรรม 
การเรียนรู้ 

แบบบนัทึกกิจกรรมการเรียนรู้ ระดบัคุณภาพ 2  
ผา่นเกณฑ ์



 

119 
 

  

 

ใบงานที ่2 เร่ือง ข้อความกบัภาพ 
ค าช้ีแจง ให้นักเรียนพิมพ์ขอ้ความแนะน าตนเอง จดัขอ้ความและลงสีให้ขอ้ความ พร้อมใส่รูปของ
ผูจ้ดัท าลงในหนา้เวบ็เพจดว้ย 
 
 ตัวอย่าง 
 

 

 
 

นางสาวอศัณยี ์  หมาดบ ารุง 

ผูจ้ดัท า 
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ผลการประเมินการปฏิบัติกจิกรรม 
 
ค าช้ีแจง ใหน้กัเรียนประเมินผลการปฏิบติักิจกรรมของนกัเรียน โดยท าเคร่ืองหมาย � ตามเกณฑท่ี์ 
ก าหนดไว ้

1) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ดว้ยหอ้งเรียนเสมือนจริง 
� ดี   � พอใช ้ � ปรับปรุง 

   2) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ 
� ดี   � พอใช ้ � ปรับปรุง 

 
เกณฑ์การประเมินผลการปฏิบัติกจิกรรม 

       1. เกณฑ์การประเมินผลการปฏิบัติกจิกรรมการสอนด้วยห้องเรียนเสมือนจริง 
       ดี       หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมผา่นหอ้งเรียนเสมือนจริง 
      ไดถู้กตอ้งทุกขั้นตอน 

                   พอใช ้ หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมผา่นห้องเรียนเสมือนจริง 
       ไดถู้กตอ้งบางขั้นตอน 
                ปรับปรุง หมายถึง นกัเรียนไม่สามารถปฏิบติักิจกรรมผา่นหอ้งเรียนเสมือนจริงได ้
       2. เกณฑ์การประเมินผลการปฏิบัติกจิกรรมการเรียนรู้ 

       ดี        หมายถึง   นกัเรียนสามารถตอบค าถามจากกิจกรรมไดถู้กตอ้งทุกขอ้ 
                 พอใช ้    หมายถึง  นกัเรียนสามารถตอบค าถามจากกิจกรรมไดถู้กตอ้งเพียงบางขอ้ 
               ปรับปรุง   หมายถึง  นกัเรียนสามารถตอบค าถามจากกิจกรรมไดไ้ม่ถูกตอ้ง 
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แผนการจัดการเรียนรู้ที ่ 3 

  
หน่วยการเรียนรู้ที ่ 4    การสร้างเวบ็เพจด้วยโปรแกรมดรีมวฟีเวอร์ CS6 
เร่ือง 3  การแทรกตารางในเว็บเพจ         เวลาเรียน 2  ช.ม. 
สอนวนัที ่.........เดือน ................................. พ.ศ.255ค      ภาคเรียนที ่ 2/255ค 
 
1. สาระส าคัญ/ความคิดรวบยอด 
 การแทรกตาราง การเพิ่มแถว คอลมัน์ของตาราง การปรับขนาดตารางให้ เหมาะสมกบัขอ้มูลท่ี
ตอ้งการน าเสนอในช้ินงาน 
2. ตัวช้ีวดั/จุดประสงค์การเรียนรู้ 
 2.1 ตัวช้ีวดั  
  ง 3.1 ป 6/5 ใช้คอมพิว เตอร์ ช่วยสร้าง ช้ินงานจากจินตนาการหรืองานท่ีท าใน
ชีวติประจ าวนัอยา่งมีจิตส านึกและความรับผดิชอบ 
 2.2 จุดประสงค์การเรียนรู้ 
  1. รู้และเขา้ใจหลกัการแทรกตารางดว้ยโปรแกรม ดรีมวฟีเวอร์ CS6 ไดอ้ยา่งถูกตอ้ง 
  2. ใชค้  าสั่งการแทรกตารางในโปรแกรมดรีมวฟีเวอร์ CS6  ไดอ้ยา่งถูกตอ้ง 
  3. น าความรู้เก่ียวกบัการแทรกตารางในโปรแกรมดรีมวีฟเวอร์ CS6 ไปใชใ้นชีวิตประจ าวนัได้
อยา่งเหมาะสม 
 
3. สาระการเรียนรู้ 
 3.1 สาระการเรียนรู้แกนกลาง 

1. การสร้างช้ินงานตอ้งมีการวางแผนงานและการ ออกแบบอยา่งสร้างสรรค ์ 
2. ใชค้อมพิวเตอร์ช่วยสร้างช้ินงาน เช่น แผน่พบั  ป้ายประกาศ เอกสารแนะน าช้ินงาน สไลด์

น าเสนอ ขอ้มูล โดยมีการอา้งอิงแหล่งขอ้มูล ใช้ ทรัพยากร อยา่งคุม้ค่า ไม่คดัลอกผลงานผูอ่ื้น ใช้ค  า
สุภาพและไม่สร้างความเสียหายต่อผูอ่ื้น 
 
4. กจิกรรมการเรียนรู้ 
 ข้ันน าเข้าสู่บทเรียน   
  1. นกัเรียนตอบค าถามกระตุน้ความคิด 
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  2. ครูถามนกัเรียนว่าการท่ีเราน าขอ้มูลมาวางสะเปะสะปะกบัการน าขอ้มูลมาใส่ในตาราง
แบบไหนจะท าใหง้านของเราดูเป็นระเบียบมากกวา่กนั แลว้ใหน้กัเรียนตอบค าถามพร้อมบอกเหตุผล 
  3. ครูน าเขา้บทเรียนในเร่ืองการแทรกตารางและจดัการกบัตารางในเวบ็เพจ 

ขั้นด าเนินกจิกรรมการสอนผ่านห้องเรียนเสมือนจริง 
การด าเนินกิจกรรมการสอนผ่านห้องเรียนเสมือนจริงในทุกขั้นตอน นักเรียนจะมีการ

แลกเปล่ียนเรียนรู้กบัเพื่อนร่วมเรียนรู้ และขอค าแนะน าจากครู ผา่นทางห้องสนทนาอิเล็กทรอนิกส์ 
(Chat Room) และกระดานเสวนา (Webboard) และผ่านวิดิโอคอลทางแอพพลิเคชัน่ไลน์ โดยมี
ขั้นตอนดงัน้ี 

2.1 เลือกและระบุกิจกรรมท่ีตอ้งการเรียนรู้ 
      2.1.1 นกัเรียน Download กิจกรรมพร้อมทั้งแบบบนัทึกผลการปฏิบติักิจกรรม เร่ือง 

การแทรกตารางในเวบ็เพจ  แลว้ท าการศึกษาเพื่อท าความเขา้ใจกบักิจกรรม 
2.1.2 นักเรียนเลือกศึกษาเน้ือหาของบทเรียนตามท่ีตนเองสนใจ จากบทเรียนท่ี

ก าหนดให ้แลว้บนัทึกลงในสมุด 
2.2 ก าหนดเป้าหมายการเรียนรู้  นกัเรียนก าหนดเป้าหมายของการเรียนรู้ แลว้บนัทึกลงใน

สมุด ส าหรับการก าหนดเป้าหมายการเรียนรู้ ใหน้กัเรียนระบุวา่นกัเรียนตอ้งการเรียนรู้อะไร เช่น 
          2.2.1 เพื่อศึกษาการหลกัในการแทรกตารางแบบต่าง ๆ 
          2.2.2 เพื่อศึกษาค าสั่งต่าง ๆ เก่ียวกบัตาราง และคุณสมบติัของตาราง 

2.3 วางแผนการเรียนรู้ 
      2.3.1 นกัเรียนระบุขั้นตอนการปฏิบติักิจกรรม ลงในใบงานท่ี 3 โดยใหร้ะบุวา่นกัเรียนมี

วธีิการศึกษา สืบคน้อยา่งไร เพื่อตอบค าถามจากใบงานท่ีก าหนดให ้
         2.3.2 นักเรียนศึกษาเกณฑ์การประเมินผลการเรียนรู้ โดยท่ีเกณฑ์การประเมินผลท่ี

นกัเรียนตอ้งประเมิน ประกอบไปดว้ย 3 องคป์ระกอบ ไดแ้ก่ 1) การเรียนรู้ดว้ยห้องเรียนเสมือนจริง  
2) กิจกรรมการเรียนรู้ และ 3) พฤติกรรมการเรียนรู้ของนกัเรียน 

2.4  เรียนรู้ตามแผนการเรียนรู้ 
          2.4.1 นกัเรียนเรียนรู้ตามแผนการเรียนรู้ โดยเร่ิมจากศึกษาเน้ือหาจากการสอนผ่าน

หอ้งเรียนเสมือนจริง  วิชาคอมพิวเตอร์  เร่ือง การแทรกตารางในเวบ็เพจ หลงัจากศึกษาจนไดค้  าตอบ
ของกิจกรรม ใหน้กัเรียนบนัทึกผลลงในใบงานท่ี 3  ใหค้รบทุกขอ้ 
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          2.4.2 ประเมินผลงานการเรียนรู้ของตนเองตามเกณฑ์ท่ีนกัเรียนไดก้ าหนดไว ้ ลงใน
แบบบนัทึกกิจกรรมการเรียนรู้ แลว้น าเสนอผลงานการเรียนรู้ โดยการอพัโหลดใบงานท่ี 3 ส่งใน   
www.wikispace.com 

2.5 สรุปผลการเรียนรู้ 
          นักเรียนร่วมกันสรุปบทเรียน เร่ือง การแทรกตารางในเว็บเพจ พร้อมทั้งร่วม

แลกเปล่ียนเรียนรู้กบัเพื่อนร่วมเรียนรู้และผูส้อน 
2.6 ประเมินผลการเรียนรู้ 

          2.6.1 ผูส้อนท าการประเมินผลงานการเรียนรู้ของนกัเรียน พร้อมทั้งให้ขอ้เสนอแนะกบั
นกัเรียน เพื่อท่ีนกัเรียนจะไดน้ าไปปรับปรุงผลงานการเรียนรู้ 

          2.6.2 นกัเรียนปรับปรุงผลงานการเรียนรู้ตามขอ้เสนอแนะของผูส้อน 
 

5.  ส่ือ/แหล่งเรียนรู้ 
 5.1 ส่ือการเรียนรู้ 
  5.1.1 ห้องเรียนเสมือนจริง วิชาคอมพิวเตอร์ ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  
  5.1.2 ใบงานท่ี 3 เร่ือง การแทรกตาราง 
 5.2 แหล่งการเรียนรู้ 
  -   หอ้งปฏิบติัการคอมพิวเตอร์ 

   
6. การวดัและประเมินผล 

วธีิการ เคร่ืองมือ เกณฑ์ 
ตรวจใบงานท่ี 3 ใบงานท่ี 3 ร้อยละ 60 ผา่นเกณฑ์ 
ประเมินการน าเสนอผลงาน แบบประเมินการน าเสนอผลงาน ระดบัคุณภาพ 2  

ผา่นเกณฑ ์
ตรวจแบบบนัทึกกิจกรรม 
การเรียนรู้ 

แบบบนัทึกกิจกรรมการเรียนรู้ ระดบัคุณภาพ 2  
ผา่นเกณฑ ์
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ใบงานที ่3  เร่ือง การแทรกตาราง 
ค าช้ีแจง ให้นักเรียนสร้างตาราง แทรกภาพลงในตาราง และพิมพ์ข้อความท่ีก าหนดให้ลงในหน้า    
เวบ็เพจพร้อมตกแต่งขอ้ความใหส้วยงาม 
 ตัวอย่าง 

 

Welcome to my webpage 

 
ประวัติส่วนตัว 

 

ชื่อ – นามสกุล                  ชื่อเล่น 

วัน เดือน ปี เกิด 

อายุ 

ท่ีอยู ่

 

 

โรงเรียน 
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ผลการประเมินการปฏิบัติกจิกรรม 
 
ค าช้ีแจง ใหน้กัเรียนประเมินผลการปฏิบติักิจกรรมของนกัเรียน โดยท าเคร่ืองหมาย � ตามเกณฑท่ี์ 
ก าหนดไว ้

1) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ดว้ยหอ้งเรียนเสมือนจริง 
� ดี   � พอใช ้ � ปรับปรุง 

   2) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ 
� ดี   � พอใช ้ � ปรับปรุง 

 
เกณฑ์การประเมินผลการปฏิบัติกจิกรรม 

       1. เกณฑ์การประเมินผลการปฏิบัติกจิกรรมการสอนด้วยห้องเรียนเสมือนจริง 
       ดี       หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมผา่นหอ้งเรียนเสมือนจริง 
      ไดถู้กตอ้งทุกขั้นตอน 

                   พอใช ้ หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมผา่นห้องเรียนเสมือนจริง 
       ไดถู้กตอ้งบางขั้นตอน 
                ปรับปรุง หมายถึง นกัเรียนไม่สามารถปฏิบติักิจกรรมผา่นหอ้งเรียนเสมือนจริงได ้
       2. เกณฑ์การประเมินผลการปฏิบัติกจิกรรมการเรียนรู้ 

       ดี        หมายถึง   นกัเรียนสามารถตอบค าถามจากกิจกรรมไดถู้กตอ้งทุกขอ้ 
                 พอใช ้    หมายถึง  นกัเรียนสามารถตอบค าถามจากกิจกรรมไดถู้กตอ้งเพียงบางขอ้ 
               ปรับปรุง   หมายถึง  นกัเรียนสามารถตอบค าถามจากกิจกรรมไดไ้ม่ถูกตอ้ง 
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แผนการจัดการเรียนรู้ที ่ 4 

 
หน่วยการเรียนรู้ที ่ 4 การสร้างเวบ็เพจด้วยโปรแกรมดรีมวฟีเวอร์ CS6   
เร่ือง การแทรกมัลติมิเดียลงในเวบ็เพจ               เวลาเรียน 2  ช.ม.    
สอนวนัที ่.........เดือน ................................. พ.ศ.2558            ภาคเรียนที ่ 2/2558 
 
1. สาระส าคัญ/ความคิดรวบยอด 
          การแทรกมลัติมิเดีย การปรับค่าการเล่น และขนาดของมลัติมิเดีย ให้เหมาะสมกับข้อมูลท่ี
ตอ้งการน าเสนอในช้ินงาน 
 
2. ตัวช้ีวดั/จุดประสงค์การเรียนรู้ 
 2.1 ตัวช้ีวดั  
  ง 3.1 ป 6/5 ใช้คอมพิว เตอร์ ช่วยสร้าง ช้ินงานจากจินตนาการหรืองานท่ีท าใน
ชีวติประจ าวนัอยา่งมีจิตส านึกและความรับผดิชอบ 
 2.2 จุดประสงค์การเรียนรู้ 
  1.  รู้และเขา้ใจหลกัการแทรกมลัติมิเดียดว้ยโปรแกรม ดรีมวฟีเวอร์ CS6  ไดอ้ยา่งถูกตอ้ง 
  2. ใชค้  าสั่งการแทรกมลัติมิเดียในโปรแกรมดรีมวฟีเวอร์ CS6  ไดอ้ยา่งถูกตอ้ง 
  3. น าความรู้เก่ียวกบัการแทรกมลัติมิเดียในโปรแกรมดรีมวฟีเวอร์ CS6 ไปใชใ้นชีวิตประจ าวนั
ไดอ้ยา่งเหมาะสม 
 
3. สาระการเรียนรู้ 
 3.1 สาระการเรียนรู้แกนกลาง 

1. การสร้างช้ินงานตอ้งมีการวางแผนงานและการ ออกแบบอยา่งสร้างสรรค ์ 
2. ใชค้อมพิวเตอร์ช่วยสร้างช้ินงาน เช่น แผน่พบั  ป้ายประกาศ เอกสารแนะน าช้ินงาน สไลด์

น าเสนอ ขอ้มูล โดยมีการอา้งอิงแหล่งขอ้มูล ใช้ ทรัพยากร อยา่งคุม้ค่า ไม่คดัลอกผลงานผูอ่ื้น ใช้ค  า
สุภาพและไม่สร้างความเสียหายต่อผูอ่ื้น 
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4. กจิกรรมการเรียนรู้ 
 ข้ันน าเข้าสู่บทเรียน   
  1. นกัเรียนตอบค าถามกระตุน้ความคิด 
  2. นกัเรียนร่วมกนัแสดงความคิดเห็นวา่ ถา้มีส่ือท่ีเป็นมลัติมิเดียเพิ่มลงไปในหนา้เวบ็เพจจะ
ท าใหเ้วบ็เพจดูน่าสนใจหรือไม่ เพราะเหตุใด 
  3. ครูน าส่ือมลัติมิเดียในรูปแบบต่าง ๆ มาให้นกัเรียนดูและบอกนกัเรียนวา่เราสามารถน าส่ือ
เหล่าน้ีไปใส่ในเวบ็เพจของเราไดเ้ช่นกนั 

ขั้นด าเนินกจิกรรมการสอนผ่านห้องเรียนเสมือนจริง 
การด าเนินกิจกรรมการสอนผ่านห้องเรียนเสมือนจริงในทุกขั้นตอน นักเรียนจะมีการ

แลกเปล่ียนเรียนรู้กบัเพื่อนร่วมเรียนรู้ และขอค าแนะน าจากครู ผา่นทางห้องสนทนาอิเล็กทรอนิกส์ 
(Chat Room) และกระดานเสวนา (Webboard) และผ่านวิดีโอคอลทางแอพพลิเคชัน่ไลน์ โดยมี
ขั้นตอนดงัน้ี 

2.1 เลือกและระบุกิจกรรมท่ีตอ้งการเรียนรู้ 
      2.1.1 นกัเรียน Download กิจกรรมพร้อมทั้งแบบบนัทึกผลการปฏิบติักิจกรรม เร่ือง 

การแทรกมลัติมิเดียลงในเวบ็เพจ  แลว้ท าการศึกษาเพื่อท าความเขา้ใจกบักิจกรรม 
2.1.2 นักเรียนเลือกศึกษาเน้ือหาของบทเรียนตามท่ีตนเองสนใจ จากบทเรียนท่ี

ก าหนดให ้แลว้บนัทึกลงในสมุด 
2.2 ก าหนดเป้าหมายการเรียนรู้  นกัเรียนก าหนดเป้าหมายของการเรียนรู้ แลว้บนัทึกลงใน

สมุด ส าหรับการก าหนดเป้าหมายการเรียนรู้ ใหน้กัเรียนระบุวา่นกัเรียนตอ้งการเรียนรู้อะไร เช่น 
          2.2.1 เพื่อศึกษาการใชค้  าสั่งในการแทรกมลัติมิเดียและการก าหนดคุณลกัษณะต่าง ๆ 

2.3 วางแผนการเรียนรู้ 
      2.3.1 นกัเรียนระบุขั้นตอนการปฏิบติักิจกรรม ลงในใบงานท่ี 4 โดยใหร้ะบุวา่นกัเรียนมี

วธีิการศึกษา สืบคน้อยา่งไร เพื่อตอบค าถามจากใบงานท่ีก าหนดให ้
          2.3.2 นกัเรียนศึกษาเกณฑ์การประเมินผลการเรียนรู้ โดยท่ีเกณฑ์การประเมินผลท่ี

นกัเรียนตอ้งประเมิน ประกอบไปดว้ย 3 องคป์ระกอบ ไดแ้ก่ 1) การเรียนรู้ดว้ยระบบเทคโนโลยี
เสมือนจริง 2) กิจกรรมการเรียนรู้ และ 3) พฤติกรรมการเรียนรู้ของนกัเรียน 

2.4  เรียนรู้ตามแผนการเรียนรู้ 
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          2.4.1 นกัเรียนเรียนรู้ตามแผนการเรียนรู้ โดยเร่ิมจากศึกษาเน้ือหาจากการสอนผ่าน
ห้องเรียนเสมือนจริง วิชาคอมพิวเตอร์ เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 
หลงัจากศึกษาจนไดค้  าตอบของกิจกรรม ใหน้กัเรียนบนัทึกผลลงในใบงานท่ี 4  ใหค้รบทุกขอ้ 

          2.4.2 ประเมินผลงานการเรียนรู้ของตนเองตามเกณฑ์ท่ีนกัเรียนไดก้ าหนดไว ้ ลงใน
แบบบนัทึกกิจกรรมการเรียนรู้ แลว้น าเสนอผลงานการเรียนรู้ โดยการอพัโหลดใบงานท่ี 4 ส่งใน   
www.wikispace.com 

2.5 สรุปผลการเรียนรู้ 
          นกัเรียนร่วมกนัสรุปบทเรียน เร่ือง การแทรกมลัติมิเดียวลงในเวบ็เพจพร้อมทั้งร่วม

แลกเปล่ียนเรียนรู้กบัเพื่อนร่วมเรียนรู้และผูส้อน 
2.6 ประเมินผลการเรียนรู้ 

          2.6.1 ผูส้อนท าการประเมินผลงานการเรียนรู้ของนกัเรียน พร้อมทั้งให้ขอ้เสนอแนะกบั
นกัเรียน เพื่อท่ีนกัเรียนจะไดน้ าไปปรับปรุงผลงานการเรียนรู้ 

          2.6.2 นกัเรียนปรับปรุงผลงานการเรียนรู้ตามขอ้เสนอแนะของผูส้อน 
 

5.  ส่ือ/แหล่งเรียนรู้ 
 5.1 ส่ือการเรียนรู้ 
  5.1.1 ห้องเรียนเสมือนจริง วิชาคอมพิวเตอร์ ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  
  5.1.2 ใบงานท่ี 4 เร่ือง การแทรกมลัติมิเดีย 
 5.2 แหล่งการเรียนรู้ 
  -   หอ้งปฏิบติัการคอมพิวเตอร์ 

   
6. การวดัและประเมินผล 

วธีิการ เคร่ืองมือ เกณฑ์ 
ตรวจแบบทดสอบหลงัเรียน  แบบทดสอบหลงัเรียน  (ประเมินตามสภาพจริง) 
ตรวจใบงานท่ี 4 ใบงานท่ี 4 ร้อยละ 60 ผา่นเกณฑ์ 
ประเมินการน าเสนอผลงาน แบบประเมินการน าเสนอผลงาน ระดบัคุณภาพ 2 ผา่นเกณฑ ์
ตรวจแบบบนัทึกกิจกรรมการ
เรียนรู้ 

แบบบนัทึกกิจกรรมการเรียนรู้ ระดบัคุณภาพ 2 ผา่นเกณฑ ์
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ใบงานที ่4  เร่ือง การแทรกมัลติมิเดีย 
ค าช้ีแจง ใหน้กัเรียนแทรกวดีิโอเก่ียวกบัการใชง้านโปรแกรมดรีมวีฟเวอร์ CS6 ลงในหนา้เวบ็เพจ 
 
ตัวอย่าง 
 

Welcome to my webpage 

 
ประวัติส่วนตัว 

 

ชื่อ – นามสกุล                  ชื่อเล่น 

วัน เดือน ปี เกิด 

อายุ 

ท่ีอยู ่

 

 

โรงเรียน 

 

 

วิดีโอเก่ียวกับการใชง้านโปรแกรมดรีมวีฟเวอร์ CS6 
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ผลการประเมินการปฏิบัติกจิกรรม 
 
ค าช้ีแจง ใหน้กัเรียนประเมินผลการปฏิบติักิจกรรมของนกัเรียน โดยท าเคร่ืองหมาย � ตามเกณฑท่ี์ 
ก าหนดไว ้

1) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ดว้ยหอ้งเรียนเสมือนจริง 
� ดี   � พอใช ้ � ปรับปรุง 

   2) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ 
� ดี   � พอใช ้ � ปรับปรุง 

 
เกณฑ์การประเมินผลการปฏิบัติกจิกรรม 

       1. เกณฑ์การประเมินผลการปฏิบัติกจิกรรมการสอนด้วยห้องเรียนเสมือนจริง 
       ดี       หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมผา่นหอ้งเรียนเสมือนจริง 
      ไดถู้กตอ้งทุกขั้นตอน 

                   พอใช ้ หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมผา่นห้องเรียนเสมือนจริง 
       ไดถู้กตอ้งบางขั้นตอน 
                ปรับปรุง หมายถึง นกัเรียนไม่สามารถปฏิบติักิจกรรมผา่นหอ้งเรียนเสมือนจริงได ้
       2. เกณฑ์การประเมินผลการปฏิบัติกจิกรรมการเรียนรู้ 

       ดี        หมายถึง   นกัเรียนสามารถตอบค าถามจากกิจกรรมไดถู้กตอ้งทุกขอ้ 
                 พอใช ้    หมายถึง  นกัเรียนสามารถตอบค าถามจากกิจกรรมไดถู้กตอ้งเพียงบางขอ้ 
               ปรับปรุง   หมายถึง  นกัเรียนสามารถตอบค าถามจากกิจกรรมไดไ้ม่ถูกตอ้ง 
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ภาคผนวก ง 
-  แผนผงัการออกแบบห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ด้วย  
   โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนักเรียนช้ันประถมศึกษาปีที่ 6 
-  การออกแบบรายละเอยีดหน้าห้องเรียนเสมือน เร่ืองการสร้างเวบ็ไซต์ด้วย 
   โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนักเรียนช้ัน ประถมศึกษาปีที่ 6 
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แผนผงัการออกแบบห้องเรียนเสมอืน เร่ือง การสร้าง 
เวบ็ไซต์ด้วยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6 

 
 

  ฐานขอ้มูล                                                       

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Join Class room 

Homepage 

ผา่น 

ติดต่อครูซี 

จบ 

วธีิการใชง้านหอ้งเรียน
เสมือน 

จุดประสงคก์ารเรียนรู้ 

แบบทดสอบก่อนเรียน 

 วดีิโอการสอน 
ขั้นตอนการสร้างเวบ็เพจ 

ใบงาน 1-4 

แบบทดสอบหลงัเรียน 
ไม่ผา่น 

วดีิโอคอลกบัครูซี 
ผา่นทาง

แอพพลิเคชัน่ไลน์ 

สมคัรสมาชิก Log in 
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การออกแบบรายละเอยีดหน้าจอห้องเรียนเสมือน เร่ือง การสร้าง 
เวบ็ไซต์ด้วยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6 

หน้า Homepage 
 

 

 

 

 

 

 

 

 

หน้า Join Classroom 
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ตารางภาคผนวกที่ 1 รายละเอียดหน้าจอห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วย
โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6 
 

หน่วยการ 
เรียนรู้ 

เร่ือง ภาพ/วดิีโอ จุดประสงค์การเรียนรู้ 

1  รู้จกักบั Dream 
Weaver 

 รู้ จั ก ค ว า ม ห ม า ย ข อ ง
โปรแกรม Dream Weaver 

2 การเรียกใชง้าน
โปรแกรม Dream 

Weaver 

 
 
 
 
 
 

เ รี ย ก ใ ช้ ง าน โป รแกรม 
Dream Weaver ได ้

3 ส่วนประกอบของ
โปรแกรม Dream 

Weaver 
 
 
 

 รู้จักส่วนประกอบต่าง ๆ 
ของโปรแกรม 

4 รู้จกัแถบเคร่ืองมือ  
Insert Toolbar 

 
 
 
 
 

รู้จักแถบเคร่ืองมือ Insert 
Toolbar 
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หน่วยการ 
เรียนรู้ 

เร่ือง ภาพ/วดิีโอ จุดประสงค์การเรียนรู้ 

5 ขั้นตอนการสร้างเวบ็  
 
 
 
 
 
 

สร้างเว็บไซต์และก าหนด
คุณสมบติัของเวบ็เพจได ้

6 การบนัทึกและเปิด
เวบ็เพจ 

 
 
 
 
 
 
 

เปิดและบนัทึกงานได ้

7 การใส่ขอ้ความลง
บนเวบ็เพจ 

 
 
 
 
 
 

ใส่ข้อความลงบนเว็บเพจ
ได ้

8 การแทรกภาพบน
เวบ็เพจ 

 
 
 
 

 
 
 
 
 

แทรกรูปภาพบนเวบ็เพจได ้

 



 

 
 
 
 

ภาคผนวก  จ 
- แบบสอบถามความคิดเห็นส าหรับผู้ เช่ียวชาญเกี่ยวกับการพัฒนาห้องเรียน
เสมือน เร่ืองการสร้างเวบ็ไซต์ด้วยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนักเรียน
ช้ันประถมศึกษาปีที่ 6 

- แบบประ เมิ น ค่ า คว ามสอดค ล้อ งดั ช นี ช้ี วั ด ขอ ง ข้ อค า ถ าม  (IOC)                      
กบัวตัถุประสงค์ ส าหรับผู้เช่ียวชาญด้านวดัและประเมินผล ที่มีต่อการพฒันา
ห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรม ดรีมวีฟเวอร์ CS6 
ส าหรับนักเรียนช้ันประถมศึกษาปีที่ 6   

- แบบสอบถามความคิดเห็นเกี่ยวกับความพึงพอใจของนักเรียนที่มีต่อการ
พัฒนาห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ 
CS6 ส าหรับนักเรียนช้ันประถมศึกษาปีที่ 6 ส าหรับผู้เรียน (IOC) 
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แบบสอบถามความคิดเห็นส าหรับผู้เช่ียวชาญเกีย่วกบั 
การพฒันาห้องเรียนเสมือนเสมือนจริง เร่ือง การสร้างเว็บไซต์ด้วย 
โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6  

ค าช้ีแจง  โปรดแสดงความคิดเห็นของท่าน โดยใส่เคร่ืองหมาย () ลงในช่องความคิดเห็นพร้อม
เขียนขอ้เสนอแนะท่ีเป็นประโยชน์ในการน าไปพิจารณาแกไ้ขปรับปรุงในล าดบัต่อไป ขอ้ก าหนดของ
ความคิดเห็น ก าหนดให ้
  +1  หมายถึง    แน่ใจวา่สอดคลอ้งกบัส่ิงท่ีตอ้งการศึกษา 
    0 หมายถึง   ไม่แน่ใจวา่สอดคลอ้งกบัส่ิงท่ีตอ้งการศึกษา 
  -1 หมายถึง   ไม่สอดคลอ้งกบัส่ิงท่ีตอ้งการศึกษา 

 
ที่ รายการประเมิน ความเห็นของ

ผู้เช่ียวชาญ 
ข้อเสนอ
แนะ 

+1 0 -1 
1 เป็นการเรียนรู้ดว้ยตนเอง โดยยดึผูเ้รียนเป็นส าคญั     
2 ช่วยพฒันาความสามารถในการคิดวิเคราะห์ของนกัเรียน     
3 ท าใหมี้ประสบการณ์ในการใชเ้คร่ืองคอมพิวเตอร์มากข้ึน     
4 สอนตามจุดประสงคข์องการเรียน     
5 มีแหล่งสนบัสนุนการเรียนท่ีเหมาะสม เช่น การติดต่อผูส้อน 

กระดานแลกเปล่ียนเรียนรู้ แหล่งเรียนรู้ 
    

6 เปิดโอกาสใหผู้เ้รียนติดต่อกบัผูส้อนใหมี้ปฏิสัมพนัธ์ระหวา่ง 
ผูเ้รียน กบัผูส้อน ผูเ้รียนกบัผูเ้รียน และผูเ้รียนกบัส่ือ 

    

7 น าเสนอเน้ือหาเป็นระบบ ช่วยใหเ้ห็นความต่อเน่ืองของ
เน้ือหา 

    

8 สามารถทบทวนเน้ือหาไดจ้นเขา้ใจ ตามความสามารถของ
ผูเ้รียน 
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ที่ รายการประเมิน ความเห็นของ
ผู้เช่ียวชาญ 

ข้อเสนอ
แนะ 

+1 0 -1 
9 กิจกรรมระหวา่งเรียนและการฝึกทกัษะช่วยใหผู้เ้รียนมีความ

เขา้ใจ เน้ือหาในบทเรียน 
    

10 เปิดโอกาสใหผู้เ้รียนมีส่วนร่วมในบทเรียน     
11 มีความสะดวกในการเขา้ถึงบทเรียนหรือการคน้หา 

ขอ้มูลต่าง ๆ 
    

12 กระตุน้ใหผู้เ้รียนอยากเรียนรู้ในเน้ือหาตอนต่อไป     
13 ผลการประเมินต่างๆ สามารถโตต้อบไดท้นัที     
14 ภาพประกอบและภาพเคล่ือนไหว มีส่วนช่วยใหเ้ขา้ใจเน้ือหา  

ไดดี้ข้ึน 
    

15 ศึกษาและทบทวนบทเรียนไดไ้ม่จ  ากดัเวลาและมีอิสระ 
ในการเรียน 

    

 
ความคิดเห็นเพิ่มเติม  
................................................................................................................................................................. 
................................................................................................................................................................. 
................................................................................................................................................................. 
................................................................................................................................................................. 
................................................................................................................................................................. 
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แบบประเมินค่าความสอดคล้องดัชนีช้ีวดัของข้อค าถาม IOC   
ส าหรับผู้เช่ียวชาญด้านวดัและประเมินผล 

ทีม่ีต่อการพฒันาห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ด้วย 
โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6  

 
ค าช้ีแจง       ท่านผูเ้ช่ียวชาญได้โปรดกรุณาแสดงความคิดเห็นของท่านที่มีต่อการพฒันาห้องเรียน
เสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
โดยใส่เคร่ืองหมาย  ( )  ลงในช่องความคิดเห็นของท่านพร้อมเขียนขอ้เสนอแนะท่ีเป็นประโยชน์
ในการน าไปพิจารณาแกไ้ขปรับปรุงในล าดบัต่อไป  โดยท่ีขอ้ก าหนดของความคิดเห็นก าหนดให้เป็น
ดงัต่อไปน้ี 

+1 หมายถึง    แน่ใจวา่สอดคลอ้งกบัจุดประสงคก์ารเรียนรู้ 
  0 หมายถึง  ไม่แน่ใจวา่สอดคลอ้งกบัจุดประสงคก์ารเรียนรู้  
 -1   หมายถึง  ไม่สอดคลอ้งกบัจุดประสงคก์ารเรียนรู้ 

 
จุดประสงค์การเรียนรู้ ข้อที่ จ านวนข้อ 

1. รู้จกัการวางแผน ออกแบบและพฒันาเวบ็ไซต์ 1-3 3 
2. รู้จกัความหมายของโปรแกรม Dreamweaver 4 1 
3. เรียกใชง้านโปรแกรม Dreamweaver ได ้ 5-6 2 
4. รู้จกัส่วนประกอบต่าง ๆ ของโปรแกรม Dreamweaver 7-19 13 
5. สร้างเวบ็ไซตแ์ละก าหนดคุณสมบติัของเวบ็เพจได ้ 20-41 22 
6. เปิดและบนัทึกงานได ้ 42-47 6 
7. ใส่ขอ้ความลงบนเวบ็เพจได ้ 48-62 15 
8. แทรกรูปภาพบนเวบ็เพจได ้ 63-73 11 
9. การจดัการเวบ็เพจดว้ยตาราง 74-87 14 
10. แทรกมลัติมิเดียลงบนเวบ็เพจไดถู้กตอ้ง 88-90 3 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

1. ขั้นตอนการออกแบบและพฒันาเวบ็ไซตข์อ้ใด
เรียงล าดบัไดถู้กตอ้ง 
   ก. ออกแบบและสร้าง พฒันาและเผยแพร่ 
       เตรียมขอ้มูล 
  ข. ออกแบบและสร้าง เตรียมขอ้มูล  
      พฒันาและเผยแพร่ 
  ค. เตรียมขอ้มูล พฒันาและเผยแร่ 
      ออกแบบและสร้าง 
  ง. เตรียมขอ้มูล ออกแบบและสร้าง 
      พฒันาและเผยแพร่ 

    

2. หวัใจของการออกแบบเวบ็ไซต ์ขอ้ใดถูกตอ้ง
มากท่ีสุด 
  ก. ออกแบบให้ตรงกบักลุ่มเป้าหมาย 
  ข. ออกแบบให้โดดเด่นกวา่คู่แข่ง 
  ค. ออกแบบให้น่ามองดูแลว้สบายตา 
  ง. ออกแบบใหมี้เน้ือหาครบถว้นสมบูรณ์ 

    

3. ขอ้ใดไม่ใช่ลกัษณะการออกแบบโครงสร้าง
เวบ็ไซต ์(Site structure) 
  ก. แบบเรียงล าดบั 
  ข. แบบระดบัชั้น 
  ค. แบบแผนภูมิ 
  ง. แบบผสม 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

4. ขอ้ใดคือความหมายของโปรแกรม 
Dreamweaver ท่ีถูกตอ้งท่ีสุด 
  ก. โปรแกรมส าหรับท าภาพกราฟิก 
  ข. โปรแกรมส าหรับท างานมลัติมีเดีย 
  ค. โปรแกรมส าหรับออกแบบเวบ็ไซต ์ 
       สร้างเวบ็เพจ 
  ง. โปรแกรมส าหรับสร้างตารางและท า    
       แบบฟอร์ม 

    

5. วธีิเรียกใชง้านโปรแกรม Dreamweaver ท่ี
ถูกตอ้งคือขอ้ใด 
  ก. Start > Search > Adobe Dreamweaver 
  ข. Start > Setting > Adobe Dreamweaver 
  ค. Start > Document > Adobe Dreamweaver 
  ง. Start> Programs > Adobe Dreamweaver 

    

6. เคร่ืองมือส าหรับช่วยเลือกขั้นตอนเร่ิมตน้การใช้
งานโปรแกรมท่ีแสดงข้ึนทุกคร้ังท่ีเปิดโปรแกรม
คือเคร่ืองมือในขอ้ใด 
  ก. Screen Capture 
  ข. Welcome Screen 
  ค. Insert Toolbar 
  ง. Properties Inspector 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

7.ขอ้ใดคือความหมายของ Menu Bar ท่ีถูกตอ้ง
ท่ีสุด 
  ก. แถบค าสั่งในการก าหนดมุมมอง 
  ข. แถบเมนูท่ีเก็บค าสั่งทั้งหมดของโปรแกรมไว ้
  ค. แถบแสดงคุณสมบติัของวตัถุท่ีก าลงัเลือก 
      บนเพจ 
  ง. แถบท่ีรวบรวมเคร่ืองมือต่าง ๆ ส าหรับใชง้าน    
      เฉพาะเร่ือง 

    

8. ชุดค าสั่งท่ีใชจ้ดัการกบัไฟลเ์วบ็เพจต่าง ๆ เช่น 
สร้างเวบ็เพจใหม่ คือชุดค าสั่งในขอ้ใด 
  ก. Edit 
  ข. View 
  ค. Insert 
  ง. File 

    

9. ชุดค าสั่งในหมวดหมู่ของการแกไ้ข เช่น ตดั 
คดัลอก คือชุดค าสั่งในขอ้ใด 
  ก. Edit 
  ข. View 
  ค. Insert 
  ง. File 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

10. ชุดค าสั่งท่ีใชแ้ทรกวตัถุต่าง ๆ ลงเวบ็เพจ คือ
ชุดค าสั่งในขอ้ใด 
  ก. Edit 
  ข. View 
  ค. Insert 
  ง. File 

    

11. ชุดค าสั่งท่ีใชป้รับเปล่ียนมุมมองของเวบ็เพจ
ขณะท างาน คือชุดค าสั่งในขอ้ใด 
  ก. Edit 
  ข. View 
  ค. Insert 
  ง. File 

    

12. ชุดค าสั่งท่ีใชแ้กไ้ขวตัถุต่างๆ บนเวบ็เพจ เช่น
แกไ้ขขนาดภาพ คือชุดค าสั่งในขอ้ใด 
  ก. Modify 
  ข. Text 
  ค. Command 
  ง. Site 

    

13. ชุดค าสั่งท่ีใชป้รับเปล่ียนรูปแบบโดยรวมของ
ขอ้ความบนเวบ็เพจ คือชุดค าสั่งในขอ้ใด 
  ก. Modify 
  ข. Text 
  ค. Command 
  ง. Site 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

14. มุมมองในการท างานของโปรแกรม 
Dreamweaver มีก่ีแบบ 
  ก. 5 แบบ 
  ข. 4 แบบ 
  ค. 3 แบบ 
  ง. 2 แบบ 

    

15. มุมมองโคด้และออกแบบมีช่ือเรียกในขอ้ใด 
  ก. Split 
  ข. Code 
  ค. Design 
  ง. Code and Design 

    

16. Data เป็นกลุ่มค าสั่งส าหรับท างานในขอ้ใด 
  ก. วางวตัถุท่ีใชส้ร้างแบบฟอร์มเพื่อกรอกขอ้มูล 
  ข. วางวตัถุท่ีใชจ้ดัโครงสร้างของเวบ็เพจ 
  ค. เพิ่มปุ่มค าสั่งจากกลุ่มอ่ืนเขา้มาเก็บได ้
  ง. จดัการฐานขอ้มูล 
 

    

17. Layout เป็นกลุ่มค าสั่งส าหรับท างานในขอ้ใด 
  ก. วางวตัถุท่ีใชส้ร้างแบบฟอร์มเพื่อกรอกขอ้มูล 
  ข. วางวตัถุท่ีใชจ้ดัโครงสร้างของเวบ็เพจ 
  ค. เพิ่มปุ่มค าสั่งจากกลุ่มอ่ืนเขา้มาเก็บได ้
  ง. จดัการฐานขอ้มูล 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

18. Form เป็นกลุ่มค าสั่งส าหรับท างานในขอ้ใด 
  ก. วางวตัถุท่ีใชส้ร้างแบบฟอร์มเพื่อกรอกขอ้มูล 
  ข. วางวตัถุท่ีใชจ้ดัโครงสร้างของเวบ็เพจ 
  ค. เพิ่มปุ่มค าสั่งจากกลุ่มอ่ืนเขา้มาเก็บได ้
  ง. จดัการฐานขอ้มูล 

    

19. Favorite เป็นกลุ่มค าสั่งส าหรับท างานในขอ้ใด 
  ก. วางวตัถุท่ีใชส้ร้างแบบฟอร์มเพื่อกรอกขอ้มูล 
  ข. วางวตัถุท่ีใชจ้ดัโครงสร้างของเวบ็เพจ 
  ค. เพิ่มปุ่มค าสั่งจากกลุ่มอ่ืนเขา้มาเก็บได ้
  ง. จดัการฐานขอ้มูล 

    

20. ขอ้ใดคือค าสั่งในการสร้างไซตเ์พื่อจดัระบบ
ใหข้อ้มูลไดถู้กตอ้ง 
  ก. Web > New site 
  ข. File > New site 
  ค. Edit > New site 
  ง. Site > New site 

    

21. ขอ้ใดไม่ใช่ขอ้ดีในการสร้างไซตใ์หม่ 
  ก. เพื่อใหโ้ปรแกรมรู้แหล่งการเก็บขอ้มูล 
  ข. ช่วยใหเ้น้ือหาและภาพประกอบถูกเก็บ ไวท่ี้  
       จุดเดียวกนั 
  ค. เพิ่มความเร็วในการอพัโหลดขอ้มูลข้ึนระบบ 
      อินเทอร์เน็ต 
  ง. ลดปัญหาภาพประกอบหายเม่ือน าเวบ็ไซตอ์พั 
     โหลดข้ึนระบบอินเทอร์เน็ต 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

22. ขอ้ใดคือค าสั่งในการแกไ้ขไซตท่ี์ถูกตอ้ง 
  ก. Web > Manage site 
  ข. File > Manage site 
  ค. Edit > Manage site 
  ง. Site > Manage site 

    

23. ค  าสั่ง Edit ในหนา้ต่าง Manage site ใชท้  าส่ิง
ใด 
  ก. สร้างเวบ็ไซตใ์หม่ 
  ข. แกไ้ขเวบ็ไซต ์
  ค. คดัลอกเวบ็ไซต ์
  ง. ลบเวบ็ไซต ์

    

24. ค  าสั่ง New ในหนา้ต่าง Manage site ใชท้  าส่ิง
ใด 
  ก. สร้างเวบ็ไซตใ์หม่ 
  ข. แกไ้ขเวบ็ไซต ์
  ค. คดัลอกเวบ็ไซต ์
  ง. ลบเวบ็ไซต ์

    

25. ค  าสั่ง Duplication ในหนา้ต่าง Manage site ใช้
ท าส่ิงใด 
  ก. สร้างเวบ็ไซตใ์หม่ 
  ข. แกไ้ขเวบ็ไซต ์
  ค. คดัลอกเวบ็ไซต ์
  ง. ลบเวบ็ไซต ์
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

26. ค  าสั่ง Remove ในหนา้ต่าง Manage site ใชท้  า
ส่ิงใด 
  ก. สร้างเวบ็ไซตใ์หม่ 
  ข. แกไ้ขเวบ็ไซต ์
  ค. คดัลอกเวบ็ไซต ์
  ง. ลบเวบ็ไซต ์

    

27. ค  าสั่งในขอ้ใด ใชส้ าหรับก าหนดคุณสมบติั
พื้นฐานของเวบ็ไซต ์
  ก. View > Page Properties 
  ข. Insert > Page Properties 
  ค. Modify > Page Properties 
  ง. Edit > Page Properties 

    

28. ในไดอะล็อกบอ็กซ์ Page Properties แบ่ง
คุณสมบติัของเวบ็เพจเป็นก่ีหมวด 
  ก. 5 หมวด 
  ข. 4 หมวด 
  ค. 3 หมวด 
  ง. 2 หมวด  

    

29. ในหมวดการก าหนดคุณสมบติัทัว่ไปในการ
แสดงผล “Page Font” ใชท้  าส่ิงใด 
  ก. เลือกสีของขอ้ความ 
  ข. เลือกสีพื้นหลงัของเวบ็เพจ 
  ค. เลือกภาพฉากหลงัของเวบ็เพจ 
  ง. เลือกรูปแบบตวัอกัษรท่ีตอ้งการใชก้บัหนา้เวบ็ 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

30. ในหมวดการก าหนดคุณสมบติัทัว่ไปในการ
แสดงผล “Background Color” ใชท้  าส่ิงใด 
  ก. เลือกสีของขอ้ความ 
  ข. เลือกสีพื้นหลงัของเวบ็เพจ 
  ค. เลือกภาพฉากหลงัของเวบ็เพจ 
  ง. เลือกรูปแบบตวัอกัษรท่ีตอ้งการใชก้บัหนา้เวบ็ 

    

31. ในหมวดการก าหนดคุณสมบติัทัว่ไปในการ
แสดงผล “Text Color” ใชท้  าส่ิงใด 
  ก. เลือกสีของขอ้ความ 
  ข. เลือกสีพื้นหลงัของเวบ็เพจ 
  ค. เลือกภาพฉากหลงัของเวบ็เพจ 
  ง. เลือกรูปแบบตวัอกัษรท่ีตอ้งการใชก้บัหนา้เวบ็ 

    

32. ในหมวดการก าหนดคุณสมบติัทัว่ไปในการ
แสดงผล “Background Image” ใชท้  าส่ิงใด 
  ก. เลือกสีของขอ้ความ 
  ข. เลือกสีพื้นหลงัของเวบ็เพจ 
  ค. เลือกภาพฉากหลงัของเวบ็เพจ 
  ง. เลือกรูปแบบตวัอกัษรท่ีตอ้งการใชก้บัหนา้เวบ็ 

    

33. การสร้างเวบ็เพจใหม่ท าไดโ้ดยใชค้  าสั่งในขอ้
ใด 
  ก. Insert > New > Blank Page 
  ข. Edit > New > Blank Page 
  ค. File > New > Blank Page 
  ง. View > New > Blank Page 
 

    



149 

 

ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

34. ส่วนท่ีอยูด่า้นบนสุดของเวบ็เพจคือส่วนใด 
  ก. Page Footer 
  ข. Page Header 
  ค. Page Body 
  ง. Navigator Bar 

    

35. ส่วนท่ีใชเ้ช่ือมโยงไปยงัส่วนต่าง ๆ ของ
เวบ็ไซต ์คือส่วนใด 
  ก. Page Footer 
  ข. Page Header 
  ค. Page Body 
  ง. Navigator Bar 

    

36. ส่วนใดท่ีใชแ้สดงเน้ือหาภายในเวบ็ไซต ์
  ก. Page Footer 
  ข. Page Header 
  ค. Page Body 
  ง. Navigator Bar 

    

37. ส่วนท่ีอยูด่า้นล่างสุดของหนา้เวบ็เพจ คือส่วน
ใด 
  ก. Page Footer 
  ข. Page Header 
  ค. Page Body 
  ง. Navigator Bar 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

38. ในการออกแบบเวบ็ไซตก์ารเลือกใชโ้ทนสีใด
ท่ีแสดงถึงความเยอืกเยน็ สุขุม 
  ก. โทนสีส้ม 
  ข. โทนสีเขียว 
  ค. โทนสีเหลือง 
  ง. โทนสีฟ้า – น ้าเงิน 

    

39. ในการออกแบบเวบ็ไซตก์ารเลือกใชโ้ทนสีใด
ท่ีแสดงถึงการใหค้วามหวงั ความสดใสได ้
  ก. โทนสีส้ม 
  ข. โทนสีเขียว 
  ค. โทนสีเหลือง 
  ง. โทนสีฟ้า – น ้าเงิน 

    

40. ในการออกแบบเวบ็ไซตก์ารเลือกใชโ้ทนสีใด
ท่ีแสดงถึง ความเป็นมิตร ความอบอุ่น ความสดใส 
  ก. โทนสีส้ม 
  ข. โทนสีเขียว 
  ค. โทนสีเหลือง 
  ง. โทนสีฟ้า – น ้าเงิน 

    

41. ในการออกแบบเวบ็ไซตก์ารเลือกใชโ้ทนสีใด
ท่ีแสดงถึง ธรรมชาติ ชีวิต การพกัผอ่น 
  ก. โทนสีส้ม 
  ข. โทนสีเขียว 
  ค. โทนสีเหลือง 
  ง. โทนสีฟ้า – น ้าเงิน 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

42. การบนัทึกเวบ็เพจ ท าไดโ้ดยใชค้  าสั่งในขอ้ใด 
  ก. Insert > Save 
  ข. Edit > Save 
  ค. File > Save 
  ง. View > Save 

    

43. คียล์ดับนคียบ์อร์ดท่ีใชส้ าหรับบนัทึกงานคือ
ขอ้ใด 
  ก. Ctrl + O 
  ข. Ctrl + S 
  ค. Ctrl + N 
  ง. Ctrl + C 

    

44. การเปิดไฟลเ์วบ็เพจท่ีสร้างไวแ้ลว้ข้ึนมาแกไ้ข
ท าไดโ้ดยใชค้  าสั่งใด 
  ก. Insert > Open 
  ข. Edit > Open 
  ค. File > Open 
  ง. View > Open 

    

45. คียล์ดับนคียบ์อร์ดท่ีใชส้ าหรับเปิดงานท่ีสร้าง
ไวแ้ลว้ข้ึนมาแกไ้ขคือขอ้ใด 
  ก. Ctrl + O 
  ข. Ctrl + S 
  ค. Ctrl + N 
  ง. Ctrl + C 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

46. เม่ือตอ้งการทดสอบเวบ็เพจกบับราวเซอร์
จะตอ้งกดปุ่มในขอ้ใด 
  ก. F12 
  ข. F11 
  ค. F10 
  ง. F9 

    

47. นามสกุลของไฟลง์านในโปรแกรม 
Dreamweaver คือนามสกุลในขอ้ใด 
  ก. xx.psd 
  ข. xx.jpeg  
  ค. xx.ppt 
  ง. xx.html 

    

48. การข้ึนบรรทดัใหม่ในยอ่หนา้เดิมให้แทรก
แทก๊ในขอ้ใดทา้ยประโยค 
  ก. <p> 
  ข. <br/> 
  ค. <pre> 
 ง. <em> 

    

49. แบบอกัษรในขอ้ใดท่ีไม่ใช่แบบอกัษร
มาตรฐานในการท าเวบ็เพจ 
  ก. Verdana 
  ข. Geneva 
  ค. TH Sarabun 
  ง. MS San Serif 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

50. การตดัขอ้ความข้ึนบรรทดัใหม่สามารถเลือก
ค าสั่งใดได ้
  ก. Strong 
  ข. Emphasis 
  ค. Block Quote 
  ง. Paragraph  

    

51. ปุ่ม           ใชส้ าหรับท าส่ิงใด 
  ก. กั้นขอ้ความไปทางขวา 
  ข. กั้นขอ้ความไปทางซา้ย 
  ค. การใส่ล าดบัและตวัเลขก ากบั 
  ง. การขีดเส้นใตข้อ้ความ 

    

52. ล าดบัหวัขอ้ท่ีใหญ่ท่ีสุดคือ Heading หมายเลข
ใด 
  ก. Heading 4 
  ข Heading 3 
  ค. Heading 2 
  ง. Heading 1 

    

53. แทก็ค าสั่ง <strong>...</strong> ใชท้  าส่ิงใด 
  ก.  ตวัหนา 
  ข. ตวัเอียง 
  ค.  ข้ึนบรรทดัใหม่ 
  ง. ข้ึนยอ่หนา้ใหม่ 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

54. แทก็ค าสั่ง <em>...</em> ใชท้  าส่ิงใด 
  ก.  ตวัหนา 
  ข. ตวัเอียง 
  ค.  ข้ึนบรรทดัใหม่ 
  ง. ข้ึนยอ่หนา้ใหม่ 

    

55. Bullet คือค าสั่งท่ีใชท้  าส่ิงใด 
  ก.  กั้นขอ้ความไปทางขวา 
  ข. กั้นขอ้ความไปทางซา้ย 
  ค. การใส่ล าดบั 
  ง. การใส่ตวัเลขก ากบั 

    

56. Numbered list คือค าสั่งท่ีใชท้  าส่ิงใด 
  ก.  กั้นขอ้ความไปทางขวา 
  ข. กั้นขอ้ความไปทางซา้ย 
  ค. การใส่ล าดบั 
  ง. การใส่ตวัเลขก ากบั 

    

57. รหสัสี #000 คือสีใด 
  ก. สีขาว 
  ข. สีด า 
  ค. สีแดง 
  ง. สีเหลือง 

    

58. รหสัสี #FFF คือสีใด 
  ก. สีขาว 
  ข. สีด า 
  ค. สีแดง 
  ง. สีเหลือง 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

59. ในการก าหนดขนาดตวัอกัษร Medium 
หมายความวา่อยา่งไร 
  ก. ขนาดตวัอกัษรมาตรฐาน 
  ข. ขนาดตวัอกัษรท่ีเล็กกวา่มาตรฐาน 
  ค. ขนาดตวัอกัษรท่ีเล็กท่ีสุด 
  ง. ขนาดตวัอกัษรท่ีเล็กกวา่มาตรฐาน 1 เท่า 

    

60. ในการก าหนดขนาดตวัอกัษร x-small 
หมายความวา่อยา่งไร 
  ก. ขนาดตวัอกัษรมาตรฐาน 
  ข. ขนาดตวัอกัษรท่ีเล็กกวา่มาตรฐาน 
  ค. ขนาดตวัอกัษรท่ีเล็กท่ีสุด 
  ง. ขนาดตวัอกัษรท่ีเล็กกวา่มาตรฐาน 1 เท่า 

    

61. ในการก าหนดขนาดตวัอกัษร smaller 
หมายความวา่อยา่งไร 
  ก. ขนาดตวัอกัษรมาตรฐาน 
  ข. ขนาดตวัอกัษรท่ีเล็กกวา่มาตรฐาน 
  ค. ขนาดตวัอกัษรท่ีเล็กท่ีสุด 
  ง. ขนาดตวัอกัษรท่ีเล็กกวา่มาตรฐาน 1 เท่า 

    

62. ในการก าหนดขนาดตวัอกัษร small 
หมายความวา่อยา่งไร 
  ก. ขนาดตวัอกัษรมาตรฐาน 
  ข. ขนาดตวัอกัษรท่ีเล็กกวา่มาตรฐาน 
  ค. ขนาดตวัอกัษรท่ีเล็กท่ีสุด 
  ง. ขนาดตวัอกัษรท่ีเล็กกวา่มาตรฐาน 1 เท่า 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

63. ภาพท่ีเกิดจากลายเส้นผสมกนัจนเกิดเป็น
รูปทรงต่าง ๆ เวลายอ่-ขยายจะไม่เสียรูปทรง คือ
ภาพแบบใด 
  ก. ภาพแบบ GIF 
  ข. ภาพแบบ Bitmap 
  ค. ภาพแบบ Vector 
  ง. ภาพแบบ JPEG 

    

64. ภาพท่ีเกิดจากพิกเซลหรือเมด็สีรูปทรง
ส่ีเหล่ียมจตุัรัสเรียงต่อกนั คือภาพแบบใด 
  ก. ภาพแบบ GIF 
  ข. ภาพแบบ Bitmap 
  ค. ภาพแบบ Vector 
  ง. ภาพแบบ JPEG 

    

65. ในการแกไ้ขภาพเคร่ืองมือ         ใชส้ าหรับท า
ส่ิงใด 
  ก. ปรับปรุงความละเอียดของภาพ 
  ข. เพิ่มความสวา่งและคอนทราสต ์
  ค. เพิ่มความคมชดั 
  ง. ครอปภาพ 

    

66. ในการแกไ้ขภาพเคร่ืองมือ          ใชส้ าหรับท า
ส่ิงใด 
  ก. ปรับปรุงความละเอียดของภาพ 
  ข. เพิ่มความสวา่งและคอนทราสต ์
  ค. เพิ่มความคมชดั 
  ง. ครอปภาพ 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

67. ในการแกไ้ขภาพเคร่ืองมือ          ใชส้ าหรับท า
ส่ิงใด 
  ก. ปรับปรุงความละเอียดของภาพ 
  ข. เพิ่มความสวา่งและคอนทราสต ์
  ค. เพิ่มความคมชดั 
  ง. ครอปภาพ 

    

68. ในการแกไ้ขภาพเคร่ืองมือ        ใชส้ าหรับท า
ส่ิงใด 
  ก. ปรับปรุงความละเอียดของภาพ 
  ข. เพิ่มความสวา่งและคอนทราสต ์
  ค. เพิ่มความคมชดั 
  ง. ครอปภาพ 

    

69. ในการใส่ภาพพื้นหลงั ขอ้ใดคือการเรียงฉาก
หลงัโดยไล่ไปตามแนวนอน 
  ก. no – repeat 
  ข. repeat – x 
  ค. repeat – y 
  ง.  repeat  

    

70. ในการใส่ภาพพื้นหลงั ขอ้ใดคือการเรียงฉาก
หลงัโดยไล่ไปตามแนวตั้ง 
  ก. no – repeat 
  ข. repeat – x 
  ค. repeat – y 
  ง.  repeat 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

71. ในการใส่ภาพพื้นหลงั ขอ้ใดคือการเรียงฉาก
หลงัแบบปกติโดยซ ้ าจนเตม็หนา้เวบ็เพจ 
  ก. no – repeat 
  ข. repeat – x 
  ค. repeat – y 
  ง.  repeat 

    

72. ในการใส่ภาพพื้นหลงั ขอ้ใดคือการเรียงฉาก
หลงัโดยไม่เรียงซ ้ า 
  ก. no – repeat 
  ข. repeat – x 
  ค. repeat – y 
  ง.  repeat 

    

73. การเรียงฉากหลงัในขอ้ใดเหมาะกบัการน า
ภาพขนาดใหญ่มาใช ้
  ก. no – repeat 
  ข. repeat – x 
  ค. repeat – y 
  ง.  repeat 

    

74. เคร่ืองมือในขอ้ใดใชใ้นการสร้างตาราง 
  ก. 
  ข. 
  ค. 
  ง.  
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

75. ในหนา้ต่าง Table ขอ้ใดใชก้ าหนดความกวา้ง
ทั้งหมดของตาราง 
  ก. Cell padding 
  ข. Cell spacing 
  ค. Table width 
  ง. Border thickness 

    

76. ในหนา้ต่าง Table ขอ้ใดใชก้ าหนดความหนา
ของพื้นขอบตาราง 
  ก. Cell padding 
  ข. Cell spacing 
  ค. Table width 
  ง. Border thickness 

    

77. ในหนา้ต่าง Table ขอ้ใดใชก้ าหนดระยะห่าง
ระหวา่งเซลลแ์ต่ละเซลล ์
  ก. Cell padding 
  ข. Cell spacing 
  ค. Table width 
  ง. Border thickness 

    

78. ในหนา้ต่าง Table ขอ้ใดใชก้ าหนดระยะห่าง
ระหวา่งเซลลก์บัเน้ือหาภายในเซลล ์
  ก. Cell padding 
  ข. Cell spacing 
  ค. Table width 
  ง. Border thickness 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

79. ตารางแบบใดเหมาะกบัการออกแบบเวบ็เพจท่ี
มีขอ้ความมาก ๆ และไม่ซีเรียสกบัเลยเ์อาตข์อง
ภาพมากนกั 
  ก. ตารางแบบก าหนดขนาดตายตวั 
  ข. ตารางแบบขยายขนาดอิสระ 
  ค. ตารางซอ้นตาราง 
  ง. ตารางเด่ียว 

    

80. ในการสร้างตารางเคร่ืองมือ           ใชท้  าส่ิงใด 
  ก. เปล่ียนหน่วยความกวา้งของตารางเป็น\   
       เปอร์เซ็นต ์
  ข. เปล่ียนหน่วยความกวา้งของตารางเป็นพิกเซล 
  ค. ยกเลิกค่าความสูงของตาราง 
  ง. ยกเลิกค่าความกวา้งของตาราง 

    

81. ในการสร้างตารางเคร่ืองมือ         ใชท้  าส่ิงใด 
  ก. เปล่ียนหน่วยความกวา้งของตารางเป็น 
       เปอร์เซ็นต ์
  ข. เปล่ียนหน่วยความกวา้งของตารางเป็นพิกเซล 
  ค. ยกเลิกค่าความสูงของตาราง 
  ง. ยกเลิกค่าความกวา้งของตาราง 

    

82. ในการสร้างตารางเคร่ืองมือ          ใชท้  าส่ิงใด 
  ก. เปล่ียนหน่วยความกวา้งของตารางเป็น 
       เปอร์เซ็นต ์
  ข. เปล่ียนหน่วยความกวา้งของตารางเป็นพิกเซล 
  ค. ยกเลิกค่าความสูงของตาราง 
  ง. ยกเลิกค่าความกวา้งของตาราง 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

83. ในการสร้างตารางเคร่ืองมือ          ใชท้  าส่ิงใด 
  ก. เปล่ียนหน่วยความกวา้งของตารางเป็น 
       เปอร์เซ็นต ์
  ข. เปล่ียนหน่วยความกวา้งของตารางเป็นพิกเซล 
  ค. ยกเลิกค่าความสูงของตาราง 
  ง. ยกเลิกค่าความกวา้งของตาราง 

    

84. ในการก าหนดคุณสมบติัตางราง Brdr color 
คือการก าหนดส่ิงใด 
  ก. ก าหนดสีพื้นตาราง   
  ข. ก าหนดสีขอบตาราง 
  ค. ก าหนดต าแหน่งตาราง 
  ง. ก าหนดภาพพื้นหลงัของตาราง  

    

85. ในการก าหนดคุณสมบติัตางราง BG color คือ
การก าหนดส่ิงใด 
  ก. ก าหนดสีพื้นตาราง   
  ข. ก าหนดสีขอบตาราง 
  ค. ก าหนดต าแหน่งตาราง 
  ง. ก าหนดภาพพื้นหลงัของตาราง 

    

86.ในการก าหนดคุณสมบติัตางราง BG Image คือ
การก าหนดส่ิงใด 
  ก. ก าหนดสีพื้นตาราง   
  ข. ก าหนดสีขอบตาราง 
  ค. ก าหนดต าแหน่งตาราง 
  ง. ก าหนดภาพพื้นหลงัของตาราง 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

87. ในการก าหนดคุณสมบติัตางราง Align คือการ
ก าหนดส่ิงใด 
  ก. ก าหนดสีพื้นตาราง   
  ข. ก าหนดสีขอบตาราง 
  ค. ก าหนดต าแหน่งตาราง 
  ง. ก าหนดภาพพื้นหลงัของตาราง 

    

88. ในการน าคลิบวดีิโอมาใส่ในเวบ็เพจการตั้งค่า
คุณสมบติั Auto rewind หมายถึงส่ิงใด 
  ก. การรักษาสัดส่วนของวิดีโอเม่ือปรับความ  
       กวา้งความสูง 
  ข. ใหก้ลบัไปต าแหน่งเร่ิมตน้เม่ือเล่นจบ 
  ค. ความกวา้ง / /ความสูง ของวดีิโอ 
  ง. เร่ิมเล่นอตัโนมติัเม่ือเปิดเวบ 

    

89. ในการน าคลิบวดีิโอมาใส่ในเวบ็เพจการตั้งค่า
คุณสมบติั Auto play หมายถึงส่ิงใด 
  ก. การรักษาสัดส่วนของวิดีโอเม่ือปรับความ 
       กวา้งความสูง 
  ข. ใหก้ลบัไปต าแหน่งเร่ิมตน้เม่ือเล่นจบ 
  ค. ความกวา้ง / /ความสูง ของวดีิโอ 
  ง. เร่ิมเล่นอตัโนมติัเม่ือเปิดเวบ 
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ข้อสอบ 

ความคิดเห็น 

ข้อเสนอแนะ 
+1 0 -1 

90. ในการน าคลิบวดีิโอมาใส่ในเวบ็เพจการตั้งค่า
คุณสมบติั Width / Height หมายถึงส่ิงใด 
  ก. การรักษาสัดส่วนของวิดีโอเม่ือปรับความ
กวา้งความสูง 
  ข. ใหก้ลบัไปต าแหน่งเร่ิมตน้เม่ือเล่นจบ 
  ค. ความกวา้ง / /ความสูง ของวดีิโอ 
  ง. เร่ิมเล่นอตัโนมติัเม่ือเปิดเวบ 

    

 
 

 ขอ้คิดเห็นและขอ้เสนอแนะเพิ่มเติม 
……………………………………………………………………………………………...…

……...……………………………………………………………….………………………………… 
……...……………………………………………………………….………………………………… 
……...……………………………………………………………….………………………………… 
……...……………………………………………………………….………………………………… 

 
 

         ลงช่ือ...........................................................ผูป้ระเมิน 
                                                                       (.............................................................) 
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แบบสอบถามความคิดเห็น เกีย่วกบัความพงึพอใจของนักเรียน 
ทีม่ีต่อการพฒันาห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ด้วยโปรแกรมดรีมวฟีเวอร์ CS6 

 ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6 (IOC) 
ค าช้ีแจง   กรุณาท าเคร่ืองหมาย    ลงในช่องวา่งใหต้รงกบัความคิดเห็นของท่านมากท่ีสุดและกรุณา
เขียนค าแนะน าลงในช่องขอ้เสนอแนะ 

+1   หมายถึง   แน่ใจวา่ขอ้ค าถามและรูปแบบของภาษามีความเหมาะสม 
 0    หมายถึง   ไม่แน่ใจวา่ขอ้ค าถามและรูปแบบของภาษามีความเหมาะสม 
-1    หมายถึง   แน่ใจวา่ขอ้ค าถามและรูปแบบของภาษาไม่มีความเหมาะสม 
 

ที่ รายการประเมิน ความเห็นของ
ผู้เช่ียวชาญ 

+1 0 -1 
1 ดา้นเน้ือหา    
 1.1 เน้ือหาวชิาในบทเรียนมีความสอดคลอ้งกบัวตัถุประสงคก์าร

เรียนรู้ 
ขอ้เสนอแนะ………………………………………………………. 

   

 1.2 การล าดบัเน้ือหาเรียงจากง่ายไปหายาก 
ขอ้เสนอแนะ……………………………………………………… 

   

 1.3 ผูเ้รียนสามารถเขา้ถึงเน้ือหาไดร้วดเร็ว 
ขอ้เสนอแนะ……………………………………………………….… 

   

 1.4 ผูเ้รียนเขา้ใจเน้ือหาในบทเรียนไดง่้าย 
ขอ้เสนอแนะ……………………………………………………….…    
1.5  ผูเ้รียนน าความรู้ท่ีไดไ้ปประยกุตใ์ชใ้นชีวติประจ าวนัได้ 
ขอ้เสนอแนะ……………………………………………………….… 

   

 1.6  ผูเ้รียนตระหนกัถึงคุณค่าและประโยชน์ของความรู้ท่ีไดรั้บ 
ขอ้เสนอแนะ……………………………………………………….…    
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ที่ รายการประเมิน ความเห็นของ
ผู้เช่ียวชาญ 

+1 0 -1 
2 ดา้นการน าเสนอดว้ยภาพ สี เสียงประกอบ และการเช่ือมโยงเน้ือหา 

   
 2.1  ภาพประกอบสอดคลอ้งกบัเน้ือหา 

ขอ้เสนอแนะ……………………………………………………….… 
   

 2.2  ภาพประกอบมีความน่าสนใจสามารถส่ือสารไดช้ดัเจน 
ขอ้เสนอแนะ……………………………………………………….…    

 2.3  มีภาพไอคอนสวยงามน่าสนใจ ส่ือความหมายชดัเจน 
ขอ้เสนอแนะ……………………………………………………….…    

 2.4  การเช่ือมโยงเน้ือหาเพื่อสร้างปฏิสัมพนัธ์ระหวา่งผูเ้รียนกบั
บทเรียน 
ขอ้เสนอแนะ……………………………………………………….… 

   

 2.5  การเช่ือมโยง (Link) เน้ือหาของห้องเรียนเสมือนไดง่้าย 
ขอ้เสนอแนะ……………………………………………………….… 

   

3.  ดา้นแบบทดสอบและการประเมินผล 
   

 3.1  หอ้งเรียนเสมือนมีแบบทดสอบหลงัเรียนช่วยใหผู้เ้รียนได ้
        ตรวจสอบความเขา้ใจในเน้ือหาบทเรียนไดเ้หมาะสม 
ขอ้เสนอแนะ……………………………………………………….… 

   

3.2 ค าถามมีความชัดเจน 
ขอ้เสนอแนะ……………………………………………………….…    
3.3  แบบทดสอบสอดคล้องกับว ัตถุประสงค์  
ขอ้เสนอแนะ……………………………………………………….… 

   

3.4  ความยากง่ายของแบบทดสอบเหมาะสม 
ขอ้เสนอแนะ……………………………………………………….…    
3.5  สรุปผลคะแนนท้ายบทเรียนชัดเจน  
ขอ้เสนอแนะ……………………………………………………….… 
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ที่ รายการประเมิน ความเห็นของ
ผู้เช่ียวชาญ 

+1 0 -1 
4.  ด้านส่ิงอ านวยความสะดวก  

   
 4.1 การติดต่อส่ือสารผ่านจดหมายอิเล็กทรอนิกส์  

ขอ้เสนอแนะ……………………………………………………….… 
   

4.2 การส่งขอ้ความ (Send Massage)โดยใชโ้ปรแกรมเฟสบุค๊ 
(Facebook) 
ขอ้เสนอแนะ……………………………………………………….… 

   

4.3 การติดต่อส่ือสารผา่นแอพพิเคชัน่ไลน์ (Line) 
ขอ้เสนอแนะ……………………………………………………….… 

   

 

 

 

 

 

 

 

 



 
 
 
 
 
 
 
 
 

ภาคผนวก  ฉ 
แบบสอบถามความความคดิเห็นเกีย่วกบัความต้องการในการจดัสภาพแวดล้อม

ทางการเรียนด้วยห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ด้วย 
โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6  
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แบบสอบถามความความคิดเห็นเกี่ยวกบัความต้องการในการจัดสภาพแวดล้อมทางการเรียน 

ด้วยห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซต์ด้วย 
โปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6  

 
ค าช้ีแจง   
               แบบสอบถามความความคิดเห็นเก่ียวกบัความตอ้งการในการจดัสภาพแวดลอ้มทางการเรียน
ห้องเรียนเสมือน เร่ือง การสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้น
ประถมศึกษาปีท่ี 6 ในการวจิยัคร้ังน้ีมีวตัถุประสงคข์องการวจิยั ดงัต่อไปน้ี 

1.  เพื่อหาประสิทธิภาพของดว้ยห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรม ดรีม
วฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  

2.  เพื่อเปรียบเทียบผลสัมฤทธ์ิก่อนเรียนและหลงัเรียนของนกัเรียนท่ีเรียนจากดว้ยห้องเรียน
เสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6  
3.  เพื่อหาความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 6   ท่ีใชด้ว้ยห้องเรียนเสมือน เร่ือง การสร้าง
เวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6  

แบบสอบถามคร้ังน้ีมี  3  ส่วน ไดแ้ก่  
ส่วนท่ี 1 ขอ้มูลทัว่ไปเก่ียวกบัผูเ้ช่ียวชาญ 
ส่วนท่ี 2 สภาพปัญหาการจดัการเรียนการสอนวชิาคอมพิวเตอร์ในปัจจุบนั 
ส่วนท่ี 3 ลกัษณะสภาพการจดัการเรียนการสอนของการออกแบบดว้ยห้องเรียนเสมือน ท่ีพึง

ประสงค ์
 ในการน้ีผูว้ิจยัจะเก็บความคิดเห็นของท่านเป็นความลบัแต่จะน าความคิดเห็นของท่านมาใช้
ประโยชน์ในการการจดัสภาพแวดล้อมทางการเรียนท่ีเหมาะสมกบัการสร้างด้วยห้องเรียนเสมือน 
เร่ือง การสร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 จึงขอ
ความอนุเคราะห์ให้ท่านตอบแบบสอบถามความคิดเห็นตามความเป็นจริงท่ีสุด  และขอกราบ
ขอบพระคุณท่านท่ีใหค้วามร่วมมือเป็นอยา่งดีมาไว ้ ณ โอกาสน้ีดว้ย 
ค าช้ีแจง  โปรดแสดงความคิดเห็นของท่านโดยท าเคร่ืองหมาย   ลงในช่องท่ีตรงกบัความคิดเห็น 
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               ของท่านมากท่ีสุด 
 

ส่วนที ่1 ข้อมูลทัว่ไปเกี่ยวกบัผู้เช่ียวชาญ 
1. สถานะ  ครูท่ีจบเอกคอมพิวเตอร์    ครูท่ีไม่จบเอกคอมพิวเตอร์  
2. เพศ      ชาย       หญิง  
3. ระดบัการศึกษา   ปริญญาตรี            ปริญญาโท   สูงกวา่ปริญญาโท 
4. อาย ุ      20 – 30  ปี    31 – 40  ปี    41 -50  ปี 
   51-60    ปี   
 

เกณฑ์การให้คะแนน ใน ส่วนที ่2  และส่วนที ่3  
ระดบัคะแนน     5 หมายถึง  เห็นดว้ยอยา่งยิง่ 
ระดบัคะแนน     4 หมายถึง  เห็นดว้ยมาก 
ระดบัคะแนน     3  หมายถึง  เห็นดว้ย 
ระดบัคะแนน     2 หมายถึง  เห็นดว้ยนอ้ย 
ระดบัคะแนน     1 หมายถึง  เห็นดว้ยนอ้ยท่ีสุด 
 

ส่วนที ่2 สภาพปัญหาการจัดการเรียนการสอนวชิาคอมพวิเตอร์ในปัจจุบัน 
 

 

 
รายการประเมิน 

ระดับความพงึพอใจ 

5 4 3 2 1 
1. อุปกรณ์ไม่เพียงพอกบัความตอ้งการของผูเ้รียน      
2. เวลาในการใชง้านและเรียนรู้ในสถานศึกษามีนอ้ย  
    เกินไป 

     

3. นกัเรียนเนน้ความสนุกสนาน ขาดการใฝ่รู้      
4. นกัเรียนมุ่งเนน้การเขา้หาส่ิงบนัเทิง เกม หรือการ  
    เขา้สังคมการพดูคุยมากกวา่จะเขา้สู่ดา้นการเรียนรู้ 

     

5. นกัเรียนขาดความตั้งใจในการเขา้เรียนรู้      
6. นกัเรียนใชเ้คร่ืองมือในการสืบคน้ขอ้มูลไม่ถูกตอ้ง  
    และไม่เหมาะสม 

     

 
ส่วนที ่2 สภาพปัญหาการจัดการเรียนการสอนวชิาคอมพวิเตอร์ในปัจจุบัน (ต่อ) 
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รายการประเมิน ระดับความพงึพอใจ 
5 4 3 2 1 

7. การจดัการเรียนการสอนดงัต่อไปน้ีท่านมีความคิดเห็นอยูใ่นระดบัใด 
   7.1 การพฒันาทกัษะกระบวนการท่ีส่งเสริมการคิด
วเิคราะห์ 

     

   7.2 การจดัการเรียนการสอนอยา่งต่อเน่ืองจากง่ายไป
ยาก 

     

   7.3 การเตรียมการสอนล่วงหนา้      
   7.4 การแจง้วตัถุประสงคใ์นเน้ือหาสาระวชิาท่ีสอน      
   7.5 การพฒันาการสอนแบบใหม่        
   7.6 การท าวจิยัชั้นเรียนเพื่อพฒันาความสามารถของ  
          นกัเรียนเป็นรายบุคคล 

     

8. รูปแบบการสอนบทเรียน วชิา คอมพิวเตอร์ดงัต่อไปน้ีท่านมีความเห็นอยูใ่นระดบัใด 
   8.1  การสอนแบบบรรยาย      
   8.2  การสอนผา่นเวบ็ (หอ้งเรียนเสมือน)      
   8.3  การสอนแบบแกปั้ญหา      
   8.4 การสอนแบบสาธิต      
   8.5 การสอนแบบสถานการณ์จ าลอง      
   8.6 การสอนแบบทดลอง      

 

 
 
 
 
 
 
 



171 

 

ส่วนที่ 3 ลักษณะสภาพการจัดการเรียนการสอนของการออกแบบบทเรียนผ่านห้องเรียนเสมือน
 วชิาคอมพวิเตอร์ทีพ่งึประสงค์ 
 
 

รายการประเมิน 
ระดับความพงึพอใจ 

5 4 3 2 1 

1. ท่านต้องการให้ใช้ส่ือประกอบการจัดการเรียนการสอน ดังต่อไปนี ้อยู่ในระดับใด 
1.1 การสอนดว้ยหอ้งเรียนเสมือน (ผา่นเวบ็)      
1.2 การสอนดว้ยส่ือบทเรียนคอมพิวเตอร์ช่วยสอน 
      ออฟไลน์ 

     

    1.3 การสอนดว้ยบทเรียนคอมพิวเตอร์ออนไลน์      
1.4 การสอนดว้ยส่ือสองมิติ (แผนภาพ, แผนภูมิ, 
     แผนท่ี)  

     

1.5 การสอนดว้ยส่ือสามมิติ (วดีิโอ)      
1.6 การสอนดว้ยส่ือส่ิงพิมพ ์(หนงัสือแบบเรียน, 
      เอกสาร) 

     

    1.7 กระดาน, ชอลค์      
    1.8 บตัรค า, ภาพการ์ตูน      
    1.9 เคร่ืองฉายภาพน่ิง      
    1.10 เคร่ืองเล่นแผน่เสียง      

1.1 การสอนดว้ยหอ้งเรียนเสมือน (ผา่นเวบ็)      
2. กจิกรรมการเรียนการสอน ดังต่อไปนีอ้ยู่ในระดับใด 
     2.1 ท างานเป็นกลุ่ม      
     2.2 ศึกษาคน้ควา้ดว้ยตนเอง      
     2.3 นิทรรศการ      
     2.4 การสาธิต      
     2.5 การอภิปรายกลุ่ม      
     2.6 การระดมความคิด      
     2.7 การสร้างผลงาน      
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ส่วนที่ 3 ลักษณะสภาพการจัดการเรียนการสอนของการออกแบบบทเรียนผ่านห้องเรียนเสมือน
 วชิาคอมพวิเตอร์ทีพ่งึประสงค์ (ต่อ) 
 

3. ท่านต้องการออกแบบบทเรียนบนเว็บ  วชิา คอมพวิเตอร์ ให้มีลกัษณะดังต่อไปนี ้อยู่ใน  
    ระดับใด 

รายการประเมิน 
ระดับความพงึพอใจ 

5 4 3 2 1 
    3.1 สอนแบบใชเ้ทคโนโลยี (หอ้งเรียนเสมือน)      
    3.2 สอนแบบบรรยาย      
    3.3 สอนแบบเกม      
    3.4 สอนแบบบูรณาการ      
    3.5 การเรียนรู้แบบกลุ่มร่วมมือ แบบ  STAD        
    3.6 การจดัการศึกษาเฉพาะบุคคล      
    3.7 การจดัการศึกษาแบบการเรียนร่วม      
    3.8 การเรียนรู้แบบมีส่วนร่วม      
    3.9 การแสดงบทบาทสมมติ      
    3.10 การบูรณาการเน้ือหาความรู้ (Content 
Integration) 

     

    3.11 การเรียนท่ีเนน้เน้ือหาความรู้มากกวา่กระบวน 
             การคิด 

     

    3.12 การเรียนการสอนท่ีเนน้ครูผูส้อนเป็นศูนยก์ลาง             
            ของการเรียนรู้ 

     

    3.13 การเรียนแบบใชปั้ญหาเป็นหลกั      
    3.14 ฝึก ย  ้า ซ ้ า ทวน อยูเ่สมอเพื่อให้นกัเรียนเกิด         
            ทกัษะท่ีสุดในการเรียนรู้ท่ีคงทน 

     

4. ท่านต้องการให้ส่ือการเรียนการสอนในวชิา คอมพวิเตอร์ มีลกัษณะดังต่อไปนี ้อยู่ในระดับใด 
    4.1 เน้ือหามีความถูกตอ้งชดัเจนเหมาะสมกบั 
           ระดบัชั้น 

     

    4.2 เน้ือหาบทเรียนครอบคลุมวตัถุประสงค ์      
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ส่วนที่ 3 ลักษณะสภาพการจัดการเรียนการสอนของการออกแบบบทเรียนผ่านห้องเรียนเสมือน
 วชิาคอมพวิเตอร์ทีพ่งึประสงค์ (ต่อ) 
 

รายการประเมิน 
ระดับความพงึพอใจ 

5 4 3 2 1 

    4.3  การจดัล าดบัเน้ือหาเหมาะสม      
    4.4 ความน่าสนใจของเน้ือหาในบทเรียน      
    4.5 การล าดบัเน้ือหาจากง่ายไปหายาก      
    4.6 ปริมาณของเน้ือหาแต่ละหน่วยเหมาะสม      
    4.7 ค าถามมีความชดัเจน      
    4.8 แบบทดสอบสอดคลอ้งกบัวตัถุประสงค ์      
    4.9 ความยากง่ายของแบบทดสอบเหมาะสม      
    4.10 ความถูกตอ้งของภาษาท่ีใช ้      

    4.11 สรุปผลคะแนนทา้ยบทเรียนชดัเจน      

    4.12 การน าเสนอดึงดูดความสนใจ      

    4.13 การน าเสนอตามล าดบัขั้นตอน      

    4.14 การเร้าความสนใจดว้ยเสียงประกอบบทเรียน      

    4.15 ความสอดคลอ้งระหวา่งภาพกบัค าบรรยาย      

    4.17 ความชดัเจนของภาพท่ีน ามาใช ้      

    4.18 ความเหมาะสมในการใชเ้ทคนิคการน าเสนอ      

    4.19 รูปแบบการน าเสนอท่ีจูงใจ      

    4.20 รูปแบบอกัษรท่ีใชน้ าเสนอเน้ือหาอ่านง่าย      

    4.21 ขนาดตวัอกัษรในการน าเสนอเหมาะสม      

    4.22 การเลือกใชสี้ตวัอกัษรเหมาะสม      

    4.23 การใชสี้พื้นจอภาพเหมาะสม      

    4.24 สีตวัอกัษรท่ีใชเ้ช่ือมโยงแต่ละหนา้จอ      
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ส่วนที่ 3 ลักษณะสภาพการจัดการเรียนการสอนของการออกแบบบทเรียนผ่านห้องเรียนเสมือน
 วชิาคอมพวิเตอร์ทีพ่งึประสงค์ (ต่อ) 
 

 
รายการประเมิน 

ระดับความพงึพอใจ 

5 4 3 2 1 

5. ท่านมีความคิดเห็นว่าต้องการจัดการเรียนการสอนผ่านเครือข่าย ในหัวข้อดังต่อไปนี้ อยู่ใน
ระดับใด 
   5.1 การรับและส่งไปรษณียอิ์เล็กทรอนิกส์ (E-mail)      
   5.2 การถ่ายโอนแฟ้มขอ้มูล (File Transfer)       
   5.3 การเช่ือมต่อเขา้ใชง้าน (Log In)        
   5.4 การคน้หาขอ้มูล (Search Engine)       
   5.5 การอภิปรายและการประชุมทางไกล  
         (Discussion and Teleconference)  

     

   5.6 วดีิโอคอนเฟอร์เร้น (video conference)       
   5.7 กิจกรรมแบบประวงิเวลา (delay)       
   5.8 กิจกรรมลิสเซิร์ฟ (LISTSERV)       
   5.9 ยสูเน็ต (USENET)       

   5.10 กระดานอิเล็กทรอนิกส์ (Electronic Boards)      

   5.11 การติดต่อส่ือสารแบบโตต้อบทนัที (Real Time)  
         ผา่นโปรแกรมทอลก์ (Talk)  

     

    5.12 การส่งขอ้ความ (Send Massage) โดยใช ้ 
            โปรแกรมไอซีคิว (ICQ) 

     

    5.13 การส่งขอ้ความ (Send Massage) โดยใช ้ 
            โปรแกรมเฟซบุค (Facebook) 

     

      5.14 การส่งขอ้ความ (Send Massage) โดยใช ้ 
              โปรแกรมทวสิเตอร์ (Twister)          

     

     5.15 การติดต่อส่ือสารผา่นแอพพลิเคชัน่ไลน์ (Line)       
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ข้อเสนอแนะ 
................................................................................................................................................................. 
................................................................................................................................................................. 
................................................................................................................................................................. 
................................................................................................................................................................. 
 
   

                 ผูป้ระเมิน………………….………... 
                                                            (……...................................................) 
                                ต  าแหน่ง.................................................. 
                                วนัท่ี.........../......................../.................. 



ภาคผนวก  ช 
-  แบบประเมินสภาพปัญหาการจดัการเรียนการสอนวชิาคอมพวิเตอร์ 
-  ตารางภาคผนวก 
 ตารางภาคผนวกที ่2   จ  านวนและร้อยละของสถานภาพผูต้อบแบบสอบถาม 
 ตารางภาคผนวกที ่ 3  สภาพปัญหาการจดัการเรียนการสอนวชิาคอมพิวเตอร์ในปัจจุบนั 
 ตารางภาคผนวกที่  4  ลกัษณะสภาพการจดัการเรียนการสอนวิชาคอมพิวเตอร์ท่ีพึงประสงค์ของ

 การออกแบบหอ้งเรียนเสมือน 
 ตารางภาคผนวกที่  5  ความคิดเห็นของผูเ้ช่ียวชาญเพื่อหาค่าดชันีความสอดคลอ้ง (IOC) ของขอ้ 

 ค  าถามเพื่อสร้างแบบสอบถามความคิดเห็นส าหรับผูเ้ช่ียวชาญ เก่ียวกบัการ
 พัฒนาห้ อ ง เ รี ยน เส มือน  เ ร่ื อ งก ารส ร้ า ง เ ว็บ ไซต์ด้ว ย โปรแกรม               
 ดรีมวฟีเวอร์  ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี  6 

 ตารางภาคผนวกที่ 6  ความคิดเห็นของผูเ้ช่ียวชาญด้านวดัและประเมินผล เพื่อหาดัชนีความ
 สอดคลอ้ง  (IOC) ของแบบทดสอบก่อนและหลงัเรียน   

 ตารางภาคผนวกที ่7  ผลวเิคราะห์ค่าความยากง่าย อ านาจจ าแนก และความเช่ือมัน่ของแบบทดสอบ  
 ตารางภาคผนวกที่ 8  ความคิดเห็นของผูเ้ช่ียวชาญเพื่อหาค่าดชันีความสอดคลอ้ง (IOC) ของขอ้

 ค าถามเพื่อสร้างแบบสอบถามประเมินความพึงพอใจของนักเรียนชั้ น
 ประถมศึกษาปีท่ี 6 ท่ีมีต่อการพฒันาการพฒันาห้องเรียนเสมือน เร่ืองการ
 สร้างเวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์     

 ตารางภาคผนวกที่  9  รายงานสรุปผลการหาประสิทธิภาพของห้องเรียนเสมือน เร่ือง การสร้าง
 เว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์CS6 ส าหรับนักเรียนชั้นประถมศึกษา      
 ปีท่ี6  

 ตารางภาคผนวกที่10 คะแนนก่อนและหลังการเรียนด้วยห้องเรียนเสมือนของนักเรียน
 ทั้งหมด 30  คน 
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แบบประเมินสภาพปัญหาการจัดการเรียนการสอนวชิาคอมพวิเตอร์ 
ตารางภาคผนวกที ่2  จ านวนและร้อยละของสถานภาพผู้ตอบแบบสอบถาม 

สถานภาพ จ านวน ร้อยละ 

1. สถานะ 
    -  ครูท่ีจบเอกคอมพิวเตอร์ 
    -  ครูท่ีไม่จบเอกคอมพิวเตอร์ 

 
48 
15 

 
76.19 
23.81 

รวม 63 100 

2.  เพศ 
    -  ชาย 
    -  หญิง 

 
27 
36 

 
42.86 
57.14 

รวม 63 100 

3.  ระดับการศึกษา 
    -  ปริญญาตรี         
     -  ปริญญาโท 
     -  สูงกวา่ปริญญาโท 

 
57 
6 
- 

 
90.48 
9.52 

- 

รวม 63 100 

4.  อายุ 
     -  20 – 30  ปี 
     -  31 – 40  ปี  
     -  41 -50  ปี 
     -  51-60   ปี 

 
33 
25 
5 
- 

 
52.38 
39.68 
7.94 

- 

รวม 63 100 
 
จากตารางภาคผนวกท่ี 2 พบวา่ผูต้อบแบบสอบถามส่วนใหญ่เป็นครูท่ีจบเอกคอมพิวเตอร์ 

คิดเป็นร้อยละ 76.91  ส่วนใหญ่เป็นเพศหญิง คิดเป็นร้อยละ 57.14  ระดับการศึกษาส่วนใหญ่จบ
การศึกษาระดบัปริญญาตรี คิดเป็นร้อยละ 90.48  รองลงมาคือระดบัปริญญาโท คิดเป็นร้อยละ 9.52
และผูต้อบแบบสอบถามส่วนใหญ่มีอายุ 20-30 ปี  คิดเป็นร้อยละ 52.38 รองลงมาคือ อายุ 31-40 ปี คิด
เป็นร้อยละ 39.68 และอาย ุ41-50  ปี คิดเป็นร้อยละ 7.94   



  178 

 

 

 

ตารางภาคผนวกที ่ 3  สภาพปัญหาการจัดการเรียนการสอนวชิาคอมพวิเตอร์ในปัจจุบัน 

รายการประเมิน X  S.D. แปลผล 
1. อุปกรณ์ไม่เพียงพอกบัความตอ้งการของผูเ้รียน 4.63 0.60 มากท่ีสุด 

2. การท างานของเคร่ืองคอมพิวเตอร์ในห้องเรียน  
    ท่ีค่อนขา้งชา้ 

4.43 0.80 มาก 

3. เวลาในการใชง้านและเรียนรู้ในสถานศึกษามีนอ้ย  
    เกินไป 

4.56 0.67 มากท่ีสุด 

4. นกัเรียนมุ่งเนน้การเขา้หาส่ิงบนัเทิง เกม หรือการเขา้  
    สังคม การพดูคุยมากกวา่จะเขา้สู่ดา้นการเรียนรู้ 

4.24 0.80 มาก 

5. นกัเรียนขาดความตั้งใจในการเขา้เรียนรู้ 4.83 0.38 มากท่ีสุด 

6. นกัเรียนใชเ้คร่ืองมือในการสืบคน้ขอ้มูลไม่ถูกตอ้ง  
    และไม่เหมาะสม 

4.41 0.73 มาก 

7. การจัดการเรียนการสอนดังต่อไปนีท่้านมีความคิดเห็น อยู่ในระดับใด 
   7.1 การพฒันาทกัษะกระบวนการท่ีส่งเสริมการคิด  
         วเิคราะห์ 

4.44 0.84 มาก 

   7.2 การจดัการเรียนการสอนอยา่งต่อเน่ืองจากง่ายไปยาก 4.46 0.76 มาก 
   7.3 การเตรียมการสอนล่วงหนา้ 4.46 0.74 มาก 
   7.4 การแจง้วตัถุประสงคใ์นเน้ือหาสาระวชิาท่ีสอน 4.38 0.81 มาก 
   7.5 การพฒันาการสอนแบบใหม่   4.43 0.73 มาก 
   7.6 การท าวจิยัชั้นเรียนเพื่อพฒันาความสามารถของ  
          นกัเรียนเป็นรายบุคคล 4.44 0.78 

มาก 

   7.7 การสอนแบบบรรยาย 2.78 0.97 นอ้ย 
   7.8  การสอนผา่นเวบ็ (หอ้งเรียนเสมือน) 4.68 0.56 มากท่ีสุด 
   7.9  การสอนแบบแกปั้ญหา 3.83 0.75 มาก 
   7.10 การสอนแบบสาธิต 3.95 0.77 มาก 
   7.11 การสอนแบบสถานการณ์จ าลอง 4.44 0.62 มาก 
   7.12 การสอนแบบทดลอง 4.56 0.53 มากท่ีสุด 

ค่าเฉลีย่รวม 4.33 0.71 มาก 
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 จากตารางภาคผนวกท่ี 3 แสดงระดบัความคิดเห็นของครูคอมพิวเตอร์ท่ีมีต่อสภาพปัญหาการ
จดัการเรียนการสอนวชิาคอมพิวเตอร์ในปัจจุบนั โดยมีรายการประเมินค่าเฉล่ียโดยรวมอยูท่ี่ 3.95  ซ่ึง
แปลผลออกมาไดว้่าอยู่ในระดบัเห็นดว้ยมาก โดยสภาพปัญหาท่ีพบมากท่ีสุด คือ นกัเรียนขาดความ
ตั้งใจในการเขา้เรียนรู้ อุปกรณ์ไม่เพียงพอกบัความตอ้งการของผูเ้รียน และเวลาในการใช้งานและ
เรียนรู้ในสถานศึกษามีน้อย เกินไป ส่วนในดา้นการจดัการเรียนการสอนส่วนใหญ่จะเห็นดว้ยมาก
ท่ีสุดกบัการสอนผา่นเวบ็ (หอ้งเรียนเสมือน) และการสอนแบบทดลอง 
  
ตารางภาคผนวกที ่ 4  ลกัษณะสภาพการจัดการเรียนการสอนวชิาคอมพวิเตอร์ทีพ่งึประสงค์ของการ      
                                   ออกแบบห้องเรียนเสมือน 
 

รายการประเมิน X  S.D. แปลผล 

1. ท่านต้องการให้ใช้ส่ือประกอบการจัดการเรียนการสอน ดังต่อไปนี ้อยู่ในระดับใด 

1.1 การสอนดว้ยหอ้งเรียนเสมือน (ผา่นเวบ็) 4.62 0.49 มากท่ีสุด 
1.2 การสอนดว้ยส่ือบทเรียนคอมพิวเตอร์ช่วยสอน 
      ออฟไลน์ 

4.59 0.50 มากท่ีสุด 

    1.3 การสอนดว้ยบทเรียนคอมพิวเตอร์ออนไลน์ 4.51 0.50 มากท่ีสุด 
1.4 การสอนดว้ยส่ือสองมิติ (แผนภาพ, แผนภูมิ, แผนท่ี)  4.30 0.71 มาก 
1.5 การสอนดว้ยส่ือสามมิติ (วดีิโอ) 4.41 0.80 มาก 
1.6 การสอนดว้ยส่ือส่ิงพิมพ ์(หนงัสือแบบเรียน, 
      เอกสาร) 

2.94 0.80 ปานกลาง 

    1.7 กระดาน, ชอลค์ 2.92 0.70 ปานกลาง 
    1.8 บตัรค า, ภาพการ์ตูน 3.63 0.77 มาก 
    1.9 เคร่ืองฉายภาพน่ิง 3.41 0.85 ปานกลาง 
    1.10 เคร่ืองเล่นแผน่เสียง 3.35 0.72 ปานกลาง 

ค่าเฉลีย่รวม       3.87   0.68 มาก 
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ตารางภาคผนวกที ่ 4  ลกัษณะสภาพการจัดการเรียนการสอนวชิาคอมพวิเตอร์ทีพ่งึประสงค์ของการ      
                                   ออกแบบห้องเรียนเสมือน (ต่อ) 
 

รายการประเมิน X  S.D. แปลผล 

2. กจิกรรมการเรียนการสอน ดังต่อไปนีอ้ยู่ในระดับใด    
     2.1 ท างานเป็นกลุ่ม 4.51 0.50 มากท่ีสุด 
     2.2 ศึกษาคน้ควา้ดว้ยตนเอง 2.59 0.69 ปานกลาง 
     2.3 นิทรรศการ 2.56 0.78 ปานกลาง 
     2.4 การสาธิต 2.60 0.87 ปานกลาง 
     2.5 การอภิปรายกลุ่ม 3.38 0.71 ปานกลาง 
     2.6 การระดมความคิด 4.57 0.50 มากท่ีสุด 
     2.7 การสร้างผลงาน 4.62 0.61 มากท่ีสุด 

ค่าเฉลีย่รวม       3.55   0.67 มาก 

3. ท่านต้องการให้จัดการเรียนการสอนในรูปแบบ ดังต่อไปนี ้อยู่ในระดับใด 
    3.1 สอนแบบใชเ้ทคโนโลยี (หอ้งเรียนเสมือน) 4.56 0.64 มากท่ีสุด 
    3.2 สอนแบบบรรยาย 1.49    0.88 นอ้ยท่ีสุด 
    3.3 สอนแบบเกม 4.59    0.61 มากท่ีสุด 
    3.4 สอนแบบบูรณาการ 4.03    0.80 มาก 
    3.5 การเรียนรู้แบบกลุ่มร่วมมือ แบบ  STAD   4.46    0.59 มาก 
    3.6 การจดัการศึกษาเฉพาะบุคคล 4.37    0.63 มาก 
    3.7 การจดัการศึกษาแบบการเรียนร่วม 4.14    0.82 มาก 
    3.8 การเรียนรู้แบบมีส่วนร่วม 4.10    0.71 มาก 
    3.9 การแสดงบทบาทสมมติ 4.02    0.91 มาก 
    3.10 การบูรณาการเน้ือหาความรู้ (Content Integration) 2.40    1.09 นอ้ย 
    3.11 การเรียนท่ีเนน้เน้ือหาความรู้มากกวา่กระบวน 
             การคิด 

3.76    0.89 มาก 
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ตารางภาคผนวกที ่ 4  ลกัษณะสภาพการจัดการเรียนการสอนวชิาคอมพวิเตอร์ทีพ่งึประสงค์ของการ      
                                   ออกแบบห้องเรียนเสมือน (ต่อ) 
 

รายการประเมิน X  S.D. แปลผล 
    3.12 การเรียนการสอนท่ีเนน้ครูผูส้อนเป็นศูนยก์ลางของ 
            การเรียนรู้ 

1.37 0.94 นอ้ยท่ีสุด 

    3.13 การเรียนแบบใชปั้ญหาเป็นหลกั 3.76 0.67 มาก 
    3.14 ฝึก ย  ้า ซ ้ า ทวน อยูเ่สมอเพื่อให้นกัเรียนเกิดทกัษะ              2.06           1.08              นอ้ย    
           ท่ีสุดในการเรียนรู้ท่ีคงทน  
                                     ค่าเฉลีย่รวม                                                3.51           0.80                มาก 

4. ท่านต้องการให้ส่ือการเรียนการสอนในวชิา คอมพวิเตอร์ มีลกัษณะดังต่อไปนี ้อยู่ในระดับใด 
    4.1 เน้ือหามีความถูกตอ้งชดัเจนเหมาะสมกบัระดบัชั้น 4.60 0.52 มากท่ีสุด 
    4.2 เน้ือหาบทเรียนครอบคลุมวตัถุประสงค ์ 4.52 0.56 มากท่ีสุด 
    4.3  การจดัล าดบัเน้ือหาเหมาะสม 4.59 0.53 มากท่ีสุด 
    4.4 ความน่าสนใจของเน้ือหาในบทเรียน 4.52 0.53 มากท่ีสุด 
    4.5 การล าดบัเน้ือหาจากง่ายไปหายาก 4.68 0.50 มากท่ีสุด 
    4.6 ปริมาณของเน้ือหาแต่ละหน่วยเหมาะสม 4.65 0.57 มากท่ีสุด 
    4.7 ค าถามมีความชดัเจน 4.73 0.45 มากท่ีสุด 
    4.8 แบบทดสอบสอดคลอ้งกบัวตัถุประสงค ์ 4.70 0.50 มากท่ีสุด 
    4.9 ความยากง่ายของแบบทดสอบเหมาะสม 4.48 0.67 มาก 
    4.10 ความถูกตอ้งของภาษาท่ีใช ้ 4.59 0.53 มากท่ีสุด 
    4.11 สรุปผลคะแนนทา้ยบทเรียนชดัเจน 4.57 0.53 มากท่ีสุด 
    4.12 การน าเสนอดึงดูดความสนใจ 4.79 0.41 มากท่ีสุด 
    4.13 การน าเสนอตามล าดบัขั้นตอน 4.70 0.50 มากท่ีสุด 
    4.14 การเร้าความสนใจดว้ยเสียงประกอบบทเรียน 4.59 0.53 มากท่ีสุด 
    4.15 ความสอดคลอ้งระหวา่งภาพกบัค าบรรยาย 4.63 0.60 มากท่ีสุด 
    4.16 ความเหมาะสมของภาพในการส่ือความหมาย 4.76 0.43 มากท่ีสุด 
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ตารางภาคผนวกที ่ 4  ลกัษณะสภาพการจัดการเรียนการสอนวชิาคอมพวิเตอร์ทีพ่งึประสงค์ของการ      
                                   ออกแบบห้องเรียนเสมือน (ต่อ) 
 

รายการประเมิน X  S.D. แปลผล 
    4.17 ความชดัเจนของภาพท่ีน ามาใช ้ 4.87 0.34 มากท่ีสุด 
    4.18 ความเหมาะสมในการใชเ้ทคนิคการน าเสนอ 4.87 0.34 มากท่ีสุด 
    4.19 รูปแบบการน าเสนอท่ีจูงใจ 4.81 0.43 มากท่ีสุด 
    4.20 รูปแบบอกัษรท่ีใชน้ าเสนอเน้ือหาอ่านง่าย 4.78 0.42 มากท่ีสุด 
    4.21 ขนาดตวัอกัษรในการน าเสนอเหมาะสม 4.86 0.35 มากท่ีสุด 
    4.22 การเลือกใชสี้ตวัอกัษรเหมาะสม 4.83 0.38 มากท่ีสุด 
    4.23 การใชสี้พื้นจอภาพเหมาะสม 4.81 0.47 มากท่ีสุด 
    4.24 สีตวัอกัษรท่ีใชเ้ช่ือมโยงแต่ละหนา้จอ 4.86 0.35 มากท่ีสุด 
                                   ค่าเฉลีย่รวม                                          4.70 0.48 มากทีสุ่ด 

5. ท่านมีความคิดเห็นว่าต้องการจัดการเรียนการสอนผ่านเครือข่าย ในหัวข้อดังต่อไปนี้ อยู่ในระดับใด 
   5.1 การรับและส่งไปรษณียอิ์เล็กทรอนิกส์ (E-mail)  4.60 0.49 มากท่ีสุด 

   5.2 การถ่ายโอนแฟ้มขอ้มูล (File Transfer)  4.33 0.78 มาก 
   5.3 การเช่ือมต่อเขา้ใชง้าน (Log In)   4.30 0.84 มาก 
   5.4 การคน้หาขอ้มูล (Search Engine)  4.30 0.84 มาก 
   5.5 การอภิปรายและการประชุมทางไกล  
       (Discussion and Teleconference)  

3.89 0.70 มาก 

   5.6 วดีิโอคอนเฟอร์เร้น (Video Conference)  4.57 0.64 มากท่ีสุด 
   5.7 กิจกรรมแบบประวงิเวลา (Delay)  4.05 0.89 มาก 
   5.8 กิจกรรมลิสเซิร์ฟ (Listserv)  3.94 0.64 มาก 
   5.9 ยสูเน็ต (USENET)  3.87 0.63 มาก 
   5.10 กระดานอิเล็กทรอนิกส์ (Electronic Boards) 4.70 0.50 มากท่ีสุด 
   5.11 การติดต่อส่ือสารแบบโตต้อบทนัที (Real Time)  
         ผา่นโปรแกรมทอลก์ (Talk)  

3.86 0.72 มาก 
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ตารางภาคผนวกที ่ 4  ลกัษณะสภาพการจัดการเรียนการสอนวชิาคอมพวิเตอร์ทีพ่งึประสงค์ของการ      
                                   ออกแบบห้องเรียนเสมือน (ต่อ) 
 

รายการประเมิน X  S.D. แปลผล 
    5.12 การส่งขอ้ความ (Send Massage) โดยใช ้ 
            โปรแกรมไอซีคิว (ICQ) 

4.05 0.66 มาก 

    5.13 การส่งขอ้ความ (Send Massage) โดยใช ้ 
            โปรแกรมเฟซบุค (Facebook) 

4.76 0.50 มากท่ีสุด 

      5.14 การส่งขอ้ความ (Send Massage) โดยใช ้ 
              โปรแกรมทวิตเตอร์ (Twitter)          

4.32 0.64 มาก 

     5.15 การติดต่อส่ือสารผา่นแอพพลิเคชัน่ไลน์  (Line)  4.68 0.47 มากท่ีสุด 
ค่าเฉลีย่รวม 4.28 0.66 มาก 

 จากตารางภาคผนวกท่ี 4  ผูต้อบแบบสอบถามส่วนใหญ่ต้องการสอนด้วยการสอนด้วย

หอ้งเรียนเสมือน (ผา่นเวบ็) เป็นส่ือประกอบการจดัการเรียนการสอน กิจกรรมการเรียนการสอนส่วน

ใหญ่ตอ้งการให้นกัเรียนท างานเป็นกลุ่ม ระดมความคิด และสร้างผลงาน ตอ้งการให้จดัการเรียนการ

สอนโดยเนน้เทคโนโลยี(ห้องเรียนเสมือน) มากท่ีสุด และตอ้งการจดัการเรียนการสอนผา่นเครือข่าย 

ในหวัขอ้การติดต่อส่ือสารผา่นแอพพลิเคชัน่ไลน์มากท่ีสุด 
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ตารางภาคผนวกที่  5  ความคิดเห็นของผูเ้ช่ียวชาญเพื่อหาค่าดชันีความสอดคล้อง (IOC) ของขอ้ 
ค าถามเพื่อสร้างแบบสอบถามความคิดเห็นส าหรับผูเ้ช่ียวชาญ เก่ียวกบัการ
พฒันาห้องเรียนเสมือน เร่ืองการสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์    
ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี  6 

 

รายการ 

ระดับความสอดคล้อง 

ผู้เ
ชี่ย

วช
าญ

  1
 

ผู้เ
ชี่ย

วช
าญ

  2
 

ผู้เ
ชี่ย

วช
าญ

  3
 

ค่า
คว

าม
สอ

ดค
ล้อ

ง 

หม
าย
เห
ตุ 

1. เป็นการเรียนรู้ดว้ยตนเอง โดยยดึผูเ้รียนเป็นส าคญั 1 0 1 0.66  

2. ช่วยพฒันาความสามารถในการคิดวิเคราะห์ของนกัเรียน 0 1 1 0.66  
3. ท าใหมี้ประสบการณ์ในการใชเ้คร่ืองคอมพิวเตอร์มากข้ึน 1 1 1 1  
4. สอนตามจุดประสงคข์องการเรียน 1 1 1 1  
5. มีแหล่งสนบัสนุนการเรียนท่ีเหมาะสม เช่น การติดต่อ  
    ผูส้อน กระดานแลกเปล่ียนเรียนรู้ แหล่งเรียนรู้ 

1 1 1 1  

6. เปิดโอกาสใหผู้เ้รียนติดต่อกบัผูส้อนใหมี้ปฏิสัมพนัธ์  
    ระหวา่ง ผูเ้รียนกบัผูส้อน ผูเ้รียนกบัผูเ้รียน และผูเ้รียนกบั  
    ส่ือ 

1 1 1 1  

7. น าเสนอเน้ือหาเป็นระบบ ช่วยใหเ้ห็นความต่อเน่ือง  
    ของเน้ือหา 

1 1 1 1  

8. สามารถทบทวนเน้ือหาไดจ้นเขา้ใจ ตามความสามารถ  
    ของผูเ้รียน 

1 1 1 1  

9. กิจกรรมระหวา่งเรียนและการฝึกทกัษะช่วยใหผู้เ้รียนมี  
    ความเขา้ใจเน้ือหาในบทเรียน 

1 1 0 0.66  

10. เปิดโอกาสใหผู้เ้รียนมีส่วนร่วมในบทเรียน 1 1 1 1  
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ตารางภาคผนวกที่  5  ความคิดเห็นของผูเ้ช่ียวชาญเพื่อหาค่าดชันีความสอดคล้อง (IOC) ของขอ้ 
ค าถามเพื่อสร้างแบบสอบถามความคิดเห็นส าหรับผูเ้ช่ียวชาญ เก่ียวกบัการ
พฒันาห้องเรียนเสมือน เร่ืองการสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์    
ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี  6 (ต่อ) 

 

รายการ 

ระดับความสอดคล้อง 

ผู้เ
ชี่ย

วช
าญ

  1
 

ผู้เ
ชี่ย

วช
าญ

  2
 

ผู้เ
ชี่ย

วช
าญ

  3
 

ค่า
คว

าม
สอ

ดค
ล้อ

ง 

หม
าย
เห
ตุ 

11. มีความสะดวกในการเขา้ถึงบทเรียนหรือการคน้หา  
      ขอ้มูลต่าง ๆ 

1 1 0 0.66  

12. กระตุน้ใหผู้เ้รียนอยากเรียนรู้ในเน้ือหาตอนต่อไป 1 0 1 0.66  
13. ผลการประเมินต่างๆ สามารถโตต้อบไดท้นัที 1 0 1 0.66  
14. ภาพประกอบและภาพเคล่ือนไหว มีส่วนช่วยใหเ้ขา้ใจ  
      เน้ือหาไดดี้ข้ึน 

1 1 1 1  

15. ศึกษาและทบทวนบทเรียนไดไ้ม่จ  ากดัเวลาและมีอิสระ  
      ในการเรียน 

1 1 1 1  

ค่าเฉลีย่รวม 0.93 0.80 0.93 0.86  
ผลจากการประเมินไดค้่าดชันีความสอดคลอ้ง เท่ากบั 0.86  ไม่มีขอ้ค าถามท่ีมีค่าความ

สอดคลอ้งของความตรงของเน้ือหา ความเหมาะสมของค าถามและรูปแบบภาษา ท่ีมีค่าต ่ากวา่ 0.5  
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ตารางภาคผนวกที ่6  ความคิดเห็นของผูเ้ช่ียวชาญดา้นวดัและประเมินผล เพื่อหาดชันีความสอดคลอ้ง  
                                  (IOC) ของแบบทดสอบก่อนและหลงัเรียน   
 
จุดประสงค์

ข้อที่ 
ข้อสอบ
ข้อที่ 

คะแนนความคิดเห็น 
ของผู้เช่ียวชาญ 

R  IOC สรุป 

คนที่1 คนที่2 คนที่3 

1 1 0 +1 +1 +2 0.7 ใชไ้ด ้
2 +1 +1 +1 +3 1 ใชไ้ด ้
3 +1 +1 +1 +3 1 ใชไ้ด ้

2 4 +1 +1 +1 +3 1 ใชไ้ด ้
3 5 +1 +1 +1 +3 1 ใชไ้ด ้

6 +1 +1 +1 +3 1 ใชไ้ด ้
4 7 +1 +1 +1 +3 1 ใชไ้ด ้

8 +1 +1 +1 +3 1 ใชไ้ด ้
9 +1 +1 +1 +3 1 ใชไ้ด ้

10 +1 +1 +1 +3 1 ใชไ้ด ้
11 +1 +1 +1 +3 1 ใชไ้ด ้
12 +1 +1 +1 +3 1 ใชไ้ด ้
13 +1 +1 +1 +3 1 ใชไ้ด ้
14 +1 +1 +1 +3 1 ใชไ้ด ้
15 +1 0 +1 +2 0.7 ใชไ้ด ้
16 +1 +1 +1 +3 1 ใชไ้ด ้
17 +1 +1 +1 +3 1 ใชไ้ด ้
18 0 +1 +1 +2 0.7 ใชไ้ด ้
19 +1 +1 +1 +3 1 ใชไ้ด ้
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ตารางภาคผนวกที ่6  ความคิดเห็นของผูเ้ช่ียวชาญดา้นวดัและประเมินผล เพื่อหาดชันีความสอดคลอ้ง  
                                  (IOC) ของแบบทดสอบก่อนและหลงัเรียน (ต่อ) 

จุดประสงค์
ข้อที่ 

ข้อสอบ
ข้อที่ 

คะแนนความคิดเห็น 
ของผู้เช่ียวชาญ 

R  IOC สรุป 

คนที่1 คนที่2 คนที่3 

5 20 +1 +1 +1 +3 1 ใชไ้ด ้
21 +1 +1 +1 +3 1 ใชไ้ด ้
22 +1 +1 +1 +3 1 ใชไ้ด ้
23 +1 +1 +1 +3 1 ใชไ้ด ้
24 +1 +1 +1 +3 1 ใชไ้ด ้
25 +1 +1 +1 +3 1 ใชไ้ด ้
26 +1 +1 +1 +3 1 ใชไ้ด ้
27 +1 +1 +1 +3 1 ใชไ้ด ้
28 +1 0 +1 +2 0.7 ใชไ้ด ้
29 +1 +1 +1 +3 1 ใชไ้ด ้
30 +1 +1 +1 +3 1 ใชไ้ด ้
31 +1 +1 +1 +3 1 ใชไ้ด ้
32 +1 +1 +1 +3 1 ใชไ้ด ้
33 +1 +1 +1 +3 1 ใชไ้ด ้
34 0 +1 +1 +2 0.7 ใชไ้ด ้
35 +1 +1 +1 +3 1 ใชไ้ด ้
36 +1 +1 +1 +3 1 ใชไ้ด ้
37 +1 +1 +1 +3 1 ใชไ้ด ้
38 +1 +1 +1 +3 1 ใชไ้ด ้
39 +1 +1 +1 +3 1 ใชไ้ด ้
40 +1 +1 +1 +3 1 ใชไ้ด ้
41 +1 +1 +1 +3 1 ใชไ้ด ้
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ตารางภาคผนวกที ่6  ความคิดเห็นของผูเ้ช่ียวชาญดา้นวดัและประเมินผล เพื่อหาดชันีความสอดคลอ้ง  
                                  (IOC) ของแบบทดสอบก่อนและหลงัเรียน (ต่อ) 

จุดประสงค์
ข้อที่ 

ข้อสอบ
ข้อที่ 

คะแนนความคิดเห็น 
ของผู้เช่ียวชาญ 

R  IOC สรุป 

คนที่1 คนที่2 คนที่3 

6 42 +1 +1 +1 +3 1 ใชไ้ด ้
43 +1 +1 +1 +3 1 ใชไ้ด ้
44 +1 +1 +1 +3 1 ใชไ้ด ้
45 +1 +1 +1 +3 1 ใชไ้ด ้
46 +1 +1 +1 +3 1 ใชไ้ด ้
47 +1 +1 +1 +3 1 ใชไ้ด ้

7 
 

48 +1 +1 +1 +3 1 ใชไ้ด ้
49 +1 +1 0 +2 0.7 ใชไ้ด ้
50 +1 +1 +1 +3 1 ใชไ้ด ้
51 +1 +1 +1 +3 1 ใชไ้ด ้
52 +1 +1 +1 +3 1 ใชไ้ด ้
53 +1 +1 +1 +3 1 ใชไ้ด ้
54 +1 +1 +1 +3 1 ใชไ้ด ้
55 +1 +1 +1 +3 1 ใชไ้ด ้
56 +1 +1 +1 +3 1 ใชไ้ด ้
57 0 +1 +1 +2 0.7 ใชไ้ด ้
58 +1 +1 +1 +3 1 ใชไ้ด ้
59 +1 +1 +1 +3 1 ใชไ้ด ้
60 +1 +1 +1 +3 1 ใชไ้ด ้
61 +1 +1 +1 +3 1  
62 +1 +1 +1 +3 1  
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ตารางภาคผนวกที ่6  ความคิดเห็นของผูเ้ช่ียวชาญดา้นวดัและประเมินผล เพื่อหาดชันีความสอดคลอ้ง  
                                  (IOC) ของแบบทดสอบก่อนและหลงัเรียน (ต่อ) 

จุดประสงค์
ข้อที่ 

ข้อสอบ
ข้อที่ 

คะแนนความคิดเห็น 
ของผู้เช่ียวชาญ 

R  IOC สรุป 

คนที่1 คนที่2 คนที่3 

8 
 
 

63 +1 +1 +1 +3 1 ใชไ้ด ้
64 +1 +1 +1 +3 1 ใชไ้ด ้
65 +1 +1 +1 +3 1 ใชไ้ด ้
66 +1 +1 +1 +3 1 ใชไ้ด ้
67 +1 +1 +1 +3 1 ใชไ้ด ้
68 +1 +1 +1 +3 1 ใชไ้ด ้
69 +1 0 +1 +2 0.7 ใชไ้ด ้
70 +1 +1 +1 +3 1 ใชไ้ด ้
71 +1 +1 +1 +3 1 ใชไ้ด ้
72 +1 +1 +1 +3 1 ใชไ้ด ้
73 +1 +1 +1 +3 1 ใชไ้ด ้

9 74 +1 +1 +1 +3 1 ใชไ้ด ้
75 +1 +1 +1 +3 1 ใชไ้ด ้
76 +1 +1 +1 +3 1 ใชไ้ด ้
77 0 +1 +1 +2 0.7 ใชไ้ด ้
78 +1 +1 +1 +3 1 ใชไ้ด ้
79 +1 +1 +1 +3 1 ใชไ้ด ้
80 +1 +1 +1 +3 1 ใชไ้ด ้
81 +1 +1 +1 +3 1 ใชไ้ด ้
82 +1 +1 +1 +3 1 ใชไ้ด ้
83 +1 +1 +1 +3 1 ใชไ้ด ้
84 +1 +1 0 +2 0.7 ใชไ้ด ้
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ตารางภาคผนวกที ่6  ความคิดเห็นของผูเ้ช่ียวชาญดา้นวดัและประเมินผล เพื่อหาดชันีความสอดคลอ้ง  
                                  (IOC) ของแบบทดสอบก่อนและหลงัเรียน (ต่อ) 

จุดประสงค์
ข้อที่ 

ข้อสอบ
ข้อที่ 

คะแนนความคิดเห็น 
ของผู้เช่ียวชาญ 

R  IOC สรุป 

คนที่1 คนที่2 คนที่3 

 
 
 

85 +1 +1 +1 +3 1 ใชไ้ด ้
86 +1 +1 +1 +3 1 ใชไ้ด ้
87 +1 +1 +1 +3 1 ใชไ้ด ้

10 88 +1 +1 +1 +3 1 ใชไ้ด ้
89 +1 +1 +1 +3 1 ใชไ้ด ้
90 +1 +1 +1 +3 1 ใชไ้ด ้
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ตารางภาคผนวกที ่7  ผลวเิคราะห์ค่าความยากง่าย อ านาจจ าแนก และความเช่ือมัน่ของแบบทดสอบ  
                                   

ข้ อ  ( p )  ความหมาย ( r )  ความหมาย 

ส รุปผล  
ก าร

วิ เ ค ราะ ห์
ข้ อสอบ  

1 0.30 ขอ้สอบท่ีค่อนขา้งยาก 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
2 0.83 ขอ้สอบท่ีง่ายมาก 0.07 อ านาจจ าแนกต ่า ใชไ้ม่ได ้
3 0.70 ขอ้สอบท่ีค่อนขา้งง่าย 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
4 0.50 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.60 อ านาจจ าแนกสูง ใชไ้ด ้
5 0.50 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.20 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
6 0.63 ขอ้สอบท่ีค่อนขา้งง่าย 0.20 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
7 0.57 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
8 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
9 0.53 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.80 อ านาจจ าแนกสูง ใชไ้ด ้
10 0.53 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
11 0.50 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.73 อ านาจจ าแนกสูง ใชไ้ด ้
12 0.57 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.60 อ านาจจ าแนกสูง ใชไ้ด ้
13 0.53 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.40 อ านาจจ าแนกสูง ใชไ้ด ้
14 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
15 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.60 อ านาจจ าแนกสูง ใชไ้ด ้
16 0.37 ขอ้สอบท่ีค่อนขา้งยาก 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
17 0.60 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.13 อ านาจจ าแนกต ่า ใชไ้ม่ได ้
18 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
19 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
20 0.53 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.67 อ านาจจ าแนกสูง ใชไ้ด ้
21 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้

 

 



  192 

 

 

 

ตารางภาคผนวกที ่7  ผลวเิคราะห์ค่าความยากง่าย อ านาจจ าแนก และความเช่ือมัน่ของแบบทดสอบ   
                                  (ต่อ) 
 

ข้ อ  ( p )  ความหมาย ( r )  ความหมาย 

ส รุปผล  
ก าร

วิ เ ค ราะ ห์
ข้ อสอบ  

22 0.77 ขอ้สอบท่ีค่อนขา้งง่าย -0.33 อ านาจจ าแนกต ่า ใชไ้ม่ได ้
23 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
24 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
25 0.37 ขอ้สอบท่ีค่อนขา้งยาก 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
26 0.33 ขอ้สอบท่ีค่อนขา้งยาก 0.40 อ านาจจ าแนกสูง ใชไ้ด ้
27 0.50 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.73 อ านาจจ าแนกสูง ใชไ้ด ้
28 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
29 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
30 0.67 ขอ้สอบท่ีค่อนขา้งง่าย 0.00 อ านาจจ าแนกต ่า ใชไ้ม่ได ้
31 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.20 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
32 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.40 อ านาจจ าแนกสูง ใชไ้ด ้
33 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
34 0.57 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.60 อ านาจจ าแนกสูง ใชไ้ด ้
35 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
36 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.40 อ านาจจ าแนกสูง ใชไ้ด ้
37 0.47 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
38 0.33 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
39 0.37 ขอ้สอบท่ีค่อนขา้งยาก 0.20 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
40 0.50 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
41 0.60 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.53 อ านาจจ าแนกสูง ใชไ้ด ้
42 0.37 ขอ้สอบท่ีค่อนขา้งยาก 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
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ตารางภาคผนวกที ่7  ผลวเิคราะห์ค่าความยากง่าย อ านาจจ าแนก และความเช่ือมัน่ของแบบทดสอบ   
                                  (ต่อ) 
 

ข้ อ  ( p )  ความหมาย ( r )  ความหมาย 

ส รุปผล  
ก าร

วิ เ ค ราะ ห์
ข้ อสอบ  

43 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.40 อ านาจจ าแนกสูง ใชไ้ด ้
44 0.47 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.40 อ านาจจ าแนกสูง ใชไ้ด ้
45 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
46 0.73 ขอ้สอบท่ีค่อนขา้งง่าย -0.13 อ านาจจ าแนกต ่า ใชไ้ม่ได ้
47 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
48 0.53 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.53 อ านาจจ าแนกสูง ใชไ้ด ้
49 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
50 0.60 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
51 0.47 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.13 อ านาจจ าแนกต ่า ใชไ้ม่ได ้
52 0.47 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
53 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
54 0.87 ขอ้สอบท่ีง่ายมาก -0.27 อ านาจจ าแนกต ่า ใชไ้ม่ได ้
55 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
56 0.53 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.40 อ านาจจ าแนกสูง ใชไ้ด ้
57 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
58 0.37 ขอ้สอบท่ีค่อนขา้งยาก 0.20 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
59 0.50 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.73 อ านาจจ าแนกสูง ใชไ้ด ้
60 0.33 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
61 0.30 ขอ้สอบท่ีค่อนขา้งยาก 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
62 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
63 0.77 ขอ้สอบท่ีค่อนขา้งง่าย 0.07 อ านาจจ าแนกต ่า ใชไ้ม่ได ้
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ตารางภาคผนวกที ่7  ผลวเิคราะห์ค่าความยากง่าย อ านาจจ าแนก และความเช่ือมัน่ของแบบทดสอบ   
                                  (ต่อ) 
 

ข้ อ  ( p )  ความหมาย ( r )  ความหมาย 

ส รุปผล  
ก าร

วิ เ ค ราะ ห์
ข้ อสอบ  

64 0.50 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
65 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.40 อ านาจจ าแนกสูง ใชไ้ด ้
66 0.50 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
67 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.40 อ านาจจ าแนกสูง ใชไ้ด ้
68 0.37 ขอ้สอบท่ีค่อนขา้งยาก 0.20 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
69 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.20 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
70 0.47 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.40 อ านาจจ าแนกสูง ใชไ้ด ้
71 0.37 ขอ้สอบท่ีค่อนขา้งยาก 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
72 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
73 0.37 ขอ้สอบท่ีค่อนขา้งยาก 0.20 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
74 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
75 0.53 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
76 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.40 อ านาจจ าแนกสูง ใชไ้ด ้
77 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
78 0.57 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
79 0.50 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
80 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
81 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
82 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.20 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
83 0.40 ขอ้สอบท่ีค่อนขา้งยาก 0.27 อ านาจจ าแนกค่อนขา้งต ่า ใชไ้ด ้
84 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
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ตารางภาคผนวกที ่7  ผลวเิคราะห์ค่าความยากง่าย อ านาจจ าแนก และความเช่ือมัน่ของแบบทดสอบ   
                                  (ต่อ) 
 

ข้ อ  ( p )  ความหมาย ( r )  ความหมาย 

ส รุปผล  
ก าร

วิ เ ค ราะ ห์
ข้ อสอบ  

85 0.50 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.60 อ านาจจ าแนกสูง ใชไ้ด ้
86 0.57 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.47 อ านาจจ าแนกสูง ใชไ้ด ้
87 0.37 ขอ้สอบท่ีค่อนขา้งยาก 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
88 0.53 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.80 อ านาจจ าแนกสูง ใชไ้ด ้
89 0.43 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.33 อ านาจจ าแนกปานกลาง ใชไ้ด ้
90 0.53 ขอ้สอบท่ียาก – ง่ายพอเหมาะดี 0.53 อ านาจจ าแนกสูง ใชไ้ด ้

KR-20 0.82 

หมายเหตุ    ค่า  p  ระหวา่ง  0.20 – 0.80 
       ค่า  r  เท่ากบั  0.20 ข้ึนไป 
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ตารางภาคผนวกที ่8  ความคิดเห็นของผูเ้ช่ียวชาญเพื่อหาค่าดชันีความสอดคลอ้ง (IOC) ของขอ้ค าถาม
เพื่อสร้างแบบสอบถามประเมินความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 
6 ท่ีมีต่อการพฒันาการพฒันาห้องเรียนเสมือน เร่ืองการสร้างเว็บไซต์ด้วย
โปรแกรมดรีมวฟีเวอร์     

 

รายการ 

ระดับความสอดคล้อง 

ผู้เ
ชี่ย

วช
าญ

  1
 

ผู้เ
ชี่ย

วช
าญ

  2
 

ผู้เ
ชี่ย

วช
าญ

  3
 

ค่า
คว

าม
สอ

ดค
ล้อ

ง 

หม
าย
เห
ตุ 

1. ดา้นเน้ือหา 
    1.1 เน้ือหาวชิาในห้องเรียนเสมือนมีความสอดคลอ้งกบั

วตัถุประสงคก์ารเรียนรู้ 
1 1 1 1 

 
 

    1.2 การล าดบัเน้ือหาเรียงจากง่ายไปหายาก 1 1 1 1  
    1.3 ผูเ้รียนสามารถเขา้ถึงเน้ือหาไดร้วดเร็ว 1 1 1 1  
    1.4 ผูเ้รียนเขา้ใจเน้ือหาในบทเรียนไดง่้าย 1 1 1 1  
    1.5 ผูเ้รียนน าความรู้ท่ีไดไ้ปประยกุตใ์ชใ้นชีวติประจ าวนั  
          ได ้

0 1 1 0.66  

    1.6 ผูเ้รียนตระถึงคุณค่าและประโยชน์ของความรู้ท่ีไดรั้บ 1 0 1 0.66  
ค่าเฉลีย่รวมด้านเนือ้หา 0.83 0.83 1 0.89  

2. ดา้นการน าเสนอดว้ยภาพ สี เสียงประกอบ และการเช่ือมโยงเน้ือหา 
     2.1  ภาพประกอบสอดคลอ้งกบัเน้ือหา 1 1 1 1  
     2.2  ภาพประกอบมีความน่าสนใจสามารถส่ือสารได ้ 
           ชดัเจน 

0 0 1 0.33  

     2.3  มีภาพไอคอนสวยงามน่าสนใจ ส่ือความหมาย  
            ชดัเจน 

1 0 0 0.33  

     2.4  การเช่ือมโยงเน้ือเพื่อสร้างปฏิสัมพนัธ์ระหวา่ง  
            ผูเ้รียนกบับทเรียน 

1 1 1 1  
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ตารางภาคผนวกที ่8  ความคิดเห็นของผูเ้ช่ียวชาญเพื่อหาค่าดชันีความสอดคลอ้ง (IOC) ของขอ้ค าถาม
เพื่อสร้างแบบสอบถามประเมินความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 
6 ท่ีมีต่อการพฒันาการพฒันาหอ้งเรียนเสมือน เร่ืองการสร้างเวบ็ไซตด์ว้ย
โปรแกรมดรีมวฟีเวอร์ (ต่อ)     

รายการ 

ระดับความสอดคล้อง 

ผู้เ
ชี่ย

วช
าญ

  1
 

ผู้เ
ชี่ย

วช
าญ

  2
 

ผู้เ
ชี่ย

วช
าญ

  3
 

ค่า
คว

าม
สอ

ดค
ล้อ

ง 

หม
าย
เห
ตุ 

     2.5  การเช่ือมโยง (Link) เน้ือหาของห้องเรียนเสมือน           
           ท าไดง่้าย 

1 1 1 1  

ค่าเฉลีย่รวมด้านการน าเสนอด้วยภาพ สี เสียงประกอบ  
และการเช่ือมโยงเนือ้หา 

0.80 0.60 0.80 0.73  

3.  ด้านแบบทดสอบและการประเมินผล  
      3.1  การสอนผา่นเวบ็มีแบบทดสอบหลงัเรียนช่วยให ้ 
             ผูเ้รียนไดต้รวจสอบความเขา้ใจในเน้ือหาบทเรียน  
             ไดเ้หมาะสม 

1 1 1 1  

     3.2  ค  าถามมีความชัดเจน 0 0 1 0.33  
     3.3  แบบทดสอบสอดคล้องกับว ัตถุประสงค์  0 0 1 0.33  
     3.4  ความยากง่ายของแบบทดสอบเหมาะสม 0 1 1 0.66  
     3.5  สรุปผลคะแนนท้ายบทเรียนชัดเจน  0 0 1 0.33  
ค่าเฉลีย่รวมด้านแบบทดสอบและการประเมินผล  0.2 0.4 1 0.53  
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ตารางภาคผนวกที ่8  ความคิดเห็นของผูเ้ช่ียวชาญเพื่อหาค่าดชันีความสอดคลอ้ง (IOC) ของขอ้ค าถาม
เพื่อสร้างแบบสอบถามประเมินความพึงพอใจของนกัเรียนชั้นประถมศึกษาปีท่ี 
6 ท่ีมีต่อการพฒันาการพฒันาหอ้งเรียนเสมือน เร่ืองการสร้างเวบ็ไซตด์ว้ย
โปรแกรมดรีมวฟีเวอร์    (ต่อ) 

 

รายการ 

ระดับความสอดคล้อง 

ผู้เ
ชี่ย

วช
าญ

  1
 

ผู้เ
ชี่ย

วช
าญ

  2
 

ผู้เ
ชี่ย

วช
าญ

  3
 

ค่า
คว

าม
สอ

ดค
ล้อ

ง 

หม
าย
เห
ตุ 

4.  ด้านส่ิงอ านวยความสะดวก 
     4.1  การติดต่อส่ือสารผ่านจดหมาย

อิเล็กทรอนิกส์  
1 1 1 1  

     4.2  การส่งขอ้ความ (Send Massage)โดยใชโ้ปรแกรม 
            เฟสบุค๊ (Facebook) 

1 1 1 1  

     4.3 การติดต่อส่ือสารผา่นแอพพลิเคชัน่ไลน์ (Line) 1 1 1 1  
ค่าเฉลีย่รวมด้านส่ิงอ านวยความสะดวก  1 1 1 1  

      
 ผลจากการประเมินไดค้่าเฉล่ียความสอดคลอ้งดา้นเน้ือหา = 0.89 ดา้นการน าเสนอดว้ยภาพ สี 
เสียงประกอบ และการเช่ือมโยงเน้ือหา = 0.73 ดา้นแบบทดสอบและการประเมินผล = 0.53  และดา้น
ส่ิงอ านวยความสะดวก  = 1 ไม่มีขอ้ค าถามท่ีมีค่าความสอดคลอ้งของความตรงของเน้ือหา ความ
เหมาะสมของค าถามและรูปแบบภาษาท่ีมีค่าต ่ากวา่ 0.5  
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ตารางภาคผนวกที ่ 9  รายงานสรุปผลการหาประสิทธิภาพของหอ้งเรียนเสมือน เร่ือง การสร้าง 
         เวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์CS6  ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี  6  

คนที่ ร้อยละของคะแนนระหว่างกิจกรรม (E1) ร้อยละของคะแนนแบบทดสอบ (E2) 

  1 77.50 70.00 

2 75.00 83.33 

3 80.00 80.00 

4 82.50 80.00 

5 77.50 83.33 

6 85.00 76.67 

7 85.00 76.67 

8 82.50 83.33 

9 85.00 83.33 

10 82.50 76.67 

11 82.50 80.00 

12 82.50 80.00 

13 82.50 76.67 

14 82.50 83.33 

15 77.50 83.33 

16 82.50 76.67 

17 75.00 76.67 

18 77.50 80.00 

19 82.50 83.33 

20 82.50 80.00 

21 87.50 80.00 

22 87.50 83.33 

23 82.50 83.33 
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ตารางภาคผนวกที ่ 9  รายงานสรุปผลการหาประสิทธิภาพของหอ้งเรียนเสมือน เร่ือง การสร้าง 
         เวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์CS6  ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี  6   
        (ต่อ) 
 

คนที่ ร้อยละของคะแนนระหว่างกิจกรรม (E1) ร้อยละของคะแนนแบบทดสอบ (E2) 

24 77.50 83.33 

25 82.50 80.00 

26 82.50 80.00 

27 82.50 83.33 

28 85.00 83.33 

29 87.50 83.33 

30 82.50 83.33 

เฉลีย่ร้อยละ                 (E1)      81.92           (E2)        80.56 

จากตารางภาคผนวกท่ี 9   แสดงการหาประสิทธิภาพจากคะแนนร้อยละของการท ากิจกรรม
ระหว่างระหว่างเรียนรู้และค่าคะแนนร้อยละของแบบทดสอบหลงัการเรียนรู้ด้วยห้องเรียนเสมือน 
ของกลุ่มทดลองจ านวน 30  คน โดยพบวา่ค่า  E1/E2 เท่ากบั 81.92/80.56  ซ่ึงถือวา่สูงกวา่สมมติฐาน
ท่ีตั้งไวน้ัน่ก็คือ 80/80  
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ตารางภาคผนวกที ่ 10  คะแนนก่อนและหลงัการเรียนดว้ยหอ้งเรียนเสมือนของนกัเรียนทั้งหมด  
           30  คน 

คนที่ คะแนนก่อนเรียน คะแนนหลังเรียน 

  1 14 21 

2 14 25 

3 14 24 

4 14 24 

5 14 25 

6 15 23 

7 13 23 

8 11 25 

9 14 25 

10 9 23 

11 15 24 

12 11 24 

13 9 23 

14 12 25 

15 12 25 

16 14 23 

17 11 23 

18 17 24 

19 13 25 

20 8 24 

21 12 24 

22 10 25 

23 14 25 
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ตารางภาคผนวกที ่  10  คะแนนก่อนและหลงัการเรียนดว้ยหอ้งเรียนเสมือนของนกัเรียนทั้งหมด  
           30  คน (ต่อ) 

คนที่ คะแนนก่อนเรียน คะแนนหลังเรียน 

24 15 25 

25 15 24 

26 16 24 

27 13 25 

28 15 25 

29 14 25 

30 14 25 

 
 
 
 



ภาคผนวก  ซ 
แบบทดสอบก่อนเรียน/หลงัเรียน 
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แบบทดสอบก่อนเรียน/หลงัเรียน 
ค าช้ีแจง  แบบทดสอบน้ีมีทั้งหมด  30 ขอ้ ใหน้กัเรียนใส่เคร่ืองหมาย    ในช่อง  ก.  ข.  ค.  และ  ง.  
เพื่อเลือกค าตอบท่ีถูกตอ้งท่ีสุด 
1. ขอ้ใดคือความหมายของโปรแกรม Dreamweaver ท่ีถูกตอ้งท่ีสุด 
  ก. โปรแกรมส าหรับท าภาพกราฟิก 
  ข. โปรแกรมส าหรับท างานมลัติมีเดีย 
  ค. โปรแกรมส าหรับออกแบบเวบ็ไซต ์สร้างเวบ็เพจ 
  ง. โปรแกรมส าหรับสร้างตารางและท าแบบฟอร์ม 
2. วธีิเรียกใชง้านโปรแกรม Dreamweaver ท่ีถูกตอ้งคือขอ้ใด 
  ก. Start > Search > Adobe Dreamweaver 
  ข. Start > Setting > Adobe Dreamweaver 
  ค. Start > Document > Adobe Dreamweaver 
  ง. Start> Programs > Adobe Dreamweaver 
3. เคร่ืองมือส าหรับช่วยเลือกขั้นตอนเร่ิมตน้การใชง้านโปรแกรมท่ีแสดงข้ึนทุกคร้ังท่ีเปิดโปรแกรมคือ
เคร่ืองมือในขอ้ใด 
  ก. Screen Capture 
  ข. Welcome Screen 
  ค. Insert Toolbar 
  ง. Properties Inspector 
4. มุมมองในการท างานของโปรแกรม Dreamweaver มีก่ีแบบ 
  ก. 5 แบบ 
  ข. 4 แบบ 
  ค. 3 แบบ 
  ง. 2 แบบ 
5. มุมมองโคด้และออกแบบมีช่ือเรียกในขอ้ใด 
  ก. Split 
  ข. Code 
  ค. Design 
  ง. Code and Design 
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6. ขอ้ใดคือค าสั่งในการสร้างไซตเ์พื่อจดัระบบใหข้อ้มูลไดถู้กตอ้ง 
  ก. Web > New site 
  ข. File > New site 
  ค. Edit > New site 
  ง. Site > New site 
7. ขอ้ใดไม่ใช่ขอ้ดีในการสร้างไซตใ์หม่ 
  ก. เพื่อใหโ้ปรแกรมรู้แหล่งการเก็บขอ้มูล 
  ข. ช่วยใหเ้น้ือหาและภาพประกอบถูกเก็บ ไวท่ี้ จุดเดียวกนั 
  ค. เพิ่มความเร็วในการอพัโหลดขอ้มูลข้ึนระบบอินเทอร์เน็ต 
  ง. ลดปัญหาภาพประกอบหายเม่ือน าเวบ็ไซตอ์พัโหลดข้ึนระบบอินเทอร์เน็ต 
8. ในหมวดการก าหนดคุณสมบติัทัว่ไปในการแสดงผล “Background Color” ใชท้  าส่ิงใด 
  ก. เลือกสีของขอ้ความ 
  ข. เลือกสีพื้นหลงัของเวบ็เพจ 
  ค. เลือกภาพฉากหลงัของเวบ็เพจ 
  ง. เลือกรูปแบบตวัอกัษรท่ีตอ้งการใชก้บัหนา้เวบ็ 
9. ในหมวดการก าหนดคุณสมบติัทัว่ไปในการแสดงผล “Text Color” ใชท้  าส่ิงใด 
  ก. เลือกสีของขอ้ความ 
  ข. เลือกสีพื้นหลงัของเวบ็เพจ 
  ค. เลือกภาพฉากหลงัของเวบ็เพจ 
  ง. เลือกรูปแบบตวัอกัษรท่ีตอ้งการใชก้บัหนา้เวบ็ 
10. ในหมวดการก าหนดคุณสมบติัทัว่ไปในการแสดงผล “Background Image” ใชท้  าส่ิงใด 
  ก. เลือกสีของขอ้ความ 
  ข. เลือกสีพื้นหลงัของเวบ็เพจ 
  ค. เลือกภาพฉากหลงัของเวบ็เพจ 
  ง. เลือกรูปแบบตวัอกัษรท่ีตอ้งการใชก้บัหนา้เวบ็ 
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11. การสร้างเวบ็เพจใหม่ท าไดโ้ดยใชค้  าสั่งในขอ้ใด 
  ก. Insert > New > Blank Page 
  ข. Edit > New > Blank Page 
  ค. File > New > Blank Page 
  ง. View > New > Blank Page 
12. การบนัทึกเวบ็เพจ ท าไดโ้ดยใชค้  าสั่งในขอ้ใด 
  ก. Insert > Save 
  ข. Edit > Save 
  ค. File > Save 
  ง. View > Save 
13. คียล์ดับนคียบ์อร์ดท่ีใชส้ าหรับบนัทึกงานคือขอ้ใด 
  ก. Ctrl + O 
  ข. Ctrl + S 
  ค. Ctrl + N 
  ง. Ctrl + C 
14. การเปิดไฟลเ์วบ็เพจท่ีสร้างไวแ้ลว้ข้ึนมาแกไ้ขท าไดโ้ดยใชค้  าสั่งใด 
  ก. Insert > Open 
  ข. Edit > Open 
  ค. File > Open 
  ง. View > Open 
15. คียล์ดับนคียบ์อร์ดท่ีใชส้ าหรับเปิดงานท่ีสร้างไวแ้ลว้ข้ึนมาแกไ้ขคือขอ้ใด 
  ก. Ctrl + O 
  ข. Ctrl + S 
  ค. Ctrl + N 
  ง. Ctrl + C 
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16. เม่ือตอ้งการทดสอบเวบ็เพจกบับราวเซอร์จะตอ้งกดปุ่มในขอ้ใด 
  ก. F12 
  ข. F11 
  ค. F10 
  ง. F9 
17. นามสกุลของไฟลง์านในโปรแกรม Dreamweaver คือนามสกุลในขอ้ใด 
  ก. xx.psd 
  ข. xx.jpeg  
  ค. xx.ppt 
  ง. xx.html 
18. Bullet คือค าสั่งท่ีใชท้  าส่ิงใด 
  ก.  กั้นขอ้ความไปทางขวา 
  ข. กั้นขอ้ความไปทางซา้ย 
  ค. การใส่ตวัเลขก ากบั 
  ง. การใส่ล าดบั 
19. ในการแกไ้ขภาพเคร่ืองมือ          ใชส้ าหรับท าส่ิงใด 
  ก. ปรับปรุงความละเอียดของภาพ 
  ข. เพิ่มความสวา่งและคอนทราสต ์
  ค. เพิ่มความคมชดั 
  ง. ครอปภาพ 
20. เคร่ืองมือในขอ้ใดใชใ้นการสร้างตาราง 
  ก. 
  ข. 
  ค. 
  ง.  
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21. ในการสร้างตารางเคร่ืองมือ           ใชท้  าส่ิงใด 
  ก. เปล่ียนหน่วยความกวา้งของตารางเป็น\  เปอร์เซ็นต ์
  ข. เปล่ียนหน่วยความกวา้งของตารางเป็นพิกเซล 
  ค. ยกเลิกค่าความสูงของตาราง 
  ง. ยกเลิกค่าความกวา้งของตาราง 
22. ในการสร้างตารางเคร่ืองมือ         ใชท้  าส่ิงใด 
  ก. เปล่ียนหน่วยความกวา้งของตารางเป็นเปอร์เซ็นต ์
  ข. เปล่ียนหน่วยความกวา้งของตารางเป็นพิกเซล 
  ค. ยกเลิกค่าความสูงของตาราง 
  ง. ยกเลิกค่าความกวา้งของตาราง 
23. ในการสร้างตารางเคร่ืองมือ          ใชท้  าส่ิงใด 
  ก. เปล่ียนหน่วยความกวา้งของตารางเป็นเปอร์เซ็นต ์
  ข. เปล่ียนหน่วยความกวา้งของตารางเป็นพิกเซล 
  ค. ยกเลิกค่าความสูงของตาราง 
  ง. ยกเลิกค่าความกวา้งของตาราง 
24. ในการสร้างตารางเคร่ืองมือ          ใชท้  าส่ิงใด 
  ก. เปล่ียนหน่วยความกวา้งของตารางเป็นเปอร์เซ็นต ์
  ข. เปล่ียนหน่วยความกวา้งของตารางเป็นพิกเซล 
  ค. ยกเลิกค่าความสูงของตาราง 
  ง. ยกเลิกค่าความกวา้งของตาราง 
25. ในการก าหนดคุณสมบติัตางราง Brdr color คือการก าหนดส่ิงใด 
  ก. ก าหนดสีพื้นตาราง   
  ข. ก าหนดสีขอบตาราง 
  ค. ก าหนดต าแหน่งตาราง 
  ง. ก าหนดภาพพื้นหลงัของตาราง  
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26. ในการก าหนดคุณสมบติัตางราง BG color คือการก าหนดส่ิงใด 
  ก. ก าหนดสีพื้นตาราง   
  ข. ก าหนดสีขอบตาราง 
  ค. ก าหนดต าแหน่งตาราง 
  ง. ก าหนดภาพพื้นหลงัของตาราง 
27.ในการก าหนดคุณสมบติัตางราง BG Image คือการก าหนดส่ิงใด 
  ก. ก าหนดสีพื้นตาราง   
  ข. ก าหนดสีขอบตาราง 
  ค. ก าหนดต าแหน่งตาราง 
  ง. ก าหนดภาพพื้นหลงัของตาราง 
28. ในการน าคลิบวดีิโอมาใส่ในเวบ็เพจการตั้งค่าคุณสมบติั Auto rewind หมายถึงส่ิงใด 
  ก. การรักษาสัดส่วนของวิดีโอเม่ือปรับความ กวา้งความสูง 
  ข. ใหก้ลบัไปต าแหน่งเร่ิมตน้เม่ือเล่นจบ 
  ค. ความกวา้ง / /ความสูง ของวดีิโอ 
  ง. เร่ิมเล่นอตัโนมติัเม่ือเปิดเวบ 
29. ในการน าคลิบวดีิโอมาใส่ในเวบ็เพจการตั้งค่าคุณสมบติั Auto play หมายถึงส่ิงใด 
  ก. การรักษาสัดส่วนของวิดีโอเม่ือปรับความกวา้งความสูง 
  ข. ใหก้ลบัไปต าแหน่งเร่ิมตน้เม่ือเล่นจบ 
  ค. ความกวา้ง / /ความสูง ของวดีิโอ 
  ง. เร่ิมเล่นอตัโนมติัเม่ือเปิดเวบ 
30. ในการน าคลิบวดีิโอมาใส่ในเวบ็เพจการตั้งค่าคุณสมบติั Width / Height หมายถึงส่ิงใด 
  ก. การรักษาสัดส่วนของวิดีโอเม่ือปรับความกวา้งความสูง 
  ข. ใหก้ลบัไปต าแหน่งเร่ิมตน้เม่ือเล่นจบ 
  ค. ความกวา้ง / ความสูง ของวดีิโอ 
  ง. เร่ิมเล่นอตัโนมติัเม่ือเปิดเวบ 
 



ภาคผนวก  ฌ 
แบบสอบถามความพงึพอใจของนักเรียนช้ันประถมศึกษาปีที่  6   

ที่มีต่อการพฒันาห้องเรียนเสมือน 
 เร่ือง การสร้างเวบ็ไซต์ด้วยโปรแกรมดรีมวฟีเวอร์ CS6 
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แบบประเมินความพงึพอใจของนักเรียนช้ันประถมศึกษาปีที่ 6 
ทีม่ีต่อการพฒันาห้องเรียนเสมือน  

เร่ือง การสร้างเวบ็ไซต์ด้วยโปรแกรมดรีมวฟีเวอร์ CS6  
ค าช้ีแจง  ใหน้กัเรียนแสดงความคิดเห็นท่ีมีต่อการพฒันาห้องเรียนเสมือน เร่ือง การสร้างเวบ็ไซตด์ว้ย
โปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนชั้นประถมศึกษาปีท่ี 6 โดยท าเคร่ืองหมาย ลงใน
ช่องวา่งความคิดเห็นของนกัเรียน โดยก าหนดระดบัความพึงพอใจเป็นดงัต่อไปน้ี 

5 หมายถึง มีความพึงพอใจอยูใ่นระดบั มากท่ีสุด 
4 หมายถึง มีความพึงพอใจอยูใ่นระดบั มาก 
3 หมายถึง มีความพึงพอใจอยูใ่นระดบั ปานกลาง 
2 หมายถึง มีความพึงพอใจอยูใ่นระดบั นอ้ย 
1 หมายถึง มีความพึงพอใจอยูใ่นระดบั นอ้ยท่ีสุด 

รายการประเมิน ระดับความพงึพอใจ 

5 4 3 2 1 

1. ด้านเนือ้หา 
1.1 เน้ือหาวชิาในการสอนผา่นเวบ็มีสอดคลอ้งกบัวตัถุประสงคก์าร

เรียนรู้    
  

1.2 การล าดบัเน้ือหาเรียงจากง่ายไปหายาก      
1.3 ผูเ้รียนสามารถเขา้ถึงเน้ือหาไดร้วดเร็ว      
1.4 ผูเ้รียนเขา้ใจเน้ือหาในบทเรียนไดง่้าย 

   
  

1.5 ผูเ้รียนน าความรู้ท่ีไดไ้ปประยกุตใ์ชใ้นชีวติประจ าวนัได้      
1.6 ผูเ้รียนตระถึงคุณค่าและประโยชน์ของความรู้ท่ีไดรั้บ      
2.  ด้านการน าเสนอด้วยภาพ สี เสียงประกอบ และการเช่ือมโยงเนือ้หา 
     2.1  ภาพประกอบสอดคลอ้งกบัเน้ือหา      
     2.2  ภาพประกอบมีความน่าสนใจสามารถส่ือสารไดช้ดัเจน      
     2.3  มีภาพไอคอนสวยงามน่าสนใจส่ือความหมายชดัเจน      
     2.4  การเช่ือมโยงเน้ือเพื่อสร้างปฏิสัมพนัธ์ระหวา่งผูเ้รียนกบั 
            บทเรียน 

   
  

     2.5  การเช่ือมโยง (Link) เน้ือหาของบทเรียนบนเวบ็ไดง่้าย      
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รายการประเมิน ระดับความพงึพอใจ 

5 4 3 2 1 

3.  ด้านแบบทดสอบและการประเมินผล  
     3.1  การสอนผา่นเวบ็มีแบบทดสอบหลงัเรียนช่วยใหผู้เ้รียนได ้ 
            ตรวจสอบความเขา้ใจในเน้ือหาบทเรียนไดเ้หมาะสม    

  

     3.2  ค  าถามมีความชัดเจน      
     3.3  แบบทดสอบสอดคล้องกับว ัตถุประสงค์       
     3.4  ความยากง่ายของแบบทดสอบเหมาะสม 

   
  

     3.5  สรุปผลคะแนนท้ายบทเรียนชัดเจน       
4.  ด้านส่ิงอ านวยความสะดวก  
     4.1  การติดต่อส่ือสารผ่านจดหมายอิเล็กทรอนิกส์       
     4.2  การส่งขอ้ความ (Send Massage)โดยใชโ้ปรแกรมเฟสบุค๊
(Facebook) 

   
  

     4.3  การส่ือสารผา่นแอพพลิเคชัน่ไลน์      
 

 

 

 

 

 

 

 



ภาคผนวก ญ 
-  สคริปต์วดิโีอแนะน าบทเรียนในแต่ละหน่วยของห้องเรียนเสมือน เร่ือง 

การสร้างเวบ็ไซต์ด้วยโปรแกรมดรีมวฟีเวอร์ CS6  
ส าหรับนักเรียน ช้ันประถมศึกษาปีที่ 6 
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สคริปต์วดิีโอแนะน าบทเรียนในแต่ละหน่วยของห้องเรียนเสมือน เร่ือง การสร้าง 
เวบ็ไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ CS6 ส าหรับนักเรียนช้ันประถมศึกษาปีที ่6 

ตารางภาคผนวกที ่11 สคริปตแ์นะน าบทเรียนในแต่ละหน่วยการเรียนรู้  
หน่วยการ 
เรียนรู้ 

เร่ือง ภาพ ค าบรรยาย 

- 

แนะน าหอ้งเรียน
เสมือน 

ครูซีบรรยาย สวัสดีค่ะนักเรียนทุกคน ยินดีต้อนรับเข้า สู่ 
หอ้งเรียนเสมือนวชิาคอมพิวเตอร์ เร่ืองการสร้าง
เวบ็ไซตด์ว้ยโปรแกรมดรีมวฟีเวอร์ CS6 ส าหรับ
นกัเรียนชั้นประถมศึกษาปีท่ี 6 กบัครูซีนะคะ ใน
ห้อง เ รียน น้ีนัก เ รียนจะได้ความ รู้ เ ก่ี ยวกับ
วธีิการใชง้านโปรแกรมดรีมวฟีเวอร์ในการสร้าง
เวบ็ไซตข์องตวัเองนะคะ ไม่ว่าจะเป็นการสร้าง
น่าเวบ็เพจ การใส่ขอ้ความ การแทรกตาราง และ
ยงัมีบทเรียนอ่ืน ๆ ท่ีน่าสนใจให้นักเรียนได้
ศึกษาในห้องเรียนน้ีอีกมากมาย อยากรู้กนัแล้ว
ใช่ไหมค่ะว่าในห้อง เ รียนน้ีความรู้อะไรท่ี
นักเรียนจะได้บ้าง เราไปลองศึกษาแต่ละละ
บทเรียนกนัเลยดีกวา่ค่ะ  

1  รู้จกักบั Dream 
Weaver 

ครูซีบรรยาย สวัสดีค่ะนัก เรียนทุกคน ว ันน้ีเราจะมาเ ร่ิม
บท เ รี ย น แ ร ก ใ น ห้ อ ง เ รี ย น เ ส มื อ น วิ ช า
คอมพิว เตอร์  เ ร่ืองการสร้าง เว็บไซต์ด้วย
โปรแกรมดรีมวีฟเวอร์ CS6 กนันะคะ บทเรียน
แรกของ วัน น้ี คื อบท เ รี ยน เ ร่ื อ ง  รู้ จัก กับ
โปรแกรมดรีมวีฟเวอร์ โปรแกรมดรีมวีฟเวอร์
คืออะไร ถ้านักเรียนต้องการทราบเราไปเร่ิม
เรียนในบทเรียนกนัเลยดีกวา่ค่ะ 
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หน่วยการ 
เรียนรู้ 

เร่ือง ภาพ ค าบรรยาย 

2 การเรียกใชง้าน
โปรแกรม Dream 

Weaver 

ครูซีบรรยาย สวัสดีค่ะนักเรียนทุกคน หลังจากท่ี รู้จักกับ
บทเรียนแรกกันไปแล้ว  ว ันน้ีในห้องเ รียน
เสมือนวิชาคอมพิวเตอร์ เร่ืองการสร้างเวบ็ไซต์
ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6 เราจะมาเร่ิมเขา้
สู่โปรแกรมของจริงกนัดีกว่าค่ะ ไหน ๆ เราก้อ
รู้จกักบัโปรแกรมแลว้ ท าไมนกัเรียนไม่ลองใช้
มนัสักหน่อยใช่ไหมละคะ  

3 ส่วนประกอบของ
โปรแกรม Dream 

Weaver 

ครูซีบรรยาย สวสัดีค่ะนกัเรียนทุกคน นกัเรียนทุกคนไดล้อง
เขา้โปรแกรมดรีมวีฟเวอร์ CS6 กนัแลว้ใช่ไหม
ค่ะ เป็นยงัไงกนับา้งหน้าตาของโปรแกรม ดูงง 
ๆ กันไหมคะ ท่ายงัไงวนัน้ีครูซีจะมาแนะน า
เก่ียวกบัส่วนประกอบต่าง ๆ ของโปรแกรมดรีม
วฟีเวอร์ วา่หนา้ตาท่ีนกัเรียนเห็นนั้นมนัคืออะไร
กนับา้ง อยากรู้แลว้ใช่ไหมละคะ เราไปดูกนัเลย
ค่ะ  

4 รู้จกัแถบเคร่ืองมือ  
Insert Toolbar 

ครูซีบรรยาย สวสัดีค่ะนกัเรียนทุกคน หลงัจากท่ีนกัเรียนรู้จกั
กบัส่วนประกอบต่าง ๆ ของโปรแกรมดรีมวีฟ
เวอร์ CS6 กันแล้ว วนัน้ีครูซีจะมาแนะน า
นกัเรียนเก่ียวกบักลุ่มค าสั่งและเคร่ืองมือต่าง ๆ 
วา่แต่ละค าสั่งเอาไวใ้ชท้  าอะไรกนับา้ง หลงัจาก
ท่ีนักเรียนศึกษาบทเรียนน้ีเสร็จแล้วครูซีจะให้
นกัเรียนทุกคนลงมือปฏิบติักนัจริง ๆ แลว้นะคะ 
อยากสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟเวอร์ 
CS6 กนัแลว้ใช่ไหมละคะ นกัเรียนทุกคนจะตอ้ง
ตั้ งใจศึกษาบทเรียนต่าง ๆ ท่ีผ่านมารวมถึง
บทเรียนน้ีให้ดีนะคะครูซีจะไปรอทุกคนอยู่ท่ี
หอ้งเรียนถดัไป พยายามเขา้นะคะ  
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หน่วยการ 
เรียนรู้ 

เร่ือง ภาพ ค าบรรยาย 

5 ขั้นตอนการสร้างเวบ็ ครูซีบรรยาย สวสัดีค่ะนักเรียนทุกคน เป็นยงัไงกันบ้างคะ
หลังจากท่ีศึกษาบทเรียนท่ีผ่าน ๆ มา คิดว่า
นกัเรียนพอจะสร้างเวบ็ไซต์กนัไดไ้หมคะ วนัน้ี
ครูซีจะให้นัก เ รียนทุกคนเ ร่ิมต้นการสร้าง
เวบ็ไซต์ดว้ยโปรแกรมดรีมวีฟเวอร์ CS6 นะคะ 
ในบทเรียนน้ีเราจะมาเร่ิมตน้สร้างเว็บเพจโดย
การก าหนดคุณสมบัติพื้นฐานของเว็บเพจกัน
ก่อนเลยนะคะ วา่แต่เราจะก าหนดคุณสมบติัของ
เว็บเพจกนัยงัไงและก าหนดแบบไหน ลองไป
ศึกษากนัในบทเรียนน้ีเลยดีกวา่ค่ะ  

6 การบนัทึกและเปิด
เวบ็เพจ 

ครูซีบรรยาย สวสัดีค่ะนักเรียนทุกคน ในบทเรียนท่ีผ่านมา
นักเรียนลองก าหนดคุณสมบติัของเว็บเพจกัน
แล้วใช่ไหมคะ ครูซีอยากเห็นจงัเลยว่าเว็บเพจ
ของแต่ละคนหนา้ตาเป็นยงัไง ตอ้งท าไดส้วยกนั
แน่ ๆ เลยค่ะ แต่วา่หลงัจากเราก าหนดคุณสมบติั
แลว้เรายงัไม่ไดบ้นัทึกเวบ็เพจของเราเลยนะคะ 
เช่นนั้นงานท่ีเราท ามาก็จะหายนะสิคะ วนัน้ีเพื่อ
ไม่ให้งานท่ีเราท าสูญหายไป ครูซีจะมาสอนให้
นักเรียนทุกคนบนัทึกเว็บเพจท่ีตนเองท า แล้ว
ลองเรียกใช้งานเว็บเพจท่ีนักเรียนได้บนัทึกไว้
กนัดูค่ะ ลองไปท ากนัเลยดีกวา่ค่ะ 

7 การใส่ขอ้ความลง
บนเวบ็เพจ 

ครูซีบรรยาย สวสัดีค่ะนกัเรียนทุกคน ตอนน้ีนกัเรียนทุกคนมี
เว็บเพจท่ีก าหนดคุณสมบัติพื้นฐานเป็นของ
ตนเองแล้วใช่ไหมคะ ท่าเช่นนั้นวนัน้ีเราจะมา
ใส่ข้อความลงในเว็บเพจท่ีเราได้บันทึกไวใ้น
บทเรียนท่ีผ่านมากันดีกว่าค่ะ เว็บไซต์ท่ีมีแต่
หน้าว่าง ๆ มันก็ไม่ได้ให้สาระอะไรกับเรา
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หน่วยการ 
เรียนรู้ 

เร่ือง ภาพ ค าบรรยาย 

เพราะฉะนั้นวนัน้ีครูซีจะสอนให้นกัเรียนทุกคน
ใส่ข้อความลงบนเว็บเพจของตวัเองนะคะ ให้
เวลาคิดขอ้ความและเน้ือหาท่ีนักเรียนตอ้งการ
ใส่ ถ้านกัเรียนคิดไดแ้ล้วเราไปลองท าพร้อม ๆ 
กบัครูซีเลยดีกวา่ค่ะ 

8 การแทรกภาพบน
เวบ็เพจ 

ครูซีบรรยาย สวสัดีค่ะนกัเรียนทุกคน เป็นยงัไงกนับา้งคะเวบ็
เพจของแต่ละคน ตอนน้ีเว็บเพจของทุกคนมี
ขอ้ความท่ีนกัเรียนตอ้งการใส่ลงไปแลว้ใช่ไหม
คะ วา่แต่ มนัดูไม่ค่อยน่าสนใจเท่าไรเลยใช่ไหม
ละคะ มองไปทางไหนก็มีแต่ตวัหนงัสือ ท ายงัไง
กนัดี ถา้จะใหเ้วบ็เพจของเราน่าสนใจมากข้ึนเรา
จะตอ้งมีภาพประกอบเน้ือหาของเรา ถ้าใครยงั
ไม่ไดเ้ตรียมภาพประกอบครูซีให้เวลาไปเตรียม
ภาพประกอบของตวัเองให้เรียบร้อย หลงัจาก
นั้นเราจะไปแทรกภาพบนเวบ็เพจของเรากนัค่ะ 

9 การจดัการเวบ็เพจ
ดว้ยตาราง 

ครูซีบรรยาย สวสัดีค่ะนกัเรียนทุกคน ครูซีไดเ้ห็นเวบ็เพจของ
นกัเรียนทุกคนแลว้นะคะ แต่ละคนท าออกมาได้
ดีมาก หลงัจากท่ีนกัเรียนไดใ้ส่ขอ้ความลงไป 
แทรกภาพลงในเวบ็เพจ วนัน้ีครูซีจะมาสอนทุก
คนเก่ียวกบัการใส่ตารางบนเวบ็เพจ ตารางเอาไว้
ท าอะไร ตารางเอาไวเ้วลานกัเรียนตอ้งการให้
ขอ้มูลของนกัเรียนมีความเป็นระเบียบ มีการจดั
หมวดหมู่ใหดู้ง่ายยิง่ข้ึน ลองไปดูตวัอยา่งพร้อม
วธีิการจดัการกบัตารางกนัเลยดีกวา่ค่ะ 
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หน่วยการ 
เรียนรู้ 

เร่ือง ภาพ ค าบรรยาย 

10 การแทรกมลัติมิเดีย 
บนเวบ็เพจ 

ครูซีบรรยาย สวสัดีค่ะนกัเรียนทุกคน บทเรียนน้ีเป็นบทเรียน
สุดท้ายของห้องเรียนเสมือนวิชาคอมพิวเตอร์ 
เร่ืองการสร้างเว็บไซต์ด้วยโปรแกรมดรีมวีฟ
เวอร์ CS6 นกัเรียนมีเวบ็เพจเป็นของตวัเอง ใส่
ข้อความหรือ เ น้ือหา ท่ีตัว เองต้องการ  ใ ส่
ภาพประกอบ รวมทั้งจัดหมวดหมู่ด้วยตาราง
แล้ว บทเรียนสุดทา้ยท่ีครูซีจะมาสอนนักเรียน
วนัน้ีคือการท าให้เวบ็เพจของเราน่าสนใจยิ่งข้ึน 
นัน่ก็คือ การแทรกมลัติมิเดียลงบนเว็บเพจของ
นักเรียน ถ้านักเรียนคนใดยงัไม่มีไฟล์มัลติมิ
เดียวครูซีแนะน าให้นกัเรียนไปจดัเตรียมไฟล์มา
ก่อนนะคะ ถา้พร้อมแล้วเราไปเรียนบทเรียนน้ี
กนัเลยค่ะ 

 
 



ภาคผนวก  ฎ 
ตวัอย่างห้องเรียนเสมือน เร่ืองการสร้างเวบ็ไซต์ 

ด้วยโปรแกรมดรีมวฟีเวอร์ CS6
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ตัวอย่างห้องเรียนเสมอืน เร่ืองการสร้างเวบ็ไซต์ด้วยโปรแกรมดรีมวฟีเวอร์ CS6 

 

 
 
 
 
 
 
 
 
 
 
 
ภาพภาคผนวก ฎ ที ่1  หนา้เขา้สู่หอ้งเรียน 

จากภาพภาคผนวก ฎ ท่ี 1  แสดงหนา้เขา้สู่หอ้งเรียน เพื่อเขา้เรียนร่วมกบัเพื่อนในหอ้งเรียน 
เสมือนจริงวชิาคอมพิวเตอร์ ส าหรับนกัเรียนชั้นประถมศึกษาปีท่ี 6 
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ภาพภาคผนวก ฎ ที ่2  วธีิการใชง้านโปรแกรมเสมือนจริง 

จากภาพภาคผนวก ฎ ท่ี 2  แสดงหนา้วธีิการใชง้านห้องเรียนเสมือน ซ่ึงจะอธิบายเก่ียวกบั
วธีิการใชง้านหอ้งเรียนเสมือนและการสแกนคิวอาร์โคด้ต่าง ๆ 

 

 

ภาพภาคผนวก ฎ ที ่3  แบบทดสอบก่อนเรียน 
จากภาพภาคผนวก ฎ ท่ี 3 แสดงหนา้แบบทดสอบก่อนเรียนมีค าช้ีแจงใหน้กัเรียน มีไฟล์

วดีิโอตวัอยา่งการคลิกเขา้ไปท าแบบทดสอบ และมีไฟลแ์บบทดสอบใหด้าวน์โหลด 
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ภาพภาคผนวก ฎ ที ่4  จุดประสงคก์ารเรียนรู้  
จากภาพภาคผนวก ฎ ท่ี  4  แสดงจุดประสงคก์ารเรียนรู้ของบทเรียน เร่ือง การสร้าง

เวบ็ไซตด์ว้ยโปรแกรมดรีมวีฟเวอร์ CS6 
 

 

 

ภาพภาคผนวก ฎ ที ่5  ตวัอยา่งบทเรียนในหน่วยท่ี 1   
จากภาพภาคผนวก ฎ ท่ี 5 แสดงหนา้หน่วยท่ี 1 รู้จกักบั Dream Weaver แสดงจุดประสงค์

การเรียนรู้ในหน่วยท่ี 1 แสดงวิดีโอตวัอย่างหน้าตาของโปรแกรมดรีมวีฟเวอร์ และแสดงขอ้ความ
ค าอธิบายเก่ียวกบัเร่ือง รู้จกักบั Dream Weaver 
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ภาพภาคผนวก ฎ ที ่6  ตวัอยา่งบทเรียนในหน่วยท่ี 2   
จากภาพภาคผนวก ฎ ท่ี 6 แสดงหน้าการเรียกใช้งานโปรแกรมดรีมวีฟเวอร์ แสดง

จุดประสงค์การเรียนรู้ในหน่วยท่ี 2 แสดงวิดีโอตวัอย่างการเรียกใชง้านโปรแกรมดรีมวีฟเวอร์ และ
แสดงขอ้ความค าอธิบายเก่ียวกบัเร่ือง การเรียกใชง้านโปรแกรมดรีมวฟีเวอร์ 

 

     

 
ภาพภาคผนวก ฎ ที ่7  ตวัอยา่งบทเรียนในหน่วยท่ี  3 

จากภาพภาคผนวก ฎ ท่ี 7  แสดงหนา้ส่วนประกอบของโปรแกรมดรีมวีฟเวอร์ เวอร์ แสดง
จุดประสงคก์ารเรียนรู้ในหน่วยท่ี 3 แสดงวิดีโอตวัอยา่งส่วนประกอบของโปรแกรมดรีมวีฟเวอร์ และ
แสดงขอ้ความค าอธิบายเก่ียวกบัเร่ือง ส่วนประกอบของโปรแกรมดรีมวฟีเวอร์ เวอร์ 
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ภาพภาคผนวก ฎ ที ่8  ตวัอยา่งบทเรียนในหน่วยท่ี  4     

จากภาพภาคผนวก ฎ ท่ี 8  แสดงหนา้รู้จกัแถบเคร่ืองมือ Insert Toolbar แสดงจุดประสงค์
การเรียนรู้ในหน่วยท่ี 4 แสดงวิดีโอตวัอย่างรู้จกัแถบเคร่ืองมือ Insert Toolbar และแสดงขอ้ความ
ค าอธิบายเก่ียวกบัเร่ือง รู้จกัแถบเคร่ืองมือ Insert Toolbar 

 
 

ภาพภาคผนวก ฎ ที ่9   ตวัอยา่งบทเรียนในหน่วยท่ี 5 
จากภาพภาคผนวก ฎ ท่ี 9  แสดงหนา้ขั้นตอนการสร้างเวบ็ แสดงจุดประสงคก์ารเรียนรู้ใน

หน่วยท่ี 5 แสดงวดีิโอตวัอยา่งขั้นตอนการสร้างเวบ็ และแสดงขอ้ความค าอธิบายเก่ียวกบัเร่ือง ขั้นตอน
การสร้างเวบ็ 
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ภาพภาคผนวก ฎ ที ่10  ตวัอยา่งบทเรียนในหน่วยท่ี 6 
จากภาพภาคผนวก ฎ ท่ี 10 แสดงหน้าการบนัทึกและเปิดเวบ็เพจ แสดงจุดประสงค์การ

เรียนรู้ในหน่วยท่ี 6 แสดงวิดีโอตวัอย่างการบนัทึกและเปิดเว็บเพจ และแสดงขอ้ความค าอธิบาย
เก่ียวกบัเร่ือง การบนัทึกและเปิดเวบ็เพจ 

 

 

ภาพภาคผนวก ฎ ที ่11  ตวัอยา่งบทเรียนในหน่วยท่ี 7 
จากภาพภาคผนวก ฎ ท่ี 11 แสดงหนา้การใส่ขอ้ความลงบนเวบ็เพจ แสดงจุดประสงคก์าร

เรียนรู้ในหน่วยท่ี 7 แสดงวิดีโอตวัอย่างการใส่ขอ้ความลงบนเวบ็เพจและแสดงขอ้ความค าอธิบาย
เก่ียวกบัเร่ือง การใส่ขอ้ความลงบนเวบ็เพจ 
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ภาพภาคผนวก ฎ ที ่12  ตวัอยา่งบทเรียนในหน่วยท่ี 8 
จากภาพภาคผนวก ฎ ท่ี 12 แสดงหน้าการแทรกภาพบนเวบ็เพจ แสดงจุดประสงค์การ

เรียนรู้ในหน่วยท่ี 8 แสดงวิดีโอตวัอย่างการแทรกภาพเวบ็บนเพจ และแสดงขอ้ความค าอธิบาย
เก่ียวกบัเร่ือง การแทรกภาพบนเวบ็เพจ 

 

 

 

ภาพภาคผนวก ฎ ที ่13  ติดต่อครูประจ าวชิา 
จากภาพภาคผนวก ฎ ท่ี 13 แสดงหน้าติดต่อครูประจ าวิชา ซ่ึงมีช่องทางในการติดต่อให้

นกัเรียนไดเ้ลือกหลายช่องทาง  
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ภาพภาคผนวก ฎ ที ่14  สมาชิกในหอ้งเรียนเสมือน 
จากภาพภาคผนวก ฎ ท่ี 14 แสดงหนา้รายช่ือสมาชิกท่ีเรียนบทเรียนในหอ้งเรียนเสมือน 
  

 

ภาพภาคผนวก ฎ ที ่15 ปฎิทินกิจกรรม 
จากภาพภาคผนวก ฎ ท่ี 15 แสดงหนา้ปฏิทินกิจกรรมต่าง ๆ และวนันัดส่งใบงาน 
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ภาพ
ภาคผนวก ฎ ที ่16  รายละเอียดกิจกรรม 

จากภาพภาคผนวก ฎ ท่ี 16 แสดงหนา้รายละเอียดกิจกรรมยอ่ยต่าง ๆ 

 

 

ภาพภาคผนวก ฎ ที ่17  โตต้อบกบัครูประจ าวชิา 
จากภาพภาคผนวก ฎ ท่ี 17 แสดงหนา้การโตต้อบสอบถามเก่ียวกบังานและกิจกรรมรวมถึง

บทเรียนต่าง ๆ 
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